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What’s New

Overview

The middle tier of the SAS Intelligence Platform provides an execution environment
for business intelligence Web applications such as SAS Web Report Studio and SAS
Information Delivery Portal.

The middle tier has the following changes and enhancements:

O

O 0o o o g

O

common Web administration

better integration with third-party security products
SAS Content Server

SAS Web Application Themes

SAS Information Delivery Portal administration
SAS Web Report Studio administration

SAS BI Dashboard administration

The middle tier and its applications are supported on Windows and UNIX. JBoss,
WebLogic, and WebSphere application servers are supported on Windows and UNIX.
Beginning with the third maintenance release for SAS 9.2 and later, the WebSphere
application server is supported on the z/OS platform.

Common Web Administration

A common Web infrastructure provides consistent and cohesive Web applications that
are well integrated. This infrastructure layer results in the following enhancements:

O

A new SAS Web Infrastructure Platform provides basic services and applications
that are used by all Web applications that run in the middle tier of the intelligence
platform. The SAS Web Infrastructure Platform contains some of the technology
that the SAS Web Infrastructure Kit contained in previous releases, such as the
SAS Services Application and the SAS Stored Processes Web Application.
However, the SAS Web Infrastructure Platform technologies are used not only by
the SAS Information Delivery Portal, but also by other SAS Web applications. The
SAS Web Infrastructure Kit no longer exists.
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What’s New

You can customize SAS themes in a single place. The Web applications can then
be configured to use the theme that you customize.

All Web authentication occurs through a central authentication service. This
change simplifies the task of configuring Web authentication.

SAS Web Administration Console enables you to log on from a remote site and
view information that is normally available in the SAS Management Console. You
can view authenticated users and system users that are logged on to a SAS Web
applications, as well as the current configuration of Web applications deployed at
your site.

In the second maintenance release for SAS 9.2 and later, the Restart Maintenance
Wizard provides the following features:

o Enables you to send e-mail to users to log off from their sessions within a
specified deadline.

0 Logs off users after the specified deadline.
0 Prohibits new users from logging in to their user applications.

The second maintenance release for SAS 9.2 and later also includes the Quiesce
System. The Quiesce System feature is useful when you want to enable existing
users to stay logged on to their user sessions, but you want to quiesce the system
by preventing new users from logging on to SAS Web applications. You can also
access the SAS Content Server page to manage folders and permissions for content
in the SAS Content Server.

With the SAS Deployment Manager, you can either remove an existing
configuration or rebuild SAS Web applications. Beginning with the second
maintenance release for SAS 9.2 and later, when you rebuild Web applications by
using the SAS Deployment Manager, the EAR files for the Web applications are
automatically exploded and placed in two different directories.

The SAS Configuration Manager, which is available in the SAS Management
Console, enables you change settings or specify property names and values for
several applications, including SAS Information Delivery Portal, SAS Web Report
Studio, and SAS BI Dashboard.

Logging for all SAS applications is accomplished by using the Logging Service
Configuration dialog box within the Configuration Manager in SAS Management
Console.

System folders are not accessible to SAS Web application users, and can be
accessed only through SAS Management Console. For example, System and Users
folders are both system folders, and are not visible from within SAS Web Report
Studio 4.2.

Beginning with the second maintenance release for SAS 9.2 and later, the
sas-environment.xml file is used to define the available set of SAS environments
for SAS client applications. You use this file to configure multiple environments by
customizing and deploying this file to an HTTP server.

Beginning with the third maintenance release for SAS 9.2 and later, you can alert
users by displaying a warning message before they are logged out of their inactive
sessions. This feature is supported for SAS Web Report Studio, SAS Package
Viewer, SAS Shared applications, SAS Preferences, SAS Web Infrastructure
Platform administration, and SAS Stored Processes. However, if the SAS
Information Delivery Portal 4.2 is configured at your site, this feature should not
be enabled. SAS Information Delivery Portal 4.3 supports this feature.

Beginning with the third maintenance release for SAS 9.2 and later, the JVM
command for the bind address is enabled by default to ensure that the Web
application server and the JGroups software use the same bind address:
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0 Beginning with the November 2010 Release, you can manually load and update
content in the SAS Content Server.

Better Integration with Third-Party Security Products

The following enhancements have been added:

0 Web authentication is supported for JBoss, Oracle WebLogic, and IBM WebSphere
application servers.

O The middle-tier software supports interaction with WebSeal and SiteMinder.

0 Administrators can configure client certification for one-way and two-way SSL
authentication.

SAS Content Server

The SAS Content Server is a content repository that stores digital content (such as
documents, reports, and images) that is created and used by SAS client applications.
The Web-based Distributed Authoring and Versioning (WebDAV) protocol is used to
access the SAS Content Server. The SAS Web Administration Console enables you to
access the SAS Content Server to view directories, change permissions to directories,
and create and delete directories.

Beginning with the second maintenance release for SAS 9.2 and later, multiple
folders in the SAS Content Server can be deleted concurrently within the SAS Web
Administration Console.

Beginning with the third maintenance release for SAS 9.2 and later, the SAS
Content Server supports database persistence. By default, the SAS Content Server is
configured to use the file system for persistence and need not be changed. In special
cases, the SAS Content Server can be reconfigured to share and use the database that
is used by SAS Shared Services. By default, SAS Shared Services uses the SAS Table
Server, but it can be configured to use a different database such as Oracle, MySql,
PostgreSQL, DB/2, or SQL Server.

Also, in the third maintenance release for SAS 9.2, the manual setting of
JAVA_HOME variable to point to Java 5 is not required.

Beginning with the November 2010 release and later, content for the SAS Content
Server can be loaded or updated manually by running a batch file or a script. In
addition, directive URLs can be updated manually.

SAS Webh Application Themes

SAS Web Application Themes contain definitions for themes that are used by several
SAS Web applications. Themes enable you to create and apply consistent, visual
customization and company branding that is be applied to all theme-enabled SAS Web
Applications.

SAS Web applications such as SAS Web Report Studio, SAS Information Delivery
Portal, and SAS BI Dashboard can be configured to facilitate a common look and feel
across SAS applications. In SAS Web Report Studio, themes apply to the user interface,
including the dialog boxes that are used to view, create, edit, and share reports.
Themes contain images, HTML templates, and cascading style sheets (CSS).
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SAS Flex Application Themes

Beginning with the November 2010 release, SAS BI Dashboard 4.3 and SAS BI
Portlets are displayed with the Flex interface that is provided by SAS Flex Application
Themes 2.2. At start-up time, Flex applications load Flex themes automatically. A
theme consists of ShockWave Flash (SWF) files that include cascading style sheets
(CSS) files. The theme content is downloaded to the client, and is cached by the user’s
Web browser. As a result, subsequent uses of the Web application result in quicker
loading of theme content than it is at initial loading. The SAS Corporate theme is the
default theme for all Flex applications.

SAS Information Delivery Portal Administration

SAS Information Delivery Portal 4.3

SAS Information Delivery Portal 4.3 offers these new features for administration:

O

A content promotion tool is provided. This tool consists of stand-alone batch scripts,
shell scripts, and metadata extraction templates. These scripts and templates use
the metadata server’s import and export capabilities to promote portal metadata
from a SAS 9.1.3 or SAS 9.2 deployment to another SAS 9.2 deployment.

SAS Flex Application Themes 2.2 is available in the November 2010 release, and
SAS BI Portlets display with the Flex interface.

You can alert users by displaying a warning message before they are logged out of
their inactive sessions.

You can choose to enable unchallenged access to the portal. Users can then access
the portal and interact with selected content without providing a user ID and
password. The option is similar to the Public Kiosk feature in the SAS 9.1.3
release of the SAS Information Delivery Portal. You can either enable the option
in an existing deployment, or you can enable it during the process of a new
installation or a migration from SAS 9.1.3.

A Diagnostics Portlet enables you to view information about the portal’s
environment.

The SAS Web OLAP Viewer for Java is no longer supported. It has been replaced by
functionality that is available in SAS Web Report Studio 4.3. Therefore, SAS
Information Delivery Portal 4.3 contains the following changes:

O
O

O

Bookmarks and data explorations are not supported.

All data explorations are migrated to SAS Web Report Studio 4.3 reports.
However, users can still use the search capabilities within SAS Information
Delivery Portal 4.3 to find those reports, as well as information maps.

SAS Information Delivery Portal 4.3 includes a new Report Portlet that displays
SAS Web Report Studio 4.3 reports.

During software updates, the SAS Information Delivery Portal converts instances
of the Information Map Viewer portlet to the new Report Portlet.

Visual Data Explorer is not available to display information maps.

If SAS Information Delivery Portal 4.3 runs on a JBoss Web application server, and
Secure Sockets Layer is configured in your environment, the server.xml file should be
edited to specify the emptySessionPath parameter within the section on SSL
Connector. This is necessary to enable the SAS BI Portlets to run in this environment.
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SAS Information Delivery Portal 4.2

The following enhancements pertain to the administration of SAS Information
Delivery Portal 4.2 and later:

O The portal uses the SAS Web Infrastructure Plat
form for authentication, security, and other common Web infrastructure

services. The portal uses a common framework that provides consistency among
all SAS Web applications for configuration:

message logging within Configuration Manager
WebDAV content access

m
m
O logon and authentication methods
m

themes and branding specifications
o0 For managing portal content, a group content administrator is recommended. The

group content administrator can share personal content with the group, and can
edit or remove content that has been shared with the group.

o STICKY pages are referred to as PERSISTENT pages.

0 The Portal Admins group, which existed in SAS Information Delivery Portal 2.0, is
not created in the current version. Instead, the Portal ACT is created and used to
set permissions on the Permissions trees.

0 The SAS Trusted User, who is also the portal administrator, is responsible for
administering the portal, and is a member of the Portal ACT.

O The public kiosk does not exist anymore. The content administrator shares content
with the PUBLIC group to ensure that all users have access to the content.

o0 By default, PUBLIC users have restricted access. In order to enable PUBLIC
users to access content in the SAS Information Delivery Portal, you need to enable
permissions.

0 In SAS 9.1.3, the portal created permission trees for identity groups that defined
the roles. In SAS 9.2, the portal does not create the permission trees associated
with the roles.

SAS Bl Portlets Administration

The October 2009 release and later provides SAS BI Portlets that are based on JSR
168 and available in the SAS Enterprise BI Server offering. These portlets are
seamlessly integrated into the SAS Information Delivery Portal. SAS BI Portlets are
also compatible with the WebSphere Portal 6.1.0.

The November 2010 release consists of the following new features and changes:

0 The SAS BI Dashboard portlet is a new addition to the suite of SAS BI Portlets.

o0 The Diagnostics portlet is a new portlet that enables you to determine the current
status of the portal’s environment.

o The SAS Collection Portlet, which is included in the suite of SAS BI Portlets and
is compliant with JSR 168, does not allow users to search for data explorations.
All data explorations are migrated to SAS Web Report Studio 4.3 reports. Users
can, however, search for information maps in SAS BI Portlets.

o SAS Flex Application Themes 2.2 provides the Flex interface, which displays SAS
BI Portlets.

If SAS Information Delivery Portal 4.3 runs on a JBoss Web application server, and
Secure Sockets Layer is configured in your environment, the server.xml file should be
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edited to specify the emptySessionPath parameter within the section on SSL
Connector. This is necessary to enable the SAS BI Portlets to run in this environment.

Promotion of Portal Gontent

Using the content promotion tool provided in SAS Information Delivery Portal 4.3,
you can promote the following types of portal content to SAS 9.2 deployments:

o Portal Application Tree
User Permissions Tree
Portal page template
Portal content object
Portlet instance

o Portal page

O o o g

Batch files and scripts are available to promote portal content.

Typically, organizations develop and test portal content on one system before
deploying the content to a production system. The content promotion tool enables you
to move portal content from a development system to a production system, and the tool
eliminates the need to regenerate the content manually.

SAS Web Report Studio Administration

SAS Web Report Studio 4.3

SAS Web Report Studio 4.3 consists of the following enhancements and changes:

0 Folders for images, templates, and items for report distribution for users now
reside within the /SASWebReportStudio/Common folder. Previously, these folders
were located within the /SAS Folders/System/Applications/SAS Web Report
Studio/Web Report Studio 4.2 folder. When you upgrade to SAS Web Report
Studio 4.3, report templates and report distribution items are copied to the new
location. Existing banner images and conditional highlighting images remain in
the old location (so that referencing reports continue to work) and are also copied
to the new location.

o0 By default, clustering is enabled.

0 By default, in-process scheduling is supported in a clustered environment. An
in-process scheduling server runs as a process inside SAS Web Report Studio,
which eliminates the need to send jobs to an external scheduling server. The
in-process server is installed as part of the SAS Web Report Studio installation,
which eliminates the need to install, maintain, and license separate scheduling
servers.

0o SAS Web Report Studio 4.3 has 30 UDP ports available for use by the application.
These ports are in the range of 7560 to 7589.

O An event is logged in the WebReportStudio KeyActions.log file when a user
creates, edits, or deletes a distribution list.

0 Details about SAS Web Report Studio users’ logon and logoff from sessions can be
viewed conveniently in the WebReportStudio KeyActions.log file.

0 You can specify a different directory (other than the default directory) where the
Key User Action log files can be saved.
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You can specify whether the display of the left pane in SAS Web Report Studio
window should depend on the user’s preferences during the previous logon session.
By specifying the value of user for the
wrs.ReportViewPrefs.LeftPanelOpenState property, you can ensure that SAS
Web Report Studio retrieves the user’s action from the previous logon session, and
accordingly displays or eliminates the left pane in the application.

Two new capabilities have been added to SAS Web Report Studio 4.3 and SAS Web
Report Viewer 4.3: Allow Direct Access to Cubes and Allow Direct Access to
Tables. The Allow Direct Access to Cubes capability is included by default in the
following roles: Web Report Studio: Report Creation, Web Report Studio:
Advanced, and Web Report Viewer: Advanced.

The Open Maps as Reports capability has been renamed to Allow Direct Access to
Information Maps. In addition, the Repair Report capability has been renamed to
Update Resources. For sites that upgrade from SAS Web Report Studio 4.2, the
names of these capabilities will remain the same.

O New styles are available for reports.

0 The Distribute Report Wizard includes new features.

0 SAS Web Report Studio reports can be scheduled only by regular users with a SAS

identity. SAS internal accounts cannot be used to schedule reports.

The optional trusted parameter is not available in the Report Output Generation
tool.

To distribute reports with the Report Output Generation tool in environments with
multihomed machines, the outputgen. ini file should be updated to include the
-Djgroups.bind_addr command.

Reports can be scheduled only by regular users with a metadata identity. SAS
internal accounts such as the SAS Trusted User cannot be used to schedule reports.

SAS Web OLAP Viewer for Java

The SAS Web OLAP Viewer for Java application is no longer supported. It has been
replaced by functionality that is available in SAS Web Report Studio 4.3. SAS Web
Report Studio 4.3 contains the following changes:

O
O

Bookmarks and data explorations are not supported.

All data explorations are migrated to SAS Web Report Studio 4.3 reports. You can
still use the search capabilities within SAS Information Delivery Portal 4.3 to find
those reports, as well as, the information maps.

The migration tool creates a copy of the original data explorations and bookmarks,
and places them in the same location where the original content resided.

Visual Data Explorer is not available to display information maps in SAS
Information Delivery Portal 4.3.

In Edit mode within the portal, users can select a SAS Web Report Studio report
instead of a data exploration.

The SAS Collection Portlet, which is included in the suite of SAS BI Portlets and
is compliant with JSR 168, does not allow users to search for data explorations.
All data explorations are migrated to SAS Web Report Studio 4.3 reports. Users
can, however, search for information maps.

SAS Web Report Studio 4.2

The following enhancements pertain to SAS Web Report Studio 4.2 administration:
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In SAS Web Report Studio 4.2, you have the flexibility to choose the location of the
SAS Web Report Studio user folders anywhere below the SAS Folders directory in
the Folders tab window in SAS Management Console. Previously, in SAS Web
Report Studio 3.1, you were required to use predefined storage folders. This is no
longer the case.

The /BIP Tree/ReportStudio/Shared/Reports folder path does not exist in
SAS Web Report Studio 4.2. However, if your organization migrated from SAS
9.1.3 to SAS 9.2, the legacy path is automatically enabled in the Web Report
Studio 4.2 Properties dialog box within SAS Management Console. As a result, the
legacy folder paths are available to users on the SAS Web Report Studio Location
drop-down menu.

SAS Web Report Studio 4.2 offers three predefined roles with certain capabilities
that are assigned to these roles initially. These predefined roles include Report
Viewing, Report Creation, and Advanced. You are not required to use predefined
roles. You have the ability to create roles and capabilities that meet the needs of
your organization. You can determine the number of roles to create, which features
are available for each role, and control other aspects of role-based behavior.

The Report Distribution Wizard has been significantly enhanced to enable you to
create and edit recipient lists by specifying recipient names and e-mail addresses,
and channel information within the wizard’s dialog boxes.

When users need to view a report, and are transferred by an external application
such as the SAS Information Delivery Portal, those users are transferred to SAS
Web Report Studio (if the application is installed). The functionality offered by the
SAS Web Report Studio is determined by the roles and capabilities that are
assigned to these users.

You can set security measures to limit SAS Web Report Studio to interact only
with information maps that are in designated locations. For example, you might
limit the availability of all relational information maps because some of those
information maps include row-level permissions.

The pefaultLoggerProperties.xml file is not used. Logging for all applications
is now accomplished by using the Logging Service Configuration dialog box within
Configuration Manager in SAS Management Console.

Previously, if client-side pooling was configured, SAS Web Report Studio 3.1
required that the pooling administrator’s user name and password be stored in the
metadata. This requirement has been waived in SAS Web Report Studio 4.2.

In previous versions of SAS Web Report Studio, the LocalProperties.xml file
offered the only practical method to override properties and their values. Although
this file is available and supported in SAS Web Report Studio 4.2, it is
recommended that you use the Configuration Manager in SAS Management
Console to configure and set properties for SAS Web Report Studio. The
Configuration Manager offers a consistent interface to set properties for all SAS
applications.

0 SAS Web Report Studio 4.2 enables you to add disclaimer text to graphs and tables.
0 The report output generation tool enables you to create pre-generated, static

versions of reports from the command line. This tool has been updated with the
rptbatch.bat file, which calls upon the outputgen.exe file. In addition, new
parameters have been added to the report output generation tool.

The WebReportStudioProperties.xml file is no longer used in SAS Web Report
Studio 4.2. Instead, the Advanced tab in Web Report Studio Properties 4.2 is used
to specify property names and property values.

Previous users of SAS Web Report Studio can locate their home folders in the new
SAS 9.2 home folders. These new folders have restricted metadata permissions.
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SAS Web Report Studio 4.2 maintains a working area that is hidden from users.
This working area, which is located at/system/Applications/SAS Web Report
Studio/Web Report Studio 4.2, is accessed by using the SAS Management
Console. This location might store shared content such as images.

Banner images are stored in the /Web Report Studio 4.2/BannerImages folder.
Sample conditional highlighting image files are deployed in the /Web Report
Studio 4.2/ConditionalHighlightingImages folder.

In SAS Web Report Studio 4.2, PUBLIC users do not have personal home folders.
In addition, PUBLIC users do not have a location to store their history and
preferences. As a result, PUBLIC users’ report history is not retained.

By default, PUBLIC users have restricted access. In order to enable PUBLIC
users to access SAS Web Report Studio, you need to enable permissions.
Beginning with the third maintenance release for SAS 9.2 and later, the log file,
SASBIReportServices4.2.log, is created when you first run the report output
generation tool with default permissions.

In the third maintenance release for SAS 9.2, if you run the commands for the
report output generation tool on a z/OS system with WebSphere, retrieve the fully
qualified pathname to the generated file. Then, locate the generated .in file or .jcl
file, and copy the relevant contents into the command line text used to run the
distribution job.

In the third maintenance release for SAS 9.2, you can change the location of the
temporary workspace for SAS Web Report Studio and SAS Web Report Viewer.

SAS Bl Dashhoard Administration

SAS Bl Dashhoard 4.3

SAS BI Dashboard 4.3 offers several new features and enhancements that make
administration easier, flexible, and convenient. These enhancements are as follows:

O

Storage folders for SAS BI Dashboard 4.3 now exist in both the foundation SAS
Metadata Repository and the SAS Content Server or the file system.

Users’ folders for SAS BI Dashboard 4.3 can be located anywhere below the sas
Folders directory on the Folders tab of SAS Management Console. Previously, in
SAS BI Dashboard 4.2, you were required to use predefined storage folders. This
is no longer the case.

Configuration files for SAS BI Dashboard 4.3 are stored on the SAS Content
Server. Previously, all files were stored in a file system.

You can use the SAS Content Server Administration Console to manage SAS BI
Dashboard 4.3 files and WebDAV folders in the SAS Content Server.

You can enable users to log on, view, and interact with a dashboard by creating
metadata identities for the users.

As with all SAS applications, logging is accomplished by using the Logging Service
Configuration dialog box within the Configuration Manager in SAS Management
Console.

You can register a stored process and make it available to SAS BI Dashboard 4.3
users.

Three types of caching are available: data caching, content caching, and client
caching.

Data caching was available previously in SAS BI Dashboard 4.2. Beginning with
SAS BI Dashboard 4.3, files for data caching are stored in the SAS Content Server.
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Content caching, which is a new type of caching, is enabled by default in SAS BI
Dashboard 4.3.

Client browsers that display dashboards with SAS BI Dashboard 4.3 use Flash in
the Rich Internet Application (RIA) architecture. Client caching is enabled by
default.

Image files are no longer cached.

SAS BI Dashboard 4.3 supports the SAS Comment Manager.

DSX files are stored in the SAS Content Server.

DSX files are modified by exporting the DSX file from SAS Management Console,
making necessary changes to the files, and importing the files.

The standard logging facility used by the SAS 9.2 Intelligence Platform is
supported. In SAS Management Console, the Logging Service dialog box enables
you to manage performance, track security enforcement, and analyze specific
situations.

The SAS BI Dashboard Portlet is installed along with the other SAS BI Portlets.
This portlet allows users to display a dashboard that is created with the SAS BI
Dashboard application. The configuration of this portlet is identical to the
configuration of the SAS BI Portlets for the WebSphere Portal.

Partial promotion is supported for SAS BI Dashboard 4.3. However, there are
special considerations that apply to the promotion process.

o0 You can specify a session time-out interval for inactive user sessions.

0 You can alert users by displaying a warning message before they are logged out of

their inactive sessions.

SAS Bl Dashhoard 4.2

In SAS BI Dashboard 4.2, an alert can be set up to enable Event Generation

Framework to regularly poll BI Dashboard indicators, determine whether an event
qualifies for an alert, and generate an alert for the user. In order to minimize the
impact of constant polling on BI Dashboard’s performance, you can customize and set
parameters for alert latency.

SAS Webh Parts for Microsoft SharePoint

In the November 2010 release, SAS Web Parts for Microsoft Sharepoint is a new

product that includes:

o SAS BI Dashboard Web Part that displays dashboards and KPIs to enable users to

monitor organizational performance

O SAS Stored Process Web Part that enables users to view the results of a stored

process at the SharePoint site
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Introduction to This Guide

This guide covers the administration of the SAS Web applications that run in the
middle tier of the SAS Intelligence Platform.

The middle tier provides an execution environment for business intelligence Web
applications such as SAS Web Report Studio and SAS Information Delivery Portal.
These applications communicate with the user by sending data to and receiving data
from the user’s Web browser. Users in your organization work with the Web
applications in order to query data, to generate reports, and to share and deliver
information across the entire enterprise.

As an administrator, you can create a custom middle-tier environment for your users
that meets your organization’s security, availability, scalability, performance, and
maintainability requirements. This guide provides post-installation instructions for
carrying out the administrative tasks that you might need to perform.

This guide assumes that you are familiar with the concepts and terminology that are
introduced in the SAS Intelligence Platform: Overview document. For a list of all of the
documents that SAS publishes to support administration of the SAS Intelligence
Platform, see http://support.sas.com/92administration.

Accessibility Features in the SAS Intelligence Platform Products

For information about accessibility for any of the products mentioned in this book,
see the documentation for that product. If you have questions or concerns about the
accessibility of SAS products, send e-mail to accessibility@sas.com.

Prerequisites for Administering the Web Applications


http://support.sas.com/92administration
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What You Should Know

Before you administer the Web applications, familiarize yourself with the following:

O

basic concepts and components of the SAS Intelligence Platform, as described in
the SAS Intelligence Platform: Overview.

the SAS environment, as described in the SAS Intelligence Platform: System
Administration Guide.

the SAS applications servers. You should understand how the servers are started
and which servers are required for different types of content.

For the start-up order for servers, see “Starting the Web Applications” on page
17. For a summary of the servers that are required for particular content, see the
SAS Intelligence Platform: Application Server Administration Guide.

security concepts, as described in the SAS Intelligence Platform: Security
Administration Guide. You should understand authentication and authorization,
and know how to manage access in the metadata layer. You should also know how
to create and manage user and group definitions in metadata.

the middle-tier environment, as described in “Understanding the Middle-Tier
Environment” on page 7.

basic procedures for using the applications that you plan to administer. For
example, if you are responsible for administering SAS Web Report Studio, then you
should know how to log on, navigate, and create reports in SAS Web Report Studio.

What You Should Do

The Web applications must be functional before they can be administered. Therefore,
before you administer the Web applications, do the following:

O

O

O

Perform a planned installation and initial configuration, as described in the SAS
Intelligence Platform: Installation and Configuration Guide.
o If you are upgrading from SAS 9.1.3 to SAS 9.2, then refer to the SAS
Intelligence Platform: 9.1.3 to 9.2 Migration Guide.

o If you are upgrading from SAS 9.2 to a maintenance release of SAS 9.2, see
Maintenance Planning for SAS 9.2.

Your installation should include the standard, required SAS user accounts that are
described in the SAS Intelligence Platform: Installation and Configuration Guide.

Verify that your Web applications operate correctly. You should be able to start the
Web applications, log on, and perform basic tasks in those applications.

High-Level Overview of Administrative Tasks

After you have installed the middle-tier software, you can administer the Web
applications in the middle tier. Some of the tasks that you might perform include the
following:

O

O

Make resources and content items available to the Web applications.

For example, you can make fonts and graphics available to report creators who
work in SAS Web Report Studio. If your deployment includes the SAS Information
Delivery Portal, then you can add reports, files, links, and other items to the portal
environment.

Ensure that users see only the information that they are authorized to access.
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In order to implement security, you register users in metadata, assign users to
groups, and set up authorization for those groups. In this way, you can control
access to all content.

Note: Most of the tasks related to user management and authorization are
described in the SAS Intelligence Platform: Security Administration Guide. A

o Change the method of authentication.

Instead of using the SAS Metadata Server for authentication, you can use a Web
application server (JBoss, IBM WebSphere, or Oracle WebLogic) to authenticate
users. You can also implement single sign-on, so that users are not repeatedly
prompted for their user IDs when they access different Web applications.

For a detailed discussion of different types of authentication and configuration
guidelines, see “Authentication Mechanisms” in the SAS Intelligence Platform:
Security Administration Guide. For information about configuring Web
authentication for JBoss, IBM WebSphere, or Oracle WebLogic, go to http://
support.sas.com/resources/thirdpartysupport/v92/.

0 Customize the environment for your users.

The Web applications enable you to customize the interface in different ways:
0 SAS Web Report Studio enables you to customize reports for your organization.
0 The SAS Information Delivery Portal enables you to create different views for

different types of users. In addition, your developers can create the content,

custom portlets, logos, company colors, and page themes that best suit your
organization.

o Optimize performance.

One way to improve performance is to set up workspace server pooling, as
described in the SAS Intelligence Platform: Application Server Administration
Guide. You can also make configuration changes that are specified in Chapter 3,
“Best Practices for Configuring Your Middle Tier,” on page 23.

In addition, the Web applications have their own specific tasks:
“Main Tasks for Administering the Portal” on page 286

“Main Tasks for Administering SAS Web Report Studio” on page 190
“Main Tasks for Administering SAS BI Dashboard” on page 423


http://support.sas.com/resources/thirdpartysupport/v92/
http://support.sas.com/resources/thirdpartysupport/v92/
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Understanding the Middle-Tier Environment

The middle tier of the SAS Intelligence Platform enables users to access intelligence
data and functionality via a Web browser. This tier provides Web-based interfaces for
report creation and information distribution, while passing analysis and processing
requests to the SAS servers.

The middle tier of the SAS Intelligence Platform provides an environment in which
the business intelligence Web applications, such as SAS Web Report Studio and the
SAS Information Delivery Portal, can execute. These products run in a Web application
server and communicate with the user by sending data to and receiving data from the
user’s Web browser. The middle tier applications rely on servers on the SAS server tier
to perform SAS processing, including data query and analysis.

The following figure shows how the middle tier interacts with other tiers of the SAS
Intelligence Platform. For a description of these components, see SAS Intelligence
Platform: Overview.
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Display 2.1 Architecture of the SAS Intelligence Platform
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The middle tier includes the following third-party software and SAS software

elements:

a Web application server

a Java Development Kit
SAS Web applications, which can include SAS Web Report Studio, the SAS
Information Delivery Portal, the SAS BI Dashboard, SAS Help Viewer for the Web,
and other SAS products and solutions
O the SAS Web Infrastructure Platform, which includes the SAS Content Server and
other infrastructure applications and services
SAS Shared Services

a Java remote method invocation (RMI) server, which enables access to SAS
Foundation Services and associated extension services

The SAS Intelligence Platform architecture gives you the flexibility to distribute
these components according to your organization’s requirements. For small
implementations, the middle-tier software, SAS Metadata Server, and other SAS
servers, such as the SAS Workspace Server and SAS Stored Process Server, can all run
on the same machine. In contrast, a large enterprise might have multiple servers and a
metadata repository that are distributed across multiple platforms. In addition, the
components of the different tiers, such as Web applications that run in a Web
application server, might be distributed on separate machines.

SAS software components in the middle-tier include the SAS Foundation Services
and the SAS Web Infrastructure Platform.

The following figure illustrates the middle-tier components:
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Display 2.2 Middle-Tier Components
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Web Application Server

The Web application server provides the execution environment for Web applications
that run on the middle tier. The following third-party servers are supported:

o JBoss Application Server
o IBM WebSphere Application Server
o Oracle WebLogic Server

For information about the currently supported versions of these products, see the SAS
third-party Web page at http://support.sas.com/resources/thirdpartysupport/
v92/. The Web applications in the middle-tier are supported on Windows and UNIX
operating systems. Beginning with the third maintenance release for SAS 9.2 and later,
Web applications in the middle-tier are supported on the z/OS operating system.

The following applications and services run in the Web application server
environment:

O applications and services that are part of the SAS Web Infrastructure Platform
o SAS Shared Services

o the SAS Web Report Studio, SAS Information Delivery Portal, SAS BI Dashboard,
and SAS Help Viewer for the Web applications

Depending on which products and solutions you have purchased, your site might
have additional Web applications.


http://support.sas.com/resources/thirdpartysupport/v92/
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Java Development Kit

If you are using JBoss or WebLogic application server, a Java Development Kit (JDK)
must be installed. (WebSphere application server ships with its own version of the JDK
that is installed when you install WebSphere software). For information about the
currently supported versions of the JDK, see the SAS third-party Web site at http://
support.sas.com/resources/thirdpartysupport/v92.

SAS Web Infrastructure Platform

The SAS Web Infrastructure Platform is a collection of services and applications that
provide common infrastructure and integration features to be used by SAS Web
applications. These services and applications provide the following benefits:

O consistency in installation, configuration, and administration tasks for Web
applications

O greater consistency in users’ interactions with Web applications
O integration among Web applications as a result of the ability to share common
resources

The following services and applications are included in the SAS Web Infrastructure
Platform:

Tahle 2.1 Services and Applications in the SAS Web Infrastructure Platform

Application or Service Features

SAS BI Web Services for Java Can be used to enable your custom applications to invoke and
obtain metadata about SAS Stored Processes. Web services
enable distributed applications that are written in different
programming languages and that run on different operating
systems to communicate using standard Web-based protocols.
The most common protocol is the Simple Object Access Protocol
(SOAP).

The SAS BI Web Services for Java interface is based on the
XML For Analysis (XMLA) Version 1.1 specification.

SAS Shared Web Assets Contains graph applet JARs that are shared across SAS Web
applications. They display graphs in stored processes and in the
SAS Stored Process Web application.

SAS Web Infrastructure Provides a common infrastructure for SAS Web applications.

Platform Services The infrastructure supports activities such as auditing,
authentication, configuration, status and monitoring, e-mail,
theme management, and data sharing across SAS Web
applications.
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Application or Service

Features

SAS Logon Manager

Provides a common user authentication mechanism for SAS
Web applications. It displays a dialog box for user ID and
password entry, authenticates the user, and launches the
requested application. SAS Logon Manager supports a single
sign-on authentication model. When this model is enabled, it
provides access to a variety of computing resources (including
servers and Web pages) during the application session without
repeatedly prompting the user for credentials.

You can configure SAS Logon Manager to display custom
messages and to specify whether a logon dialog box is displayed
when users log off.

In addition, you can use third-party products in conjunction
with SAS Logon Manager to enable users to access multiple
Web applications within the same browser session.

SAS Preferences Manager

Provides a common mechanism for managing preferences for
SAS Web applications. The feature enables administrators to
set default preferences for locale, theme, alert notification, and
time, date, and currency display. In the SAS Information
Delivery Portal, users can view the default settings and update
their individual preferences.

SAS Stored Process Web
Application

Executes stored processes on behalf of a Web client and returns
results to a Web browser. The SAS Stored Process Web
application is similar to the SAS/IntrNet Application Broker,
and has the same general syntax and debug options. Web
applications can be implemented using the SAS Stored Process
Web application, the Stored Process Service API, or a
combination of both. Here is how the SAS Stored Process Web
Application processes a request:

1 Users enter information in an HTML form using their
Web browser and then submit it. The information is
passed to the Web server, which invokes the first
component, the SAS Stored Process Web application.

2 The Stored Process Web application accepts data from the
Web server, and contacts the SAS Metadata Server for
retrieval of stored process information.

3 The stored process data is then sent by the Stored Process
Web application to a stored process server via the object
spawner.

4 The stored process server invokes a SAS program that
processes that information.

5 The results of the SAS program are sent back through the
Web application and Web server to the Web browser and
the awaiting users.
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Application or Service Features

SAS Web Administration Console Provides features for monitoring and administering middle-tier
components. This browser-based interface enables
administrators to do the following:

O Monitor authenticated users and system users who are
logged into SAS Web applications, and send e-mail to
authenticated users.

O Before system maintenance, use the Restart Maintenance
Wizard to send e-mail to users to log off from their
sessions within a specified deadline, log off users after the
deadline, and prohibit new users from logging on to their
applications.

O Before minor system maintenance, use the Quiesce
System feature to allow existing users to stay logged into
their user sessions, and quiesce the system by preventing
new users from logging on to SAS Web applications.

O Create, delete, and manage permissions for multiple
folders on the SAS Content Server

O View configuration information for each middle-tier
component.

SAS Content Server Stores digital content (such as documents, reports, and images)
that is created and used by the SAS Web applications.

In the middle tier, the SAS Web Infrastructure Platform plays an important and
critical role with a collection of middle-tier services and applications that provide basic
integration services.

In the Web application server, two services are available to all SAS Web applications:

o SAS Foundation Services

o SAS Web Infrastructure Platform Services

SAS Foundation Services

The SAS Foundation Services is a set of core infrastructure services that enables
Java programmers to write distributed applications that are integrated with the SAS
platform. This suite of Java application programming interfaces provides core
middleware infrastructure services. These services include the following:

O client connections to SAS application servers
dynamic service discovery

user authentication

profile management

session management

activity logging

metadata and content repository access
connection management

WebDAV service

O 0O oo o oo o

Extension services for information publishing, event management, and SAS Stored
Process execution are also provided. All of the SAS Web applications that are described
in this document use the SAS Java Platform Services. If you have correctly installed
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and configured the Web applications, the platform services are defined in your SAS
metadata repository.

You can verify this metadata in the SAS Management Console. Depending on the
Web applications that were installed, the SAS Portal Local Services (used by the SAS
Information Delivery Portal) are displayed in the SAS Management Console.

In addition, other applications and portlets might have deployment of their own local
services.

SAS Web Infrastructure Platform Services

The SAS Web Infrastructure Platform Services provide common infrastructure and
integration features that can be shared by any SAS application. Here is a description of
the features:

0 Audit provides a single, common auditing capability. The addition of SAS Shared
Services extends the functionality.

0 Authentication is a common method for authenticating middle-tier applications. A
corresponding Web service provides connectivity based on WS security standards
for Web service clients.

0 Configuration is a standard way to define, store, and retrieve configuration
information for SAS applications.

o Directives provide application integration so that SAS applications can share
intelligence and data. Applications can link to one another without requiring
specific information about a particular deployment location.

O Mail is a single, common mechanism for Simple Mail Transfer Protocol
(SMTP)-based mail.

0 Status and monitoring is a collective set of services providing information about
the configured or functioning system.

0 Themes provide access to theme definitions for presentation assets used in Web
applications.

0 Registry provides access to services for desktop clients; a client needs to know only
a single endpoint to determine other required locations.

SAS Content Server

The SAS Content Server is part of the SAS Web Infrastructure Platform. This server
stores digital content (such as documents, reports, and images) that is created and used
by SAS Web applications. For example, the SAS Content Server stores report
definitions that are created by users of SAS Web Report Studio, as well as images and
other elements that are used in reports. A process called content mapping ensures that
report content is stored using the same folder names, folder hierarchy, and permissions
that the SAS Metadata Server uses to store corresponding report metadata.

In addition, the SAS Content Server stores documents and other files that are to be
displayed in the SAS Information Delivery Portal or in SAS solutions.

To interact with the SAS Content Server, client applications use Web-based
Distributed Authoring and Versioning (WebDAV) based protocols for access, versioning,
collaboration, security, and searching. Administrative users can use the browser-based
SAS Web Administration Console to create, delete, and manage permissions for folders
on the SAS Content Server. Administrative users can also search the SAS Content
Server by using industry-standard query syntax, including XML Path Language
(XPath) and DAV Searching and Locating (DASL).
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SAS Shared Services

SAS Shared Services provides standard features that are used by the SAS BI
Dashboard and which can also be used by the SAS Information Delivery Portal, SAS
Web Report Studio, and certain SAS solutions. The features include the following:

alert enables users to register to receive time-sensitive, action-oriented
registration and messages when a specified combination of events and conditions
notification occurs. Alerts empower users by allowing them to control the type of

notifications that they receive and when the notifications are
delivered. Alerts can be sent to the user’s e-mail address or
displayed in the SAS Information Delivery Portal.

comment enables users to create comments related to business intelligence

management objects. Users can then reply to, search for, retire, delete, or add
attachments to existing comments. In addition, users can find
comments that were created by a particular user, with a specified
date range, or with specific text. This feature enables the capture of
human intelligence and supports collaborative decision making
related to business data.

SAS Foundation Services

SAS Foundation Services is a set of core middleware infrastructure services that
integrate distributed applications on the middle tier with other components of the SAS
Intelligence Platform. This suite of Java APIs provides the following services:

O client connections to SAS application servers
dynamic service discovery

user authentication

profile management

session management

activity logging

metadata and content repository access
connection management

WebDAV service

O O o o o oo d

Extension services for information publishing, event management, and SAS Stored
Process execution are also provided. All of the SAS Web applications that are described
in this document use SAS Foundation Services. For more information about SAS
Foundation Services, see the SAS Foundation Services: Administrator’s Guide.

SAS Web Applications

SAS Web applications reside and execute on the middle tier. These applications
require a Web browser on each client machine and a Web application server on the
middle-tier machine where the application runs. These applications communicate with
the user by sending data to and receiving data from the user’s Web browser. For
example, an application of this type displays its user interface by sending an HTML
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document to the user’s browser. The user can submit input to the application by
sending it an HTTP response, usually by clicking a link or submitting an HTML form.

SAS Web Report Studio

SAS Web Report Studio is a Web application that anyone can use to view, interact
with, create, and distribute public and private reports. Simply open an existing report
and interact with the information based on your current needs. For example, you can
view, reply to, or add comments to a report. Report authors can easily point and click to
query central sources of data. You can add prompts and design the layout of tables,
graphs, and text using drag and drop to create a well-formatted report. All this is
accomplished by using a Web browser. You do not need to understand a programming
language. Period reports can be scheduled to process unattended on a recurring basis
and then distributed using e-mail.

In addition, powerful SAS analytical results can be used by business professionals
across an organization through their Web browsers by leveraging SAS stored processes
in SAS Web Report Studio. Stored processes are SAS programs, created by business
analysts who are proficient in SAS, that contain instructions for calculating analytical
results that are rendered as part of a report or as a complete report. Stored processes
typically include queries, prompted filters, titles, images, and statistical analyses to
deliver predictive analytics to a large audience. SAS Web Report Studio combines
query, reporting, and analytical capabilities in a single Web-based tool that everyone
can use to meet a broad set of information needs.

The Report Wizard enables novice users to quickly create and distribute basic queries
and reports based on either relational or multidimensional data sources in five easy
steps. More advanced users can use additional layout and query capabilities that are
available, including the ability to define custom calculations and complex filter
combinations, multiple queries, and SAS analytical results into a single document. A
gallery of predefined layout choices expedites the report creation process, and an
extensive range of advance report components enable users to create and interact with
reports from their Web browsers. Reports and the application can be branded to match
a corporate style.

Reports can be shared with others or kept in private folders based on security
settings. Certain pages of reports can be distributed to authorized users via e-mail or a
subscription channel.

SAS Web Report Studio runs within the Web application server, and requires the
SAS BI Report Services (which includes the report output generation tool) and the SAS
BI Report Services Configuration (which creates libraries used by the SAS Web Report
Studio). SAS Web Report Studio can be invoked from the SAS Information Delivery
Portal.

SAS Information Delivery Portal

The SAS Information Delivery Portal is a Web application that enables you to
aggregate data from a variety of sources and present the data in a Web browser. The
Web browser content might include the output of SAS Stored Processes, links to Web
addresses, documents, syndicated content from information providers, SAS Information
Maps, SAS reports, and Web applications. The portal also provides a secure
environment for sharing information with users.

Using the portal, you can distribute different types of content and applications as
appropriate to internal users, external customers, vendors, and partners. You can use
the portal along with the Publishing Framework to perform the following tasks:

O Publish content to SAS publication channels or WebDAV repositories
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0 Subscribe to publication channels
O View packages published to channels

The portal’s personalization features enable users to organize information about their
desktops in a way that makes sense to them.

For more information, see the SAS Information Delivery Portal Help, which is
available from within the product.

SAS Bl Dashhoard

SAS BI Dashboard 4.3 enables users to create, maintain, and view dashboards to
monitor key performance indicators that convey how well an organization is performing.
SAS BI Dashboard 4.3 includes an easy-to-use, drag and drop interface for creating
dashboards that include graphics, text, colors, and hyperlinks. The application
leverages Flash in the Rich Internet Application (RIA) architecture.

The Dashboard Viewer enables users to:

O Interact with data through interactive highlighting
0O Quickly get to a subset of data through prompts and filters

Dashboards can link to:
O SAS reports and analytical results

O Scorecards and objects associated with solutions such as SAS Strategy
Management

o Stored Processes

O Indicators

O Virtually any item that is addressable by a Uniform Resource Identifier (URI)

With the ability to save favorite dashboards and add comments, users can collaborate
and easily access dashboards with customized information. All content is displayed in a

role-based, secure, customizable, and extensible environment.
For more information, see the SAS BI Dashboard: User’s Guide.

SAS Documentation for the Web

Your installation can include the following documentation software:

0 SAS Help Viewer for the Web is an application that enables users to view and
navigate SAS online Help in the various SAS Web applications.

Note: SAS Help Viewer Metadata Configuration is another name that is
associated with this application. Whereas SAS Help Viewer for the Web is the
name for the delivery system software, SAS Help Viewer Metadata Configuration
is the name for the configured component. This component combines SAS Help
Viewer for the Web software with various Help content and creates an EAR file
that can be deployed on a Web application server. A

0 SAS OnlineDoc for the Web is an application that contains an online library of
reference documentation for the SAS System.

Note: You must manually deploy SAS OnlineDoc for the Web in your Web
application server. Manual deployment is required even if you selected the automatic
deployment option in SAS Deployment Wizard. For more information, see “Deploying
SAS OnlineDoc Manually for the Web” on page 100. 2

You can install SAS Help Viewer for the Web without installing SAS OnlineDoc for
the Web. However, the reverse is not true. In order to install and configure SAS
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OnlineDoc for the Web, in the SAS Deployment Wizard you must choose to install both
SAS Help Viewer for the Web and SAS OnlineDoc for the Web.

SAS BI Portlets

The October 2009 Release and later provides SAS BI Portlets that are based on JSR
168 and available in the SAS Enterprise BI Server offering. These portlets are
seamlessly integrated into the SAS Information Delivery Portal that runs on JBoss,
WebLogic, or WebSphere Web application servers. SAS BI Portlets enable users to
access, view, or work with content items that reside in either the SAS metadata server
or the SAS Content Server.

Starting the Web Applications

Main Steps for Starting the Web Applications

To start the Web applications, follow these steps:

1 Start the necessary servers and services in the correct order. For the correct
start-up order, see “Starting Servers in the Correct Order” on page 18.

2 Start a browser session and point the browser to the Web application that you
want to access. For the correct URL, see the Instructions.html document,
which resides in the Documents subdirectory of your configuration directory. The
exact URL varies with the Web application server that you are using and the
configuration that you have defined for your environment.

3 Log on to the Web application. For instructions about logging on to a Web
application, see the online Help that is provided with the application.

Required Servers
In order for clients to access the SAS Intelligence Platform, the following components
must be running on network-accessible machines:
o SAS Metadata Server
0 SAS Object Spawner, which acts as a listener for SAS Workspace Server, SAS
Pooled Workspace Servers, and SAS Stored Process Servers

Depending on which SAS products you have installed, one or more instances of the
following additional components might also be required to be running on
network-accessible machines:

o SAS OLAP Server

SAS Table Server

SAS Services Application

SAS/CONNECT Spawner

SAS/SHARE Server

SAS Content Server

Web Application Server (JBoss, WebLogic, or WebSphere)

O oo o o o
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For example, the following table documents some SAS servers that can be involved
when a user accesses a stored process or a report.

Table 2.2 Examples of Server Interactions for Stored Processes and Reports

Object Type SAS Servers

Stored process O Metadata server

O Workspace server (for package results) or stored process server (for
streaming results)1

Report Metadata server
Workspace server (for relational data)
OLAP server (for multidimensional data)

SAS Content Server (for retrieval from WebDAV)

O o o o

1 Workspace servers and stored process servers have a dependency on the object spawner.

Starting Servers in the Correct Order

Because of dependencies, it is important to start the servers in the correct order.
Server dependencies are explained in the SAS Intelligence Platform: System
Administration Guide. The following is an example of a start-up order that meets the
dependency requirements for servers:

1 Start the SAS Metadata Server

Start the SAS OLAP Server

Start SAS object spawner

Start the SAS/SHARE server

Start the SAS/CONNECT server

Start the SAS Table Server

Start the SAS Services Application (Remote Services)

0 N & O & N

Start the Web application server. (The SAS Content Server starts automatically
when the application server is started).

The SAS OLAP Server, SAS/CONNECT Spawner, and SAS/SHARE Server can be
started anytime after the SAS Metadata Server has been started.

Servers should be stopped in the inverse order, with the metadata server stopped
last.

Deploying EAR Files in the Correct Order

The SAS Deployment Wizard deploys SAS Web applications to the Web application
server. However, you can also deploy EAR files manually from the Web application
server. EAR files reside in the SAS-configuration-directory\Levl\Web\Staging
directory.

There is no required start-up order for deploying the EAR files to JBoss or WebLogic.
Although, you can deploy the EAR files in any order of your choice, it is highly
recommended that you follow this sequence for WebSphere.

1 SAS Web Application Themes (sas.themes.ear)
2 SAS Flex Application Themes (sas.flexthemes.ear)
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SAS Web Infrastructure Platform Services (sas.wip.services9.2.ear)
SAS Web Infrastructure Platform Applications (sas.wip.apps9.2.ear)
SAS Content Server (sas.wip.scs9.2.ear)

SAS Stored Process Application (sas.storedprocess9.2.ear)

SAS Information Delivery Portal 4.3 (sas.portal4.3.ear)

SAS Package Viewer 4.3 (sas.packageviewer4.3.ear)

SAS Web Report Studio 4.3 (sas.webreportstudio4.3.ear)

10 SAS Shared Services Application (sas.shared9.2.ear)

11 SAS BI Dashboard 4.3 (sas.bidashboard4.3.ear)

12 SAS BI Portlets (sas.biportlets4.3 ear)

13 SAS Help Viewer Metadata Configuration (webdocmd9.2.ear)

© o0 N OO o1 A W
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Best Practices for Middle-Tier Configuration

This chapter provides sample middle-tier topologies and guidelines for achieving
better efficiency and performance with the middle-tier components in the SAS
Intelligence Platform. The middle tier provides an environment for running the
following SAS Web clients:

0 SAS Information Delivery Portal

o SAS Web Report Studio

o SAS BI Dashboard

Configuration instructions vary depending on the Web application server installed at
your site. For configuration instructions that pertain to the topics discussed in this
chapter, see the following third-party vendor Web sites:

0 JBoss Application Server: http://www.jboss.org/docs

o IBM WebSphere Application Server: http://www.ibm.com/support/

documentation/us/en


http://www.ibm.com/support/documentation/us/en
http://www.ibm.com/support/documentation/us/en
http://www.jboss.org/docs
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0 Oracle WebLogic Server: http://www.oracle.com/technology/documentation/
index.html

Sample Middle-Tier Deployment Scenarios

Overview of Middle-Tier Deployment Scenarios

This section describes sample topologies for the middle-tier components. These
sample topologies can help you design a middle-tier configuration that meets the needs
of your organization with regard to performance, security, maintenance, and other
factors.

As with all tiers in the SAS Intelligence Platform, deployment of the middle tier
involves careful planning. When you design and plan the middle tier, you must balance
performance requirements against a number of other criteria. To understand these
criteria and to evaluate sample deployment scenarios, see the following subsections:

0 “Scenario 1: Web Applications Deployed in a Single Web Application Server” on
page 24

O “Scenario 2: Static Content Deployed in a Reverse Proxy” on page 27

O “Scenario 3: Web Applications Deployed across a Web Application Server Cluster”
on page 29
0 “Additional Considerations for a Deployment” on page 32

The topologies that are presented here range from simple to complex. Scenario 1
represents the deployment that results from using the SAS Deployment Wizard to
configure the Web application server and deploy the SAS Web applications. Scenarios 2
and 3 provide advanced features, such as greater security and efficiency, but require
more effort to implement and to maintain.

All scenarios include the SAS server tier. The server tier consists of a SAS Metadata
Server that resides on a dedicated machine. The server tier also includes additional
systems that run various SAS application servers, including SAS Workspace Servers,
SAS Pooled Workspace Servers, SAS Stored Process Servers, and SAS OLAP Servers.

Scenario 1: Web Applications Deployed in a Single Web Application
Server

Scenario 1 illustrates the most basic topology. All of the SAS middle-tier components
are installed on a single system. All the SAS Web applications run in a single Web
application server. The SAS Remote Services application is also installed on the same
middle-tier server, but runs as a server application outside the Web application server.

The following figure illustrates the topology for Scenario 1.


http://www.oracle.com/technology/documentation/index.html
http://www.oracle.com/technology/documentation/index.html
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Figure 3.1

Scenario 1: Middle Tier on a Single System

Clients Middle Tier SAS Servers

-

\

N [ N A

J | 5 &

| Web Browser | Web Application Server | SAS Table Server |
/ SAS Web Infrastructure Platform K /
SAS Content Server
\ - SAS Stored Process L / a )
| SAS Package Viewer )
SAS Shared Services ) >
SAS Web Application Themes «
SAS Flex Application Themes
SAS Information Delivery Portal
SAS Bl Portlets
SAS Web Report Studio
SAS Bl Dashboard SAS Work S
—»|_SAS Help Viewer for the Web SAS P;;Iescipsvcgrksepr;lgg Server
SAS OLAP Server
\SAS Stored Process Server
( N

SAS Remote Services

™ RMI Server
\& )

3!

| SAS Metadata Server |

(N J

After installation, the system contains the following middle-tier software:

0 Web application server (WebLogic Server, WebSphere Application Server, or JBoss)

O the following SAS Web applications, which run in the Web application server:
o SAS Web Infrastructure Platform

O O o oooo oo o o

SAS Content Server

SAS Stored Process

SAS Package Viewer

SAS Shared Services

SAS Web Application Themes

SAS Flex Application Themes (available in the November 2010 Release)
SAS Information Delivery Portal

SAS BI Portlets (available in the October 2009 Release and later)
SAS Web Report Studio

SAS BI Dashboard

SAS Help Viewer for the Web

o0 the SAS Remote Services application, which runs in a separate Java Virtual
Machine process
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Here are the advantages and disadvantages of this topology:

Table 3.1 Scenario 1 Advantages and Disadvantages

Topic Advantages Disadvantages

Security None The SAS Web applications are
exposed to attacks from Web clients.
If SSL is enabled, the middle-tier
server has the computational load of
encrypting data, in addition to the
load of hosting the SAS Web
applications.

Performance None In 32-bit computing environments,
the Java virtual machine might reach
memory addressing limits.

Scalability None This topology does not support
hundreds of concurrent users.

Availability None This topology has no provision for
planned or unplanned down time.

Maintainability The SAS Deployment Wizard can None
automate the configuration and
deployment.

This topology is simple to maintain
and is ideal for development
environments where frequent changes
might be required.

Further Considerations for Scenario 1

As the maintainability advantages in the previous table indicates, scenario 1 is easy
to implement. This middle-tier topology can be completely installed and configured by
the SAS Deployment Wizard. SAS provides another topology that can be completely
installed and configured by the SAS Deployment Wizard, yet provides better scalability
and performance.

In 32-bit computing environments, the scenario 1 topology can reach a performance
limit due to the memory constraints of 32-bit addressing and the fact that all of the
SAS Web applications are running in a single Java virtual machine that is provided by
the Web application server. A variation of this scenario is to use the SAS Deployment
Wizard to distribute the SAS Web applications across two Web application server
instances (managed servers) on the same middle-tier server. This distribution of Web
applications is different from clustering in that there is still only one instance of each
application. By distributing the applications to two managed servers, this alternative
configuration allows more memory availability for the applications deployed on each
managed server and also increases the number of users that can be supported. Some
SAS Solutions and some Web application servers that use 32-bit Java environments are
configured with multiple servers by the SAS Deployment Wizard automatically.
However, you can choose to configure multiple managed servers by running the wizard
with the custom prompting level and selecting this feature.
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Scenario 2: Static Content Deployed in a Reverse Proxy

This sample topology delivers static HTML content to clients from an HTTP server
that is configured as a reverse proxy. This strategy reduces the work load on the Web
application server. Examples of HTTP servers that can be configured as reverse proxies
are Apache HTTP Server and Microsoft Internet Information Services (IIS).

When a browser makes a request for a SAS Web application, a part of the request is
for static content such as HTML files, images, cascading style sheets, and JavaScript
scripts. The SAS Themes Web application provides this static content. In this scenario,
the SAS Themes content is unpacked and delivered by the reverse proxy. The reverse
proxy simply returns the requested content to the browser, and the browser displays
the document.

Note: If you unpack and deploy the SAS Themes static content on the reverse proxy,
then you must redeploy this content if you later install a SAS software upgrade or
apply maintenance that includes new files for the static content. A

If the reverse proxy can be configured to cache content, then the performance
improvement is even greater. The portion of the request that is for dynamic content
still requires some type of data manipulation by the SAS Web applications and the Web
application server must perform that work before returning the requested page.

The following figure illustrates the topology for scenario 2.

Figure 3.2 Scenario 2: Using a Reverse Proxy

Clients HTTP Server Middle Tier SAS Servers

4 N\ 4 I\ 4 N\
J = = =

Web Application Web Application Server SAS Table Server

| Server Plug-in SAS Web Infrastructure Platform

Module SAS Content Server
l SAS Stored Process n 4

SAS Package Viewer

J

SAS Web Application SAS Shared Services ——
Themes SAS Web Application Themes

SAS Flex Application Themes

SAS Information Delivery Portal
\ / SAS Bl Portlets

SAS Web Report Studio

SAS Bl Dashboard

t» SAS Help Viewer for the Web

SAS Workspace Server

SAS Pooled Workspace Server
SAS OLAP Server

SAS Stored Process Server

L N\

SAS Remote Services
RMI Server

: y

SAS Metadata Server

AN J

In a typical configuration, the HTTP server is configured with a module or plug-in
that enables the reverse proxy function of communicating with the Web application
server. By having the reverse proxy as the single point of contact for browser requests,
the Web application server is not directly exposed to clients. The reverse proxy provides
a layer of security for the SAS Web applications.
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Although this topology must be manually configured and maintained, here are the
advantages and disadvantages of this topology:

Tahle 3.2 Scenario 2 Advantages and Disadvantages

Topic Advantages Disadvantages

Security The reverse proxy provides a layer of  Adding firewalls to the network is a
security. good next step.

The network on the middle-tier server
can be configured to reject HTTP
packets that do not originate from the
reverse proxy.

SSL can be enabled on the client side
of the reverse proxy without affecting
the work load on the Web application
server or the performance of the SAS
Web applications.

The Web application server and SAS
Web applications can be configured to
perform Web authentication for single
sign-on to SAS Web applications and
other Web resources in the network.

Performance Response time is improved because As with scenario 1, in 32-bit
processing static content is offloaded computing environments, the Java
from the Web application server to the virtual machine might reach memory
reverse proxy. addressing limits. However, a second

managed server instance can be
configured, as mentioned in the
scenario 1 section.

Scalability There are no advantages in this This topology does not support
scenario, but the topology provides an  hundreds of concurrent users.
upward path to clustering Web
application servers.

Availability None This topology has no provision for

planned or unplanned down time.

Maintainability The SAS Deployment Wizard can still ~ After manual or automatic

automate the configuration and
deployment of the Web application
server and the SAS Web applications.

installation and configuration with
the SAS Deployment Wizard, there
are manual steps to perform.

The reverse proxy must be configured
with the connection information for
the SAS Web applications.

For instructions about how to configure an HTTP server as a reverse proxy for SAS
Web applications deployed on JBoss, WebSphere Application Server, or WebLogic
Server, see the SAS third-party Web site at http://support.sas.com/resources/
thirdpartysupport/v92.
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Scenario 3: Web Applications Deployed across a Web Application
Server Cluster

The sample topology in scenario 3 includes a cluster of Web application servers in a
network that implements a secure demilitarized zone (DMZ).

The following figure illustrates the topology for scenario 3. Note that the Web
application servers and SAS Web applications are distributed across multiple
middle-tier machines.

Figure 3.3 Scenario 3: Clustered Web Application Servers and a Demilitarized Zone
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Note: As indicated in the figure, if you configure a cluster of Web application
servers, then you must deploy all the SAS Web applications to each node in the cluster.
Each node must be configured identically. A

In the figure, note that the SAS Remote Services Application and SAS Content
Server Web application reside on a host that is separate from the cluster of Web
application servers. This separation serves to illustrate that the SAS Remote Services
Application is a server application that does not participate in clustering. The SAS
Remote Services Application could just as well reside on any one of the hosts in the
cluster. The separation in the figure also shows that the SAS Content Server Web
application is a Web application that is deployed on a Web application server.

In this scenario, the SAS Content Server is not in a cluster.

Although this topology requires manual configuration and greater maintenance than
the topologies in the previous scenarios, here are the advantages and disadvantages of
this topology:
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Table 3.3 Scenario 3 Advantages and Disadvantages

Topic

Advantages

Disadvantages

Security

The SAS Web applications and the
Web application server cluster are
protected by the DMZ.

The Web application server and SAS
Web applications can be configured to
perform Web authentication for single
sign-on to SAS Web applications and
other Web resources in the network.

None

Performance

Response time is improved because
processing static content performed by
the reverse proxy and because of the
greater computing capacity of the Web
application server cluster.

None

Scalability

Once the cluster of Web application
servers is established, additional
managed servers can be added to the
cluster to support larger numbers of
concurrent users.

None

Availability

Clustering provides fault isolation
that is not possible with a single Web
application server. If a node in the
cluster fails, then only the users with
active sessions on that node are
affected.

You can plan downtime for
maintenance by taking managed
servers offline. New requests are then
directed to the SAS Web applications
deployed on the remaining nodes
while maintenance is performed.

None

Maintainability

Configuration and deployment of the
first Web application server and the
SAS Web applications can still be
automated with the SAS Deployment
Wizard. This first Web application
server can be cloned to speed the
creation of the cluster.

The reverse proxy must be configured
with the connection information for
the SAS Web applications.

Creating the Web application server
cluster requires additional
configuration.

Understanding Clusters

In order to provide greater scalability, availability, and robustness, WebLogic Server,
WebSphere Application Server, and JBoss support some form of clustering. With
clustering, multiple Web application server instances participate in a load-balancing
scheme to handle client requests. Workload distribution is usually managed by the
same application server plug-in module that enables the use of a reverse proxy for static
content. See “Scenario 2: Static Content Deployed in a Reverse Proxy” on page 27.

The Web application server instances (managed servers) in a cluster can coexist on
the same machine (vertical clustering), or the managed servers can run on a group of
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middle-tier server machines (horizontal clustering). The SAS Web applications can be
deployed on both vertical and horizontal clusters.

A different approach to load distribution involves merely deploying individual SAS
Web applications on separate, non-clustered Web application servers. Though this
approach reduces the memory load for any given server, a clustering strategy is
preferable. Deployment is easier to manage with a cluster because all machines and
server instances are identically configured. Furthermore, Web application servers
provide deployment management services that facilitate management of a cluster. It is
relatively easy to add additional nodes and increase the size of the cluster.

Requirement for Session Affinity

For SAS Web applications to be deployed into a clustered environment, the Web
application servers must implement session affinity. Session affinity is an association
between a Web application server and a client that requests an HTTP session with that
server. This association is known in the industry by several terms, including session
affinity, server affinity, and sticky sessions. With session affinity, once a client has been
assigned to a session with a Web application server, the client remains with that server
for the duration of the session. By default, session affinity is enabled in WebSphere
Application Server and WebLogic Server.

Why session affinity is required: Although WebSphere Application Server, WebLogic
Server, and JBoss provide the ability to migrate HTTP sessions from one server to
another, the SAS Web applications do not support this capability. Business intelligence
sessions often contain large data elements, such as results sets from ad hoc queries,
reporting, and analytical tasks, that cannot be migrated easily among Web application
servers.

Understanding Demilitarized Zones

Many organizations use a series of firewalls to create a demilitarized zone (DMZ)
between their servers and the client applications. A DMZ provides a network barrier
between the servers and the clients. A DMZ provides this protection whether the
clients reside within the organization’s computing infrastructure (intranet) or reside
outside the organization on the Internet.

In the previous figure, the outer firewall that connects to the public network is called
the domain firewall. Typically, only the HTTP (80) and HTTPS (443) network ports are
open through this firewall. Servers that reside directly behind this firewall are exposed
to a wide range of clients through these limited ports, and as a result the servers are
not fully secure.

An additional firewall, the protocol firewall, is configured between the non-secure
machines in the DMZ and the machines in the secure middle-tier network. The protocol
firewall has additional network ports opened. However, the range of IP addresses that
are allowed to make connections is typically restricted to the IP addresses of the servers
that reside in the DMZ.

The DMZ usually contains HT'TP servers, reverse proxies, and load-balancing
software and hardware. Do not deploy Web application servers or any SAS servers that
handle important business logic, data, or metadata in the DMZ.

If your applications are accessed by clients through the Internet, then you should
include a DMZ as part of your deployment in order to safeguard critical information.
For deployments on a corporate intranet, you might want to implement a DMZ as an
additional layer of security.
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Additional Considerations for a Deployment

This section presents a few more things that you might want to consider when you
plan your middle-tier deployment.

Load-Balancing Software and Hardware for the HTTP Servers

In scenario 3, the Web application servers are clustered to balance the load and to
provide increased availability. While this scenario provides redundancy for the
application servers, the HTTP server that is deployed as a reverse proxy remains a
potential bottleneck and single point of failure. To improve availability and increase
capacity, you can distribute HT'TP traffic across multiple reverse proxies by placing
load-balancing software or hardware in front of those servers. A single load-balancing
component can accept client HTTP requests and distribute those requests across a
cluster of reverse proxies.

A number of vendors sell load-balancing software and hardware products for HTTP
servers, including IBM, Cisco, and Nortel. If you are interested in this type of
load-balancing, you can explore the product lines for these and other vendors.

Secure Sockets Layer

If you are moving sensitive information across the Internet, then you might want to
use HTTPS and Secure Socket Layer (SSL) to encrypt your communication links. SSL
uses Public Key Cryptography, which is based on the implementation of a public and
private key pair. Each of your servers that handles encrypted communications manages
certificates that contain both the private key and the public key. A description of how
Public Key Cryptography and SSL work is beyond the scope of this document. However,
there are many good sources for that information.

Here are some factors to consider when determining whether and how to use SSL:

0 Which links do you want to encrypt? In the figures shown for the various
scenarios, each arrow represents a potential communications link that might be
encrypted. You should consider encrypting the following:

0 Encrypt any data that is capable of moving across the public Internet. If
connections to your site go through a virtual private network (VPN), then those
connections are already encrypted. Otherwise, traffic to and from your site is
open to packet analysis by Internet users.

O Encrypt all traffic that moves between the client and your HTTP server that
resides in the DMZ.

O Always encrypt traffic that is used to transmit credit card numbers, Social
Security numbers, and any other sensitive information.

To achieve strong security, encrypt links all the way to the Web application
server. If you are concerned about internal packet analysis, you can encrypt
everything. However, total encryption comes with a cost, as explained in the
remaining considerations.

0 Some load-balancing schemes might rely on packet content for routing. When that
is the case, encryption can impede the work that is performed by load-balancing
software or hardware because encryption renders the packet content
undecipherable.

o Cryptography requires resource-intensive computation, and this resource
requirement typically reduces the amount of traffic that your servers are able to
handle.
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0 The certificates that are used with SSL expire at fixed intervals. When a user’s
certificate expires, the user must obtain a new certificate before logging on to your
applications. If you want a highly available system, then you should prepare for
certificate renewal in advance to avoid unexpected downtime.

0 You must decide whether to use certificates that are generated by a Certification
Authority (CA), or whether self-signed certificates are adequate for your
application. Self-signed certificates can save you money, but you are responsible
for managing their distribution to clients.

Web Authentication

By default, SAS Web applications use the form-based authentication that is provided
by the SAS Logon Manager Web application. When credentials are provided to the SAS
Logon Manager Web application, the credentials are sent to the SAS metadata server
for authentication. The metadata server then authenticates the credentials against its
authentication provider. The default provider is the host operating system.

As an alternative, you can configure the SAS Web applications to authenticate on the
middle tier. When users log on to a SAS Web application, the Web application server
handles the initial authentication. In this configuration, the Web application server’s
JAAS login module authentication provider verifies the user’s identity. Then, the SAS
Logon Manager Web application makes a trusted user connection to the metadata
server to check that the authenticated user has a SAS identity in metadata.

Performing Web authentication facilitates single sign-on. Most likely, your
organization has several applications behind a common set of reverse proxy and HTTP
servers. By having a common server handle authentication, users do not need to
re-authenticate for access to each application.

For more information, see the following topics:

0 For a detailed explanation of different types of authentication, see “Authentication
Mechanisms” in the SAS Intelligence Platform: Security Administration Guide.

0 For information about setting up the middle-tier applications to use Web
authentication, see the SAS third-party Web site at http://support.sas.com/
resources/thirdpartysupport/v92.

0 For information about achieving a single sign-on approach to authentication, see
“Using Single Sign-On Among Web Applications” on page 41.

Heap Size for SAS Remote Services Application

Middle-tier applications use the SAS Remote Services Application to pass session and
user context between Web applications. The SAS Remote Services application enables
the user to pass seamlessly through to the target without the requirement for a
separate logon.

During installation, the SAS Deployment Wizard enables you to specify the desired
initial and maximum heap size for the Remote Services application by using the JVM
option format.

JVM options of the SAS Remote Services Application are set to handle a moderately
high number of concurrent users. For a very large number of concurrent users and a
distributed SAS 9.2 topology, you should tune the JVM options to accommodate the
deployment.

If you use the Windows service, you can increase the minimum and maximum heap
size of the SAS Remote Services Application. Edit the wrapper.conf file located in the
SAS-configuration-directory\Levl\Web\Applications\RemoteServices directory.

Alternatively, you can add the recommended JVM options to one of the following
scripts:
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0 On Windows:
SAS-configuration-
directory\Lev1l\Web\Applications\RemoteServices\RemoteServices.bat

o On UNIX:
SAS-configuration-directory/Levl/Web/Applications/RemoteServices/
RemoteServices.sh
o On z/OS:

0 SAS-configuration-directory/Levl/Web/Applications/RemoteServices/
RemoteServices.sh

Tuning the Web Application Server

In addition to specifying Java Virtual Machine options, you can improve the
performance of SAS Web applications by configuring other aspects of your Web
application server’s behavior. For example, two obvious ways to improve the
performance of any Web application are:

O to limit the frequency with which servers check for updated JavaServer Pages and
servlets

O to make sure that the server can create sufficient threads to service incoming
requests

SAS provides a set of Java Virtual Machine option settings in the Instructions.html
file that is generated by the SAS Deployment Wizard. Use those settings as a starting
point for your tuning. In addition, SAS provides additional tuning information in “SAS
9.2 Web Applications: Tuning for Performance and Scalability” that is available with
the Web application server documentation at

http://support.sas.com/resources/thirdpartysupport/v92.

Configuring a Cluster of Weh Application Servers

Cluster configuration varies widely between Web application server vendors. Consult
your vendor’s documentation for configuration instructions. Note, however, that you
must deploy all the SAS Web applications to all nodes of the cluster. For a visual
representation, see “Scenario 3: Web Applications Deployed across a Web Application
Server Cluster” on page 29.

It is possible to configure a cluster that consists of just one node. You might set up a
single-node cluster when your sole objective is to route browser requests to an HTTP
server instead of to the Web application server. For this configuration, you set the
address of the single-node cluster equal to the address of the HT'TP server.

Configuring HTTP Sessions in Environments With Proxy Configurations

SAS Web Report Studio 4.3 uses absolute URL addresses that must be associated
with the correct HTTP session. The SAS Logon Manager knows only the address that is
stored in metadata, and the SAS Logon Manager redirects requests to that location.

If that address differs from the URL specified by the user, then the user’s session is
not tracked correctly. (For example, suppose the user specifies the internal address
http://shortname/application instead of the external address http://
shortname.example.com/application.)


http://shortname.example.com/application
http://shortname.example.com/application
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When SAS Web Report Studio receives an HTTP request, the request is redirected to
the SAS Logon Manager. The SAS Logon Manager authenticates the request, and
redirects it back to SAS Web Report Studio.

An exception applies to this process if your environment has any front-end processor
(for example, Apache, Web clustering, IBM Tivoli Access Manager WebSEAL, or CA
SiteMinder) configured. In these scenarios, or if a reverse proxy is configured with
WebSEAL, the HTTP session request comes via an internal address. For example, the
request might come via http://host:port/application instead of an external
address http://proxiedhost/application. This sequence of events triggers a
redirection filter, which typically sends the request to a location in the metadata where
the request format is expected in the form of shortname.example.com. However, the
redirection filter is not required because the proxy sends the request to the same
location, and the same address is always used.

To ensure successful resolution of HT'TP session requests in a secure environment
(any environment with a front-end processor), the redirection filter must be disabled for
SAS Web Report Studio. In addition, it is highly recommended that you disable this
filter for all SAS applications.

To disable the redirection filter for all SAS Web applications, follow these steps:

1 In SAS Management Console, navigate to Plug-ins » Application Management »
Configuration Manager » SAS Application Infrastructure Properties and
right-click to display the SAS Application Infrastructure Properties dialog box.

2 Click the Advanced tab.

3 Click add to display the Define New Property Window.

4 Enter the property name as shown, and specify the property value:
Property Name: App.RedirectionFilterDisabled
Property Value: True

5 Click OK to exit the Define New Property window.

6 Click ok to exit the SAS Application Infrastructure Properties dialog box.

7 To enable this change to go into effect, restart your Web application server.

Using an HTTP Server to Serve Static Content

Overview of Using an HTTP Server to Serve SAS Themes Webh
Application Static Content

Your middle-tier deployment can use an HTTP server to handle requests for the static
content in the SAS Themes Web application. This HTTP server can be configured as a
reverse proxy to forward requests for dynamic content to your Web application server, or
the content can be deployed on a standard HTTP server. This strategy makes efficient
use of the HTTP server, and enables the Web application server to devote its resources
to dynamic content. The performance benefits are particularly notable for large-scale
deployments that include a cluster of Web application servers. For an overview of this
configuration, see “Sample Middle-Tier Deployment Scenarios” on page 24.
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Example: Use Apache HTTP Server to Serve SAS Themes Webh
Application Static Content

This example describes how to configure Apache HTTP Server to server the SAS
Themes Web application as static content on a Windows system. There is more than
way one to configure Apache HTTP Server, and your configuration might differ from
what is presented here.

1 Locate the EAR file for SAS Web Application Themes. The EAR file is named
sas.themes.ear and is located in the
SAS-configuration-directory\Levn\Web\Staging directory.

2 Unpack sas.themes.ear. On a Windows system, you can use the unzip utility.
The EAR archive contains several files, including sas.theme.default.war and
application.xml.
3 Open the application.xml file in an editor.
In application.xml, the URL for the application is shown as

sas.theme.default.war. The mapping shows that the name of the application
(the context root) is SASTheme_default.

4 In the Apache document directory, create a directory that has the same name as
the application (SASTheme_default). Here is an example:
D:\Apache2.2\htdocs\SASTheme_ default

5 Extract the contents of sas.theme.default.war into the directory that you
created in the previous step.

6 Stop and restart Apache HTTP Server.

7 On the Web application server, stop and uninstall the SAS Themes Web
application.

8 Use SAS Management Console to change the connection properties for SAS
Themes.

a Select Application Management > Configuration Management.

b Right-click SASTheme_default and select Properties.

¢ Click the connection tab, set Host Name and Port Number to the host name
and port number of the Apache HTTP Server, and then click ok.

9 Restart each of the SAS Web applications, or restart the Web application server.

When you access a SAS Web application, the SAS Themes Web application content is
served by Apache HTTP Server rather than the Web application Server. In the Apache
HTTP Server access log, you can verify that the files from the SASTheme default
directory are being served by Apache HTTP Server.

Using a Proxy Plug-in hetween the Weh Application Server and the
HTTP Server

WebLogic Server, WebSphere Application Server, and JBoss provide plug-in modules
that enable integration with an HTTP server, such as Apache HTTP Server or Microsoft
Internet Information Services (IIS).

The plug-ins are useful for either or both of the following:

O to forward requests for dynamic content to the Web application server or servlet
container. In this scenario, the HTTP server handles all the static content and
relies on the Web application server for dynamic content.
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O to forward requests and distribute those requests among a cluster of Web
application servers using a load-balancing algorithm.

The plug-in enables the HTTP server to behave as a reverse proxy, which typically
filters requests and passes requests that meet the filter requirements to the Web
application server. Many reverse proxies use a local cache of Web pages to respond to
requests.

The configuration instructions vary greatly depending on your particular
architecture. For the best information, see the vendor’s documentation.

Using Apache Cache Control for Static Content

To avoid sending unnecessary requests to the server each time a client requests a
static content item, you can configure Apache HTTP Server to set cache time-out values
for static content.

Typically, after a browser initially downloads a static resource from the HTTP server,
the browser sends a conditional HTTP GET request each time the browser encounters
that resource again. For example, when a browser first downloads a SAS Web Report
Studio logo image, the browser stores a local copy of the image. For each subsequent
page that references the logo, the browser requests that the image be sent again if the
image has been modified since the previous download. This sequence occurs for every
static element and can result in large numbers of HTTP requests. Because the static
content for is not modified often, most of these requests are unnecessary.

When you specify a cache time-out for each static element, clients (browser, proxy, or
server cache) can avoid sending unnecessary requests to the HT'TP server in order to
check the validity of the content. When the browser first accesses a static element, the
browser stores that element locally for the duration of the time-out value that is
configured. During this time, subsequent queries to the HTTP server are suppressed for
that element. The browser resumes queries as appropriate when the time-out period
elapses within the session.

You can configure Apache HTTP Server to set cache time-out values for static
content. This is true whether Apache HTTP Server is configured to serve that static
content or is merely a reverse proxy to your Web application server.
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Middle-Tier Security

To determine how to implement middle-tier security, you should consider your
organization’s internal security policies, the security mechanisms that are in place in
your environment, the types of users who will need to access the Web applications, and
the types of content that will be made available.

Important concepts and tasks concerning middle-tier security are as follows:

0 Authentication. For a detailed discussion of different types of authentication and

configuration guidelines, see “Authentication Mechanisms” in the SAS Intelligence
Platform: Security Administration Guide. For information about configuring Web
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authentication for JBoss, IBM WebSphere, or Oracle WebLogic, go to http://
support.sas.com/resources/thirdpartysupport/v92/.

0 SAS Anonymous Web User. See “Using the SAS Anonymous Web User With SAS
Authentication” on page 40.

0 Multicast Security. See “Multicast Security” on page 40.
o Single Sign-On. See “Using Single Sign-On Among Web Applications” on page 41.

0 Secure Sockets Layer (SSL). See “Using Secure Sockets Layer (SSL) for Web
Applications” on page 41.

0 Restrictive Policy Files. See “Configuring and Deploying Restrictive Policy Files”
on page 45.

Using the SAS Anonymous Web User With SAS Authentication

The SAS Anonymous Web User (webanon) is an optional account that can be used to
grant Web clients anonymous access to certain SAS Web Infrastructure Platform
applications (SAS BI Web Services and SAS Stored Process Web Application). This
anonymous account, which is configured with the SAS Deployment Wizard, is applicable
only when SAS authentication is being used. If Web authentication is used, the Web
application server processes authentication requests, and this anonymous account has
no effect.

If the webanon account is configured, it will be used when a Web service is configured
for SAS authentication, and credentials are not supplied. If the webanon account is not
configured, there will be no credentials for authentication, and the request will fail.

In a default SAS 9.2 installation, this anonymous account is configured as an internal
user account. To determine whether to enable the webanon user account, administrators
must decide whether they want to require clients to provide credentials for all requests.
When clients provide credentials to an incoming request, these credentials are always
used for authentication whether the account has been enabled or not.

The webanon user is defined in the following locations:

O in metadata. In default installations of SAS 9.2, the SAS Anonymous Web Service
User is an internal user account that is known only to SAS and that is
authenticated internally in metadata. When internal authentication is used, it is
not necessary for this user to have a local or network account.

O in the operating system of the metadata server machine, only if you selected the
External authentication option for this user during a custom installation.

Multicast Security

A multicast group communications protocol is used to communicate among
middle-tier SAS applications in a single SAS deployment (the set of applications
connected to the same SAS Metadata Server). During installation, the SAS Deployment
Wizard supplies you with a default multicast address and port number that it generates
based on the machine’s (metadata server) IP address. The combination of multicast IP
address and multicast UDP port should be different for each SAS deployment and also
different from those used by other multicast applications at your site.

The IP address and multicast UDP port number for the multicast host must match
the values in the Web application server’s start-up script (for example,
SASServerl.bat) and the environment.properties file located in the
SAS-configuration-directory\Levl\Web\Applications\RemoteServices directory.
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The multicast group communication includes all information needed to bootstrap
SAS middle-tier applications. Because this includes sending the SAS environment
credentials (such as the sasadm account name and its password), scoping and encryption
options are provided in the SAS Deployment Wizard. The defaults are most appropriate
for deployments in the firewall, isolated data center environment. After installation, if
you choose to modify the scoping or encryption options, you can do so by specifying the
options for the -Dmulticast.security parameter for your Web application server.

For more information, see Chapter 14, “Administering Multicast Options,” on page
177.

Using Single Sign-On Among Web Applications

Single Sign-On (SSO) is an authentication model that enables users to access a
variety of computing resources without being repeatedly prompted for their user IDs
and passwords. SS0O can enable a user to access SAS servers that run on different
platforms without interactively providing the user’s ID and password for each platform.
SSO can also enable someone who is using one application to launch other applications
based on the authentication that was performed when the user initially logged in.

SAS provides these SSO features:

o To bypass the logon prompt when launching a desktop application (such as SAS
Information Map Studio, SAS Enterprise Guide, SAS Data Integration Studio,
SAS OLAP Cube Studio, or SAS Management Console), use Integrated Windows
authentication. The client and the metadata server must be in the same Windows
domain or in domains that trust each other.

o To bypass the logon prompt when launching a SAS Web application (such as SAS
Web Report Studio or SAS Information Delivery Portal), use Web authentication.

O Seamless access to data servers and processing servers is provided by mechanisms
including SAS token authentication, Integrated Windows authentication,
credential reuse, and credential retrieval.

For more information about SSO, see the SAS Intelligence Platform: Security
Administration Guide.

Using Secure Sockets Layer (SSL) for Web Applications

Overview of SSL

Secure Sockets Layer (SSL) is a protocol that provides network security and privacy.
Developed by Netscape Communications, SSL uses encryption algorithms that include
RC2, RC4, DES, TripleDES, IDEA, MD5, and others. In addition to providing
encryption services, SSL uses trusted certificates to perform client and server
authentication, and it uses message authentication codes to ensure data integrity. SSL
is supported by both Firefox and Internet Explorer. Many Web sites use the protocol to
protect confidential user information, such as credit card numbers. By convention,
URLs that require an SSL connection begin with HTTPS instead of HTTP. The SSL
protocol is application independent and allows protocols such as HTTP, FTP, and Telnet
to be transparently layered above it. SSL is optimized for HTTP. SSL includes software
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that was developed by the OpenSSL Project for use in the OpenSSL Toolkit. For more
information, see http://www.openssl.org.

This documentation assumes that you have a basic understanding of SSL, and that
you know how to obtain and use trusted certificates. See your Web application server’s
documentation for SSL implementation details at the following Web sites:

O http://www.jboss.org/docs
O http://www.oracle.com/technology/documentation/index.html

O http://www.ibm.com/support/documentation/us/en/
Also, see http://support.sas.com/resources/thirdpartysupport/v92.

Note: Transport Layer Security (TLS) is the successor to SSL V3.0. The Internet
Engineering Task Force (IETF) adopted SSL V3.0 as the de facto standard and renamed
it TLS. Throughout this document, any reference to SSL also applies to TLS. a

Set Up the SSL Environment for Your Web Application Server

After you have configured the Web application server for SSL, the Java Run Time
Environment (JRE) in which the Web applications run will be ready to provide
certificates in response to client requests.

If Web applications that communicate with each other are distributed across
different machines, then the JRE that is used by each application requires a certificate.
For example, suppose that a user logs on to the SAS Information Delivery Portal. If the
user clicks on a report from within the portal, then the portal invokes SAS Web Report
Studio in order to display the report (if the user has the appropriate capability assigned
for viewing the report with SAS Web Report Studio).

If the portal and SAS Web Report Studio run on different machines, then the
certificate must reside in the JRE for each machine. Because the portal communicates
directly with SAS Web Report Studio, and SAS Web Report Studio sends the requested
page back to the portal, the portal’s JRE must have the certificate that is used by the
JRE for SAS Web Report Studio.

If the applications run on different Web application servers within the same host,
you should configure the JRE for each Web application server.

SSL for SAS Weh Applications

After you have copied the keystore file to the appropriate directory in your Web
application server, and edited the applicable configuration file or settings to enable SSL,
you specify the https protocol and ports for SAS Web applications. This step ensures
that the appropriate SAS Web applications will use the https protocol. See “Step 1:
Specify https Protocol and Port Number” on page 43.

One-way SSL enables the application operating as the SSL client to verify the
identity of the Web application server that is operating as the SSL server. In two-way
SSL, the SSL client application verifies the identity of the Web application server, and
then the Web application server verifies the identity of the SSL-client application. In
two-way SSL, the application presents its certificate to the Web application server after
the Web application server authenticates itself to the SSL client application.

You can configure one-way or two-way SSL. For more information, see:

0 “One-Way SSL for SAS Information Delivery Portal” on page 43.
0 “Two-Way SSL for SAS Information Delivery Portal” on page 44.
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One-Way SSL for SAS Information Delivery Portal

You can configure one-way SSL for SAS Information Delivery Portal by specifying the
https protocol and ports in the SAS Management Console Configuration Manager for
the portal and other SAS applications that are used by the portal. SAS Information
Delivery Portal uses the SAS Content Server and the following SAS applications:

O

SAS Logon Manager

SAS Package Viewer

SAS Preferences Manager

SAS Help Viewer Metadata Configuration
SAS Web Application Themes

SAS Stored Process Web Application

O 0O o o o

When SSL is configured one way, all communications from all applications to the
Web application server are encrypted and protected by SSL. However, encrypting and
decrypting all communications might consume more resources and impact performance.
For efficient use of resources, you can encrypt some of the communications by applying
the https protocol to specific SAS applications. For example, SAS Web Application
Themes and Help Viewer Meta Config use static content. Therefore, you can allow the
SAS Web Application Themes and SAS Help Viewer Meta Config applications to use the
regular http protocol and port numbers, and configure all of the other applications
shown above to use the https protocol and port number.

Mixing the http and https protocols could enable an efficient environment where all
communications are not being encrypted and protected by SSL. If you mix the http and
https protocols, make sure that the SAS Logon Manager uses the https protocol. In
addition, there are other considerations that might apply to your Web application
server. For example, when you mix the protocols and your SAS Web applications are
deployed in the Web application server, both the HTTP port and the HTTPS port must
remain open and be available for use.

Step 1: Specify https Protocol and Port Number
To specify the https protocol and port number for the SAS Information Delivery
Portal and other applications used by the portal, follow these steps:

1 In SAS Management Console, navigate to Plug-ins » Application Management »
Configuration Manager » Information Delivery Portal 4.2 and right-click to
display the Information Portal Delivery 4.2 Properties dialog box.

2 Click the connection tab.

3 In the Connection tab, modify the Communication Protocol field to display
HTTPS.

4 On the Port Number field, enter the appropriate port number for the https
protocol. For example, the default port numbers for the Web application servers
are as follows: 8443 for JBoss, 7002 for WebLogic, and 9443 for WebSphere.

5 Click OK to exit the Information Delivery Portal 4.2 Properties dialog box.

6 To specify the https protocol and port number for other SAS applications, repeat
the preceding steps for these applications:

O

SAS Logon Manager

o SAS Package Viewer

0 SAS Preferences Manager
o SAS Help Viewer
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o SAS Web Application Themes
o SAS Stored Process
Next, specify the https protocol and port number for the SAS Content Server. See

“Step 2: Specify https Protocol and Port Number for the SAS Content Server” on page
44,

Step 2: Specify https Protocol and Port Number for the SAS Content Server

When you configure SSL for SAS Information Delivery Portal, specify the https
protocol and port number for the SAS Content Server. To specify the https protocol and
ports for the SAS Content Server, follow these steps:

1 In SAS Management Console, navigate to Plug-ins » Server Manager » SAS
Content Server and select it to display Connection:SAS Content Server in the
right-side panel of SAS Management Console.

2 Select the Connection:SAS Content Server and press the right-mouse button to
display and select Properties.

3 On the options tab, modify the Application protocol field to display https.

4 In the Port number field, enter the correct port number. The default port
numbers for the Web application servers are as follows: 8443 for JBoss, 7002 for
WebLogic, and 9443 for WebSphere.

5 Click oK to save your settings and exit the Connection: SAS Content Server
Properties dialog box.

Note that these changes go into effect when you start your Web application server.

Step 3: Update Remote Portlets for SSL

If you have remote portlets, update the protocol and port numbers for those portlets.
Update the URL within the portlet.xml file, recreate the PAR file, and redeploy it.

Step 4: Restart the SAS Remote Services Application and the Web
Application Server

Stop and restart the SAS Remote Services and the Web application server.

Step 5: Verify the SSL Connection

Log on to the appropriate URL that is configured with SSL. For example, to verify
the SSL connection, log on to the appropriate URL:
https://yourmachine.company.com:8443/SASPortal

Two-Way SSL for SAS Information Delivery Portal

If you want to configure two-way SSL for SAS Information Delivery Portal, there are
additional steps that you must complete in addition to the procedures that apply to
one-way SSL. With two-way SSL, you create a new, unique client certificate, install it in
the client (the Web browser), and configure your Web application server to ask for and
accept this certificate. Here is a brief summary of steps to be followed when you
configure two-way SSL:

0 Create new client certificate and sign it with your authority.
o0 Import the client certificate into the browser.
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0 Configure your Web application server to use the trust store, and to request and
accept a client certificate

0 Modify your JVM parameters for SAS Remote Services and for your Web
application server by specifying the locations of the server keystore and trust store.

For information about configuration, see your vendor documentation. Also, see
http://support.sas.com/resources/thirdpartysupport/v92/.

Configuring and Deploying Restrictive Policy Files

About Restrictive Policy Files

An express or typical installation completed with the SAS Deployment Wizard
creates a SAS environment that does not use restrictive policy files to limit the access
given to SAS Web applications. By default, the sas.all.permissions.policy file is
used to allow access to the SAS Web applications. As a result, SAS Web applications
can access the necessary content.

Java 2 Security provides a policy-based, fine-grain access control mechanism that
increases overall system integrity by checking for permissions before allowing access to
certain protected system resources. By default, Java 2 Security is turned off. If your
site requires Web applications to use Java 2 Security, the custom installation option in
the SAS Deployment Wizard enables you to configure your SAS environment with
restrictive policy files.

A custom installation of SAS 9.2 software gives you the opportunity to select the use
of restrictive policy files for JBoss or IBM WebSphere application servers. Although
WebLogic provides restrictive policy files, implementation of these policy files is
problematic, and they cannot be used in the SAS 9.2 environment. Therefore, SAS 9.2
does not support restrictive policy files for WebLogic.

Your Instructions.html file provides basic guidelines for creating policy files from
existing sample files, saving those files, and rebuilding the applications. If you chose
not to enforce restrictive policy files at the time of initial installation, choose from one of
the following methods for configuring restrictive policy files:

o Use the SAS Deployment Manager to remove the existing configuration of your
SAS environment. Then, reconfigure the environment by choosing the custom
installation option in SAS Deployment Wizard. The custom installation option
enables you to configure restrictive policy files. This method, which is highly
recommended, offers the most dependable and thorough approach to ensure that
your SAS environment is set up correctly to use the Java 2 Security and restrictive
policy files.

0 Manually configure and enforce the use of restrictive policy files. Follow this
method if your site has significantly large amounts of custom content, and the
previously described method is not feasible at your site.

CAUTION:
SAS strongly discourages the use of restrictive policy files on SAS middle-tier applications
because they provide no end-user security, they are difficult to maintain, and they can be
very detrimental to application performance. ~

The SAS Deployment Wizard implements the following restrictive policies by using
different methods for JBoss and WebSphere:
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O JBoss application server. When policy files are edited and the SAS Web
applications are rebuilt by using the SAS Deployment Manager, the edits made to
the policy files are united into a single policy file
(sas.restrictive.permissions.policy) that is applied to JBoss.

0 WebSphere. Policy files for WebSphere are applied to each EAR file. Each policy
file’s inputs are placed into the corresponding EAR file as a was.policy file.

Example Policy Files for JBoss and WehSphere

SAS applications provide policy files (example.policy) for JBoss and WebSphere in
the SAS-configuration-directory\Lev1\Web\Common\SASServerl\Application-
name\PolicyFileInputs\ears directory. These example.policy files contain default
restrictive policy settings. You do not edit policy files directly. Instead, you make a copy
of the example.policy file, rename the copied file as policy, and edit the policy file.
If the policy file exists, it is used to implement restrictive policies. See “Create
Restrictive Policies for JBoss” on page 47.

Note: The united example.policy file for JBoss is located in the SAS-configuration-
directory\Lev1\Web\Commons \SASServerl\JBoss\PolicyFileInputs\ears
directory. A

The following table shows the directory paths for the JBoss and WebSphere policy
files with security restrictions for SAS applications.

Table 4.1 Policy Files with Security Restrictions for JBoss and WebSphere

Location of example.policy below

Application \Lev1l\Web\Common\SASServerl Directory
SAS Information Delivery Portal SASPortal4.2\PolicyFileInputs\ears\sas.portal\
SAS Web Report Studio SASWebReportStudio4.2\PolicyFileInputs\ears\

sas.webreportstudio\

SAS Content Server SASContentServer9.2\PolicyFileInputs\ears\
sas.wip.scs\

SAS Shared Services SASSharedServices9.2\PolicyFileInputs\ears\
sas.shared\

SAS Stored Process Application SASStoredProcessApplication9.2\PolicyFileInputs\ears\
sas.storedprocess\

SAS WeblInfrastructure Platform SASWebInfrastructurePlatformApplications9.2\
PolicyFileInputs\ears\
sas.wip.apps\

SAS Web OLAP Viewer SASWebOLAPViewer4.2\PolicyFileInputs\ears\
sas.webolapviewer\

SAS BI Dashboard SASBIDashboard4.2\PolicyFileInputs\ears\
sas.bidashboard\

SAS BI Portlets! SASBIPortlets4.2\PolicyFileInputs\ears\
sas.biportlets\

SAS Package Viewer SASPackageViewer4.2\PolicyFileInputs\ears\

sas.packageviewer\
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Location of example.policy below
Application \Lev1l\Web\Common\SASServerl Directory

SAS Preferences SASPreferences9.2\CustomContent\wars\
sas.preferences\
SAS Help Viewer for the Web SASWebDoc9.2\PolicyFileInputs\ears\sas.webdocmd\

SAS OnlineDoc for the Web SAS-installation-
directory\Documentation\9.2\onlinedocweb\

SAS Stored Process SASStoredProcessApplication9.2\CustomContent\wars\
sas.storedprocess\

1 Available in the October 2009 Release.

Create Restrictive Policies for JBoss

To create a restrictive policy file for JBoss, follow these steps for each applicable SAS
application’s policy file:

1 Make a copy of the example.policy file in the same directory and name the copied
file as policy. If you need to edit the restrictive policy settings for JBoss, make a
copy of the example.policy, rename it as policy, and save the renamed file in
the SAS-configuration-directory\Lev1l\Web\Common\jboss\PolicyFileInputs
directory.

Note: SAS OnlineDoc for the Web is not delivered with the SAS Intelligence
Platform, and is deployed separately. To apply Java permissions to SAS OnlineDoc
for the Web, make a copy of the example.policy in the
SAS-installation-directory\Documentation\9.2\onlinedocweb directory, name
the copied file policy, and place the renamed file within the same directory. Then,
copy the contents of the policy file for SAS Online Doc for the Web directly to the
JBoss policy file. A

2 Edit the policy file that you created from the original example.policy file.
Policy files must use UTF-8 character encoding.

3 Run the SAS Deployment Manager to rebuild SAS Web applications. Select JBoss
and any applications for which you have edited the restrictive policy file.
Rebuilding for JBoss will recreate the Java 2 security policy file, and the
sas.restrictive.permissions.policy. For information about how to rebuild
Web applications, see “Rebuilding the SAS Web Applications” on page 92. If you
are using the second maintenance release for SAS 9.2 and rebuilding Web
applications, the EAR files are automatically exploded. Previously, in SAS 9.2, this
was not the case.

Note: SAS Online Doc for the Web is not rebuilt or redeployed via SAS
Deployment Manager. You must manually rebuild and redeploy SAS Online Doc
for the Web. For information about manual deployment of the application, see
“Deploying SAS OnlineDoc Manually for the Web” on page 100. A

4 If you perform an auto-configuration of JBoss, restart the JBoss application server.
If you want to follow a manual process, copy the
sas.restrictive.permissions.policy file located in the
SAS-configuration-directory\Lev1\Web\Common\jboss directory to the
JBoss-installation-directory\server\SASServerl\conf directory. Then restart
JBoss.
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Create Restrictive Policies for WehSphere

To convert a SAS 9.2 environment that does not use restrictive policies to an
environment where restrictive policies are applied, you modify the policy file for each
SAS application that has a EAR file associated with it.

Note: SAS OnlineDoc for the Web is not delivered with the SAS Intelligence
Platform, and it is deployed separately. The was.policy file for SAS OnlineDoc for the
Web already contains the appropriate restrictive policies, and is included in the EAR file
for WebSphere. Therefore, you do not edit any policies for SAS OnlineDoc for the Web. A

Although the following procedure applies to the policy file for SAS Information
Delivery Portal, you can follow the same steps by substituting the appropriate
directories for the policy file that applies to each SAS application. To convert from all
permissions to restrictive permissions for SAS applications, follow these steps:

1 In the WebSphere Admin Console, navigate to Security » Secure administration,
applications, and infrastructure. Enable Java 2 Security by selecting the check
box Use Java 2 Security to restrict application access to local
resources. Save your changes.

2 Make a copy of the example.policy file located in the SAS-configuration-
directory\Lev1\Web\Common\SASServerl\SASPortal4.2\PolicyFileInputs\ears

\sas.portal directory, name the copied file as policy, and save this file in the
same directory where example.policy file resides.

3 For all SAS applications for which you want to implement restrictive policies (with
the exception of SAS OnlineDoc for the Web), edit the policy file that you created
from the original example.policy file, and make any changes that should apply
to your site. Save the modified policy file in the SAS-configuration-
directory\Lev1\Web\Common\SASServerl\SASPortal4.2\PolicyFileInputs\ears

\sas.portal directory. Policy files must use UTF-8 character encoding.

4 Run the SAS Deployment Manager to rebuild the SAS Web applications (select the
applications for which the policy files were modified). For information about how
to rebuild Web applications, see “Rebuilding the SAS Web Applications” on page
92. The edited policy files are stripped of all comments, and their contents are
inserted into the appropriate EAR file as a was.policy file. When you rebuild the
Web applications, SAS Deployment Manager rebuilds a complete EAR file that
includes any new content that was added to the policy files.

Note: SAS OnlineDoc for the Web is not rebuilt or redeployed via SAS
Deployment Manager. You must manually rebuild and redeploy SAS OnlineDoc for
the Web. For information about manual deployment of this application, see
“Deploying SAS OnlineDoc Manually for the Web” on page 100. A

5 Using the WebSphere Admin Console, redeploy each SAS Web application that
was modified previously.

6 Using the WebSphere Admin Console, restart the Web application server.

Restore Your SAS Environment to Use Default Policies

If you customized your SAS environment by implementing the use of restrictive
policy files, and you determined that the policy restrictions are unnecessary or that the
performance impact is debilitating, you can restore your SAS environment to use
default policies. To turn off restrictive policies and the use of Java 2 Security in your
SAS environment, follow these steps:



Middle-Tier Security A Customize Permissions for Socket Access 49

1 Use the SAS Deployment Manager to remove the current configuration of your
SAS environment.

2 Use the SAS Deployment Wizard to configure your SAS environment by not
selecting the option to use restrictive policy files.

It is highly recommended that you use the SAS Deployment Manager and the SAS
Deployment Wizard to complete the process of disabling restrictive policy files. However,
if your site contains large amounts of custom content, or there are other reasons that
require you to manually disable restrictive policy handling, see the following topics:

0 “Disable Restrictive Policy Handling for JBoss” on page 49.

0 “Disable Restrictive Policy Handling for WebSphere” on page 49.

Disable Restrictive Policy Handling for JBoss

To manually disable the use of SAS restrictive policy files for JBoss, follow these
steps:
1 On Windows, access the sasserverl.bat file located in the
JBoss-home-directory\bin directory. On UNIX, access the sAsServerl.sh file
located in the JBoss-home-directory\bin directory.

2 In the section JAVA_OPTS line located within the start_as_script section, remove
the following parameters:

---Djava.security.manager-Djava.security.policy=

JBoss-home-
directory\server\SASServerl\sas.restrictive.permissions.policy

3 Restart the JBoss application server.

If JBoss is running as a Windows service, follow these steps to remove restrictive

policy files:

1 On Windows, access the wrapper.conf file located in the
JBoss-home-directory\server\SASServerl directory.

2 Remove the following parameters in the wrapper.conf file:

wrapper.java.additional. ##=-Djava.security.manager
wrapper.java.additional.##=Djava.security.policy=

JBoss-home-
directory\server\SASServer\conf\sas.restrictive.permissions.policy
3 Restart the JBoss application server.

Disable Restrictive Policy Handling for WehSphere

To manually disable SAS restrictive policy handling for WebSphere, follow these
steps:
1 Using the WebSphere Admin Console, navigate to Security » Secure
administration, applications, and infrastructure.
2 To disable Java 2 security deselect the check box for Use Java 2 security to
restrict application access to local resources.

3 Restart the WebSphere application server.

Customize Permissions for Socket Access

For each application (Web or stand-alone) that needs to communicate with a SAS
server, the Java policy files for the calling application include a permission to
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communicate with the SAS Server. By default, the example.policy files for each SAS
Web application contain wildcard permission for socket access:

permission.java.net.SocketPermission "*",
"accept,connect,listen,resolve’’;

This wildcard permission enables the Java code in the applications to connect to any
host or port that is accessible to your site’s network topology. If you want to provide
strong protection with custom access, you can create specific socket permissions for the
hosts and ports that are accessed by an individual SAS Web application.

Access Permissions for Custom Portlets and Web Applications

About Access Permissions for Custom Portlets and Webh Applications

If you implement a remote portlet or foundation service-enabled Web application, you
must add additional permissions to each Web application component’s codebase and
define a codebase and permissions for the remote portlet or foundation service-enabled
Web application.

The following sections show the permission statements that you must specify in each
application or portlet’s policy file in order to enable communication with its required
servers and services.

CodeBase: <Remote Portlet or Web Application>

The localhost is the machine where the Web application server resides along with the
metadata server and SAS Remote Services. When using a localhost, specify the
permissions for the remote portlet or Web application’s CodeBase:

O access to the SAS Metadata Server:

When running on localhost, create an entry that contains the fully qualified
host name.
// permission java.net.SocketPermission
// "localhost:8561", "listen, connect, accept, resolve";

permission java.net.SocketPermission
<SAS Metadata Server’s machine>:8561,

"listen, connect, accept, resolve";

O access to the Java RMI server and remote SAS Foundation Services:

When running on localhost, create an entry that contains the fully qualified
host name.

// permission java.net.SocketPermission
// "localhost:1024-", "listen, connect, accept, resolve";

permission java.net.SocketPermission
<SAS Services application’s machine name>:1024-,

"listen, connect, accept, resolve";

0 Access to the remote portlet or Web application’s local SAS Foundation Services:
Always create an entry for both the localhost and fully qualified host name.

permission java.net.SocketPermission
"localhost:1024-", "listen, connect, accept, resolve";
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permission java.net.SocketPermission
<remote portlet or Web application’s machine name>:1024-,

"listen, connect, accept, resolve";

0 Access for foundation service-enabled applications that call this application to pass
objects (via RMI to this application):

Create one entry per machine.

permission java.net.SocketPermission
<portal Web application’s machine name>:1024-,
"listen, connect, accept, resolve";

O Access to a SAS Stored Process, Workspace, or OLAP server:
Create one entry per machine.

permission java.net.SocketPermission

<SAS Workspace Server’s machine name>:1024-,
"connect, resolve";

permission java.net.SocketPermission

<SAS Stored Process Server’s machine name>:1024-,
"connect, resolve";

permission java.net.SocketPermission

<SAS OLAP Server’s machine name>:1024-,

"connect, resolve";
0 Access to the host and port where the SAS Web Application Themes is running:

/] ————————— Socket Access to Themes ——————————--
permission java.net.SocketPermission

Theme _host:Theme Port:,

"connect, resolve";

CodeBase: Portal

Access for foundation service-enabled applications that are called by this application
to pass objects (via RMI) (for example, remote portlets, Web applications, and
applications):

Create one entry per machine.

permission java.net.SocketPermission
<remote portlet/Web application’s machine name>:1024-,
"listen, connect, accept, resolve";

CodeBase: SASServices

The remoteservices.policy file is located in the SAS-configuration-directory
\Levl\web\applications\remoteservices directory. The following applies to
connections with applications that use SAS Foundation Service session sharing:

permission java.net.SocketPermission
<remote portlet/Web application’s machine name>:1024-,

"listen, connect, accept, resolve";
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Configuration Shared hetween the Middle Tier and the Server Tier

The Web applications and services that form the SAS middle tier require specific
configured connections to back-end servers. You might want to modify the connections
and settings in the following ways:

o Change the connection to an SMTP Mail Server.

O Modify the connection to a relational database via a data source that is defined in
the Web application server (for those deployments that include SAS Shared
Services, SAS solutions, or both).

o0 Define pooling options for connections to SAS Workspace Servers.

O Integrate Application Response Measurement (ARM) capabilities between the SAS
middle tier and SAS servers.

Configuring an SMTP Mail Server for Use with the SAS Middle Tier

The Web Infrastructure Platform includes a SAS Mail Service that is used by SAS
Web applications and services to send e-mail messages such as alert notifications and
administrative status updates. The SAS Mail Service relies on a single Java Mail
Session that is defined in the Web application server on which the service is deployed.
This Java Mail Session provides the single point of configuration to an external SMTP
mail server that your site designates to use for application e-mail. Because the SAS
Mail Service relies on this single configuration location, if the SMTP mail server
changes, you can modify the appropriate settings in a single place.
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The Java Mail Session depends on configuration information that defines the mail
transport capabilities. The SAS Mail Service requires that the following minimum set
of mail properties be specified:

0 The mail.transport.protocol property must be set to smip.
O The mail.smtp.host property must be set to the name of the SMTP mail server
that is used by SAS applications to send mail.

0 The mail.smtp.port property must be set to the corresponding port (typically 25 for
SMTP servers).

During typical production deployments, the value of the mail.debug property is set to
false. You can set this value to ¢rue if you need to debug mail transactions.

In a standard installation of SAS middle-tier components, the configuration of the
Java Mail Session is typically automated using prompted values that are provided by
the installer. To modify the settings for the Java Mail Session (for example, if the host
name of the SMTP mail server changes), see the appropriate documentation for your
Web application server.

Client-Side Pooling and Server-Side Pooling Options

A collection of reusable workspace server and stored process server processes is
referred to as a pool. By reusing server processes, pooling avoids the cost that is
associated with creating a new process for each connection. If your client application
uses frequent, short-duration connections to SAS, pooling might greatly improve your
server performance.

SAS supports the following types of pooling:

server-side is the process by which the SAS Object Spawner maintains a

pooling collection of workspace servers that are available for clients. The
usage of servers in this pool is governed by the authorization rules
that are set on the servers in the SAS metadata.

client-side is the process by which the client application maintains a collection
pooling of reusable workspace server processes.

For a comparison of client-side pooling and server-side pooling, see “Choices in
Workspace Server Pooling” in the “Server Configuration, Data Retrieval, and Risk”
chapter in the SAS Intelligence Platform: Security Administration Guide.

For more detailed information about pooling, see “Understanding Server Pooling” in
the SAS Intelligence Platform: Application Server Administration Guide.

For instructions on configuring client-side pooling properties, see “Configuring
Client-Side Pooling” in the SAS Intelligence Platform: Application Server
Administration Guide.

Configuring Data Sources Used by the SAS Middle Tier

About the Data Sources Used by the Middle Tier

Several services in the middle tier, including SAS Shared Services as well as some
solutions, provide a set of features that rely on a relational database to store service
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data. These relational tables differ from the data that is analyzed, modeled, or otherwise
processed by SAS applications, which typically is derived from a site’s enterprise or
legacy sources. Instead, the shared platform relational tables are intrinsic to or used
primarily for the operations of a particular application, product, or a specific service.
Applications and services access data from the database server via a JDBC data
source that is defined for the Web application server. In a deployment that includes
SAS Shared Services, a data source is created exclusively for use by the Shared
Services. Other SAS applications and solutions might specify additional data sources.

Using the SAS Table Server with the SAS Middle Tier

Ahout the SAS Table Server

SAS Table Server stores audit records for enhanced auditing functionality supported
by SAS Shared Services.

During an Enterprise BI Server installation, a database and a data source name
(DSN) definition are created automatically on the SAS Table Server for the exclusive
use of SAS Shared Services. Both the database and the DSN are named SharedServices.

Configuration Information for the SAS Shared Services Data Source

When using SAS Table Server, use the following configuration information for the
SharedServices DSN:

Configuration Parameter Setting

JNDI name: sas/jdbc/SharedServices

connection URL: jdbc:sastkts://serverName:port?stmtpooling=0&amp;
constring=(DSN=SharedServices)

In the URL, substitute the server name and port number of the SAS
Table Server at your site. The default port for SAS Table Server is
2171.

JDBC driver class: com.sas.tkts. TKTSDriver

These settings are configured during initial deployment. However, you need to know
the configuration information if you later make changes, such as moving the SAS Table
Server to another host system.

Note: You must specify the user name and password values as required to access
the data source. A
The following JAR files must reside on the Web application server:
sas.core.jar
sas.core.nls.jar
sas.icons.jar
sas.icons.nls.jar

sas.intrnet.javatools.jar

I I O I A B A

sas.intrnet.javatools.nls.jar
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sas.nls.collator.jar
sas.oda.tkts.jar
sas.oda.tkts.nls.jar
sas.rutil.jar
sas.rutil.nls.jar
sas.security.sspi.jar

sas.svc.connection.jar

O O0o0oooooad

sas.svc.connection.nls.jar

To modify the settings for a data source, see the documentation for your Web
application server.

The SAS Shared Services Database on SAS Table Server

The sharedServices.fdb database is located in the following directories:

On Windows:
SAS-configuration-directory\Lev1\SASTS\Content directory.

On UNIX and z/OS:

SAS-configuration-directory/Levl/SASTS/Content directory.

The Web application server points to this database. The DSN definition is a
metadata object that contains connection information that allows SAS Shared Services
to connect to the Shared Services database. The connection information is configured by
default to be optimum for SAS Shared Services.

CAUTION:
Do not change the name or contents of the DSN. Doing so prevents SAS Shared Services
from functioning. A

Back Up and Restore the Shared Services Databhase

To back up the database, use the following command:
sastback -b SharedServices.fdb -mo read only [-verbose] SharedServices.fbk
To restore the database, use the following command:

sastback -r SharedServices.fbk [-verbose] SharedServices.fdb

On Windows, UNIX, and z/OS, the SASTBACK executable is in the
SAS-installation-directory/SASFoundation/9.2/vulcan/bin directory.

Using Other Relational Databases with the SAS Middle Tier

SAS Shared Services can be configured to use a relational database other than SAS
Table Server to handle its storage requirements. In addition, some SAS solutions and
applications might require a database other than SAS Table Server (such as MySQL).
The other relational databases that can be used vary depending on the set of SAS
applications that your site has installed. Contact your on-site SAS support personnel
for more information.

Configuring Application Response Measurement (ARM) Capabhilities
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About ARM

The SAS server environment provides instrumentation for standard Application
Response Measurement (ARM) processing. ARM is an industry standard application
programming interface (API) for measuring end-to-end application response time. With
SAS servers, these ARM capabilities enable you to measure and monitor the time
required for specific SAS activities. The SAS Web Infrastructure Platform provides
additional ARM capabilities that enable the measurement and monitoring of activities
that originate in the SAS middle tier.

In the SAS Web Infrastructure Platform, the SAS Logon Manager application has
been instrumented for ARM processing. Depending on the software that is installed at
your site, other SAS Web applications and solutions might implement ARM processing
as well. For more information, see the documentation for particular SAS applications
and solutions.

Enable ARM Capabilities for SAS Logon Manager

ARM processing for SAS Logon Manager is disabled by default in a standard
deployment. To modify configuration information to enable ARM processing, follow
these steps:

1 Ensure that the sas.arm.log4j.jar, sas.entities.jar, and sas.core.jar
files are available on the CLASSPATH that is used by log4j logging.

The JAR files can be obtained from the SAS Versioned Jar Repository, which is
typically located under
SAS-installation-directory\SASVersionedJarRepository\9.2\eclipse\plugins.

2 In a text editor, open the SASLogon-log4j.xml file, which is typically located in
SAS-configuration-directory\Levn\Web\Common\LogConfig.

The directory where this file is located is defined by the com.sas.log.config.url
system property, which can be found in the start-up script or configuration file for
the Web application server.

3 Add the following lines to SASLogon-log4j.xml file:

<appender name="ArmAppender" class="com.sas.arm.log4jappender.ArmAppender">
<param name="AppName" value="IOM.APP"/>
<param name="GroupName" value="SAS"/>

</appender>

<logger name="com.sas.arm.log4j.logger">
<level value="debug"/>
<appender-ref ref="ArmAppender"/>

</logger>

Note: In the XML code, the appender element comes before the logger element.
When you edit a log4j configuration XML file, all appenders must precede all
loggers and categories. Otherwise, the configuration fails. A

4 In the Web application deployment, edit the aop-config.xml file, which is found
at exploded-apps-location\sas .wip.apps9.2.ear\sas.svcs.logon.war \WEB-
INF\spring-config. Remove the XML comments around the definition and
reference of the armProcessor bean.

Note: If the EAR files in your environment are deployed unexploded, you must
explode sas.wip.apps9.2.ear in order to edit the aop-config.xml file. To
explode the file, unarchive both the EAR file and any WAR files within the EAR
file. After you edit the aop-config.xml file, re-archive the WAR and EAR files. A
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5 In the Web application deployment, edit the services-remote-config.xml file,
which is found at exploded-apps-
location\sas.wip.services9.2.ear\sas.wip.services.war\WEB-INF\spring-
config. Remove the XML comments around the definition and reference of the
armProcessor bean.

Note: If the EAR files in your environment are deployed unexploded, you must
explode sas.wip.services9.2.ear in order to edit the
services-remote-config.xml file. To explode the file, unarchive both the EAR
file and any WAR files within the EAR file. After you edit the
services-remote-config.xml file, re-archive the WAR and EAR files. A

6 Restart the SAS Services Application and the Web application server.

Upon successful start of the application server, the ARM monitoring of logon and
logoff activities is enabled.
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SAS Web Infrastructure Platform

Ahout the SAS Web Infrastructure Platform

The SAS Web Infrastructure Platform is a collection of services and applications that
provide common infrastructure and integration features to be used by SAS Web
applications. These services and applications provide the following benefits:

O consistency in installation, configuration, and administration tasks for Web
applications
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O greater consistency in users’ interactions with Web applications

O integration among Web applications as a result of the ability to share common
resources

For a description of the SAS Web Infrastructure Platform services and applications,
see “SAS Web Infrastructure Platform” on page 10.
The following sections describe two of the applications.

SAS Preferences Manager

The SAS Preferences Manager is a Web application that provides a central facility
for users to manage their preferences and settings.

You can invoke the application by using the following URL address:

http://server:portSASPreferences

Users of SAS Information Delivery Portal can invoke the SAS Preferences Manager
from within the portal. For instructions, see the product Help.

The following figure shows a generic preferences application. The actual preferences
that are available vary depending on the software that is installed. The SAS
Preferences Manager at your site might have additional settings.

Display 6.1 SAS Preferences Manager Console

Preferences §sas
General General
Language User theme: ISAS Default j Default: SAS Default
Format Notifications

E-mail notifications: |HTML—formatted e-mail j Default: HTML-formatted e-mail
Partal

Alert notifications: |le alerts portlet ﬂ Default: My alerts portlet

Apphy ‘ Restore Defaults |

| ok || cancel |

Here are the generic settings:

General
Specify a theme for the applications. A theme includes settings for colors, fonts,
and graphics.
Users can also specify the format for notifications that are generated by SAS
applications and solutions.

Language
Select the locale (language and country) that you prefer.

Format
Select the preferred format for dates, time, and currency.

Portal
Specify the position of the portal navigation bar in the SAS Information Delivery
Portal. You can also specify the sort order for packages that are published in the
portal. You can sort packages in descending order (newest packages are at the top)
or in ascending order (oldest packages are at the top).

SAS Logon Manager
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About SAS Logon Manager

The SAS Logon Manager is a Web application that handles all authentication
requests for SAS Web applications that build on the business intelligence platform. As
a result, users see the same logon page when they access the SAS Web applications.

The purpose of the SAS Logon Manager is to authenticate and direct a successful
logon to the appropriate page. The application also serves as the central point for
handling changes to authentication mechanisms, such as the addition of Windows SSPI
or third party single sign-on products.

You can configure settings for the Logon Manager in the Application Management
» Configuration Manager section in SAS Management Console. For example, you can
specify the default theme. You can also set policies that affect logon and logoff, such as
whether to display a Log On button on the Web time-out page.

Example: Enable the Log On Button on Time-out Pages

To enable the display of a Log On button on users’ Web time-out pages, follow these
steps:
1 Log on to SAS Management Console.

2 On the Plug-ins tab, navigate to Application Management » Configuration
Manager » SAS Application Infrastructure.

3 Right-click sAs Application Infrastructure and select Properties.
4 Click the settings tab.

5 In the left pane, select Policies.

I'ml

6 In the right pane, click the locked icon next to Allow user login from

web timeout page. The icon changes to unlocked il . Click oK.

When a field has a locked icon, the value or setting for that particular field
cannot be modified on the settings tab for other SAS applications that inherit
their settings from this application. By default, all SAS applications inherit their
settings from SAS Application Infrastructure. For more information about locking
and unlocking settings, see “Setting Global Properties for SAS Applications Using
SAS Application Infrastructure Properties” on page 66.

7 On the Plug-ins tab, navigate to Application Management » Configuration
Manager » Logon Manager 9.2.

8 Right-click Logon Manager 9.2 and select Properties.
9 Click the settings tab.
10 In the left pane, select Policies.

11 In the right pane, select Yes in the list box for Allow user login from web
timeout page, and click OK.

Changes to properties do not take effect immediately on the run-time system. For
details, see “Summary of Steps for Using Configuration Manager” on page 65.

SAS Management Console
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Overview of SAS Management Console

The SAS Management Console is the primary tool available to administer the SAS
Intelligence Platform. It is a framework in which a variety of plug-ins are installed to
expand the capability of the SAS Management Console. A plug-in is an application
module that is designed to create and maintain metadata for a specific type of resource.

Only certain users can view and use plug-ins. A user’s access to plug-ins depends on
which roles the user is assigned to and which capabilities are assigned to those roles.

For information about SAS Management Console and plug-ins, see “Understanding
the State of Your System” in the SAS Intelligence Platform: System Administration
Guide. Also, see the online Help available with the SAS Management Console.

Modify Folders

If you have installed SAS Web applications such as SAS Web Report Studio, then
some SAS folders (for examples, folders that contain metadata for reports) have
associated physical content that resides on the SAS Content Server. In these instances,
a procedure called content mapping maps the metadata folder structure to
corresponding physical folders that have the same organization. Content mapping is
automatically configured when you install your system.

Do not move, rename, or delete folders within SAS Folders that are mapped to a
physical folder structure on the SAS Content Server. If you modify a folder that has
content mapping specified, then the physical content to which the folder is mapped
might become inaccessible.

For information about the SAS Folders in the SAS Management Console, see the
SAS Intelligence Platform: System Administration Guide.

Using Configuration Manager

Overview of Configuration Manager

Configuration Manager is a plug-in available in SAS Management Console. Using
the Configuration Manager, you can perform various administrative tasks such
configuring properties and values and specifying settings for the SAS Web applications.

Configuration Manager offers a consistent interface to set properties for all SAS Web
applications. Each SAS Web application has its own properties window with tabs. For
example, the following display shows the Settings tab of the Web Report Studio 4.3
Properties dialog box.

Here is a brief description of the five tabs available in the properties dialog box
associated with a SAS application:

Note: For more information about using these tabs, see the online Help for the
Configuration Manager plug-in in SAS Management Console. A

0 The General tab provides basic information about the application.

0 The Connection tab enables you to modify the parameters for connections to SAS
Web applications. For more information, see “Specifying Connection Parameters
for HTTP and HTTPS Sessions” on page 69.
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0 The settings tab offers default values for settings that can be modified. For

modifying values in the Settings tab, and to understand how the lock and unlock
icons function, see “Setting Global Properties for SAS Applications Using SAS
Application Infrastructure Properties” on page 66.

The Advanced tab includes a limited number of default property names and
values. You can modify existing properties and their values, or add custom
properties and values for SAS Web applications.

The Authorization tab enables you to specify permissions for users and groups
and apply Access Control Templates.

Although certain .XML configuration files (for example, LocalProperties.xml file
for SAS Web Report Studio) are available and supported for SAS Web applications, it is
recommended that you use the Configuration Manager to configure and set properties.

Summary of Steps for Using Configuration Manager

Here are the main steps for using Configuration Manager:

1

To access Configuration Manager, in SAS Management Console, navigate to
Plug-ins » Application Management » Configuration Manager.

To access the properties for an application, right-click the application’s node and
select Properties.

Add or modify properties as needed. You might need to unlock particular
properties before you can change them. See “Setting Global Properties for SAS
Applications Using SAS Application Infrastructure Properties” on page 66.

Changes to properties do not take effect immediately on the run-time system. To
apply these changes, you must perform one of the following tasks:

0 Stop and then restart the Web applications whose properties you changed.

0 Use the application’s JMX management bean to reload the configuration (if
the application supports JMX beans). For more information about JMX, see
“Using JMX Tools to Manage SAS Resources” on page 85.

o Alternatively, stop and then restart SAS Services Application and the Web
application server.

Example: Configure a Property for SAS Web Report Studio

Suppose that you want to add the property,
wrs.ReportViewPrefs.LeftPanelOpenState for SAS Web Report Studio 4.3, and
specify the value for this property. To configure this property and its value, follow these
steps:

1
2

Log on to SAS Management Console.

In SAS Management Console, navigate to Plug-ins » Application Management »
Configuration Manager » Web Report Studio 4.3. Right-click and select
Properties to display the Web Report Studio 4.3 Properties window.

3 Click on the advanced Tab.
4 Click add to display the Define New Property window.

5 Enter the property name as shown and specify the property value:

Property Name: wrs.ReportViewPrefs.LeftPanelOpenState
Property Value: user
Click oK to exit the Define New Property window.



66 Setting Global Properties for SAS Applications Using SAS Application Infrastructure Properties A Chapter 6

7 Click oK to exit the Web Report Studio 4.3 Properties window.

Changes to properties do not take effect immediately on the run-time system. For
details, see “Summary of Steps for Using Configuration Manager” on page 65.

The following display shows the property name,
wrs.ReportViewPrefs.LeftPanelOpenState, and its property value specified on the
Advanced tab.

Display 6.2 Advanced Tab for SAS Web Report Studio 4.3 Properties

Web Report Studio 4.3 Properties

eneral | Connection | Settings  Advanced | authorization |

Property Mame Property Yalue

App. ClientSidePoolingAdminID

Ernail.Host

Email Port 25

Logon, Target \WRSLogon
Mekadata, Host carolina.na.sas.com
IMetadata, Repositary Foundation
Metadata, Userid sastrush@saspin
Palicy . CommentAdministr ationEnabled true
webrepartstudio.max.filker .chaices 1000
webreportstudio.max. prompt. choices 1000

wis, ReportYiewPrefs, LeftPanelOpenstate  |user

virs, banner product. title. hide true

s, pfs. logPropertiesAs\Warn true

add Remave |
oK I Cancel | Help |

The dimmed fields indicate that the values are inherited from the SAS Application
Infrastructure, and these values are shared with other Web applications. The values in
the dimmed fields can be changed only in the SAS Application Infrastructure Properties
window.

For more information about the properties and values that apply to SAS Web Report
Studio 4.3, see “Configuring SAS Web Report Studio” on page 195.

Setting Global Properties for SAS Applications Using SAS Application
Infrastructure Properties

The Configuration Manager plug-ins within SAS Management Console enable you to
configure properties and specify values and settings individually for each SAS
application.
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By default, all SAS applications inherit their settings from SAS Application
Infrastructure. Settings that are changed in the SAS Application Infrastructure
Properties dialog box apply to all SAS applications that inherit their settings from SAS
Application Infrastructure.

By default, most settings are locked at the SAS Application Infrastructure level, and
these settings cannot be changed for individual SAS applications. When you unlock a
setting at the SAS Application Infrastructure level, that setting can be overridden for
individual applications. When you lock a setting at the SAS Application Infrastructure
level again, all applications inherit that setting from the SAS Application Infrastructure.

The following display shows the options for User Interface, Regional Settings,
and Pooling for Applicationon the Settings tab associated with SAS Application
Infrastructure.

Display 6.3 Settings Tab for SAS Application Infrastructure Properties

SAS Application Infrastructure Properties

General  Settings I Advanced | Authorization |

[ Show only required items {dencked by *)
User Interface
Rengional Settings |npplicati0n = User Interface Reset to defaulks |
Paaling *
Matifications Default theme: Resst I
General Configuration
Administrative and Error Me Idefault
Farmats
Formats Display Quick Help Tips: Reset | =41
Currency Formats =
Palicies I‘r’es ;I
Default Logon Target: Reset I
IWRSLogon ;I
|Applicati0n = Reqgional Settings Reset to defaults |

Diefault locale: Reset I
[

knglish - United States

|App|i-:ati0n = Pooling Reset to defaults |
* activate client-side pooling: Reset I
Use client-side pooling of 545 Servers where supparted.
[no =

oK I Cancel Help

T

The locked icon | = indicates that a field is locked. When a field has a locked icon,
the value or setting for that particular field cannot be modified on the Settings tab for
other SAS applications that inherit their settings from this application.

To unlock a field, follow these steps:

1 Click the locked icon. The icon changes to an unlocked icon il .
2 Click oK to save the unlocked field.
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In the example, the Display Quick Help Tips field has been unlocked. The
unlocked icon indicates that the values for Display Quick Help Tips can be modified
individually for any SAS application in Configuration Manager. The other fields remain
locked. Therefore, they cannot be modified individually for any SAS application.

Note: By default, all fields on the settings tab of the SAS Application
Infrastructure Properties dialog box are locked. A

The following display shows the effect of these locked states on the Settings tab for
the Web Report Studio 4.3 Properties dialog box.

Display 6.4 Settings Tab for SAS Web Report Studio 4.3 Properties

Web Report Studio 4.3 Propetrties

Generall Connection | ndvancedl nuthorizationl

[~ show only required items {denated by *)
User Interface
Regianal Settings |Applicati0n = User Interface Rieset ta defaults | =
Pooling *
Configuration * Display Quick Help Tips: Reset _l
Scheduling *

Matifications I\"es LI
General Configuration
Adrministrative and Error M Defaul Logon Target:

Formats WRSLagon
Farmats
Currency Formats |npplicati0n = Regional Settings Reset to defaults |

Cefault locale:
en_US

|npplicati0n = Pooling Resel to defaulks |

* Activate client-side pooling:
Use client-side pooling of 545 Servers where supported. ]

false
|Applicati0n = Configuration Reset to defaults |
* Allows Public Users Reset
I\"es LI
* Farce Relative URLs Reset

Some front end security processors require relative URLs For
images and ather content.

[te [~
* Show Legacy Paths Reset I
Display the WRS Location drop down with legacy paths {F they
_‘I.—I LI Foriat. LI

o4 I Cancel | Help |

In this display, the unlocked icon shows that Display Quick Help Tips can be
modified individually for SAS Web Report Studio. However, the other fields cannot be
modified individually for SAS Web Report Studio for the following reasons:

0 Those fields are locked in the SAS Application Infrastructure Properties dialog box.

O The locked states in the SAS Application Infrastructure dialog box apply globally
to all SAS application plug-ins in Configuration Manager.

Certain applications (for example, SAS Web Report Studio) have settings that are
unique to that application. Those settings are not inherited from the SAS Application
Infrastructure. Therefore, those settings can be modified on the settings tab for the
Web Report Studio 4.3 Properties dialog box without any need to reset the lock for these
settings at the SAS Application Infrastructure level.
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The following display shows settings that are unique to SAS Web Report Studio. All
of these configuration settings, which are not inherited from the SAS Application
Infrastructure level, can be modified and saved individually in this dialog box.

Display 6.5 Unique Settings for SAS Web Report Studio 4.3 Properties

Web Report Studio 4.3 Properties [ x|

General | Connection  Settings I Advanced | Authorization |

Application I Show only required items (denoted by *)
User Interface
Regional Settings |Applicati0n = Configuration Reset to defaults |
Paoling *
Configuration * * allow Public Users Reset | (=)
Scheduling *
Matifications INU ;I
General Configuration "
Administrative and Errar Mg Force Relative URLs Reset | (=)
Formats
Formats Some Frank end security processors require relative URLs for

images and other content.

= =]

Currency Formats

* Show Legacy Paths Reset I
Display the WRS Location drop down with legacy paths §if they
exist],

[ves [

* Show Manage Credentials Reset I

Helpful if users Frequently enter secondary credentials
[to =

* Web Cantainer is Clustered Reset I

Is the web container {WebSphere, Weblogic, JBaoss, .0 ina
clustered configuration? It is safe to say ves if unsure,

Yes LI

[a]'4 I Cancel Help

Specifying Connection Parameters for HTTP and HTTPS Sessions

The Connection tab in the properties dialog box for SAS applications enables you to
modify the parameters for connecting to a SAS Web application. The selections that are
displayed on the Connection tab determine the URL that is used to access the
application’s resources or services.

The following display shows the Connection tab for SAS BI Dashboard properties.
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Display 6.6 Connection Tab for Bl Dashboard 4.3 Properties

BEI Dashboard 4.3 Properties

| Settingsl Advancedl Authorizationl

Connection to the Application

Comrunication Protocal: IHTTP YI

Host Mame: Icarnlina.na.sas.com
Part Mumbet: IBDBD
Service: lisasBIDashboard

QK I Cancel | Help |

If your site changes its configuration after initial deployment, you might need to edit
the connection information parameters. Here are some situations where the connection
parameters are updated on the Connection tab:

o If a SAS Web application is moved to a different machine, you must modify the
host name property for its connection.

o If you configure Secure Sockets Layer (SSL) for improved security, you must edit
the Protocol property to modify the connection protocol to HTTPS for each affected
application.

o If clustering or load balancing is configured, the connection parameters should be
updated.

o If you deploy SAS Web Application Themes to a different Web application server,
you should modify the theme metadata by specifying the name of the theme, and
update other parameters such as host name and port number.

Changing the values for the Host Name, Port, or Service fields on the Connection
tab enables the SAS Web Application Infrastructure to seamlessly redirect clients to the
proper locations in a custom environment. For the host name, you can supply an IP
address. If you enter an IP version 6 address, you must enclose the address in brackets.

For example: [FE80::202:B3FF:FE1E:8329]
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Enabling SAS Information Delivery Portal 4.3 With SSL Configuration

If SAS Information Delivery Portal 4.3 is running on a JBoss Web application server,
and SSL is configured in your environment, then edit the server.xml file. Add the
following parameter and value to the SSL Connector section:

emptySessionPath="True"

CAUTION:
If SSL is configured, and the emptySessionPath parameter is not defined manually in the
server.xml file, then SAS BI Portlets will not function properly with SAS Information
Delivery Portal 4.3. ~

Here is an example of the section where the emptySessionPath parameter has been
specified:

Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true"
clientAuth="true" sslProtocol="TLS"
useURIValidationHack="false" disableUploadTimeout="true"
address="${jboss.bind.address}"
keystoreFile="${jboss.server.home.dir}/conf/server.keystore"
keystorePass="ServerAdminl23"
truststoreFile="${jboss.server.home.dir}/conf/server.truststore"
truststorePass="ServerAdminl23"
emptySessionPath="true"

Using the SAS Web Administration Console

About the SAS Web Administration Console

The SAS Web Administration Console provides a central location for monitoring
users, enabling an environment for system maintenance tasks, managing folders and
permissions for the SAS Content Server, and managing SAS Web applications.

The following display shows an expanded view of a main page for the SAS Web
Administration Console.
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Display 6.7 Main Page in SAS Web Administration Console

iff sasadm | Preferences | Helpw

SAS Web Administration Console §sas
L Js45 web administration consoleJllIE TS
= JEnvironment Management SAS Web-based APPhcatmns

Busers Licensed to: EBI FOR LAX
--Cﬁlsystem Maintenance Site number: 70068118
(EPSAS Content Server Container version: JBossWeb/2.0.0.GA
={Tapplication Management JVM version: 1.5.0_14
Bl Dashboard 4.2
- 58I Dashboard 4.2 - Event Gener:
- FB1 Rep Svc Wkspace Config 4.2
Ee1 web services for Java 9.2
- ﬁHeLp Viewer Meta Config 9.2
Elinformation Delivery Portal 4.2
- ﬂLngnn Manager 9.2
- EIpackage Viewer 4.2
Elpreferences Manager 9.2

- Fsas Application Infrastructure
FlsasTheme_default

- EsecurityTokenService

~shared applications 9.2

Here is a description of what you can accomplish with the SAS Web Administration
Console:

o0 The Users page enables you to view and monitor authenticated users and system
users that are currently logged on to a SAS Web application. See “Monitor Users”
on page 73.

0 The System Maintenance page provides the Restart Maintenance Wizard and the
Quiesce System feature. When you want to perform system maintenance, the
Restart Maintenance Wizard enables you to send e-mail to users to log off from
their sessions within a specified deadline, to log off users after the deadline, and to
prohibit new users from logging on to their applications. The Quiesce System
feature is useful when you want to allow existing users to stay logged on to their
user sessions, but you want to quiesce the system by preventing new users from
logging on to SAS Web applications. See “System Maintenance Tools for Managing
User Login Sessions” on page 74.

0 The SAS Content Server page enables you to manage folders and permissions for
content in the SAS Content Server. You manage content by using either the SAS
Content Server Administration Console (within the SAS Web Administration
Console) or by using a stand-alone SAS Content Server Administration Console.
You must be an unrestricted user in order to access the SAS Content Server
Administration Console.

To access the SAS Content Server feature in the SAS Web Administration
Console, select Environment Management » SAS Content Server in the
navigation pane.

For instructions on administering the SAS Content Server, see “Using the SAS
Content Server Administration Console” on page 126.

o The Application Management page enables you to view the current configuration
for Web applications that have been deployed at your site. For more information,
see “View Information about Web Applications” on page 76.

Note: The SAS Web Administration Console can be extended by other SAS
applications. Depending on the software that is installed at your site, your SAS Web
Administration Console might be different from the one shown here. For more
information about the console at your site, see the administration guides for your
applications. A
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Access the SAS Web Administration Console

To access the SAS Web Administration Console, enter the following URL in your Web
browser and substitute the server name and port number of your Web application
server:

http(s) ://server:port/SASAdmin

To use this application, you must log on as someone who is a member of the SAS
Administrators group (for example, sasadm@saspw).

Note: The SAS Content Server Administration Console has its own logon
requirements. For more information, see “Using the SAS Content Server
Administration Console” on page 126. A

Monitor Users

About the Users That Appear in the SAS Web Administration Console

The Users page in the SAS Web Administration Console lists the following types of
users:

Authenticated are users who are currently authenticated on the system.
users
System users are system-level users who are required to perform particular tasks,

such as running a stored process or accessing metadata. The
information provided on the Users page is for informational
purposes only. You cannot manage these users from the SAS Web
Administration Console.

Send E-Mail to One or More Users

You can send e-mail to any of the users who are currently logged on to a SAS Web
application. This feature is useful if you want to notify users of an impending system
operation or a system outage.

To send e-mail to a user, follow these steps:

1 Select Environment Management » Users in the navigation pane.
2 In the Users pane, select the check box next to an authenticated user’s name.
You can select multiple check boxes in order to send e-mail to several users. To

select all of the check boxes, select the check box in the heading of the last column.

3 Click the action menu = in the heading of the last column and select Send
E-mail.

4 If necessary, enter the e-mail address of the recipient. If you enter more than one
address, separate the addresses with a semicolon.

The addresses are already listed for users who have an e-mail address defined
in SAS metadata.

5 Enter the subject and text of the message.

6 If you have more than one recipient, specify whether you want to send a single
message to all recipients or to send a separate message to each recipient.

7 Click send.
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Force Users to Log Off

In some cases, users might not be actively working with a SAS Web application, and
yet their sessions remain active in the system. You can force the termination of these
user sessions by using the SAS Web Administration Console.

To force users to log off, follow these steps:

1 Select Environment Management » Users in the navigation pane.

2 In the Users pane, select the check box next to an authenticated user’s name.

You can select multiple check boxes in order to force off several users. To select
all of the check boxes, select the check box in the heading of the last column.

3 Click the action menu = in the heading of the last column and select Force Log
Off.

A confirmation page displays the user ID, e-mail address, and last logon time
for the selected user. Review this information to ensure that you want to continue
with the logoff operation.

4 Click oK to force the logoff.

System Maintenance Tools for Managing User Login Sessions

Tasks such as making changes to the metadata, restarting a metadata server,
restarting the object spawner, or restarting a Web application can be performed safely
only when users are not logged on to applications or when new users are prohibited
from logging on to the applications. The Maintenance Restart Wizard enables you to
perform a sequence of tasks to prepare the system for maintenance.

The SAS Web Administration Console cannot stop, pause, or start servers. For
instructions about system maintenance tasks such as stopping, pausing, or starting
servers, see the SAS Intelligence Platform: System Administration Guide.

Note: Do not close the Web browser during a quiesced state or when you are
completing the steps in the Restart Maintenance Wizard. If the Web browser is closed
during these sessions, restart your Web application server. A

The following display shows the System Maintenance page in the SAS Web
Administration Console.

Display 6.8 System Maintenance Page

SAS Web Administration Console

sas web Administration Console d ,
= {Environment Management System Maintenance
. Busers {8  Restart systsm...
@ : =
gi35ystem Maintenanc The Restart Wizard notifies logged-on users, shuts down the system after a specified time, and quiesces
. -{2lsAs Content Server the system. Whila the system is quiesced, you can perform maintenance operations such as making
= DApplicatign Management changes to the metadata, republishing budget forms, or restarting individual web applications; in other
E5B1 Dashboard 4.2 words, operations during which you do not want users to be logged on.
I8l Dashboard 4.2 - Event Genera Il Quiesce system...
81 Rep Sve Wkspace Config 4.2 The Quiesce system option provides a mechanism by which you can quiesce the system (temporarily put the

system into an inactive state). When the system is quiesced, users who are currently logged on can

el web Servi : : i) HE i
ol web Services for Java 9.2 continue to work within the system, but user logon capabilities are temporarily disabled.

FEiHelp viewer Meta Config 9.2
~Einformation Delivery Portal 4.2
~Logon Manager 9.2

Erackage viewer 4.2

Fpreferences Manager 9.2

Do not close your browser or otherwise end your session while the system is quiesced. If you do, you will not
be able to log on again, and you will need to restart the Java application server.

-Elsas Application Infrastructure
-HsasTheme_default
EsecurityTokenservice
[Fishared Applications 9.2
~shared Portlets 9.2
-Hshared services 9.2
Fstored Process web App 9.2




Administering the SAS Web Infrastructure Platform /A System Maintenance Tools for Managing User Login Sessions 75

Maintenance Restart Wizard

Use the Maintenance Restart Wizard to prepare a system for maintenance and
resume system operations as described in the following list:

0 Notify authenticated users who are logged on to applications that system
maintenance is planned, and specify a deadline by which they need to log off from
their applications.

0 Enable the shutdown of the system after a specified deadline.
0 Enable the system to prohibit new users from logging on to their applications.

o If the notification deadline has passed, and users and have not terminated their
sessions, the system forces authenticated users to exit and terminate their
sessions. All users are logged off.

0O Quiesce the system by temporarily putting the system into an inactive state.
When the system is quiesced, users’ logon capabilities are disabled.

0 Begin maintenance operations such as restarting the metadata server, the object
spawner, or a Web application.

0 Resume system operation by removing the quiesced state from the system, and
enabling users to log on to the system and their applications.

To use the Maintenance Restart Wizard, log on to the SAS Web Administration
Console. Navigate to Environment Management » System Maintenance. Click
Restart System and follow the Wizard’s instructions.

The following display shows the main page for the Maintenance Restart Wizard.

Display 6.9 Maintenance Restart Wizard

| Help~
Maintenance Restart Wizard gsas

«
Suspend Log On

2 Motify Users This wizard guides you through the process of a maintenance

restart of SAS middle tier applications. Periodically, you may need

to restart SAS middle tier applications without disabling other

1 Suspend Log On

3 List Current Users

4 Maintenance applications.

5  Resume Operations Click the Mext button to begin the maintenance operation by
suspending new user log on activities.

& Summary 7 : 2 e
You may cancel the maintenance restart operation by clicking the
Cancel button.

< Previous | | Mext:= | : Finish | I Cancel |

Quiesce the System

You can quiesce a system by allowing existing users to stay logged on to their
applications, and prohibiting new users from logging on to their applications.

To quiesce the system, log on to the SAS Web Administration Console. Navigate to
Environment Management » System Maintenance. Click Quiesce System. When
you are finished with your maintenance operations, click Resume system to remove the
quiesced state and enable users to log on to their applications. The following display
shows the message that is displayed when a system is quiesced.
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Display 6.10 Message Displayed When System Is Quiesced

asadm | Preferences | Helpw

SAS Web Administration Console gsas

=4¥sas Web Administration Consals® )
El [IEnvironment Management % The system is in a quiesced state. User log in has been disabled.
@ System Maintenance
PSas Content Server §#  Restart system...
@ -(Dapplication Managament The Restart Wizard is not available while the system is is quiesced.

P Resume system...

The Resume system operation removes the gueisce state from the system and enables logon
capabilities.

Do not close your browser or otherwise end your session while the system is quiesced. If you do,
you will not be able to log on again, and you will need to restart the Java application server.

View Information about Web Applications

The SAS Web Administration Console provides read-only information about the SAS
Web applications that were installed and configured at your site. This feature is useful
for viewing application information from any machine without the need to have SAS
Management Console installed on the machine.

To display the applications, expand the Application Management node in the
navigation pane.

The tree view on the left side of the page displays a hierarchical list of configured
applications. The list varies depending on the software that has been installed.

When you click the name of an application, the right side of the page displays the
following types of information:

Application settings
displays settings that are currently configured for the application. For example,
SAS Information Delivery Portal settings include the locale that is in use, the
location where portlets are deployed, the e-mail host, and default settings for
various user preferences.

You cannot change any of the application settings here. To change settings, use

the Application Management » Configuration Manager plug-in in SAS
Management Console.

Directives
provides the internal direction to the application’s URL. This information is used
internally to route applications. You might use this information to troubleshoot
applications under the guidance of SAS Technical Support.
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About the DAVTree Utility

The DAVTree utility is a stand-alone Java application that provides a tree view of
WebDAV resources. The utility enables you to manipulate content by copying files to a
WebDAV repository or by creating text files such as forms and templates.

The utility presents information in a tree view. When you select a resource item in
the tree on the left side of the window, the WebDAV properties for the resource are
displayed on the right side.

Here is an example DAVTree interface:

i DAYTree (2.0.0)
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In the interface, you see only the content that you are authorized to see.
The following guidelines apply to the use of the DAVTree utility:

o If you have not yet installed the third maintenance release for SAS 9.2, then you
must manually configure the JAVA_ HOME system variable to point to Java 5.

o If you have installed the third maintenance release for SAS 9.2 or later, there is no
need to manually configure the JAVA_ HOME system variable to point to Java 5.

Start the Utility and Connect to a WebhDAV Location

To use this utility, follow these steps:

1 Run the following command on Windows:
SAS-configuration-directory\Levn\Web\Utilities\DAVTree.bat
On UNIX and z/OS:
SAS-configuration-directory\Levn\Web\Utilities\DAVTree.sh.
The DAVTree utility appears.

2 Select File » Open.
The DAV Location dialog box appears.

3 In the URL field, enter the URL for a WebDAV location. For example, enter the
following URL and substitute the server name and port number of your WebDAV
server (SAS Content Server):

http://server:port/SASContentServer/repository/default/
4 If the WebDAV server was set up with a proxy, enter the proxy host and port.
5 Click oK. You are prompted for credentials.

6 Enter your administrator credentials in the logon dialog box.
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You can later connect to a different WebDAV location by repeating steps 2—6 and
providing the URL for the new location.

Add Resources to WehDAV

You have the following options for adding resources to the WebDAV repository.

0 Copy files to DAVTree. You can copy both text files and binary files to the
repository.

To copy a file, click and drag the file from the file system to a folder in the
DAVTree interface.

This action can be performed on Windows systems and on UNIX systems that
provide a graphical interface.

0 Create a text file.
1 Position the cursor on the folder where you want to create the text file.
2 Select Edit » Add.

You are prompted to confirm the action, and then an Add dialog box appears.
Here is an example dialog box with data entered in the fields.

{+ Resource

iy File, bxk
" Collection

Contents of nmyFile.txt.
Mew properky

L ]

ik Cancel |

3 Select Resource.

4 In the field to the left of the Resource radio button, enter the name of the text
file. If a file already exists with the name that you provide, the file is
overwritten.

The example shows a file with the name myFile.txt.

5 In the field below the Resource radio button, enter the text that you want the
file to contain. Press ENTER to start a new line.

The example shows a file that contains the text string “Contents of
myFile.txt.”

6 If you want to define a custom WebDAV property, click New property. Two text
fields appear in the gray properties panel. In the left field, add the property
name. In the right field, enter the property value.

7 Click ok.
0 Create a folder.
1 Position the cursor on the folder where you want to create the new folder.
2 Select Edit » Add.
You are prompted to confirm the action, and then an Add dialog box appears.
3 Select collection.
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4 In the field to the left of the Collection radio button, enter the name that you
want to give the folder.

5 Click ok.

Note: 'To delete a resource, select the resource in the tree and then select Edit »
Delete. You are prompted to confirm the deletion. A

Edit a Text File in WebDAV

To edit a text file, follow these steps:

1 Right-click the text file and select Edit. The Edit File dialog box appears and
displays the contents of the file.

2 Make your changes to the text.
3 Click save.

Copy or Move a File in WebDAV

To move a file from one location to another in WebDAYV, in DAVTree click and drag
the file to the desired location.
To copy rather than move a file, press and hold the CTRL key while dragging.

Note: You must refresh the view in order to see the change. A

Advanced Features

The DAVTree utility can be used as a diagnostic tool. The utility provides features
such as locking files, versioning files, and modifying WebDAV properties.

CAUTION:
These are advanced WebDAV functions. These advanced WebDAV functions, which are
not covered in this documentation, should be performed only by someone who has
WebDAV expertise. A

Using the Package Cleanup Utility to Remove Packages

Overview of the Package Cleanup Utility

The Package Cleanup utility provides a simple, command-line interface for deleting
or listing packages that have been published in a publication channel or in a WebDAV
repository.

The SAS Publishing Framework supports channels that you define in the SAS
Metadata Repository. Once channels have been defined, users can publish packages to
the channels. For example, portal users can subscribe to available channels, view the
persisted packages, and publish content (files, links, stored processes, and information
maps).

Channels can be defined with archive or WebDAV persistent stores. When a package
is published to a channel that is defined with a persistent store, the package is first
persisted to that location and then it is published to all subscribers of that channel. All
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persisted packages have an expiration date. However, expired packages are not deleted
automatically; you must explicitly delete them. You can use the Package Cleanup
utility for this purpose.

Here is the path to the utility:

On Windows:
SAS-configuration-directory\Levn\Web\Utilities\PackageCleanup.bat

On UNIX and z/OS:
SAS-configuration-directory\LevnPackageCleanup. sh.

The Package Cleanup utility enables you to review basic information about a
persisted package and delete both the metadata and the actual package. Deletions are
based on the expiration date of the package. This utility supports the deletion of
packages from either type of persistent store (archive or WebDAV). The utility also
supports the deletion of packages that are not defined in any channel.

The Package Cleanup utility also supports a listing feature. The utility can be used to
display information about packages that are published in a particular channel, packages
that are not defined in any channel, and packages that exist on a WebDAV server.

Note: You must have the appropriate permissions on a channel in order to delete
packages from the channel. See the “Authorization Model” chapter in the SAS
Intelligence Platform: Security Administration Guide. A

Deleting Packages

Delete Packages

To delete packages, follow these steps:

1 Run the command and specify the deletion date. You can also provide one of the
following arguments:
0 a channel name in order to delete packages that are defined in a specific channel

0 a WebDAV URL in order to delete packages that are in the specified WebDAV
location

Note: If you do not provide the channel or WebDAV URL, then the utility deletes
only orphaned packages that are not defined for any channel or WebDAV URL. A

After you run the command, the utility displays a list of packages that match
your deletion criteria and prompts you to confirm deletion.

2 Respond to the prompt to confirm deletion of the packages or to exit without
deleting any packages.

Minimal Syntax for Deleting Packages
Here is the minimal syntax for deleting packages that are defined in a channel:

PackageCleanup
-d expiration-date
-ch channel-name
-metauser Metadata-Server-username
-metapass Metadata-Server-password
-domain authentication-domain
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The utility deletes all packages in the specified channel that expire before the date
and time specified.
Here is the minimal syntax for deleting packages that are not defined in a channel:

PackageCleanup
-d expiration-date
-metauser Metadata-Server-username
-metapass Metadata-Server-password
-domain authentication-domain

Here is the minimal syntax for deleting packages that are defined in a WebDAV
server:

PackageCleanup
-url WebDAV-URL
-username WebDAV-Server-username
-password WebDAV-Server-password
-d expiration-date
-metauser Metadata-Server-username
-metapass Metadata-Server-password
-domain authentication-domain

Delete Specific Packages

To delete a specific package, specify -package package-name (or -pkg
package-name) along with the date. The PACKAGE option enables you to specify the
name of the package to delete.

Change Prompt Behavior

When you run the utility command, the utility displays a list of packages that match
your deletion criteria and prompts you to confirm deletion of all the packages that are
listed.

You can override this default behavior in order to be prompted for each package
individually.

To override the default, specify -prompteach. You are then prompted to delete each
package that meets the deletion criteria. After each package is processed, the utility
displays a final list of all packages that were selected. You can then choose to delete all
of those packages or exit without deleting any packages.

You can also turn off prompting altogether by specifying -noprompt. When you run
the utility in batch mode, you must use the -noprompt option (unless shell
programming is provided to respond to the prompts). It is best to run with prompts
when you are learning how to use the application. With prompts, you can review proper
date formatting and correct package deletion candidates with the option to exit without
deleting any packages.

List Packages

To obtain a list of packages, run the command and specify the -1ist option. You can
also provide one of the following arguments:

0 a channel name in order to list packages that are defined in a specific channel

0 a WebDAV URL in order to list packages that are in the specified WebDAV location

Note: If you do not provide the channel or WebDAV URL, then the utility displays
only orphaned packages that are not defined for any channel or WebDAV URL. A
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The LIST option lists the following information for each package:
O package name

0 date and time that the package was created

O date and time that the package expires

Here is the minimal syntax for listing packages that are defined in a channel:

PackageCleanup
-list
-ch channel-name
-metauser Metadata-Server-username
-metapass Metadata-Server-password
-domain authentication-domain

Here is the minimal syntax for listing packages that are not defined in a channel:

PackageCleanup
-list
-metauser Metadata-Server-username
-metapass Metadata-Server-password
-domain authentication-domain

Here is the minimal syntax for listing packages that are defined in a WebDAV server:

PackageCleanup
-list
-url WebDAV-URL
-username WebDAV-Server-username
-password WebDAV-Server-password
-metauser Metadata-Server-username
-metapass Metadata-Server-password
-domain authentication-domain

Arguments
The utility supports the following arguments:

-channel | -ch channel-name
Specify the channel that contains the packages that you want to list or delete.

-deletionDate | -d "expiration-date"
Specify the expiration date and time for the packages to be deleted. You can also
use this argument when you list packages. The utility deletes or lists packages
that have an expiration date before the date and time that you specify. The date
and time should be enclosed in quotation marks. Format: “yyyy.MM.dd at hh:mm”

-list
The utility displays a list of packages (no deletion occurs).

-metauser Metadata-Server-username
Specify the user name to use when connecting to the SAS Metadata Server.

-metapass Metadata-Server-password
Specify the password to use when connecting to the SAS Metadata Server.

-domain authentication-domain
Specify the authentication domain for the SAS Metadata Server.

-package | -pkg package-name
Specify the name of a package to delete.
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-url WebDAV-URL
Specify the WebDAV URL to use to locate packages to delete.

-username WebDAV-username
Specify the user name to use to connect to a WebDAV server.

-password WebDAV-password
Specify the password to use to connect to a WebDAV server.

-logfile | -log file-name
Specify the name of a log file to create. If the log file already exists, then the log
lines are appended to the current file.

-noprompt
The utility does not prompt for confirmation of deletions.

-deletenodate
The utility lists or deletes packages that have no expiration date defined.

-prompteach
The utility prompts you to confirm each package individually for deletion.

-debug
The utility produces debugging information for all the SAS Foundation Services.

-help
The utility displays this help information. (You must also provide the -metauser,
-metapass, and -domain arguments in order to get the help information.)

Utility Logging and Debugging

By default, application activity is sent to the Java standard out console. If you want
to log to a file, use the LOGFILE option. For example, you might specify -logfile
c:\mylog.file. If the log file already exists, then the log lines are appended to the
current file.

Use the DEBUG option to enable debugging-level information. This option provides
debugging information for all of the Foundation Services as well as the utility. This
option should be used only when you experience problems with the utility and want to
determine the cause.

Examples

This example deletes all packages published to the Sales channel that have an
expiration date before October 7, 2009, at 12:59 p.m.

PackageCleanup -ch Sales -d "2009.10.07 at 12:59 PM" -metauser userX
-metapass passX -domain DefaultAuth

This example uses the PROMPTEACH option, which enables you to confirm deletion
of each package individually.

PackageCleanup -ch Sales -d "2009.10.07 at 12:59 PM" -metauser userX
-metapass passX -domain DefaultAuth -prompteach

This example deletes a specific package that is defined in the Sales channel. The PKG
option is specified to identify the exact package to delete. In this example, the package
is named s109513698.spk and has an expiration date of October 7, 2009, at 12:59 p.m.

PackageCleanup -ch Sales -d "2009.10.07 at 12:59 PM" -pkg s109513698.spk
-metauser userX -metapass passX -domain DefaultAuth
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This example deletes all packages that are not defined in any channel. Only
packages that are not defined in a channel and have an expiration date before October
7, 2009, at 10:00 a.m. are deleted.

PackageCleanup -d "2009.10.07 at 10:00 AM" -metauser userX -metapass passX
-domain DefaultAuth

This example deletes packages that have been published to a WebDAV server. The
utility connects to the server using the specified URL and deletes all packages
published to that location that have an expiration before October 7, 2009, at 05:00 a.m.

PackageCleanup -d "2009.10.07 at 05:00 AM" -url http://myhost.com/Sales/Packages
-username davUserX -password davPasswordX -metauser userX -metapass passX
-domain DefaultAuth

This example deletes a specific package from a WebDAV server. The PKG option is
used to provide the name of the package to delete. The utility connects to the server
using the specified URL and deletes the package named s3964865240.

PackageCleanup -d "2009.10.07 at 12:59 PM" -metauser userX -metapass passX
-domain DefaultAuth -url http://myhost.com/Sales/Packages -username
davUserX -password davPasswordX -pkg 53964865240

This example lists packages (does not delete) by using the LIST option. Note that the
-d argument is not required when listing packages. This example lists all packages that
are published in the Sales channel.

PackageCleanup -list -ch Sales -metauser userX -metapass passX
-domain DefaultAuth

This example uses the LIST option to list all packages with an expiration date before
October 7, 2009, at 12:00 p.m.

PackageCleanup -ch Sales -d "2009.10.07 at 12:00 PM" -metauser userX
-metapass passX -domain DefaultAuth -prompteach -list

Using JMX Tools to Manage SAS Resources

Abhout JMX and MBeans

SAS servers implement common administrative interfaces. These interfaces enable
you to perform basic administrative functions such as stopping, pausing, and resuming
servers. You can also use the interfaces to monitor the health of the servers via real-time
and historical metrics. Java Management Extensions (JMX) is a Java technology that
supplies tools for managing and monitoring applications, system objects, devices (such
as printers), and service-oriented networks. JMX managed beans, known as MBeans,
have been implemented to provide a standard way of managing SAS resources.

Accessing the SAS MBeans
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About Accessing the SAS MBeans

You can use any of the standard JMX monitoring tools to access the MBeans that
manage SAS resources. To use these tools, you must do the following:

1 Enable access to the MBeans from the Web application server. See “Configure the
Web Application Server to Enable JMX Client Access” on page 86.

2 Make sure that the appropriate authentication credentials are set. See “Set
Authentication Credentials for SAS MBean Access” on page 86.

To connect and access the SAS MBeans, follow the specific instructions for your JMX
tool. For information about using the JConsole tool, see “Manage SAS Resources Using
JConsole” on page 87.

Configure the Web Application Server to Enable JMX Client Access

You configure the Web application server to enable access to the MBeans by setting
specific Java system options.

Specify the following Java Virtual Machine (JVM) argument to access the MBeans
locally:

com.sun.management. jmxremote

Specify the following JVM argument to access the MBeans from a remote system.
Replace portNum with the port number to use for JMX RMI connections:

com.sun.management . jmxremote.port=portNum

Remote monitoring and management requires security to ensure that unauthorized
persons cannot control or monitor your application. It is recommended that you set the
following JVM arguments when MBeans are accessed remotely:

com.sun.management.jmxremote.authenticate=true | false
com.sun.management. jmxremote.ssl=true | false

For information about these arguments, see the Java documentation.

For more information about the recommended JVM arguments in the different
application server environments, see the SAS third-party Web site at http://
support.sas.com/resources/thirdpartysupport/v92.

Set Authentication Credentials for SAS MBean Access

The primary MBean for SAS resources is the ServerFactory MBean. This MBean is
initialized with credentials that are used to connect to the SAS Metadata Server. The
values of server.admin.userid and server.admin.password properties are used to
initialize the MBean. These properties must identify an unrestricted user so that the
SAS servers can be managed properly.

To verify that these property settings are properly defined, follow these steps:

1 In a SAS session, enter metabrowse in the command prompt and then press

ENTER. The Metadata Server Configuration dialog box appears.

2 Enter your server connection information as follows:

o Enter the fully qualified server name of the system on which the SAS Metadata
Server resides.

O The user name and password combination must be an unrestricted user to
access the required metadata.
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The Metadata Browser appears.
In SAS, select Tools » Options » Explorer.
Select the General tab and clear the Metadata Browse Mode check box.
Click oxk.

In the Metadata Browser tree view, navigate to Foundation »
SoftwareComponent » Foundation Services 9.2 » PropertySets »
Environment.Properties » SetProperties » server.admin.userid.
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In the right pane, right-click befaultvalue and select Modify. The Modify Value

dialog box appears and displays a user name.
Make sure that the user name that is displayed is an unrestricted user (for

example, sasadm@saspw). If not, enter a user name that is unrestricted and click

OK.

If you changed the user name in the previous step, then you must also change the

password. Follow these steps:

a In the tree view (under SetProperties), select server.admin.password.
b In the right pane, right-click befaultvValue and select Modify. The Modify

Value dialog box appears and displays the password in encoded format.
¢ Change the value and click Ok.

For security reasons, you should enter a password that you have encoded
using SAS. To obtain this encoded password, use PROC PWENCODE. For

more information, open SAS Help and Documentation from the Help menu in

SAS, and then search on PWENCODE.

10 Restart the SAS Remote Services and the Web application server.

Manage SAS Resources Using JConsole
JConsole is a JMX tool that is included with the standard Java Development Kit

(JDK). The information provided through JMX technology enables JConsole to provide
information about application performance and functions. You can use JConsole to
interact with the JMX MBeans that are available to manage SAS resources. The
console’s simple user interface displays all MBeans in a tree navigator on the left side
of the window. When you select a specific MBean, its attributes, operations,
notifications, and other information are displayed on the right side of the window.

To access information about SAS resources using JConsole, follow these steps:

1

2

Start JConsole by running the following command:
JDK-HOME\bin\jconsole

Connect to the MBean server as follows:
o If you are accessing the MBeans locally, the Local tab should display every

JVM that is running on the local system that was started with the same user

ID as JConsole. Select the appropriate JVM and click Connect.
o If you are accessing the MBeans remotely, follow these steps:

a Select the Remote tab.

b Enter the host on which the JVM is running, along with the port where the

RMI connector was registered.

¢ You might need to specify credentials if authentication to the MBean server is

required.
d Click Connect to connect to the MBean server.

3 Select the MBeans tab. This tab displays a tree view of all the registered MBeans.

4 Expand the com.sas.services domain to see all MBeans registered in this

domain.
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5 Select the ServerFactory MBean.

6 In the right pane, select the operations tab. You can now see the operations
(listing, stopping, pausing, and so on) so that you can list the defined SAS servers
and manage your running SAS servers. When you invoke one of the
manage-server operations, a new MBean is registered that is connected to the
specified, running SAS server. The newly registered MBean can then be used to
manage and monitor that particular SAS server.

Understanding How to Use the SAS MBeans

Abhout the SAS MBeans

There are three primary MBeans provided by the SAS Web Infrastructure Platform
for managing and monitoring SAS resources:

0 ServerFactory MBean
o Spawner MBean
0 Server MBean

The following sections describe these MBeans.

ServerFactory MBean

The ServerFactory MBean is the starting point for managing SAS servers. This
MBean is registered during deployment of the SAS Web Infrastructure Platform and is
named as follows:

com.sas.services:type=ServerFactory

During initialization, the ServerFactory MBean connects to the SAS Metadata
Server. This enables the MBean to list all SAS servers defined in the metadata. The
MBean can then be used to register additional MBeans that enable the running servers
to be managed and monitored directly. The ServerFactory MBean does not have any
attributes, but supports three operations:

listDefinedServers()
provides a list of SAS IOM servers that are defined in the Metadata Server.
Information that is returned for each defined server includes the server name,
host, port, and server type. To begin actively managing a server, specify the name
of the server on the manageServerByName operation.

manageServerByName(String ServerName, String Host)
registers a Server MBean that enables you to actively manage the specified IOM
server. The newly registered MBean connects to the running IOM server and can
then be used to manage and monitor that server. The host name can be left blank
if the IOM server is defined to run on only one host. If defined to run on multiple
hosts, the proper host name should be provided.

The manageServerByName() operation does not work on a server that is

spawned by the SAS Object Spawner.

manageServer(String Host, Integer Port, String Username, String Password)
registers a Server MBean that enables you to actively manage the specified IOM
server. The IOM server that is managed is identified by the host and port provided
on the manageServer operation. The newly registered MBean can be used to
manage and monitor that specific IOM server. This operation is useful when the
IOM server is not defined in the Metadata Server.
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Spawner MBean

The Spawner MBean is created whenever an IOM Spawner is identified in one of the
ServerFactory MBean’s manageServer operations. The name of the registered MBean
uses the form:

com.sas.services:type=Server, serverType=Spawner,name="Server Name", host=Host
Name ,port=Port

The Spawner MBean enables you to manage and monitor the running Object
Spawner. You can perform SAS Spawner operations such as stop, pause, and resume.
Here are some commonly used Spawner MBean attributes:

the number of times the counters have been reset
the amount of time the server has been idle

the number of currently connected clients

the server start time

the number of currently abandoned servers

the number of currently launched servers

the total number of servers that have been launched
the number of currently failed servers

the process identifier of the server process

the amount of time spent in server method calls

O 0O o oo0ooooood

the number of method calls that the server has processed

Server MBean

The Server MBean is created whenever a SAS server is identified in one of the
ServerFactory MBean’s manageServer operations or when a server is managed via the
Spawner MBean’s manageLaunchedServer(s) operation.

A server MBean can represent a SAS Workspace Server, a SAS Stored Process
Server, a SAS Table Server, a SAS Metadata Server, or a SAS OLAP Server. The name
of the registered SAS Server MBean uses one of these three forms:

com.sas.services:type=Server, serverType=Workspace, logicalServer=
"LogicalServerName", name="Server Name",
instanceid="Unique instance ID"

com.sas.services:type=Server, serverType=StoredProcess, logicalServer=
"LogicalServerName", name="Server Name",
instanceid="Unique instance ID"

com.sas.services:type=Server, serverType=Table, logicalServer=
"LogicalServerName", name="Server Name", host=Host Name,
port=Port Number

The Server MBean enables you to manage and monitor the running SAS server. You
can perform server operations such as stop, pause, and resume.
Here are some commonly used Server MBean attributes:

the number of times the counters have been reset
the amount of time the server has been idle

the number of currently connected clients

the server start time

the last time the counters were reset

O 0O oo o d

the execution state of the server
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the amount of time spent in server method calls

the number of method calls that the server has processed
the number of clients that the server has serviced

the process identifier of the server process

O 0o o o o

the identity under which the server process is executing
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Using the SAS Deployment Manager

The SAS Deployment Manager enables you to accomplish the following tasks:

0 Update passwords for the service accounts that were configured when you ran the

SAS Deployment Wizard. For information about how to update passwords by
using the SAS Deployment Manager, see the SAS Intelligence Platform: Security
Administration Guide.

o0 Rebuild Web applications. You can rebuild Web applications that have previously

been configured but whose configuration has changed. This option rebuilds the
Web application based on the current configuration. See “Rebuilding the SAS Web
Applications” on page 92.

0 Remove one or more components of a SAS Intelligence Platform configuration from

your environment. This option enables you to remove the configuration for an
application that you are no longer using or that you are moving to another
machine. You can then use the SAS Deployment Wizard to reinstall or reconfigure
the application. For details, see “Removing a SAS Configuration” in the SAS
Intelligence Platform: Installation and Configuration Guide.

Note the following about removing a configuration:
O Installed products are not removed.

o If you remove the configuration for the SAS Information Delivery Portal, do
not select the Remove all User Content option unless you have made a
backup copy of the content repository. If you choose this option, you must
re-create the content later from your backup. When you choose to remove
portal content, all pages, portlets, and other items created by the users are
removed.

o0 If you remove the configuration for the Web Infrastructure Platform, the
contents of the SAS Content Server repository (located in the
SAS-configuration-directory\Levn \AppData\SASContentServer\Repository
directory) are not deleted. If you do not need the contents of this directory,
you should manually delete the contents before rebuilding the Web
Infrastructure Platform with the SAS Deployment Manager.

Renew your software license for some SAS solutions that depend on a SAS middle
tier. For details, see “Renewing Your Software License for SAS Solutions” in the
SAS Intelligence Platform: Installation and Configuration Guide.

Change the host names (including the network domains to which they belong) of
server machines in your deployment. For details, see “Changing Host Names” in
the SAS Intelligence Platform: System Administration Guide.

Configure Updated SAS Products. For details, see “Configure Updated SAS
Products” in the SAS Intelligence Platform: Installation and Configuration Guide.

Access the SAS Deployment Manager by running the config.exe file in the
SAS-installation-directory\SASDeploymentManager\9.2 directory.

Rebuilding the SAS Web Applications
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When to Rebuild the SAS Web Applications

The Rebuild Web Applications feature of SAS Deployment Manager provides an
automated way to rebuild the Web applications that are deployed in your environment.
You should rebuild the Web applications in the following situations:

O

You might need to rebuild applications that you have reconfigured. For example, if
you change the HTTP time-out interval for an application, then you should rebuild
the application.

Note: This administration guide informs you when an application must be rebuilt
after reconfiguration. A

Rebuild an application after you change the application’s Java security
configuration.

If a custom theme is created for your organization, then rebuild the SAS Web
Application Themes.

If custom content is created, then add files to the WAR directory and rebuild the
application to which the custom content applies. For example, to create custom
forms for SAS Stored Process, you place the file for the EAR or the WAR in the
SAS-configuration-directory
\Lev1\Web\Common\SASServerl\SASStoredProcess9.2\
CustomContent\ears\sas.storedprocess\input directory. Then, use the SAS
Deployment Manager to rebuild the SAS Stored Process application.

If custom portal content, such as a custom portlet, is created for your organization,
rebuild the SAS Information Delivery Portal. For more information, see “Rebuild
One or More Web Applications” on page 93.

Rebuild SAS Help Viewer Metadata Configuration after your initial deployment if
you later install or upgrade a SAS Web application that uses SAS Help Viewer
Metadata Configuration. (SAS Help Viewer Metadata Configuration combines SAS
Help Viewer for the Web software with various Help content into its EAR file.)

The following Web applications use SAS Help Viewer Metadata Configuration:
SAS Information Delivery Portal Help

SAS Web Report Studio Help

SAS Web Report Viewer Help

SAS BI Dashboard Help

o SAS Comment Manager Help

O
O
O
O

After installing the second maintenance release for SAS 9.2 or later, you must use
the SAS Deployment Manager to rebuild the EAR files for all Web applications
that were updated at your site. Because the EAR files are rebuilt, you might lose
any customizations that you added to the EAR files after initial deployment. For
more information, see Maintenance Planning for SAS 9.2.

Rebuild One or More Weh Applications

In SAS 9.2, the Rebuild Web Applications option in the SAS Deployment
Manager enables you to rebuild a subset of the EAR files. In the second maintenance
release for SAS 9.2 and later, when you rebuild Web applications by using the SAS
Deployment Manager, the EAR files for the Web applications are automatically placed
in two directories:

O

SAS-configuration-directory\Levl\Web\Staging. The approximate size of the
collection of EAR files for EBI is 2 GB.
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o SAS-configuration-directory\Levl\Web\Staging\exploded. The approximate size
of the Exploded directory is 2 GB. The size of the Exploded directory is similar to
the size of the EAR files in the SAS-configuration-directory\Levl\Web\Staging
directory.

In the second maintenance release for SAS 9.2 and later, the exploded EAR files are
always recreated whenever you rebuild Web applications in the SAS Deployment
Manager. Previously, in SAS 9.2, this was not the case.

Note: If you are using the second maintenance release for SAS 9.2 or later, and you
want to save disk space, you can delete the unwanted directories below the
SAS-configuration-directory\Levl\Web\Staging\exploded directory. However, if you
are using WebLogic as your Web application server, do not delete the exploded copy of
the sas.wip.services9.2 EAR file. o

To rebuild one or more Web applications, follow these steps:
1 Verify the status of the Web application server.

o Shut down the JBoss application server. This is required because the SAS
Deployment Manager modifies the existing configuration for JBoss when it
rebuilds the Web applications.

0 The WebLogic Administration Server and Node Manager must be running
when you rebuild Web applications.

0 Shut down the WebSphere application server, but leave the dmgr and
nodeagent running.

2 Make sure that the SAS Metadata Server is running.

3 In Windows, access the SAS Deployment Manager by running the config.exe file
in the SAS-installation-directory\SASDeploymentManager\9.2 directory. In a
UNIX or z/OS environment, run the config.sh file.

4 Select the Rebuild Web Applications option and click Next.

5 In the next dialog box, specify the configuration directory and the level (for
example, Levl) in which you want to rebuild the applications.

6 In the next dialog box, enter the user ID and password for an unrestricted
administrative user (for example, sasadm@saspw).

7 In the next dialog box, select the check boxes for the applications that you want to
rebuild.

8 In the next dialog box, click Start to start the rebuild. The SAS Deployment
Manager builds the EAR files for the selected applications. For the names and
location of the EAR files, see “Names of the EAR Files” on page 95.

9 Deploy the EAR files to the Web application server. See “Redeploying the SAS Web
Applications” on page 95.

10 If you are rebuilding theme content, you might need to stop and restart the Web
application server as follows:

o If SAS Web Application Themes is deployed as an EAR in a Web application
server, then the first time a custom theme is deployed, the Web application
server must be stopped and restarted. Any subsequent modifications to the
custom theme do not require a restart of the Web application server unless
the theme descriptors have been changed.

o If SAS Web Application Themes is exploded and deployed in an HTTP server
(such as Apache HTTP Server), then the Web application server does not
need to be restarted based on any theme changes.

For all other Web applications, you do not need to stop and restart the Web
application server.
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Names of the EAR Files

When the Web applications are rebuilt, the SAS Deployment Manager places the
EAR files in the following directories: SAS-configuration-directory\Levl\Web\Staging
and SAS-configuration-directory\Levl\Web\Staging\exploded directory.

Depending on the software that you have installed, the following EAR files are
available:

Table 8.1 List of EAR Files

Application EAR File

SAS BI Dashboard sas.bidashboard4.3.ear
SAS BI Portlets! sas.biportlets4.3.ear
SAS Package Viewer (ships with SAS sas.packageviewer4.3.ear
Information Delivery Portal)

SAS Information Delivery Portal sas.portal4.3.ear

SAS Shared Services sas.shared9.2.ear

SAS Stored Process sas.storedprocess9.2.ear
SAS Web Application Themes sas.themes.ear

SAS Flex Application Themes sas.flexthemes.ear

SAS Help Viewer Metadata Configuration sas.webdocmd9.2.ear

SAS Web Report Studio sas.webreportstudio4.3.ear

SAS Web Infrastructure Platform Applications sas.wip.apps9.2.ear
SAS Content Server sas.wip.scs9.2.ear

SAS Web Infrastructure Platform Services sas.wip.services9.2.ear

1 Available in the October 2009 Release and later.

Redeploying the SAS Weh Applications

Redeploying EAR Files to a Single Server or Multiple Servers

When the SAS Deployment Manager rebuilds SAS Web applications, the generated
EAR files are placed in the SAS-configuration-directory\Lev1l\Web\Staging directory.
All EAR files are placed in a single directory even if your SAS 9.2 installation included
multiple servers (for example, SASServerl and SASServer2) that were configured with
different Web Applications.

If you have multiple managed servers that were installed and configured by the SAS
Deployment Wizard in your environment, make a note of the names of the servers and
the Web applications that reside on those servers. For example, if you have six
applications located on SASServerl and three Web applications located on SASServer 2,
make a list of the applications residing on each of these servers. Alternatively, you can
refer to your Instructions.html file, which specifies the following:
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O the list of SAS Web applications to be deployed

O the location of the applications

O the target server where each application should be deployed

When you manually redeploy the SAS Web applications, you can refer to your list or

the Instructions.html file, to ensure that you redeploy the EAR files to the correct
server.

JBoss

To redeploy a SAS Web application to JBoss, follow these steps:

1 Create a directory where you can store unused EAR files. Do not create this
directory below the deployment directory or below the
JBoss-installation-directory\server\SASServerl\deploy_sas. Instead, choose a
different location to store these unused EAR files.

2 Remove the unused application EAR files from the current deployment directory,
and place them in the directory that you created for unused EAR files. Typically,
the current deployment directory is
JBoss-installation-directory\server\SASServerl\deploy_sas.

3 If applicable, repeat the previous step for each JBoss server.

4 Copy all of the new EAR files from the
SAS-configuration-directory\Levl\Web\Staging directory to the
JBoss-installation-directory\server\SASServerl\deploy_sas directory. For a list
of EAR files, see “Names of the EAR Files” on page 95. If restrictive policies were
implemented at your site, you must deploy exploded EAR files instead of
unexploded EAR archives. The exploded EAR files reside in the exploded location
within the SAS-configuration-directory \Levl\Web\Staging\exploded directory.
For instructions about exploding EAR files, see “Working with Exploded EAR Files
in a Development Environment” on page 101. If you are using the second
maintenance release for SAS 9.2 or later, the process of rebuilding Web
applications in the SAS Deployment Manager automatically results in exploding of
the EAR files.

5 Repeat Step 4 for any additional JBoss application servers (for example,
SASServer2) that have SAS applications deployed.

6 If necessary, restart JBoss. If the JBoss server has been configured for hot
deployment, then you do not need to restart JBoss. Step 1 undeploys the
application and step 2 redeploys it. However, if hot deployment is not enabled,
then you must restart JBoss.

For complete deployment instructions, see the JBoss documentation at http://
www.jboss.org/docs.

WebLogic

There are a number of ways to redeploy applications in WebLogic. To redeploy SAS
applications to WebLogic by using the WebLogic Administration Console, follow these

steps:
1 Stop and delete all SAS applications. See “Stop and Delete All SAS Applications”
on page 97.
2 Shut down the SAS managed servers. See “Shut Down the Managed Servers” on
page 97.

3 Reinstall the SAS applications. See “Reinstall the SAS Applications” on page 97.
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Restart the managed servers. See “Restart the Managed Servers” on page 98.
Start the SAS applications. See “Start the SAS Applications” on page 98.

For complete deployment instructions about WebLogic, see the WebLogic
documentation at http://www.oracle.com/technology/documentation/
index.html.

Stop and Delete All SAS Applications
To stop and delete all SAS applications, follow these steps:

1

In the WebLogic Administration Console, select Deployments in the Domain
Structure panel.

In the Deployments panel, select all applications by selecting the check box next
to Name.

On the menu for Stop, select Force Stop Now.
In the summary of Deployments tab, select Yes.

5 Wait until all applications display in Prepared state. Refresh the view as needed

8
9

until all applications reach the Prepared state.

When the managed servers are running, delete all applications by selecting Lock
and Edit in the Change Center panel.

In the Deployments panel, select all applications by selecting the check box next
to Name.

Click pelete.
In the Delete Application Assistant panel, select Yes.

10 When the message “Selected deployments were deleted,” is displayed, select

Activate Changes in the Delete Application Assistant panel.

Shut Down the Managed Servers

It is recommended that you shut down the SAS Managed Servers while the WebLogic
Admin Server is running.

To shut down the SAS managed servers while the WebLogic Admin Server running
(recommended), follow these steps:

1

In the Domain Structure panel within the WebLogic Administration Console,
select Environment » Servers in the Domain Structure.

Leave the Admin server running; do not stop it. Then, for each SAS server,
complete the following steps:

In the Summary of Servers table, select the server (for example, SASServerl).
Select the Control tab.

From the menu for Shutdown, select Force Shutdown Now.

Click Yes to the prompt Forcibly Shutdown Servers.

Verify that the server has been shut down.

-2 — S T — o -]

Reinstall the SAS Applications

With the exception of the sas.wip.services9.2 EAR file, all EAR files should be
deployed from the SAS-configuration-directory\Lev1\Web\Staging directory. The
sas.wip.services9.2 EAR file should be deployed from the
SAS-configuration-directory\Levl\Web\Staging\exploded directory.

To redeploy EAR files and install SAS applications, follow these steps:

1

Locate the Instructions.html file in the
SAS-configuration-directory\Levl\Documents directory, and make a note of the

97
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list of SAS applications and their associated servers. This information is available
in the Web Application Server section. You need this information when you
redeploy and install the EAR files.

2 In the WebLogic Administration Console, within the Domain Structure panel,
select Deployments.

3 Click Lock and Edit in the Change Center panel.
4 In the Summary of Deployments panel, click Install.

5 In the Install Application Assistant panel, browse and navigate to the
SAS-configuration-directory\Levl\Web\Staging directory.

6 In the Install Application Assistant panel, under Locate deployment to
install and prepare for deployment, select an EAR file and click Next.

7 In the options available for Choose targeting style, retain the default (Install this
deployment as an application), and click Next.

8 See the Instructions.html file to identify the server associated with the EAR
file that you are deploying. Typically, for most SAS applications, the target server
is SASServerl.

9 In the Install Application Assistant panel, under Select deployment
targets, select the target server and click Next. Typically, SAS applications are
deployed to SASServerl.

10 Under Optional Settings, General, enter a name for the EAR file or the
directory for this deployment.

11 If the Admin server and the managed server are on the same machine, under
Source accessibility, select I will make the deployment accessible
from the following location and click Next. Note that this is not a staged
mode.

12 Under Review your choices and click Finish, select No, I will review
the configuration later, and click Finish.

13 In the change Center panel, select Activate Changes. The application should
display in a New state.

14 Repeat these steps to redeploy the other EAR files and install the SAS applications.

Restart the Managed Servers

To restart the managed servers in WebLogic, follow these steps:

1 In the Domain Structure panel within the WebLogic Administration Console,
select Environment » Servers.

In the change Center panel, select Activate Changes.
On the Settings page, select the Control tab.

& N

In the Servers table under Summary of Servers, click on the server name (for
example, SASServerl).

In the Server Status table, click Start.
In the server Life Cycle Assistant panel, click Yes.
In the Server Status table, verify that the task has been completed.

0 N o o

If applicable, repeat these steps for other managed servers.

Start the SAS Applications

To start the SAS applications in WebLogic, follow these steps:

1 In the Domain Structure panel within the WebLogic Administration Console,
select Deployments. All SAS applications should display in a Prepared state.
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2 In the peployments panel, select the check box next to Name. All applications are
selected.

3 From the start menu, select Servicing All Requests.

4 In the sAS Application Assistant, select Yes.

Redeploy a SAS Web Application to WehSphere

There are two ways to redeploy a SAS Web application to WebSphere. In the first
method, you can update an installed application and select Replace the entire
application. With this method, you can maintain all of the application settings, such
as the class loader policy and mode for the EAR and WAR modules. In the second
method, you undeploy and redeploy each application individually until all of the rebuilt
applications have been redeployed.

Although you can redeploy the EAR files in any order of your choice, it is highly
recommended that you follow the sequence of EAR files specified for WebSphere. See
“Deploying EAR Files in the Correct Order” on page 18.

To redeploy a SAS Web application to WebSphere by undeploying and redeploying
each application individually, follow these steps:

1 Uninstall and then reinstall the application. For instructions, see the WebSphere
documentation.

2 In the WebSphere administrative console, select Applications » Application
Types » WebSphere enterprise applications. Then select the SAS Web
application that you are redeploying.

3 Click class loading and update detection.

4 For the class loader order, select the Classes loaded with local class
loader first (parent last) radio button.

5 Leave the WAR class loader policy set to Class loader for each WAR file
in application.

6 Click oK.
7 Click Manage Modules.

8 For each module (WAR file) listed under Manage Modules, click the WAR file link.
Then select classes loaded with local class loader first from the Class
loader order list box.

9 After you have performed the previous step for each WAR file, click OK.
10 Select startup behavior and specify a value for Startup order.
11 Save your changes.

12 Perform a full resynchronization of the dmgr and nodeagent WebSphere servers.
This action ensures the WAS Master Repository and Node Repository are updated
and synchronized. Follow these steps:

a In the WebSphere administrative console, select Administration » Nodes.
b Select the check box for the application server node.
¢ Click Full Resynchronize.

When you have completed these instructions, you can restart the application. (For
the proper start-up order of the SAS Web applications, see “Deploying EAR Files in the
Correct Order” on page 18.)

For complete deployment instructions, see the WebSphere documentation at http://
www.ibm.com/support/documentation/us/en.
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Reconfiguring the Web Application Server

Reconfigure your Web application server when any of the following conditions apply:
O A new SAS Web Application is added to your deployment.

o A Web application is unconfigured and reconfigured.

0 A software bundle is added to an existing configuration.

It is important to reconfigure your Web application server in the same manner that it
was configured initially. If you manually configured the Web application server when
you deployed SAS 9.2, then configure it again manually. If the SAS Deployment Wizard
automatically configured your Web application server, then choose the automatic
configuration option.

If the environment was first configured with the option Web Application Server:
Multiple Managed Servers in the SAS Deployment Wizard, then reconfigure the Web
application server by using the Custom path in the SAS Deployment Wizard and
selecting Web Application Server: Multiple Managed Servers. Reconfiguring a
Web application server can cause the loss of some customizations, and they need to be
reapplied.

For more information, see “Managing Your SAS Deployment” in the SAS Intelligence
Platform: Installation and Configuration Guide.

Deploying SAS OnlineDoc Manually for the Web

Manually Deploy SAS OnlineDoc for the Web

Your installation might include SAS OnlineDoc for the Web, which is an online
library of reference documentation for the SAS System. You must manually deploy SAS
OnlineDoc for the Web in your Web application server. Manual deployment is required
even if you selected the automatic deployment option in SAS Deployment Wizard.

When you installed SAS OnlineDoc for the Web using the SAS Deployment Wizard,
you encountered a dialog box that asked whether to create the application’s Enterprise
Archive (EAR) file. The EAR file that is created is located here:

SAS-installation-
directory\Documentation\9.2\onlinedocweb\sas.onlinedocweb9.2.ear

To manually deploy SAS OnlineDoc for the Web, follow these steps:

1 Make sure that you have configured your Web application server as follows:

o If you performed a planned installation and chose automatic configuration of
the Web application server, then the application server is already configured.

o If you performed a planned installation and chose manual configuration of the
Web application server, then follow the instructions in your
Instructions.html file (located in the SAS configuration directory).

o If you performed a nonplanned installation, then see the instructions for your

Web application server on the SAS third-party Web site at http://
support.sas.com/resources/thirdpartysupport/v92.

2 Deploy the sas.onlinedocweb9.2.ear file to your Web application server. For
deployment instructions, see the documentation that is provided for your Web
application server.
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Note: If you are deploying to WebSphere, then see “Change the WebSphere Class
Loader Settings” on page 101. A

If you later need to remove SAS OnlineDoc for the Web, undeploy the application
from your Web application server like you would any application. Then, uninstall the
application (for example, by using the Add or Remove utility on Windows systems).

Change the WehSphere Class Loader Settings

If you are deploying to WebSphere, then you need to change the class loader settings.
After you have added the SAS OnlineDoc for the Web application to WebSphere, follow
these steps:

1 In the WebSphere administrative console, select Applications » Application
Types » WebSphere enterprise applications. Then select SAS Online Doc for
the Web.

2 Click class loading and update detection.

3 For the class loader order, select the Classes loaded with local class
loader first (parent last) radio button.

4 Leave the WAR class loader policy set to Class loader for each WAR file
in application.

5 Click oK.
6 Click Manage Modules.

7 For the sas.onlinedocweb.war WAR file, click the WAR file link. Then, select
Classes loaded with local class loader first from the Class loader
order list box.

8 Click startup behavior, and specify a value for Startup order.
9 After you have performed the previous step for each WAR file, click OK.
10 Save your changes.

11 Perform a full resynchronization of the dmgr and nodeagent WebSphere servers.
This action ensures the WAS Master Repository and Node Repository are updated
and synchronized. Follow these steps:

a In the WebSphere administrative console, select Administration » Nodes.
b Select the check box for the application server node.
¢ Click Full Resynchronize.

Access SAS OnlineDoc for the Weh

After you deploy SAS OnlineDoc for the Web, users can access the application by
pointing their browser to the following URL:

http://server:port/SASOnlineDoc/oldoc/ui/
contents?selectedProduct=ONLINEDOCWEB&macroVersion=9.2&selectedTopic=
doccommon.hlp/onlinedoc_main.htm

In the URL, substitute the server name and port number of your Web application
server.

Working with Exploded EAR Files in a Development Environment
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In the second maintenance release for SAS 9.2 and later, the Rebuild Web
Applications option in the SAS Deployment Manager automatically explodes all EAR
files and places them in the SAS-configuration-directory\Lev1l\Web\Staging\exploded
directory. See “When to Rebuild the SAS Web Applications” on page 93. In most cases,
it is the EAR file itself that is deployed to the Web application server. The exploded
copies are typically provided for your convenience.

It can be useful to work with exploded EAR files when you want to debug or develop
new JavaServer Pages (JSP) in a Web application. If you have deleted the exploded
copy, or need to explode an EAR file manually, you can extract the contents for the EAR
file into a directory. Second, recursively extract the contents of each WAR file found in
the EAR file. Each WAR file needs to be exploded into the same parent directory where
it resides.

There are multiple ways to explode EAR files into their constituent parts. EAR files
can be exploded manually using command line tools or by using a script. The following
task outlines the general steps involved in exploding EAR files.

1 Change the working directory to the location where the EAR file resides.

2 Create a subdirectory called exploded.

3 Change the working directory to the new subdirectory exploded.

4 Create a subdirectory that matches the name of the EAR file. For example:
filename . ear.

Change the working directory to the filename.ear subdirectory.

o o

Use the jar command to explode the EAR file located in the working directory
that is two levels above the current directory.

7 Create a subdirectory called temp dir.

8 For each WAR file that is extracted into the filename.ear subdirectory, complete
the following steps:

a Move the WAR file to the temp_dir subdirectory.

b Create a subdirectory in the filename.ear directory, and make sure that the
name of the subdirectory matches the name of the WAR file (for example,
filename .war).

¢ Change the working directory to the filename .war directory.

d Use the jar command to explode the WAR file from the temp dir directory.

e Change the working directory to the filename .war directory.

f Repeat these steps until you have completed extracting all WAR files.

The following example shows how to explode EAR files manually in a UNIX and z/OS
environment by using pseudocode that you replace with the applicable syntax:

cd [location of ear]

mkdir exploded

cd exploded

mkdir [earname]

cd [earname]

jar -xvf ../../[earname]

mkdir temp dir

for each [warname]=*.war file
move [warname] temp dir
mkdir [warname]
cd [warname]
jar -xvf ../temp dir/[warname]
cd ..

done

delete temp dir
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cd ../..

Deployment of modified EAR files from an exploded directory varies with the Web
application server as follows:

JBoss
JBoss has direct support for deployment of exploded EAR files. To deploy an
exploded EAR file, move the exploded directory to the deployment directory
(deploy_sas under the JBoss server). Because the exploded directory must be
named the same as the original EAR file, the original EAR file must be removed
from the deployment directory.

WebLogic
WebLogic has direct support for deployment of exploded EAR files. To deploy an
exploded EAR file using the administrative console, select the full path to the
exploded EAR.

WebSphere
WebSphere explodes deployed EAR files on its own. Deployed files must be either
EAR files or WAR files.

Starting with version 6.1, WebSphere has the ability to update an existing
deployed application with individual files or modules. By selecting the full path to
the JSP or WAR directory, individual components of a modified, exploded EAR file
can be used in a deployed application. You can use the administrative console to
update a deployed application.

When you are ready to deploy your changes, use the SAS Deployment Manager to
rebuild the EAR file. See “Rebuilding the SAS Web Applications” on page 92.

Administering Logging for SAS Web Applications

Administering Logging Service Settings for Weh Applications

Logging for SAS Webh Applications

The SAS 9.2 Intelligence Platform uses a standard logging facility to perform logging
for SAS servers. In SAS Management Console, the Logging Service Configuration
dialog box enables you to accomplish several tasks for SAS Web applications:

o0 Edit existing output types or create a new output type.
Save an output type with a new name.

Modify the layout pattern for the log message.

Specify log event output to Console, File, Socket, or ARM.
Define new outputs.

O 0o o o o

Track user logons. You can monitor usage patterns by logging activity for SAS Web
application logons.

o Change the logging levels.

For an overview and guidelines about logging, see “Administering Logging for SAS
Servers” in the SAS Intelligence Platform: System Administration Guide.
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The logging configuration for each application is controlled independently. For
example, you can choose an application, such as SAS Web Report Studio or SAS
Information Delivery Portal, and view or set logging levels for the application.

To see the logging configuration for a SAS application, follow these steps:

1 Log on to SAS Management Console.

2 On the Plug-ins tab, navigate to Environment Management » Foundation
Services Manager » <Application> » Core » Logging Service.

3 Right-click Logging Service and select Properties. The Logging Service
Properties dialog box appears.

4 Select the service Configuration tab and then click Configuration. The
Logging Service Configuration dialog box appears for the application.

The following display shows an example Logging Service Configuration dialog box.

Display 8.1 Example Logging Service Configuration Dialog Box
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For information about how to modify and customize the logging, see “Modifying
Service Configurations” in the SAS Foundation Services: Administrator’s Guide.

By default, the Logging Service Configuration dialog box in SAS Management
Console contains two output types:

o SAS_LS_CONSOLE
o SAS_LS_FILE

One is a console output and the other is a file output.

Message logging is accomplished with a logging context. A logging context is usually
the fully qualified class name of the class where the logging message originated. In the
SAS Management Console, logging contexts are created or edited in the Logging Service
Context window (accessed through the Logging Service Configuration dialog box).

The following logging contexts are common to all SAS applications:

O com.sas

O com.sas.services

O com.sas.services.deployment
O com.sas.services.discovery

O com.sas.services.util

The five logging contexts are five packages that represent different locations in SAS
software. These logging contexts should not be edited, but you can remove them or add
additional logging contexts.

For detailed information about the logging facility, see SAS Logging: Configuration
and Programming Reference.

Change the Location of the Log Files

By default, log files are stored in the SAS-configuration-directory\Lev\Web\Logs
directory. Typically, you change the directory path for the location of the log files, if you
have a clustered environment.

To modify the location of a log file, follow these steps:

1 Log on to SAS Management Console.

2 On the Plug-ins tab, navigate to Environment Management » Foundation
Services Manager » <Application> » Core » Logging Service.

3 Right-click Logging Service and select Properties. The Logging Service
Properties dialog box appears.

4 Select the service Configuration tab and then click Configuration. The
Logging Service Configuration dialog box appears for the application.

Change the Logging Levels

In the SAS Management Console, the Logging Service Configuration window enables
you to configure the settings for logging. The log has five levels of detail: DEBUG,
INFO, WARN, ERROR, and FATAL. Enabling a level also enables the less detailed
levels above the selected level. By default, the level is set to WARN, which means that
only WARN, ERROR, and FATAL messages are recorded. In large-scale deployments,
the size of the log file can grow rapidly when INFO messages are enabled. However, you
might want to enable the INFO messages during the development and testing phases.

CAUTION:
Excessive logging can degrade performance. Therefore, you should not use the DEBUG
logging level unless you are directed to do so by SAS Technical Support. »
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If you need to debug a problem, it is recommended that you dynamically change the
log output temporarily.

For an explanation of all warnings, see “Administering Logging for SAS Servers” in
the SAS Intelligence Platform: System Administration Guide.

To change the types of messages that are stored in the log, choose the priority level
for the appropriate logging context in the Logging Context dialog box. Here is a brief
description of each type of logging:

DEBUG displays the informational events that are most useful for debugging
an application.

INFO displays informational messages that highlight the progress of the
application.

WARN displays potentially harmful situations.

ERROR displays error events that might allow the application to continue to
run.

FATAL displays very severe error events that might cause the application to

end abnormally.

To enable a different level of log messages for an application, follow these steps:
1 Log on to SAS Management Console.

2 On the Plug-ins tab, navigate to Environment Management » Foundation
Services Manager » <Application> » Core » Logging Service.

3 Right-click Logging Service and select Properties. The Logging Service
Properties dialog box appears.

4 Select the service Configuration tab and then click Configuration. The
Logging Service Configuration dialog box appears for the application.

5 On the contexts tab, select a context and click Edit. The Edit Logging Service
Context dialog box appears.

6 Select the desired level of warning from the Priority drop-down list box.
7 Click oK to exit from each window.
8 To enforce the changes that you have made, restart the SAS Web application.

Understanding How the Web Applications Provide a Logging Context

The SAS Web Infrastructure Platform has implemented a framework for providing
separate logging contexts for the individual SAS Web applications. It is useful to
understand how SAS implements individual logging contexts in case you need to modify
any of the related configuration files. In addition, you might want to create a logging
context for Web applications that are developed at your site.

The SAS Web applications implement this capability as follows:

O The web.xml file for the Web application contains the following tag element:<listener>
<listener-class>com.sas.svcs.logging.LoggingContextListener
</listener-class>
</listener>

The listener element must directly follow the filter and filter-mapping elements
and directly precede the servlet element. This listener is added as the first listener
within the <web-app> element if there are multiple listeners.

The web.xml file also contains this tag:
<context-param>
<param-name>log4j-config-name-prefix</param-name>
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<param-value>YourWebAppName</param-value>
</context-param>

In the tag, YourWebAppName should be a name that contain no spaces or special
characters (for example, SASWebReportStudio ). This name is prepended to
-log4j.xml to form the filename of the application-specific log4j configuration file.

0 Web application servers have a property defined on their command line
(com.sas.log.config.url) that points to the directory where the log4j config files are
located. The framework within the SAS Web Infrastructure Platform uses this
property to locate a particular Web applications’s log4j configuration. The
framework then loads the configuration into a private logging context for the Web
application. Any loggers that the Web application obtains from a locally deployed
Logging Service also shares this same private logging context. Check your Web
application server start-up script or configuration file to determine the appropriate
directory location.

Here is an example directory for a default deployment:

SAS-configuration-directory\Levn\Web\Common\LogConfig

The name of the log4j file has this form:

YourWebAppName-log4j.xml

where YourWebAppName is the string that was provided in the
<context-param> element of the web.xml file.
O A copy of the sas.sves.commons. jar, which contains the
com.sas.sves.logging. LoggingContextListener class, must be in the Web
application’s CLASSPATH. This is accomplished by placing the JAR file within the
WEB_INF/lib directory for the Web application.

Configuring Auditing for SAS Web Applications

Overview of Auditing

SAS Web applications and other SAS middle-tier services provide auditing features.
Depending on the application and its configuration, these auditing features can record
all actions performed both by the direct users of the system and by the system itself.
Some applications might provide a more complete audit, detailing not only the actions
that are performed but also the states of the objects that are affected by those actions.

There are two primary ways in which auditing occurs:

0 basic auditing with records that are logged to a file
O more detailed auditing with records that are written to a relational database

All SAS environments can be configured to use the basic auditing via logging that is
available through services in the SAS Web Infrastructure Platform. Alternatively, those
SAS environments that include SAS Shared Services are configured by default to use
the detailed auditing via a relational database.

Configure the Audit Log File

The services in the SAS Web Infrastructure Platform provide default auditing using
Apache log4j standards. The context com.sas.sves.audit can be configured to use valid
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appenders. The context can also apply standard logging configuration rules that are
defined for the SAS Web Infrastructure Platform Services application
(sas.wip.services9.2.ear/sas.wip.services.war).

You can change the logging configuration for the SASWIPServices9.2 Local Services
definition in the Foundation Services Manager plug-in in SAS Management Console.
For more information about setting up logging contexts for Web applications, see
“Administering Logging for SAS Web Applications” on page 103.

To set up the auditing context, follow these steps:

1 Log on to SAS Management Console.

2 On the Plug-ins tab, navigate to Environment Management » Foundation
Services Manager » SASWIPServices9.2 Local Services » Core » Logging
Service.

3 Right-click Logging Service and select Properties. The Logging Service
Properties dialog box appears.

4 Select the service Configuration tab and then click Configuration. The
Logging Service Configuration dialog box appears for the application.

5 On the contexts tab, click New and specify a logging context with the name
com.sas.svcs.audit.

6 From the Priority list box, specify the logging level that you want. The log4;j
auditing occurs at the INFO level. Therefore, you must specify either INFO or
DEBUG in order to get audit messages.

7 Specify the outputs that you want for the audit messages by moving one or more
outputs from the Available list box to the Selected list box.

Note: You can create a new output by selecting the outputs tab in the Logging
Service Configuration dialog box and clicking New. Then enter the information for
the new output. Help is available from the dialog box. A

8 Click ok to exit from each window.

9 To enforce the changes that you have made, restart the SAS Web Infrastructure
Platform Services application.

Auditing That Uses Relational Tables

SAS environments that include SAS Shared Services provide more sophisticated
audit retrieval and reporting capabilities, particularly for those applications with more
regulatory or compliance requirements. In the relational database configuration, audit
records are stored in a database named SharedServices. The records are written in
three relational tables: SharedServices.SAS_AUDIT,

SharedServices. ACTION_EXECUTOR, and SharedServices.SAS_AUDIT_ENTRY.

Enable Auditing for User Authentication Actions

The core auditing features in the middle tier can be configured to record information
about successful user logon actions, failed logon attempts such as those attributed to
incorrect credentials, and user logoff actions. By default, auditing of user
authentication and session termination is disabled in a standard configuration.

To enable auditing of user authentication, follow these steps:

1 Open the following file in a text editor:
SAS-installation-

directory\SASWebInfrastructurePlatform\9.2\Static\wars\
sas.wip.services\WEB-INF\spring-config\aop-config.xml
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2 Remove the comments from the following lines:<!---
<bean class="com.sas.svcs.authentication.impl.aop.FailedLogonAuditAdvice’ >
<property name="auditRecorder" ref="auditRecorder" />
</bean>
<bean class="com.sas.svcs.authentication.impl.aop.SuccessfullLogoffAuditAdvice">
<property name="auditRecorder" ref="auditRecorder" />
</bean>
<bean class="com.sas.svcs.authentication.impl.aop.SuccessfullLogonAuditAdvice">
<property name="auditRecorder" ref="auditRecorder" />
</bean>
_——

3 Save your changes and rebuild the EAR file for SAS Web Infrastructure Platform
Services (sas.wip.services9.2.ear). See “Rebuilding the SAS Web
Applications” on page 92.

Note: Subsequent upgrade activities can overwrite this file. For example, if you
later install a maintenance release that includes aop-config.zxml, then you must
repeat this procedure. A

Configuring a Custom Logoff Message for Web Application Users

You can configure a customized message that displays when users of SAS Web
applications log off.

Edit, customize, and save the logoff_ custom.jsp file located in the c:\Program
Files\SAS\SASWebInfrastructurePlatform\9.2\Static\wars\sas.vcs.logon
directory. On UNIX, the logoff custom.jsp file is located in the sAs_HOME/
SASWebInfrastructurePlatform/9.2/Static/wars/sas.svcs.logon directory. This
file is included as part of an HTML page. Therefore, it should contain valid HTML code.

To enable the display of a custom message when users of a SAS Web application log
off from their application, follow these steps:

1 Log on to SAS Management Console.

2 On the Plug-ins tab, select Application Management » Configuration Manager
» SAS Application Infrastructure, and right-click on Properties.

In the SAS Application Infrastructure dialog box, select the settings tab.
On the settings tab, select Policies in the left pane.

In the Display custom logoff message field, select Yes and click OK.
Exit from SAS Management Console.

Use the SAS Deployment Manager to rebuild the SAS Web applications for the
SAS Web Infrastructure Platform. For instructions, see “When to Rebuild the SAS
Web Applications” on page 93.

8 Redeploy the EAR files that were rebuilt in the SAS Deployment Manager. The
sas.wip.apps9.2 EAR file must be redeployed. In addition, it is recommended
that you redeploy sas.wip.services9.2, sas.wip.scs9.2.ear, and
sas.storedprocess9.2.ear files. For instructions, see “Redeploying EAR Files
to a Single Server or Multiple Servers” on page 95.

~N oo g A W

9 Verify that the custom logoff message is displayed when you log on and log off
from the Web application.
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Configuring the HTTP Session Time-out Interval

A session time-out interval logs off users’ inactive sessions after a specific period of
time that is defined in the Web application server configuration. The default value for a
session time-out interval is 30 minutes.

You can customize the session time-out interval for your environment by modifying
one or more of the web.xml files, and specifying a different time-out interval. For more
information, see “Modifying a Session Time-out Interval” on page 110.

Modifying a Session Time-out Interval

You can specify a session time-out interval for inactive user sessions with Web
applications. To specify a custom session time-out interval, you should manually modify
the time-out interval in the appropriate web.xml files. If an application has multiple
web. *xml*files, then you should modify all the files that are listed.

To specify a session time-out interval, follow these steps:

1 Modify the following code in the appropriate files:<session-config>
<session-timeout>time-out-interval</session-timeout>
</session-config>

Replace time-out-interval with the time-out interval in minutes. As a
recommendation, the number should be no smaller than 5.
When you are finished, save and close the file.

2 Use the SAS Deployment Manager to rebuild the EAR files that contain the SAS
Web applications.

If the Web application server is running, stop it.

4 Redeploy the Web applications whose files you modified. See “Redeploying the SAS
Web Applications” on page 95.

5 Restart the Web application server.

The following table lists the file or files that should be modified to specify a different
time-out interval for each Web application.

Table 8.2 Web Application Files to Modify for the Time-out Interval

Web Application Files to Modify Location
SAS Information Delivery web.xml.orig SAS-installation-directory
Portal

\SASInformationDeliveryPortal\
4.3\Configurable\wars\sas.portal\
WEB-INF

SAS Package Viewer (ships web.xml.orig SAS-installation-directory

with SAS Information
Delivery Portal)

\SASInformationDeliveryPortal\
4.3\Configurable\wars\
sas.packageviewer \WEB-INF

SAS Web Report Studio web.jboss.xml.orig SAS-installation-directory
web.weblogic.xml.orig \SASWebReportStudio\4.3\
web.websphere.xml.orig Configurables\wars\

sas.webreportstudio\WEB-INF
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Web Application

Files to Modify

Location

SAS BI Portlets (Available
in the October 2009
Release and later)

JSR 168 for SAS BI
Portlets (Available in the
October 2009 Release and
later)

SAS Help Viewer Metadata
Configuration

SAS BI Dashboard 4.3
(Beginning with the
November 2010 Release)

Event generation
framework in SAS BI
Dashboard 4.3 (Beginning
with the November 2010
Release)

web.xml-idp.orig

web.xml-
thirdparty.orig

web.xml.orig

web.xml.orig

web.xml.orig

web.xml.orig

SAS-installation-directory
SASBIPortlets\4.3\Configurable

\wars\sas.biportlets\WEB-INF

SAS-installation-directory
SASBIPortlets\4.3\Configurable
\wars\sas.jsrl68remoteportlet \WEB-
INF

SAS-installation-directory
\Documentation\9.2\Static\wars\
sas.webdoc\WEB-INF
SAS-installation-directory
\SASBIDashboard\4.3\Configurables
\wars\sas.\WEB-INF
SAS-installation-directory
\SASBIDashboard\4.3\Configurables

\wars\sas.bidashboard\WEB-INF

The following table lists the file or files that should be modified to specify a different
time-out interval for SAS shared applications or SAS Web Infrastructure Platform files.

Tahle 8.3 SAS Shared Application and Web Infrastructure Platform Files to Modify

for the Time-out Interval

SAS Shared
Applications and Web
Infrastructure Platform
Files

Files to Modify

Location

SAS Shared Applications

SAS Shared Services

SAS Shared Portlets

web.xml.orig

web.xml.orig

web.xml.orig

SAS-installation-directory
\SASSharedServices\9.2\
Configurable\wars\sas.shared.apps\
WEB-INF
SAS-installation-directory
\SASSharedServices\9.2\
Configurable\wars
\sas.shared.services\
SAS-installation-directory
\SASSharedServices\9.2\
Configurable\wars

\sas.svcs.portlets\WEB-INF
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SAS Shared
Applications and Web

Infrastructure Platform

Files

Files to Modify

Location

SAS Workflow

SAS Workflow Web Service

SAS Preferences

SAS Stored Process

SAS Logon Manager

SAS Content Server

SAS Web Infrastructure
Platform Client Access

SAS Web Infrastructure
Platform Administration

SAS Web Infrastructure
Platform Services

SAS SOAP Services

SAS BI Web Services
(JBoss)

web.xml.orig

web.xml.orig

web.xml.orig

web.xml.orig

web.xml.orig

web.xml.orig

web.xml.orig

web.xml.orig

web.xml.orig

web.xml.orig

jboss-web.xml.orig

web.xml.orig

SAS-installation-directory
\SASSharedServices\9.2\
Configurable\wars\sas.workflow\
WEB-INF

SAS-installation-directory
\SASSharedServices\9.2\Configurable
\wars\sas.workflow.webservice
\WEB-INF

SAS-installation-directory
\SASSharedServices\9.2\Configurable

\wars\sas.preferences \WEB-INF

SAS-installation-directory
\SASSharedServices\9.2\Configurable
\wars\sas.storedprocess\WEB-INF
SAS-installation-directory
\SASSharedServices\9.2\Configurable
\wars\sas.svcs.logon\WEB-INF
SAS-installation-directory
\SASSharedServices\9.2\Configurable
\wars\sas.svcs.scs\WEB-INF
SAS-installation-directory
\SASSharedServices\9.2\Configurable
\wars\sas.wip.access\WEB-INF
SAS-installation-directory
\SASSharedServices\9.2\Configurable
\wars\sas.wip.admin\WEB-INF
SAS-installation-directory
\SASSharedServices\9.2\Configurable
\wars\sas.wip.services\WEB-INF
SAS-installation-directory
\SASSharedServices\9.2\Configurable

\wars\sas.wip.soapservices\WEB-
INF

SAS-installation-directory
\SASSharedServices\9.2\Configurable

\wars\sas.biws\jboss\WEB-INF
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SAS Shared
Applications and Web
Infrastructure Platform

Files Files to Modify Location
SAS BI Web Services web.xml.orig SAS-installation-directory
(WebLogic) \SASSharedServices\9.2\Configurable

\wars\sas.biws\weblogic\WEB-INF

SAS BI Web Services web.xml.orig SAS-installation-directory
(WebSphere) \SASSharedServices\9.2\Configurable

\wars\sas.biws\websphere\WEB-INF

Configuring the Display of a Warning Message for Inactive User
Sessions

In SAS 9.2 and previous maintenance releases for SAS 9.2, users with inactive user
sessions were logged out and automatically redirected to the time-out Web page
displayed by the SAS Logon Manager. Beginning with the third maintenance release
for SAS 9.2 and later, you can alert users by displaying a warning message before they
are logged out of their inactive sessions. By default, this warning message displays for
5 minutes, but you can customize it by specifying a different value in minutes.

This feature is supported for:

SAS Web Report Studio

SAS Package Viewer

SAS Shared applications

SAS Preferences

SAS Web Infrastructure Platform administration
SAS Stored Processes

Beginning with the 4.3 Release of SAS BI Dashboard, this feature is supported.

O o o o o g

Note: If SAS Information Delivery Portal 4.2 is configured at your site, this feature
should not be enabled. Beginning with the November 2010 release, SAS Information
Delivery Portal 4.3 enables you to alert users by displaying a warning message before
they are logged out of their inactive sessions. A

The following table summarizes the features of the warning message.
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Table 8.4 Display Warning Message for Inactive User Sessions

Third Maintenance Release for SAS

Feature 9.2

For inactive user sessions associated with SAS (Optional) Specify the

applications (SAS Information Delivery Portal, SAS Web Policy.DisplaySessionTimeoutWarning
Report Studio, SAS Package Viewer, SAS Shared property and set the value to true. By
applications, SAS Preferences, SAS Web Infrastructure default, this warning message displays
Platform administration, and SAS Stored Process), for 5 minutes.

display a warning message to users before logging them
off their applications.

Specify the length of time for the display of a warning (Optional) Specify the

message that is enabled when the App.SessionTimeoutWarningInterval

Policy.DisplaySession TimeoutWarning property property and provide a value in

is set to true. minutes. Specifying the
Policy.DisplaySession
TimeoutWarning property is a
prerequisite for using this property. The
default value is 5 minutes. The value
specified for this property cannot exceed
the value defined for the session
time-out interval in the web.xml file.

Configuring the Display of a Warning Message for Inactive User
Sessions

Inactive users are logged off their Web applications when their sessions are inactive
for 30 minutes or for the amount of time specified by the administrator in the web.xml
files. In the third maintenance release for SAS 9.2, before logging out inactive sessions,
you can alert users about the impending log off by displaying a warning message.
When the warning message is displayed, users can click the Continue button to
activate and extend their sessions. In the third maintenance release for SAS 9.2, the
following applications support the display of a warning message:

o SAS Web Report Studio

SAS Package Viewer

SAS Shared applications

SAS Preferences

SAS Web Infrastructure Platform administration
SAS Stored Process

O o o o g

Beginning with the November 2010 release, SAS Information Delivery Portal 4.3
supports the display of a warning message.

Beginning with the 4.3 Release of SAS BI Dashboard, this feature is available.

To configure a warning message for inactive user sessions associated with SAS
applications and specify the number of minutes that the warning message should be
displayed, follow these steps:

1 On the Plug-ins tab, under Application Management » Configuration
Manager, right-click SAS Application Infrastructure and select Properties.

In the SAS Application Infrastructure Properties dialog box, click the Advanced
tab.
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2 Click add.

3 In the Define New Property dialog box, enter each property name and property
value as follows and click oK. Note that specifying the
App.SessionTimeoutWarningInterval is optional. If the
App.SessionTimeoutWarningInterval property is not specified with a custom
value, the default value of 5 minutes applies to the
Policy.DisplaySessionTimeoutWarning property. The value specified for the
App.SessionTimeoutWarningInterval must be smaller than the value or values
specified for session time-out intervals in the web.xml files. For information about
web.xml files, see “Configuring the HTTP Session Time-out Interval” on page 110.

Property Name Policy.DisplaySessionTimeoutWarning
Property Value true
Property Name App.SessionTimeoutWarningInterval
Property Value Value for Session Time-out Warning Interval
4 Click oK to save your changes.
5 To enable these properties to take effect, restart the Web application server.
If you want to specify a different session time-out interval for each SAS application,

complete this task for each SAS application by defining the
App.SessionTimeoutWarningInterval property and a custom value in minutes.
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About SAS Shared Services

SAS Shared Services provides standard features that are used by the SAS BI
Dashboard and which can also be used by the SAS Information Delivery Portal, SAS
Web Report Studio, and certain SAS solutions. The features include the following:

alert enables users to register to receive time-sensitive, action-oriented
registration and messages when a specified combination of events and conditions
notification occurs. Alerts empower users by allowing them to control the type of

notifications that they receive, and when they are delivered. Alerts
can be sent to the user’s e-mail address or displayed in the SAS
Information Delivery Portal.

comment enables users to create comments related to business intelligence

management objects. Users can then reply to, search for, retire, delete, or add
attachments to existing comments. In addition, users can find
comments that were created by a particular user, with a specified
date range or with specific text. This feature enables the capture of
human intelligence and supports collaborative decision making
related to business data.

During an Enterprise BI Server installation, a database and a data source name
definition are created automatically on the SAS Table Server for the exclusive use of
SAS Shared Services. For more information, see “Using the SAS Table Server with the
SAS Middle Tier” on page 55.

Setting the Default Alert Notification Delivery Type

Alert notifications can be sent to users either via e-mail or via display in a portlet
that users view in the SAS Information Delivery Portal. The default notification
delivery type is specified in the properties for SAS Application Infrastructure using the
Configuration Manager plug-in to SAS Management Console.

To change the alert notification setting, follow these steps:

1 Log on to SAS Management Console as an administrator.

2 On the Plug-ins tab, navigate to Application Management » Configuration

Manager » SAS Application Infrastructure.
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Right-click sSAS Application Infrastructure and select Properties.
Click the settings tab.
Select Notifications in the left pane.

o O AW

In the right pane, select a value from the Alert notifications type list box.
Here are the choices:

o My alerts portlet (default)

O Via e-mail

0 Both e-mail and alerts portlet
7 Click ok.

8 To apply this setting and make it available, restart the SAS Web Infrastructure
Platform Services, SAS Shared Services, and SAS Web Report Studio applications.
(Changes to properties do not take effect immediately on the run-time system. For
details, see “Summary of Steps for Using Configuration Manager” on page 65.)

This setting becomes the default for your site. Users can specify an individual
preference that overrides this value so that they receive notifications via a specific
delivery type that meets their needs.

Administering the SAS Comment Manager Weh Application

The SAS Comment Manager can be used by SAS Web applications to capture user
comments. For example, in SAS Web Report Studio, the File » Comments menu item
enables users to add comments to reports and graphs.

By default, all users who can log on to an application that uses the SAS Comment
Manager can view and create comments. As an administrator, you might also want to
edit and delete comments. Editing and deleting comments are considered
administrative functions. To edit and delete comments, you must configure and enable
a special administrative role in SAS metadata.

To enable the editing and deletion of comments, follow these steps:

1 Enable the administration of SAS Comment Manager as follows:

a Log on to SAS Management Console as an administrator.

b On the Plug-ins tab, navigate to Application Management » Configuration
Manager » SAS Application Infrastructure.

¢ Right-click sAs Application Infrastructure and select Properties.

d Select the Advanced tab.

e Add the property Policy.CommentAdministrationEnabled and set its value to
true.

f Click ok.

2 Configure a Comment Administrator role and assign users to the role. In SAS
Management Console, right-click User Manager and create a new role that has
the following properties:

0 For the name, enter Comment Administrator. You must specify the name
exactly as it appears here.

o For the display name, enter Comment Manager: Advanced. This name
follows the naming convention for roles.

0 For the description, enter Members can edit and delete comments [implicit].
Include [implicit] to signify that the role has implicit capabilities.

o For capabilities, you do not need to grant capabilities for the role. This role
has implicit capabilities.
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0 For members, add the appropriate users. Users who are assigned to this role
have the ability to edit and delete comments.

Note: Due to possible conflicts that can occur when multiple users delete
comments in the same comment thread, the best practice is to limit the
number of users to just a few. A

For instructions about creating roles, see the User Manager Help in SAS
Management Console.
3 Restart the Web application server.

To edit or delete a comment, follow these steps:
1 Select the comment in the left pane of SAS Comment Manager.

2 To edit the comment, in the right pane, click Edit. An Edit Comment window
opens in which you can make changes. When you are finished, click save.

3 To delete the comment, in the right pane, click belete. You are prompted to
confirm the deletion.

Here is an example of SAS Comment Manager with a comment displayed.

Display 9.1 SAS Comment Manager

{2 SAS Comment Manager - Windows Internet Explorer provic O] x|

Comments -« 2010 Comparative Analysis
Browse JRERTM)]
) New comment Refresh M M

2010 Comparative AnzlS
2010 Comparative Analysis Report

Author:
Date: 02Jun10:13:41:24

Are the sales numbers for May available yet? | didn't see them in this
raport.

Reply...
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About the SAS Content Server

The SAS Content Server is a content repository that stores digital content (such as
documents, reports, and images) created and used by SAS client applications. Examples
of such content include reports and documents created by users of SAS Web Report
Studio and the SAS Information Delivery Portal.

The Web-based Distributed Authoring and Versioning (WebDAV) protocol is currently
the main method used to access the SAS Content Server. In addition to the basic
features of HTTP, the WebDAV protocol is an extension to HT'TP and provides write
access, version control, search, and other features.

The SAS Content Server starts automatically when the Web application server is
started and depends on the SAS Services Application. The SAS Services Application
deploys a set of services called Remote Services that are used by SAS Information
Delivery Portal, the SAS Stored Process Web application, and other Web applications.
The SAS Services Application must be started before you start your Web application
server.
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Moving Content or Backing up the SAS Content Server

The SAS Content Server should be backed up whenever the metadata server is
backed up. For instructions about how to back up the SAS Content Server, see “Best
Practices for Backing Up Your SAS System” in the SAS Intelligence Platform: System

Administration Guide.

Use the WebDAVDump and WebDAVRestore utilities to:
o Back up specific locations such as a subset of the WebDAV content.

0 Create a backup for input to a system other than the SAS Content Server.

o0 Move content from one SAS Content Server to another one.

O Share content that is available in the SAS Content Server.

For instructions about using the WebDAVDump and the WebDAVRestore utilities,

see SAS Note 38667.

Deploying Content Manually to the SAS Content Server

SAS Web applications such as the SAS Information Delivery Portal and SAS Web
Report Studio require the availability of content for its users. The SAS Content Server
contains a content repository that stores digital content (such as documents, reports,
and images) that is created and used by SAS client applications. Beginning with SAS
BI Dashboard 4.3, dashboard files are stored in this content repository.

To enable the availability of DAV content in the SAS Content Server, you can load
content, update existing content, and adjust Web applications that store SBIP URLs.
These tasks can be automated or they can be performed manually.

The following table shows the choices available in the SAS Deployment Wizard, and
the results or manual tasks that follow these choices.

Table 10.1 Selecting Automatic Options or Manual Performance of Tasks

Options Selected in SAS Deployment Wizard

Results and Instructions for Manual Tasks

Web Application Server: Automatic Configuration

Web Application Server: Automatic Deployment

The Web application server is configured
automatically. SAS Web applications are deployed
automatically, and content is loaded to the SAS
Content Server. If applicable, Web applications
that store SBIP URLs are adjusted automatically.

Web Application Server: Automatic Configuration

Manually deploy Web applications, load the content to the SAS
Content Server, and adjust any Web applications that store
SBIP URLs.

The Web application server is configured
automatically. Instructions are provided on how to
manually deploy SAS Web applications, load
content to the SAS Content Server, and adjust any
Web applications that store SBIP URLs.

Manually configure the Web application server, deploy the Web
applications, load the content to the SAS Content Server, and
adjust any Web applications that store SBIP URLs.

Instructions are provided on how to perform all
tasks manually.

The following table shows when you can load or update content (and adjust URLs)

either automatically or manually.
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Table 10.2 Criteria for Deploying Content to the SAS Content Server

Configuration of

Deployment of

Web Application Web

Server Applications Load Content Update Content Adjust URLs
Automatic Automatic Automatic Automatic Automatic
Automatic Automatic Manual Manual Manual
Manual Manual Manual Manual Manual

The following table shows the files associated with loading content to the SAS
Content Server or updating content. The filename for the batch or script file includes
the order number.

Table 10.3 Files for Loading or Updating Content Manually

Manual Task

Directory Path and Filename

Load content to the SAS
Content Server.

On Windows:

SAS-configuration-directory\Lev1\Web\Utilities\manualLoadContent-
OrderNumber .bat

On UNIX and z/OS:
SAS-configuration-directory/Levl/Web/Utilities/manualLoadContent-

OrderNumber.sh

Update content in the
SAS Content Server.

On Windows:

SAS-configuration-directory\Levl\Web\Utilities\manualUpdateContent-
OrderNumber .bat

On UNIX and z/OS:
SAS-configuration-directory/Levl/Web/Utilities/manualUpdateContent-

OrderNumber.sh

Adjust URLs for Updated
Content.

On Windows:

SAS-configuration-directory\Levl\Web\Utilities\manualAdjustUrls-
OrderNumber .bat

On UNIX and z/OS:
SAS-configuration-directory/Levl/Web/Utilities/manualAdjustUrls-

OrderNumber.sh

Load Content Manually to the SAS Content Server

If you deploy SAS Web applications manually, you need to load content manually to
the SAS Content Server. For information about how to load content manually for SAS
Web applications, see your Instructions.html file.

Use the following batch file or shell script to load content manually:

o0 On Windows:

SAS-configuration-directory\Levl\Web\Utilities\manualLoadContent-

OrderNumber .bat
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o0 On UNIX and z/OS:

SAS-configuration-directory/Levl/Web/Utilities/
manualLoadContent.sh-OrderNumber.sh

If Web applications were deployed manually, this script contains the credentials for
the SAS Administrator, as well as the SAS Trusted User. The password is always
encrypted in the file. After loading content successfully, delete the file or remove
credentials for the SAS Administrator and the SAS Trusted User.

If Web applications were deployed automatically, the script does not contain the
required credentials. You will need to manually enter the required credentials in this
script file.

Detailed log messages are written to the
product-name_loadContent_date-and-time . log file.

These logs are located in these locations:

On Windows:

SAS-configuration-directory\Levl\Logs\Configure

On UNIX and z/OS:
SAS-configuration-directory/Levl/Logs/Configure

Update Content Manually for the SAS Content Server

If you deploy updated SAS Web applications manually, you must manually update
the DAV content in the SAS Content Server. For more information, see your
UpdateInstructions.html file, which is located in the SAS-configuration-directory /
Levl/Documents directory.

Here are some reasons why you would update content manually:

O During a migration or upgrade to the November 2010 release of SAS 9.2, data
explorations must be converted to reports. URL references should be adjusted to
refer to metadata that has moved either during migration or an upgrade. For
more information, see “Server Tier Post-migration Tasks” in SAS Intelligence
Platform: 9.1.3 to 9.2 Migration Guide.

o Before portal content is promoted to SAS Information Delivery Portal 4.3, data
explorations must be converted to reports and directive URLs should be adjusted
manually. For more information, see “Promote the Entire Portal Application Tree”
on page 380.

Use the following batch file or shell script to update the DAV content manually:
0 On Windows:

SAS-configuration-directory\Levl\Web\Utilities\manualUpdateContent-
OrderNumber .bat

o0 On UNIX and z/OS:

SAS-configuration-directory/Levl/Web/Utilities/
manualUpdateContent-OrderNumber.sh

If Web applications were deployed manually, this script contains the credentials for
the SAS Administrator, as well as the SAS Trusted User. The password is always
encrypted in the file. After loading content successfully, delete the file or remove
credentials for the SAS Administrator and the SAS Trusted User.

If Web applications were deployed automatically, the script does not contain the
required credentials. You will need to manually enter the required credentials in this
script file.

Detailed log messages are written to a file called product-name
_updateContent_date-and-time.log
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These log files are located in the following directories:
One Windows:
SAS-configuration-directory\Levl\Logs\Configure

On UNIX and z/OS:
SAS-configuration-directory/Levl/Logs/Configure

Adjust Directive URLs Manually

Directive URLS are updated either during the migration of a product from one
version to another version, or when a product’s content is modified and updates are
required. When the script is run to adjust URLs, it updates references to metadata that
has moved either during migration or an upgrade. These references are stored as SBIP
URLs.

Here are some reasons why you would adjust directive URLs manually:

0 During a migration or upgrade to the November 2010 release of SAS 9.2, data
explorations must be converted to reports and URL references should be adjusted
to refer to metadata that has moved either during migration or an upgrade. For
more information, see “Server Tier Post-migration Tasks” in SAS Intelligence
Platform: 9.1.3 to 9.2 Migration Guide.

o Before portal content is promoted to SAS Information Delivery Portal 4.3, the data
explorations must be converted to reports and directive URLs should be adjusted
manually. For more information, see “Promote the Entire Portal Application Tree’
on page 380.

4

Use the following script files when it is necessary to manually adjust URLs:
0O manualAdjustUrls.bat-OrderNumber.bat
0O manualAdjustUrls.sh-OrderNumber.sh

Here are some examples of instances where there is a need to manually adjust URLs:

O When a migration is performed, some reports might be moved to a user’s home
folder. If there were reference to the data in those reports (in the form of SBIP
URLs), those references would be updated.

0 During a migration or an upgrade, data explorations are converted to reports. If
there were references to the data explorations (in the form of SBIP URLs), those
references would be updated.

After updating content manually for the SAS Content Server, adjust directive URLs
manually by running the appropriate script or batch file:

o0 On Windows:

SAS-configuration-directory\Levl\Web\Utilities\manualAdjustURLs-
OrderNumber .bat

o0 On UNIX and z/OS:

SAS-configuration-directory/Levl/Web/Utilities/
manualAdjustURLs-OrderNumber.sh

The instructions for running the script or batch file is provided in the
Instructions.html during a migration or the UpdateInstructions.html file during
an upgrade. The script contains the credentials for the SAS Administrator, as well as
the SAS Trusted User. The password is always encrypted. When you have successfully
loaded the content, delete the file or remove the credentials for the SAS Administrator
and the SAS Trusted User.

When URLs are updated, log files are produced for each SAS Web application.
Detailed log messages are written to a file called product-name
_adjustUrls_date-and-time.log
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These log files are located in the following directories:
One Windows:
SAS-configuration-directory\Levl\Logs\Configure

On UNIX and z/OS:
SAS-configuration-directory/Levl/Logs/Configure

Using the SAS Content Server Administration Console

About the SAS Content Server Administration Gonsole

The SAS Content Server Administration Console enables you to manage files and
WebDAV folders in the SAS Content Server. Using the console, you can perform the
following management tasks:

o view folders

O control access to WebDAV folders and files by setting permissions
O create folders

o delete folders

Access the SAS Content Server Administration Console

To access the console, enter the following URL in your Web browser and substitute
the server name and port number of your SAS Content Server:
http://server:port/SASContentServer/dircontents.jsp

Note: This console is also part of the SAS Web Administration Console. You can
administer the SAS Content Server by using either interface. For more information
about accessing the SAS Web Administration Console, see “Using the SAS Web
Administration Console” on page 71. A

Log on to the console as someone who has user administration capabilities (for
example, sasadm@saspw). You must be an unrestricted user to administer content in
the SAS Content Server. The term "(Admin)" after your name at the top of the page
indicates that you are logged on as an unrestricted user and that you have full
administrator rights to use the console.

As a security precaution, make sure that you log off when you are finished using the
console. If you go to another URL or close the tabbed page in your browser without
logging off, your console logon remains in effect. This means that the console can be
accessed again without re-entering a user name and password.

A Brief Tour of the Console Interface

The following display shows an example SAS Content Server Administration Console
as it appears in a browser window.
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Display 10.1 SAS Content Server Administration Console

SAS Web Administration Console

EH@SAS Web Administration Cansole [«

2l D;virnnment Management SCS Admin Console | Contents & person/sasadm (Admin)
-Busers

fSystem Maintenance
[EDSAS Content Server z
[Capplication Management Item name Primary type Date created Date modified Delete | Permissions
sasdav nt:davcollection 2009-08-19T10:03:48 229-04:00 none r
sasfolders ntdavcollection 2009-08-19T10:03:48.249-04:00 none r

Add folder
©2008 SAS Institute

Objects in the console are either folders or files. By default, the initial view of the
console displays the following folders:

sasdav
contains content that has been added to the SAS Content Server. By default,
sasdav contains the following folders:

O sasdav/Users contains personal repository folders for users. A user’s folder
is created automatically when the user logs on to a SAS Web application.
Users have full rights to their own folders.

O sasdav/Templates contains templates that are used for e-mail notification in
SAS solutions.

sasfolders
contains content that has been defined in the SAS Folders tree in the SAS
Metadata Server. You see a folder only if the folder contains content.

CAUTION:
Administrators should not manage folders and content here. The content within this
folder and subfolders is mapped to SAS Folders in the SAS Metadata Server. It
is recommended that you use the SAS Management Console to add and manage
folders. A

Depending on the software that is installed at your site, your console might contain
additional folders.
To navigate in the console, follow these steps:

1 Click an item in the list to display information about that item.
2 Use the breadcrumb trail above the list to return to a parent folder. For example,

My AT
inthe —° @ [ Users breadcrumb trail, click sasdav to return to the
sasdav folder.

The console displays the following information for each item listed:

Item name displays the name of the folder or file.

Primary type is an internal value that designates the type of object in the
repository.

Date created is the date when the object was created.

Date modified is the date when the object was modified.

Delet . A U -
elere when the delete icon —° @ [ Users is clicked, the
selected objects are deleted.
Permissions .. . . .
when the permissions icon is clicked, opens a page where

permissions can be modified for the object.
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Modify Permissions for WehDAV Folders and Files

The sasfolders directory should be accessed only by trusted or unrestricted users.
These users are recognized as unrestricted administrators for the SAS Content Server,
and do not require the Access Control List (ACL) to grant them access to this directory.
If other types of users attempt to access this location, their permissions are verified
before they are granted any access.

The sasdav directory can be accessed by regular users, and ACLs can be used to
grant access to specific users and groups.

Principals can be granted permissions for folders and files. In the SAS Content
Server, a principal is either a user or a group of users defined in the SAS Metadata
Server. Principals can be given permissions that allow them to perform specific tasks
such as reading an object, writing to an object, deleting an object, and so on.

You set permissions for an object by specifying which principals have which types of
access. To modify permissions for an object, follow these steps:

1 Click the permission icon next to the item that you want to modify. A
permissions page appears.

2 For each principal listed, modify the permissions by changing each permission to
Yes or No.

Note: You might see a principal named jer:authenticated. This principal refers to
any user who can log on to a SAS Web application. By default, authenticated users
have Read and Inherit Read permissions only. A

3 To add more principals to the page, do one of the following:
o If you know the principal’s name, enter it in the field and click save changes.

0 Click search for Principals to search for a name. When you find the
principal that you want to add, select the check box next to the principal’s name
and then click Return.

After the principal’s name appears on the permission page, you can set
permissions for the principal.

The following display shows a portion of the console with permissions for a folder.

Display 10.2 Folder Permissions in the SAS Content Server

SCS Admin Console | Permissions & person/sasadm (Admin) | Logout

Principal READ WRITE DELETE ADMIN INHERIT INHERIT INHERIT INHERIT Remove
READ WRITE DELETE ADMIN

Owner{Nobody) Yes ITS;I m Yes Yes m m Yes

jerauthenticated |Yesj|l\ln B IND = |Nn B |Yesj |I\In B II\Jn -] IND B r

Add principat: o Hfne & [wo Z [no & [no H e H [ue B [ne F

@ Subfolders and files
© This folder onlv

© Owverwrite permissions for all

Save changes |

The following permissions are available for you to apply to objects:
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Table 10.4 Permissions for Objects

Permissions Purpose

Read Allows the principal to read the object. For folders, this
permission allows the principal to see the members of the folder.

Write Allows the principal to write an object. For folders, this
permission allows the principal to create new objects in a folder.

Delete Allows the principal to delete the object.

Admin Allows the principal to change the permissions on an object

Inherit Read Objects created in this folder inherit this setting for their Read

permission (and Inherit Read permission for subfolders).

Inherit Write Objects created in this folder inherit this setting for their Write
permission (and Inherit Write permission for subfolders).

Inherit Delete Objects created in this folder inherit this setting for their Delete
permission (and Inherit Delete permission for subfolders).

Inherit Admin Objects created in this folder inherit this setting for their Admin
permission (and Inherit Admin permission for subfolders).

Note: Inherited permissions are assigned when objects are created. Each object has
its own set of permissions. Inherited permissions are static; dynamic inheritance does
not occur. A

If you are applying permissions to folders, then the following options are available:

Table 10.5 Results of Applying Permissions to Folders

Permissions for Folders Results

Subfolders and files Changed permissions are applied to subfolders
and files that exist below the current folder.

This folder only Changed permissions are applied to subfolders
and files that exist in the current folder.

Overwrite permissions for all Changed permissions are applied to all folders
and files.

Create a New Folder

To add a folder below the current folder, enter the name of the new folder in the field
and click Add Folder.

Note: Although you can add a folder to the sasfolders location, the folder that you
add is not added to the SAS Metadata Server. The best practice is to add folders to
metadata using SAS Management Console. A

Add Files to the SAS Content Server

You cannot use the SAS Content Server Administration Console to add files to
folders. To add files, you can use one of the following methods:
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O

Use Microsoft Web folders to add content to the appropriate folder. You must use a
browser on a Windows client machine in order to use this method.

For example, the sasdemo user might open the following location as a Web
folder:
http://myServer:8080/SASContentServer/repository/default/sasdav/
Users/sasdemo/

Then, copy and paste content into the folder.

Use the SAS DAVTree utility to drag and drop folders or files into console folders.
To use this utility, run the following command:
SAS-configuration-directory\Levn\Web\Utilities\DAVTree.bat
On UNIX and z/OS, the utility command is DAVTree. sh.

For more information about using DAVTree, see “Using the DAVTree Utility to
Manage WebDAV Content” on page 77.

Use the SAS Publishing Framework to publish files to the WebDAV repository.

Portal users can publish portal content to the WebDAV repository by using the
portal’s publish and subscribe tools.

Programmatically publish content to WebDAV.

Usage of these tools and techniques is beyond the scope of this documentation (with
the exception of the DAVTree utility).

Delete Folders or Files

Delete a single or multiple folders when you are sure that the folders and their
contents are not required.

CAUTION:
Exercise caution when deleting items from the SAS Content Server. ~

When deleting folders, the following rules apply:

O
O

O

Do not delete the sasdav or sasfolders.

If you delete an item in the sasfolders tree, then applications that rely on the
content mapping between the SAS Content Server and the SAS Metadata Server
might not be able to access the content. To add and delete SAS metadata objects,
use SAS Management Console.

For information about the best practices to be followed for managing SAS
folders in SAS Management Console, see “Working With SAS Folders” in the SAS
Intelligence Platform: System Administration Guide.

When you delete a folder, all objects within that folder are also deleted.

To delete a folder or file, select the beletecheck box next to the name of the folder or
file that you want to delete. The item is deleted; you are not prompted to confirm the
deletion. To delete multiple folders or files, select multiple check boxes for pDelete.

Implementing Authorization for the SAS Content Server

Overview of SAS Gontent Server Authorization

SAS users and groups are defined in a SAS Metadata Repository. The SAS Web
Administration Console enables you to specify which users or groups are authorized to
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access specific folders in the SAS Content Server repository, and what type of access
permissions they have for the folders.

Use the SAS Web Administration Console to create folders and associate access
controls with the folders.

Note: This topic does not describe authentication for the SAS Content Server. By
default, SAS Content Server users are authenticated by using SAS token
authentication. A

Before you can associate access controls with a folder, you must complete these tasks:

1 Use the SAS Web Administration Console to create the folder on the SAS Content
Server.

2 Ensure that the appropriate user and group definitions exist on the SAS Metadata
Server for the SAS Content Server users and groups for whom you want to control
access to the folder.

After you have created the WebDAV folders and have ensured that the appropriate
user and group definitions are created on the SAS Metadata Server, use SAS Web
Administration Console to associate access controls with the folders.

Example Scenario: SAS Content Server Authorization

Within your portal implementation, you might use the publish and subscribe
capabilities to publish (write) and subscribe to (read) group folders on a WebDAV
publication channel.

The following scenario shows the application’s publish and subscribe setup for sales
and executive teams that need different access to read (subscribe to) and write (publish)
information that is stored in three different directories on the SAS Content Server. On
the SAS Metadata Server, these teams are represented by two groups, Americas Sales
and Sales Executives.

This publish and subscribe scenario has a requirement for three different content
areas, or group folders, on the SAS Content Server:

o Catalog Sales: The /sasdav/Catalog Sales directory contains catalog sales
information. The Americas Sales and Sales Executives groups can both read
(subscribe to) and write (publish) information.

0 Field Sales: The /sasdav/Field Sales directory contains direct sales
information. The Americas Sales and Sales Executives groups can both read, but
only the Sales Executives group can write information.

0 Sales Execs: The /sasdav/Sales Execs directory contains executive-level sales
information. Only the Sales Executives group can read and write information.

The following table summarizes this scenario’s group-based folders on the SAS
Content Server, and the permissions for each group:

Table 10.6 Summary of WebDAV Folders on the SAS Content Server

Folder Americas Sales Sales Executives
/sasdav/Catalog Sales Read, Write Read, Write
/sasdav/Field Sales Read Read, Write
/sasdav/Sales Execs (none) Read, Write

To create this sample configuration, follow these steps:
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1 In SAS Management Console, define the users, groups, and login credentials that

need to access the SAS Content Server. When you define login credentials, you
must specify the same authentication domain name that you specified for the SAS
Content server during installation.

For this example, the following users, groups, and logins are defined:

Table 10.7 Example Users, Groups, and Logins

Group Metadata User Metadata Authentication
Identities Identities User ID Domain
America Sales salesusrl salesusrl DefaultAuth
Sales Executives execusrl execusrl DefaultAuth
SAS Trusted User sastrust sastrust DefaultAuth

For example, the America Sales group contains a user named salesusrl as a
member, and salesusrl has an associated login with a user ID of salesusrl and an
authentication domain of DefaultAuth. The America Sales group might include
other members as well.

In the SAS Web Administration Console, create your new directory under the
sasdav directory. For this example, navigate to the sasdav directory, and then
create these three subdirectories: Catalog Sales, Field Sales, and Sales
Execs.

In the SAS Web Administration Console, configure the access permissions for the
folders that you created. For this example, set the access permissions for each
subdirectory, using the following tables as guides:
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Tahle 10.8 WebDAV Permissions for /sasdav/Catalog Sales

Inherit Inherit Inherit
Group Read Write Delete Read Write Delete
Americas Yes Yes No Yes Yes No
Sales
Sales Yes Yes No Yes Yes No
Executives
Table 10.9 WebDAV Permissions for /sasdav/Field Sales

Inherit Inherit Inherit
Group Read Write Delete Read Write Delete
Americas Yes No No Yes No No
Sales
Sales Yes Yes No Yes Yes No
Executives
Table 10.10 WebDAV Permissions for /sasdav/Sales Execs

Inherit Inherit Inherit
Group Read Write Delete Read Write Delete
Americas No No No No No No
Sales
Sales Yes Yes No Yes Yes No
Executives

Reconfiguring the SAS Content Server to Share the Database Used hy
SAS Shared Services

Beginning with the third maintenance release for SAS 9.2 and later, SAS Content
Server supports database persistence. By default, the SAS Content Server uses the file
system for persistence, and you need not change this setup. In some environments
though, there might be a compelling need to use a database back end. In such cases,
you can reconfigure the SAS Content Server to share the database that is used by SAS
Shared Services.

By default, SAS Shared Services uses the SAS Table Server. However, SAS Shared
Services can be configured to use a different database such as TKTS, Oracle, MySQL,
Postgres, DB/2, or SQL Server.

JCRCopyRepository File

To migrate the contents of the current SAS Content Server’s repository to the
database-based repository, obtain the JCRCopyRepository.bat or the
JCRCopyRepository.sh file from SAS Technical Support. Place the script file in the
SAS-configuration-directory/Web/Utilities directory. This file should be customized
for your environment. After the file is customized and saved, run the batch or script file
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to reconfigure the SAS Content Server and share the database used by SAS Shared
Services.

Note: The JCRCopyRepository script file does not ship with your software. To
obtain a copy of the JCRCopyRepository script file, contact SAS Technical Support. A

For information about running the JCRCopyRepository script file, see “Reconfigure
SAS Content Server to Share the Database Used by SAS Shared Services” on page 135.

JCRCopyRepository.bhat File for Windows
Here is an example of the JCRCopyRepository.bat file in Windows:

@echo on
:Script for executing the JCRCopyRepository utility

setlocal

REM Define needed environment variables
call "%~dp0..\..\level env.bat"

set LAUNCHERJAR=%SASVJR HOME%\eclipse\plugins\sas.launcher.jar

set UTILITIESDIR=%LEVEL_ROOT%\Web\Utilities

set PICKLISTS=%SAS_HOME%\SASWebInfrastructurePlatform\9.2\Picklists\wars\
sas.svcs.scs\picklist

set DRIVER=path-to-jdbc-driver-JAR-file

set CLASSPATH=%UTILITIESDIR%; $LAUNCHERJAR%

"%JAVA_JRE_COMMAND%" ~
-classpath "$CLASSPATH%" "~
-Djava.system.class.loader=com.sas.app.AppClassLoader
-Dsas.app.launch.config="%PICKLISTS%" "
-Dsas.app.repository.path="$SASVJR_REPOSITORYPATH%" "
-Dsas.app.class.path="%UTILITIESDIR%; $DRIVER%" "
-Djava.security.auth.login.config=%LEVEL ROOT%\Web\Common\login.config”"
-Xmx256m "
-Dscs.jndi.jndiName=sas/jdbc/SharedServices "
-Dscs.jndi.jdbcUrl=jdbc-url "
-Dscs.jndi.driver=jdbc-driver-class”

~

~

-Dscs.jndi.user=database-user
-Dscs.jndi.pwd=password "
org.apache. jackrabbit.core.JCRCopyRepository %1 %2
endlocal
if [%2] EQU [exit] exit $ERRORLEVELS

JCRCopyRepository.sh File for UNIX and z/0S

Here is an example of the JCRCopyRepository.sh file in UNIX:

#!/bin/sh

#

# JCRCopyRepository.sh

#

._'dirname $0'/../../level_env.sh
LAUNCHERJAR=$SASVJR_HOME/eclipse/plugins/sas.launcher.jar

UTILITIESDIR=$LEVEL_ROOT/Web/Utilities
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PICKLISTS=/OPT/SAS_92/SASWebInfrastructurePlatform/9.2/Picklists
/wars/sas.svcs.scs/picklist

DRIVER=path-to-jdbc-driver-JAR-file
CLASSPATH=SUTILITIESDIR:$LAUNCHERJAR

"$JAVA_JRE COMMAND" \
-classpath "$CLASSPATH" \
-Djava.system.class.loader=com.sas.app.AppClassLoader
-Dsas.app.launch.config="$PICKLISTS" \
-Dsas.app.repository.path="$SASVJR REPOSITORYPATH" \
-Dsas.app.class.path="$UTILITIESDIR: $DRIVER" \
-Djava.security.auth.login.config=../Common/login.config\
-Xmx256m \
-Dscs.jndi.jndiName=sas/jdbc/SharedServices \
-Dscs.jndi. jdbcUrl=jdbc-url \
-Dscs.jndi.driver=jdbc-driver-class_
-Dscs.jndi.user=database-user_
-Dscs.jndi.pwd=password \

org.apache.jackrabbit.core.JCRCopyRepository $1 §2

exit 0

Reconfigure SAS Content Server to Share the Database Used hy SAS
Shared Services

To reconfigure the SAS Content Server to share and use the same database that is
used by SAS Shared Services, follow these steps.
1 Stop the Web application server. Typically, this is SASSERVER 1 in the Web
application server’s configuration directory.

2 Rename the Content Server repository from Repository to RepositoryFs.
On Windows:

move
C:\SAS-configuration-directory\Levl\AppData\SASContentServer\Repository
C:\SAS-configuration-directory
\Lev1l\AppData\SASContentServer\RepositoryFSs

On UNIX and z/OS:

mv SAS-configuration-directory/Levl/AppData/SASContentServer/Repository
SAS-configuration-directory/Levl/AppData/SASContentServer/RepositoryFS

3 In the previous step, you moved the Repository directory. Now, recreate the
directory in that same location:

On Windows:

mkdir
C:\SAS-configuration-directory\Levl\AppData\SASContentServer\Repository

On UNIX and z/OS:

mkdir SAS-configuration-directory/Levl/AppData/SASContentServer/
Repository

4 The contents of the repository.xml file should identify the database that is used
for SAS Shared Services. Copy the repository.DatabaseName .xml file from the
SAS-installation-directory/SASWebInfrastructurePlatform/9.2/Static/wars/
sas.svcs.scs/WEB-INF/templates directory to the directory that you created in
the previous step. Then, rename this file as repository.xml.
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Here is an example for the TKTS database on Windows:
copy C:\SAS_HOME\sAsSWebInfrastructurePlatform\9.2\Static\wars

\sas.svcs.scs\WEB-INF\templates\repository.tkts.xml

C:\SAS-configuration-directory

\Lev1l\AppData\SASContentServer\Repository\repository.xml
Here is an example for the TKTS database on UNIX:

cp /$SAS_HOME//sASWebInfrastructurePlatform/9.2/Static/wars/
sas.svcs.scs/WEB-INF/templates/repository.tkts.xml
SAS-configuration-directory/Levl/AppData/SASContentServer/Repository/
repository.xml

5 If this is a JBoss Web application server, open the repository.xml file and search
for the following parameter:
<param name="url" value="sas/jdbc/SharedServices

Modify the value:

<param name="url" value="java:sas/jdbc/SharedServices"/>

This value should be modified in six different locations within the
repository.zxml file.

6 On JBoss, if a workspace.xml file exists in the workspaces\default directory,
modify the value for the url parameter in two different locations within the file:
<param name="url" value="java:sas/jdbc/SharedServices"/>

7 Obtain the values for the database name, host, port, user ID, and password from
the Web Application Server.
JBoss:

Open the sharedServices-ds.xml file located in the
SAS-configuration-directory/Levl/Web/Common/jboss directory.

WebSphere:

In the WebSphere Admin Console, navigate to Resources » JDBC » Data
Sources » Custom Properties
WebLogic:

In the WebLogic Admin Console, navigate to SASDomain » Services » JDBC
» Data Sources » SharedServices » Configuration and click on the Connection
Pool tab.

8 In the JCRCopyRepository script file that was placed in the
SAS-configuration-directory/Web/Utilities directory, modify the value of the
DRIVER parameter to indicate the path to the JDBC driver for the database:
DRIVER=path-to-jdbc-driver-JAR-file

The directory path should include the list of JAR files. The listed JAR files
should be concatenated by semi-colons (Windows) or colons (UNIX).
Here is a short excerpt from an example on Windows:

SAS-configuration-
directory\Lev1l\Web\Applications\SASSharedServices9.2\JDBCDriver\

icu4d.jar;SAS-configuration-
directory\Lev1l\Web\Applications\SASSharedServices9.2\

JDBCDriver\log4j.jar;
On UNIX and z/0OS:

SAS-configuration-directory/Levl/Web/Applications/
SASSharedServices9.2/
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JDBCDriver/icu4.jar;SAS-configuration-directory/Levl/Web/Applications/
SASSharedServices9.2/
JDBCDriver/log4j.jar;

9 Specify the values for user and password in the JCRCopyRepository script file.
These values were retrieved earlier from your Web Application Server.

-Dscs.jndi.user=database-user

-Dscs. jndi.pwd=password "

10 In the same JCRCopyRepository script file, enter the values for the following
parameters:
-Dscs.jndi.jdbcUrl=jdbc-url *
-Dscs.jndi.driver=jdbc-driver-class

The values specified for the JDBC URL and the driver are determined by the
type of database used in your environment. The following table shows the
examples of values for the different types of databases:

~

Table 10.11 Parameters and Values for JDBC URL and Driver

Database Parameters Values

TKTS -Dscs.jndi.jdbcUrl jdbc:sastkts://host:2171?constring=(DSN=SharedServices)
TKTS -Dscs.jndi.driver com.sas.tkts.TKTSDriver

Oracle -Dscs.jndi.jdbcUrl For Oracle:

jdbc:oracle:think:@host:1521:0rcl
For XE:
jdbc:oracle:think:@host:1521:xe

Oracle -Dscs.jndi.driver oracle.jdbc.driver.OracleDriver

Postgres -Dscs.jndi.jdbcUrl jdbc:postgresql://host:5432/SharedServices

Postgres -Dscs.jndi.driver org.postgresql.Driver

DB2 -Dscs.jndi.jdbcUrl jdbc:db2//host:50000/database

DB2 -Dscs.jndi.driver com.ibm.db2.jcc.DB2Driver

MSSQL -Dscs.jndi.jdbecUrl jdbc:sqlserver://
host:1433;DataBaseName=SharedServices;SelectMethod=cursor

MSSQL -Dscs.jndi.driver com.microsoft.sqlserver.jdbc.SQLServerDriver

MySql -Dscs.jndi.jdbcUrl jdbc:mysql://host:3306/SharedServices

MySql -Dscs.jndi.driver com.mysql.jdbc.Driver

11 In the command window, navigate to the SAS-configuration-directory/veb/
Utilities directory.
12 Run the JCRCopyRepository script command by providing the complete directory
path of the old and new repository directories.
On Windows:

JCRCopyRepository.bat C:\SAS-configuration-

directory\Lev1\AppData\SASContentServer\RepositoryFS

C:\SAS-configuration-directory\Levl\AppData\SASContentServer\Repository
On UNIX:

. /JCRCopyRepository.sh SAS-configuration-directory/Levl/AppData/
SASContentServer/RepositoryFs SAS-configuration-directory/Levl/AppData/
SASContentServer/Repository
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13 To enable the changes to take effect, restart the Web application server. Typically,
this is the SASSERVERI1.
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Managing Generated Web Services

Starting with SAS 9.2, you can select a set of stored processes in SAS Management
Console and use the Web Service Maker to deploy them as Web services. The Web

Service Maker generates a new Web service that contains one operation for each stored
process that you selected. For more information about developing Web services, see the
SAS BI Web Services: Developer’s Guide. For more information about using the Deploy

as Web Service Wizard in SAS Management Console, see the product Help.
When you generate a Web service, the Web Service Maker also generates metadata

about the new Web service and stores it on the SAS Metadata Server. The Web Service

Maker stores information about the URL of the Web service, keywords that are
associated with the Web service, and which stored processes are used by the Web
service. You can view and update this information, perform impact analysis, and

migrate these Web services at a later time by using SAS Management Console and the

Configuration Manager in SAS Management Console.
To delete a Web service that was generated by the Web Service Maker, use the
Configuration Manager in SAS Management Console. In the Configuration Manager,
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find and expand SAS BI Web Services for Java or SAS BI Web Services for
.NET, depending on your platform. Expand the webServiceMaker node, right-click the
generated Web service, and select Delete. Deleting a generated Web service removes
the artifacts on the server and also removes the metadata that is associated with the
generated Web service. This operation cannot be undone. For more information about
the Configuration Manager, see the product Help.

Note: You must grant permissions on the /System/Services folder to users who
want to create SAS BI Web Services. You can also delete a Web service directly from
the /system/Services folder. Users need ReadMetadata and WriteMemberMetadata
to create and delete Web services. By default, a default group named BI Web Services
Users is created, which has these permissions. You can add users to this group to allow
them to create and delete Web services, or use your own groups and permission
settings. A

Configuring SAS Bl Web Services for .NET

If you are using SAS BI Web Services for .NET, then you can change the
configuration settings for generated Web services by editing a web.config file. The
following configuration settings can be edited manually in the web.config file:

NamespaceForGeneratedServices
specifies the namespace that a generated Web service uses.

AuthenticationType
specifies one of the following two values:

Trusted
The Web service is configured (in the SystemMetadataFile or the
UserMetadataFile) with a trusted connection to the metadata server. The
Web service examines the HTTP context (which means that the caller
authenticates using the standard container capabilities) in order to get the
current user ID, and uses that ID when connecting to the metadata server.
Trusted authentication is also known as Web authentication.

Host
The middle tier authenticates against the metadata server as a non-trusted
user. Host authentication is also known as SAS authentication. Using this
type of authentication means:

o If you configure the MetadataAuthenticator SecurityTokenManager (in
the microsoft.web.services3 section of this configuration file), then
clients might pass in credentials that get used to connect to the
metadata server. This configuration is enabled by default.

o If a client does not pass in credentials, or the MetadataAuthenticator is
not configured, then a default set of credentials (which might be SSPI)
needs to be set in the SystemMetadataFile or UserMetadataFile. These
credentials enable callers to anonymously connect to a server (if the
container is also configured to allow this connection).

o If a Username Token is used, the user name and password are passed as
plain text in the WS-Security Username Token. It is strongly
recommended that you use secure HTTPs when using a plain text
password.

This setting is not specific to Web services, but applies to the middle tier in general.
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AcceptableSyscc
indicates which error codes do not cause a SOAP fault. After a stored process
runs, the Web service checks the SYSCC macro value in SAS. If that value is not
in the comma-separated list for AcceptableSysce, then a SOAP fault is generated
and the message is obtained from SYSMSG.

SystemMetadataFile
specifies the location of the system metadata file. The system metadata file
contains the location (host, port, and encryption) of the metadata server, and
might contain credentials.

UserMetadataFile
specifies credentials that override what is in the SystemMetadataFile setting. To
force callers of the service to specify credentials on each call, you should not
provide default credentials for either the SystemMetadataFile or the
UserMetadataFile settings.

ClientName
is passed to the stored process at run time at the start of the _CLIENT macro.

Configuring SAS Bl Web Services for Java

SAS BI Web Services for Java is initially configured during installation using the
SAS Deployment Wizard. To modify this initial configuration, use the Configuration
Manager plug-in for SAS Management Console.

To modify common configuration properties that apply to XMLA, WebServiceMaker,
and generated Web services, navigate to the BI Web Services for Java 9.2
application folder. Then navigate to the Settings tab within the Properties dialog box.
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Display 11.1 Settings Tab for the Bl Web Services for Java 9.2 Properties Dialog Box

BI Web Services for Java 9.2 Properties
Generall Connection  3ettings | Advancedl Authorizationl
&pplication I~ Show only required items (denoted by *)
User Interface
Regional Settings |npplication = General Configuration Reset to defaults |
Paaling *
General Configuration Acceptable SYSCC List: Reset
Matifications
General Configuration Iu
Adminiskrative and Error Me
Formats Enable dynamic prompts validation: Reset
Farmats
Currency Formats I\-’es LI
545 Stared Process timeout: Reset
Specify the maximum amount of time in seconds ko wait for a 545
Stored Process to execuke before timing out,
0
i E

a8 I Cancel | Help |

In the Application » General Configuration section, you have the ability to modify
the following configuration properties:

Acceptable SYSCC List
When a Web service operation is invoked, it in turn calls the appropriate SAS
Stored Process running on the server tier. SAS execution always returns the
SYSCC macro variable upon completion. By default, if this completion code is not
0, a SOAP fault is generated and returned to the invoking client. Alternatively, a
comma-separated list of acceptable SAS completion codes can be specified to alter
this behavior. Also, a hyphen separating two values can be used to conveniently
specify a range of acceptable completion codes. In this case, the acceptable list of
completion codes are treated as warnings rather than errors and do not cause a
SOAP fault.

Note that SYSCC can be set directly by SAS code developers. Likewise, some
SAS procedures set this value, so see the appropriate SAS documentation to
determine possible values that might be returned and whether these values are
errors or just warnings in your case. For example, if a SAS procedure states that a
SYSCC value less than 4 is a warning and you are willing to accept those values,
set this property as follows: 0-4. Therefore, if the SAS stored process returns a
value of 4 or less, it is considered successful as far as the Web service is concerned
and the client receives an appropriate response rather than a fault.

Enable dynamic prompts validation
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When invoking Web service operations for stored processes that have been
configured with dynamic prompt data parameters, you can turn off validation to
obtain better throughput if you are certain that these stored processes have been
written in a robust manner to handle any possible data passed by clients. Dynamic
prompt validation is enabled by default so that the middle-tier Web service
validates client data against data providers to ensure that incoming data meets
the specified criteria before calling the appropriate stored process on the server.

SAS Stored Process timeout
Set this property if you want to limit the amount of time that a stored process is
allowed to run. If the stored process fails to execute in the specified time, it is
canceled and a SOAP fault is returned to the invoking client. A value of zero
indicates no time-out period.

To modify configuration properties that are specific to the Web Service Maker,
navigate to the WebServiceMaker folder. Then navigate to the Settings tab within the
Properties dialog box.

Display 11.2 Settings Tab for the WebServiceMaker Properties Dialog Box

WebServiceMaker Properties

General | Conmection | Keywords | I Advanced | Authotization |

Application
General Configuration

|Applicati0n = General Canfiguration Reset to defaults |

Base namespace: Reset

Ihttp:,l',l'tempuri. arg

Deployment method: Reset
Icontainer LI

Deployment targets: Reset
INm

Temporary working directory: Reset

IC 15454 ConfigiLev1\Web\Applications!, 5ASEIWebServicesfar Javad . 2t

Dielete temparary files: Reset I
fTrUE =]
Script processing Failures: Reset I

IBUILD FAILED

ok I Cancel | Help |

In the Application » General Configuration section, you have the ability to modify
the following configuration properties:

Base namespace

This property is the base namespace that is concatenated with the service name to
create a target namespace to uniquely identify generated Web services. For
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example, if the base namespace is set to http://tempuri.org, and a client
creates a new service named test without specifying an overriding namespace for
this new service, then the target namespace for this Web service becomes http://
tempuri.org/test.

Deployment method
The method used to deploy generated Web services. Select Container to deploy a
generated Web service directly to the application server (container) and make it
immediately available for execution. Select Directory to copy the generated Web
service artifact to a designated directory so that it can be deployed to the container
at a later time.

Deployment directory
When the deployment method is Directory, this property specifies the file
location to copy the generated Web service artifact.

Temporary working directory
This property specifies the directory that is used to generate Web service artifacts.

Delete temporary files
This property specifies whether to delete temporary files after a successful
deployment. In most cases you should clean up temporary files after a successful
deployment.

Script processing failures
Ant scripts are used to perform specific tasks. The output streams that are
produced from running such tasks are analyzed for failures by searching for
well-known error messages such as BUILD FAILED. More than one
comma-separated value can be specified. If any of the keywords specified in this
property are encountered, the generation process is ended, and a SOAP fault is
returned to the invoking client.

To modify more advanced configuration properties that are specific to the Web

Service Maker, navigate to the Advanced tab within the Properties dialog box.
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WebServiceMaker Properties

Generall Connectionl Keywordsl Settings  Adwanced | Authorizationl

Property Mame I Property alue |
Define New Property [ x|

Property Mame: I

Property Yalue: I

Ok I Cancel

Add Remove |
oK I Cancel | Help I

The following advanced configuration properties are available:

AddwWsSecurityAuthConstraint
If Web authentication is enabled and this property is set to true, then generated
Web services will be configured to require WS-Security Username Token
authentication. However, to fully configure application server authentication using
Java Authentication and Authorization Service (JAAS), additional configuration is
necessary. For more information, see “Securing SAS BI Web Services for Java” on
page 149. The default value for this property is true. Set this property to false if
you do not want to automatically configure WS-Security for generated Web
services. An example would be if you wanted to configure HTTP transport-level
security instead.

JAASLoginConfigName
This property enables you to specify an alternate JAAS login configuration when
using WS-Security Web authentication within the WebSphere application server.
By default, the wsLogin JAAS login configuration is used.

AttachmentConformance
This property specifies the attachment conformance that should be enabled for
generated Web services. There are two options: Message Transmission
Optimization Mechanism (MTOM) and SOAP Messages with Attachments (SWA).
The default is MTOM.

JavaHome
This property specifies the JDK to use when compiling generated code. sThe
default is to use the java.home system property, which resolves to the JDK that is
being used by the application server JVM.
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To modify configuration properties that are specific to a generated Web service,

navigate to the folder for that service. Then navigate to the Advanced tab within the
Properties dialog box.

f=; 5A5 Management Console - SASAdmin _ (O] x|
File Edt Wew Tools Help

addintegersws Properties
EEIEY RS

Plug-ins | Folders |

General | Connection | keywords Advanced | authorization |

Property Name | Froperty Walue |

Repository: ||| Foundation

[ Resource Templates Define New Property
[#--[7] Metadata Utilties
¥ G5 Publishing Framewark.
@ Schedule Manager
2 [ Server Manager Property talue: |
5 shshleta
-5 ShShpp

Property Hame: |

=
3 Object Spawner - 12833
@ [ 545 Content Server
& User Manager

£ [T Monitaring

[ Maintenance

(=[] Application Managsment.

[ 888 Configuration Manager

#1- BI Rep Svc Whspace Canfig 4.
=J-- ] BI Web Services for Java 9.2
(5 4y, webServiceMaker
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<[] Help Wiswser Meta Config 9.2
[ Logon Manager 9.2

-5 Preferences Manager 9.2

[ 55 Application Infrastructure
[ sAsTheme_default

- Stored Process Web fpp 9.2
[ web Administration Console 9.

#- =] Web Infra Platform Services 9 Add Remove
4 |
| ok | comed | e |

-

In this example, addintegerswWs is the Web service that is being modified.
The following advanced configuration properties are available:

AcceptSysccList
See Acceptable SYSCC List. This property overrides its analogous common
configuration property.

DynamicPromptsSupport

See Enable dynamic prompts validation. This property overrides its analogous
common configuration property.

MaxSTPExecTime
See SAS Stored Process timeout. This property overrides its analogous common
configuration property.

Changes to properties do not take effect immediately. To apply these changes,
perform one of the following tasks:

o0 Either stop and restart the application server, or stop and restart the SAS BI Web
Services for Java Web application (sas.wip.services9.2.ear).

o Use a Java Management Extensions (JMX) console to communicate with the
com.sas.svcs:service=biws, type=ConfigMBean management bean.

The following image shows the use of the JMX console bundled with the JDK to

reload the configuration metadata into a running SAS BI Web Services for Java
application:
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£ 12SE 5.0 Monitoring & Management Console: localhost:7503
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Overview of Security for Web Services

A default installation of SAS BI Web Services for Java or .NET is not highly secure.
The default security mechanism is SAS authentication. All requests and responses are
sent as clear-Text. If users want to authenticate as a specific user, then they can send a
user name and password as clear-Text as part of the WS-Security headers.
Authentication is performed by authenticating client credentials at the SAS Metadata
Server. Whenever user names and passwords must be sent as clear-Text, SSL should be
enabled to provide transport layer security.

If you want to use SSL and the Deploy as Web Service Wizard to communicate with a
server, then you need to enable SSL. In order to enable SSL, follow these steps:

1 Create a Java keystore on the local machine and import the server certificate of
the server that you want to communicate with. For more information about how to
perform this step, see http://java.sun.com/j2se/1.5.0/docs/tooldocs/
windows/keytool.html.

2 Pass the keystore location and password into SAS Management Console using
Java JVM arguments. The arguments that need to be set are:

javax.net.ssl.trustStore=
"fully qualified path to keystore created with keytool from step 1"
javax.net.ssl.trustStorePassword=

"trust store password"

To complete this step, add the following JavaArgs arguments to the sasmc.ini
file, which is found at C: /Program Files/SAS/SASManagementConsole/9.2:

JavaArgs_l4=-Djavax.net.ssl.trustStore =

"fully qualified path to keystore created with keytool from step 1"
JavaArgs_l5=-Djavax.net.ssl.trustStorePassword =

"trust store password"


http://java.sun.com/j2se/1.5.0/docs/tooldocs/windows/keytool.html
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If you are using XMLA Web services or generated Web services, an anonymous user
can be configured. The anonymous Web user is configured during SAS Deployment
Wizard configuration. Anonymous users cannot use the Web Service Maker; credentials
must always be provided to use the Web Service Maker. If you are using XMLA Web
services, you can pass user credentials as XMLA properties in the payload.

SAS BI Web Services can be secured by using Web authentication. This provides a
way for SAS BI Web Services to identify the calling user by using basic Web
authentication. The following two types of Web authentication can be configured:

0 WS-Security message-level security
o HTTP transport-level security

Note: Web authentication can be used with both XMLA Web services and generated
Web services but cannot be used with the Web Service Maker Web service. The Web
Service Maker must be able to authenticate one-time-passwords that are generated by
SAS Management Console clients. A

SAS BI Web Services for .NET can be secured by using Web Services Enhancements
3.0 for Microsoft .NET, which enables support for the latest security and
interoperability standards for Web services. For detailed information about using Web
Services Enhancements 3.0, WS-Security, and WS-Policy to secure SAS BI Web
Services, see “Securing SAS BI Web Services for NET” on page 148. The current
release of SAS BI Web Services for Java does not support WS-Policy.

Securing SAS Bl Web Services for .NET

If you choose to enable the anonymous user during SAS Deployment Wizard
configuration, SAS BI Web Services for .NET is configured with a default user to use for
clients who do not provide credentials when calling generated Web services. This is not
highly secure because it allows anyone to call your generated Web services. You can
change the default credentials to be a different user, to use SSPI, or you can remove the
default credentials to disable anonymous access. These credentials are stored in the file
pointed to by the SystemMetadataFile setting in your Web.config file. You can use this
anonymous user technique only when SAS BI Web Services for .NET is configured in
Host (SAS) authentication mode. When in Trusted (Web) authentication mode, the
trusted user’s credentials should be stored in the SystemMetadataFile.

Web Services Enhancements for Microsoft .NET (WSE) is a Microsoft add-on to .NET
that implements advanced Web services specifications, such as WS-Security. SAS BI
Web Services for .NET is secured with WSE by default in 9.2 using UsernameToken
authentication in clear text. Additional security measures can be configured by
performing the following tasks:

0 modifying the wse3policycache.config policy file that indicates the security policy
required by SAS BI Web Services to enable more advanced forms of security
including Kerberos, X.509, and encryption

0 modifying client applications to use WSE, and to also use a security policy that
matches the Web service

You need to modify the GeneratedServicesPolicy WSE policy in the
wse3policycache.config file to enable these advanced options. For information, see
http://msdn.microsoft.com/en-us/library/aa480582.aspx.

Note: Use caution when using the Microsoft WSE Configuration Tool
(WseConfigEditor.exe) to edit a SAS BI Web Services for .NET configuration. The WSE
Configuration Tool does not support custom policy assertions and using the tool
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completely removes them. Instead, edit the wse3policyCache.config file manually and
add the desired security elements to the existent SAS configuration. 2

Securing SAS Bl Web Services for Java

SAS Authentication

The default security configuration out-of-the box for SAS BI Web Services for Java is
SAS authentication. In this mode the Web application server does not perform any
authentication on behalf of the application. Instead, SAS BI Web Services for Java
authenticates client credentials against the configured SAS Metadata Server. Client
credentials are obtained by one of the following ways (in this order):

1 Use credentials that are passed in the UsernameToken WS-Security SOAP header.

2 Use credentials that are passed in the payload as properties (XMLA only).

3 Use anonymous credentials that are configured with the Webanon SAS metadata
login account (XMLA and generated Web services).

Typically, the WebServiceMaker service is invoked via the Deploy As Web Service
wizard in SAS Management Console. Therefore, this service must be able to process
SAS one-time passwords. For this reason the WebServiceMaker service functions only
in SAS authentication mode.

Web Authentication

Overview of Web Authentication

Alternatively to SAS authentication, the application server can be configured to
perform the authentication on behalf of the SAS BI Web Services for Java application.
This is known as Web authentication. To configure Web authentication for XMLA Web
services and generated Web services, select the Custom prompting level in the SAS
Deployment Wizard and choose Web authentication during configuration. By default,
when Web authentication is configured, WS-Security constraints are applied to the
XMLA Web service as well as to generated Web services. However, transport-level
security can be configured instead of message-level security (WS-Security) if desired.
The following information describes the manual configuration steps that are necessary
to enable Web authentication.

Message-level Security

By default, WS-Security security constraints are automatically configured when Web
authentication is configured. In this case, Rampart security is engaged and configured
in the services.xml deployment descriptor as follows:

<module ref="rampart"/>
<parameter name="InflowSecurity">
<action>
<items>UsernameToken</items>
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<passwordCallbackClass>
com.sas.web.services.axis2.PwcbHandler
</passwordCallbackClass>
</action>

</parameter>

For more information about Axis2/Rampart configuration, see http://ws.apache.org/
axis2/.

Currently, the Rampart security module is configured to require a Username Token.
The Rampart module parses the Username Token credentials. Ultimately, the
implementation consumes these credentials and uses them to programmatically invoke
the application server’s authentication provider configured for the current security
realm, thereby allowing seamless integration into the container’s security subsystem.
The following list shows how this authentication is accomplished for the different Web
containers:

JBoss Uses the org.jboss.web.tomcat.login.WebAuthentication class to
integrate with Java Authentication and Authorization Service
(JAAS).

IBM WebSphere Invokes WSLogin JAAS login configuration. To invoke a different
JAAS login configuration, set the JAASLoginConfigName SAS BI
Web Services for Java configuration property.

Oracle WebLogic Uses the weblogic.security.services.Authentication class to integrate
with JAAS.

Transport-level Security

HTTP transport-level security can be used instead of message-level security. Any
message-level security constraints previously enabled must be disabled in order to use
transport-level security. To disable generated Web services from automatically being
configured with WS-Security constraints, you should set the
AddWSSecurityAuthConstraint WebServiceMaker-specific configuration property to
false.

The following security constraints should be applied to the web.xml deployment
descriptor (sas.biws.war module with the sas.wip.services9.2.ear application) as follows:

<security-constraint>

<web-resource-collection>
<web-resource-name>All-resources</web-resource-name>
<url-pattern>/services/XMLA/*</url-pattern>
<url-pattern>/services/generatedWebServiceName/*</url-pattern>
<http-method>GET</http-method>
<http-method>POST</http-method>

</web-resource-collection>

<auth-constraint>
<role-name>SASWebUser</role-name>
</auth-constraint>
</security-constraint>

<login-config>
<auth-method>BASIC</auth-method>

</login-config>

<security-role>
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<role-name>SASWebUser</role-name>
</security-role>

The URL patterns in this code should include all of the Web services that should be
secured by the HTTP transport. Notice that the WebServiceMaker service is not one of
them because it must be configured for SAS authentication. Also, notice that the
secured Web services must be invoked by a client that is in the SASWebUser role.

Update the JBoss Application Server Configuration

The name of the security domain is configured in the jboss-web.xml deployment
descriptor. You must use this same name when creating a JAAS login configuration for
this security domain. If for example the security domain name is
SASApplicationLogin, your jboss-web.xml deployment descriptor contains the
following:

<jboss-web>
<security-domain>java:/jaas/SASApplicationLogin</security-domain>
</jboss-web>

The JAAS configuration file located in your server configuration (JBoss_Home/Server/
SASServerl/conf/login-config.xml) looks like the following code:

<application-policy name="SASApplicationLogin">
<authentication>
<!-- place site-specific login modules here -->
<login-module
code="com.sas.services.security.login.TrustedLoginModule"
flag="optional">
<module-option name="host">SAS-metadata-serve-host</module-option>
<module-option name="port">8561</module-option>
<module-option name="domain">web</module-option>
<module-option name="aliasdomain">DefaultAuth</module-option>
<module-option name="trusteduser">sastrust@saspw</module-option>
<module-option name="trustedpw">encoded-password</module-option>
</login-module>
</authentication>
</application>

You should add any site-specific login modules to the configuration. For example, if
you want to use the UsersRolesLoginModule JBoss login module to authenticate users
against a text file, follow these steps:

1 Add user names and passwords to the JBOSS_HOME/server/SASServerl/conf/
props/sas-users.properties file. Format of this file is as follows:
username=password.

2 Add user names and role to the JBOSS_HOME/server/SASServerl/conf/props/
sas-roles.properties file. Format of this file is as follows: username=SASWebUser.

3 Add the following login module to the SASApplicationLogin JAAS login
configuration:

<login-module
code="org.jboss.security.auth.spi.UsersRolesLoginModule"
flag="required">
<module-option name="usersProperties">
props/sas-users.properties
</module-option>
<module-option name="rolesProperties">
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props/sas-roles.properties
</module-option>
<module-option name="unauthenticatedIdentity">
Anonymous
</module-option>
</login-module>

Update the WebSphere Application Server Configuration

The type of security that is configured determines the JAAS login configuration that
is enabled. For example, if message-level security (WS-Security) is configured, then the
WSLogin JAAS login configuration (or the JAAS login configuration overridden with the
JAASLoginConfigName property) is enabled. Otherwise, if transport-level security is
configured, then the WEB_INBOUND JAAS login configuration is enabled.

After you have determined what JAAS login configuration is active for your
particular environment, use the administration console to add the SAS trusted login
module to that configuration. Follow these steps:

1 Navigate to Security » Security administration, applications, and
infrastructure » Java Authentication and Authorization Service. Select
Application logins or System logins depending on the configuration that you
need to modify. Select the JAAS configuration that you need to modify, and then
select JAAS login modules.

2 Click New and enter the following information:

Module class name: com.sas.services.security.login.websphere.WSTrustedLoginModule
Authentication strategy: OPTIONAL

Click oxk.
3 Click the custom Properties link and enter the following name/value pairs:

host: SAS-metadata-server-host

port: 8561

domain: web

aliasdomain: DefaultAuth

trusteduser: sastrust@saspw

trustedpw: encoded-password-for-sastrust

where encoded-password-for-sastrust is an encoded password that can be obtained
from the SAS administrator. For more information about encoding passwords, see
SAS Intelligence Platform: Security Administration Guide.

In order for the SAS trusted login module to be loaded successfully by the WebSphere
run-time application class loader during authentication, the following SAS JAR files
need to be copied from the SAS Versioned Jar Repository to WAS_HOME/lib/ext:

sas.

sas

sas.

sas

sas.

sas

core.jar

.oma.omi.jar

svc.connection. jar

.svc.sec.login. jar

svc.sec.login.websphere. jar

.security.sspi.jar

Lastly, configure the user account repository from which to authenticate against.
Using the administration console, follow these steps:

1 Navigate to Security » Secure administration, applications, and
infrastructure.

2 In the User account repository, select from the available realm definitions (such as
Local operation system) and configure it and set it as the current realm definition.
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Additionally, if transport-level security is configured, then map the SASWebUser role
to all authenticated users. Use the administration console to enable this mapping as

follows:

1 Navigate to Enterprise Applications » SAS Web Infrastructure Platform
Services » Security role to user/group mappings.

2 Select A1l authenticated for the SASWebUser role.

Update the WebLogic Application Server Configuration

Install and configure the Authentication Provider for your security realm. Follow
these steps:

1 Copy the following SAS JAR files from the SAS Versioned Jar Repository to
BEA_HOME/weblogic92/server/lib/mbeantypes. These JAR files enable you to add
and configure the SAS trusted login module to the list of authenticated providers
for a given security realm.

sas.svc.sec.login.weblogic. .mbean. jar

sas.svc.sec.login.weblogic.mbean.nls.jar

2 Copy the following SAS JAR files from the SAS Versioned Jar Repository to
BEA_HOME/weblogic92/server/lib/mbeantypes. These JAR files need to be
available to the SAS trusted login module at run time.

sas.svc.sec.login.weblogic.jar

sas.svc.sec.login.weblogic.nls. jar

sas.svc.sec.login. jar

sas.svc.sec.login.nls.jar

sas.svc.connection.jar

sas.oma.omi.jar

sas.core.jar

sas.security.sspi.jar

3 Start the administrating server and then connect to it as follows:

http://host:port/console

a
b

Navigate to Security Realms, and then to your Realm.

Select the Providers tab and then select Authentication within that
grouping. Typically, you see the configured default authenticator providers:
DefaultAuthenticator, DefaultldentifyAsserter.

Click New to add the SAS trusted login module to the chain of providers.
Enter the following information:

Name: SASTrustedAuthenticator
Type: WLTrustedAuthenticator

Click on the newly created provider and enter the following information:

Common information:

Control Flag: OPTIONAL
Provider Specific information:

Host: SAS-metadata-server-host
Domain: web
Port: 8561
Encrypt: false
Trusted User: sastrust@saspw
Trusted Password: encoded-password-for-sastrust
Debug: false
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where encoded-password-for-sastrust is an encoded password that can be
obtained from the SAS administrator. For more information about encoding
passwords, see the SAS Intelligence Platform: Security Administration Guide.
e Click save and Activate changes.
f Restart the administration server.

4 Configure user information for the authentication provider. For example, if you
are using the DefaultAuthenticator provider, you need to configure the internal
WebLogic LDAP server with user and password information.

Navigate to Security Realms, select your Realm, and then select Users and
Groups. Then click New to enter users.

Additionally, if transport-level security is configured, then map the SASWebUser role
to individual authenticated users. You can perform this action using the administration
console or you can modify the weblogic.xml deploy descriptor as follows:

<security-role-assignment>
<role-name>SASWebUser</role-name>
<principal-name>username</principal-name>

</security-role-assignment>

Update Remote Services Files

Modify the JAAS login configuration at the following location: SAS-config-dir/lev1/
web/common/login.config. The following code is an example of what this configuration
might look like:

PFS {
com.sas.services.security.login.OMILoginModule required

"host"="SAS metadata server host"
"port"="8561"
"repository"="Foundation"
"domain"="DefaultAuth"
"aliasdomain"="web"
"trusteduser"="sastrust@saspw"
"trustedpw"="encoded password for sastrust"
"debug"="false";

}i

Modify the remote services script, the wrapper.conf file, or both to add the following
JAR files to the SAS application classpath (-Dsas.app.class.path) so that application
server-specific JAAS principle and credential classes are available:

JBoss

JBOSS_HOME/Server/SASServerl/lib/jbosssx.jar

WebSphere

WAS_HOME/lib/bootstrap.jar

WAS_HOME/lib/j2ee.jar
WAS_HOME/plugins/com.ibm.ws.runtime 6.1.0.jar
WAS_HOME/plugins/com.ibm.ws.emf 2.1.0.jar
WAS_HOME/plugins/org.eclipse.emf.ecore 2.2.1.v200609210005. jar
WAS_HOME/plugins/org.eclipse.emf.common 2.2.1.v200609210005. jar

WebLogic
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WLS_HOME/server/lib/wls-ap.jar

Additional Administrative Tasks for SAS Bl Weh Services for Java

Enabling Java2 Security

Enabling Java2 Security is not recommended due to significant degradation in
performance. However, if you must enable Java2 Security, then you should familiarize
yourself with how the Axis2 engine loads Web services.

For example, when the Axis2 engine deploys a Web service, it explodes the service
archive in a temporary directory designated by the application server’s JVM and loads
service classes using its own URL class loader. This is important to WebSphere
administrators because they might think that codeBase permissions can be added to the
was.policy file for Axis2 Web service classes. This does not work because classes that
are not loaded by the WebSphere WAR class loader are not part of that protection
domain. In this case, codeBase permissions regarding these service classes must be
placed in a protection domain that covers these classes. A WebSphere administrator
can use the app.policy file because it covers all classes in the cell, or the administrator
can use the JVM java.policy file because it covers all classes in the JVM.

Running Exploded in the WebLogic Application Server

In order to support hot deployment, Axis2 requires the archive
(sas.wip.services9.2.ear) to be deployed in exploded format. Because the WebLogic
deployer does not automatically explode its archives like other containers do, the SAS
Deployment Wizard manually performs this operation during configuration processing.

Hot deployment enables SAS BI Web Services for Java to dynamically generate new
Web services and make them immediately available for consumption without having to
stop and restart the server. Axis2 hot deployment is enabled by default. To configure
SAS BI Web Services for Java in this manner, see the Deployment method configuration
property for more details.

Java Development Kit (JDK) Requirement

Because SAS BI Web Services for Java must compile generated code while running in
the application server, it requires access to a JDK at run time. Therefore, a Java
Runtime Environment (JRE) is not sufficient. Normally, the application server is
executed with a JDK and as a result SAS BI Web Services for Java has access to that
JDK. However, in rare circumstances when the application server is executed with a
JRE instead, it is necessary to configure SAS BI Web Services for Java to use a
different JDK. For more information, see the JavaHome advanced SAS BI Web Services
for Java configuration property.

Setting Up Clustering

Clustering is not automatically enabled for SAS BI Web Services for Java because
hot deployment is not supported in this type of configuration. A more likely scenario is
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to install SAS BI Web Services for Java in a non-clustered environment to develop new
Web services. After these new Web services have been iteratively tested, modified, and
retested, they can be promoted to a system that is can be clustered. Because all SAS BI
Web Services for Web services that are generated by Java are stateless, no additional
Axis2-specific clustering needs to be configured other than making the Web services
available to all nodes in the cluster. This can be accomplished in one of the following
ways:

0 Duplicate the Web services (and modules) in the Axis2 repository on each node.

0 Use an Axis2 URL-based repository so that Web services (and modules) can be
configured in a central location. To configure a central repository for Axis2, follow
these steps:

1 In the Axis2 configuration file (sas.biws.war/WEB-INF/conf/axis2.xml),
comment out the following configuration parameters:

<parameter name="ServicesDirectory">...</parameter>
<parameter name="ModulesDirectory">...</parameter>

2 In the Web application deployment descriptor file (sas.biws.war/WEB-INF/
web.xml), specify the axis2.repository.url AxisServlet initialization parameter
as follows:

<servlet>

<servlet-name>AxisServlet</servlet-name>

<init-param>
<param-name>axis2.repository.url</param-name>
<param-value>http://host:port/axis2repos/</param-value>
</init-param>
</servlet>

where axis2repos is a reachable path on a Web server that has been set up.

3 In this example, a new Web application is created with a context root of
axis2repos. This application contains the Axis2 static services (and modules)
configuration data that needs to be accessible from the previous step. The
following illustrates the layout of the application:

axis2repos.war/

modules/
addressing.mar
rahas.mar
rampart.mar
sas.biws.security.mar
modules.list

services/
myServicel.aar
myService2.aar

services.list

The modules.list file specifies the names of the modules in that directory.
For example, it contains the following content:

addressing.mar
rahas.mar

rampart.mar
sas.biws.security.mar
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The services.list file specifies the names of the services in that directory.
For example, it contains the following content:

myServicel.aar
myService2.aar

4 After the static files (services and modules) described in the previous step are
accessible, clustered instances of SAS BI Web Services for Java
(sas.wip.services9.2.ear/sas.biws.war) application can access them from this
central location.

For more information about clustering applications in your particular environment,
see the application server-specific documentation.

Enabling Application Scope

Web services are generated with the default request session scope. This enables
clients to generate a Web service, remove that Web service, and regenerate that same
Web service after making changes to it without having to worry about old classes that
Axis2 might have cached. However, when a Web service is created with application
session scope, the service’s class is never unloaded even if the service is deleted or
removed. In order to avoid this problem, new Web services are generated with request
session scope so that a service’s class is loaded on each request and classes are not
cached. However, after a service is stabilized and is not changing, you might want to
manually change the service’s session scope to application to gain performance
throughput. For example, you might change the service.xml deployment descriptor as
follows:

<serviceGroup>

<service name="myService" scope="application">

</service>
</serviceGroup>

Using the Deploy As Web Service Wizard to Overwrite an Existing Web
Service

When deploying a Web service with a name that already exists, the user is asked if
the original Web service should be overwritten. In this case, the user should cancel this
request and instead, delete the original Web service as a separate operation. Choosing
to overwrite the existing Web service might not yield expected results if hot update is
not enabled, because the Axis2 engine might not detect that the original Web service
was actually deleted. The Axis2 engine assumes that hot update is being requested, not
hot deployment. The Axis2 engine reads the repository contents every 10 seconds for
any changes to its state.

Note: It is not recommended to enable hot update in a production environment
because it could result in the system leading to an unknown state. A
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Introduction to SAS Web Application Themes

SAS Web Application Themes provide a way to define a consistent look and feel
across SAS Web applications. You can use themes to apply uniform visual
customizations and company branding to all SAS Web applications that support the
theme infrastructure. A typical custom theme might include a banner with a standard
corporate color scheme and company logo, a navigation bar with colors that coordinate
with the banner, and new colors for borders and title bars.

Theme Components

A theme is a collection of resources that control the appearance of a SAS Web
application. The following figure shows the components of a theme:

Figure 12.1 Components of a Theme
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Here is an explanation of each theme component:

theme templates
are HTML fragments that render specific portions of pages in SAS Web
applications. The templates contain dynamic substitution variables of the form
%VARIABLE-NAME that are replaced by application-specific values when the
templates are used in SAS Web applications.

cascading style sheets
determine the colors, fonts, backgrounds, alignment, and spacing for page elements
in SAS Web applications. A cascading style sheet (CSS) is a standard mechanism
for defining consistent and reusable presentation for Web-based content.

theme descriptors
are XML files that describe the style sheets, templates, and images that make up
a theme.

images
include graphics for icons, a company logo, and banner and page backgrounds. You
can incorporate your own customized graphics files as part of a new theme. Images
can be in any format supported in the browser, including GIF, PNG, and JPEG.
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Note: The application title that appears in the banner of the SAS Web application is
not part of the theme. You also cannot use themes to change the application name that
appears in the title bar of the browser window. A

The SAS Default Theme

The initial theme that is installed with the theme infrastructure is named Default.
This theme is typically used as the basis for creating new themes, so you should
understand its structure before you attempt to create a custom theme. Specifications
for the Default theme are provided in SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\specs\Default\index.html.

How Custom Themes Are Created and Deployed

The SAS-configuration-directory\Levl\\Web\Utilities\SASThemeExtensions
directory contains the scripts and resources needed to create a new theme:

O The NewTheme script creates a directory structure for your new theme, and
populates it with configuration files that are modified to create a new theme
definition. The new theme is based on the SAS default theme that ships with the
software.

0 The specs directory provides documentation for the general color palette and color
and image guidelines that are specific to each user interface component. This
document is useful when you are designing and defining your custom theme.

Developing a custom theme involves creating CSS files, image files, theme template
files, and theme descriptor files. It is possible to create a new theme by authoring these
files from scratch, but the task is laborious and requires a thorough understanding of
Web page design. The theme infrastructure provides a templating mechanism to
simplify the process.

Instead of editing CSS and theme descriptor files directly, template files (extension
.vtl) are provided that contain key/value pairs that isolate the elements of the theme
that you are likely to want to customize. In addition, context files (extension .vctxt)
enable you to create a centralized set of definitions for key values that you can use in
place of explicit values to simplify the process of maintaining the template files. When
you use the SAS Deployment Manager to rebuild the SAS Web Application Themes, the
context files are merged into the template files to create a complete set of shared and
product-specific style sheets and theme descriptors. The build process also packages
your new theme into the sas.themes.ear archive file that you deploy to make themes
available in your production environment.

Once the theme archive is deployed, users can use the Preferences page in their SAS
Web application to apply the new theme (or any of the other themes in the archive).
You can also specify the custom theme as the default for all SAS Web applications. This
means that the theme is applied automatically for users who do not made a selection on
the Preferences page.

Note: Previously, SAS Web Report Studio 3.1 used product-specific branding.
Product-specific branding is not available for SAS Web Report Studio 4.3. Use themes
to create branding in SAS Web Report Studio 4.3. A few properties for branding that
existed in SAS WebReport Studio 3.1 are supported in SAS Web Report Studio 4.3. For
information about these properties and usage, see “Customizing Report Styles for SAS
Web Report Studio” on page 239. A
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Steps for Defining and Deploying a New Theme

Overview

SAS provides a default theme for your use. You also have the choice of designing and
deploying a custom theme for your environment.
To develop and deploy a new theme, follow these steps:

1 Design the theme. See “Step 1: Design the Theme” on page 162.

2 Create a work area for the theme. See “Step 2: Create a Work Area for the
Theme” on page 163.

3 Make desired changes to the styles, graphics, and theme templates. See “Step 3:
Make Desired Changes to the Styles, Graphics, and Theme Templates” on page
167.

4 Register the theme in metadata. See “Step 4: Rebuild SAS Web Application
Themes” on page 169.

5 Rebuild SAS Web Application Themes and deploy in your test environment. See
“Step 5: Deploy SAS Web Application Themes in Your Test Environment” on page
170.

6 Test the new theme in a test environment. See “Step 6: Test the New Theme” on
page 170.

7 Move the new theme from test to production environment. See “Step 7: Move the
New Theme from Test to Production Environment” on page 170.

8 Assign the default theme. See “Step 8: Assign the Default Theme” on page 171.

Note: You might choose to perform steps 3 through 6 iteratively, making limited
changes to the theme during each iteration, so that you can more readily determine the
effects of each set of changes to the theme. To deploy multiple themes in your
environment, follow steps 1 to 6 to design and create your themes. Then follow step 7 to
move each theme from test to production environment. A

You can deploy multiple themes in your corporate environment. Before deploying the
new theme in a production environment, you should first test it in a test environment
to ensure that SAS Web applications function as expected with the new theme applied.

Step 1: Design the Theme

The first step in creating a custom theme is to plan the visual elements. Usually the
new theme is based on an existing design, your organization’s intranet standards,
another in-house written application, or a purchased application or solution. Some
organizations have a standard color palette with color specifications.

Review the specifications for the Default theme at SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\specs\Default\index.html,
and identify the component keys and image keys for the visual elements that you want
to change in the new theme. Establish a set of colors that are compatible with your
organization, and choose the images (for example, logos, banner images) you want to
use in the new theme.

Generally, you can make the largest impact by updating the background colors,
border colors, and text attributes for Web application pages and SAS Information
Delivery Portal portlets. In addition, you might want to replace the SAS logo in the
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banner with our own organization’s logo. If you select a different color palette, consider
that you might need to adjust the colors in images to match the new palette.

The Color Palette page at SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\specs\Default\html\
colorPalette.html lists all 55 color keys of the default theme and specifies the
default hexadecimal color value for each color key. It also provides links to
documentation on each user interface element where the color is applied.

Options in Designing the Theme

When you create a new theme, there are three ways to define your theme:

0 Use the Color Palette and replace the 55 default SAS colors with your
organization’s palette. The colors are applied automatically across the user
interface.

0 Specify the color to be used for each interface component. You must specify the
color for each context key of the user interface component. This approach takes
more time, but it provides maximum flexibility and control.

0 Start with the Color Palette, and make individual changes to selected user
interface components. This approach overrides how the color palette is applied in
some cases.

If you choose to set colors for the context key of each user interface component, the
Web pages at SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\specs\Default\index.html
provide tools and resources to assist you with this process.

Step 2: Create a Work Area for the Theme

To create a work area that contains a copy of the Default theme as a basis for your
new theme, use one of the following scripts provided in the
SAS-configuration-directory\Levl\Web\Utilities\SASThemeExtensions directory:

o for Windows:

NewTheme.bat theme-name true
o for UNIX:

NewTheme.sh theme-name true
o for z/OS:

NewTheme.sh theme-name true

Beginning with the third maintenance release for SAS 9.2, the NewTheme. sh script is
available for z/OS.
To use the Color Palette option, the true parameter is required in the command.

Note: The theme name must not contain spaces. A

The following figure shows the theme-name directory, which is the root directory for
theme resources. The \theme-name\MetadataTools directory contains SAS programs
for managing the theme. The Velocity directory contains several subdirectories with
files.
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Figure 12.2 Subdirectories within SASThemeExtensions Directory
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The following figure shows the subdirectory structure that is created under the SAS-
configuration-directory\Levl\Web\Utilities\SASThemeExtensions\themes\theme-
name\themes\theme-name directory.
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Figure 12.3 Subdirectories for Images, Styles, and Templates
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Here is an explanation of the folders and their contents:

\theme-name\themes\theme-name\images
contains the standard collection of images for SAS Web applications that use the
theme infrastructure. The images are divided into the following subdirectories by

category:

Common contains images that are commonly used in SAS Web
applications.

Components contains images for the collection of components (widgets) that
are shared by SAS Web applications.

WRS contains images for SAS Web Report Studio.

\theme-name\themes\theme-name\styles
contains a cascading style sheet file named custom.css that can be used to define
additional style elements for the theme. This file is empty when the work area is
created.

\theme-name\themes\theme-name\templates
contains theme templates, which are HTML fragments that render specific
portions of pages in SAS Web applications. The template files are divided into the
following subdirectories by category:

Common contains theme templates for page elements that are commonly
used in SAS Web applications.
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Components contains theme templates for the collection of components that
are shared by SAS Web applications.

WRS contains theme templates for elements in SAS Web Report
Studio pages.

The following figure shows the subdirectories below the SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\themes\theme-name\Velocity
directory.

Figure 12.4 Subdirectories within the Velocity Directory
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Here is an explanation of the contents of the directories:

\theme-name\Velocity\Stylesheets\_shared\contexts\themes
contains a context file named theme-name.vctxt that defines context values for
font families and standard colors that can be used in CSS templates.

\theme-name\Velocity\Stylesheets\Common\contexts\themes\theme-name
contains CSS template files that are used to build style sheets for page elements
that are commonly used in SAS Web applications, including
portal.theme-name.vtl, sasStyle.theme-name.vtl, and
sasScorecard.theme-name.vtl.

\theme-name\Velocity\Stylesheets\Components\contexts\themes\theme-name
contains a CSS template file named components.theme-name.vtl that is used to

build style sheets for the collection of components that are shared by SAS Web
applications.
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\theme-name\Velocity\Stylesheets\WRS\contexts\themes\theme-name
contains a CSS template file named wrs.theme-name.vtl that is used to build
style sheets for SAS Web Report Studio.

\theme-name\Velocity\ThemeDescriptors\contexts
contains a context file named theme-name.themeDescriptor.vctxt that defines
context values that can be used in theme descriptor templates.

\theme-name\Velocity\ThemeDescriptors\contexts\custom\theme-name
contains theme descriptor template files for building the XML files that define the
available collections of style sheets, theme templates, and images, including
ComponentsThemes.vtl, CustomThemes.vtl, SASThemes.vtl,
SolutionsThemes.vtl, and WRSThemes.vtl.

If you were to build the new theme at this point, it would be a fully functional
duplicate of the Default theme.

Step 3: Make Desired Changes to the Styles, Graphics, and Theme
Templates

Changing Colors

To make style changes to specific page features, you must first identify the
component key associated with that feature and then locate the CSS template file that
sets the value for that key. For example, suppose your new theme design calls for
changing the color for the title text in the banner at the top of SAS Web applications.
The Banner specifications at the Themes Web site SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\specs\Default\Components\

html\Banner.html show that the context key for the title text is
Banner Title_ Text_ Color and it displays its context value.

«Contents | Default Theme: Banner
& Component Keys | ¢~ Image Keys

Component Keys

4Portal 4 Document Manager
1] . .
Title - Secondary Title

I
2 3 4 s W

Callout # Context Key Context Value Hex Color Color Chip
1 Banner_Background_Color ${Colora4} #3bscch
2 Barner_Title_Test_Color $iCalor24} #IS7f9
3 Banner_Title_Separator_Color ${Color 35} #aZheda
4 Banner_SecondaryTitle_Text_Color ${Calora4} #iSf7fg
s Banner_UtlityBar_Background _Color ${Color49} #003399 _
6 Banner_UtlityBar_UserRole_Text_Color ${Color 14} f#roeeee
7 Banner_UtiityBar_Navigation_Links_Text_Color  ${Color24} #iSf7F9
8 Banner_UtlityBar_Menu_Text_Color ${Color 35} #aZheda
g Banner_Divider_Background_color ${Colors} | #e9e0e7
10 Banner_Divider_Border_Bottorm_Color ${Color 15} #COCE08

Each Themes Web page displays the context keys and context values.
You can specify a new color explicitly, as follows:

Banner Title Text Color=#e69b00

Because components.theme-name.vtl is a CSS template file, another option is to
use the generic color values that are defined in the theme-name.vectxt file in the
\Velocity\Stylesheets\_ shared\contexts\themes subdirectory of the work area
for the new theme. For example, you might specify the following value instead of an
explicit value:
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Banner Title Text Color=${Color53}

The corresponding color value is substituted in the resulting CSS when the new theme
is built.

The general form for using a context value in a template file is
$ {context-value-name}. Using context values instead of explicit values can make it
easier to maintain the theme because you can change all component keys that use a
given value by making one change to the context file.

Changing Graphics

Image files are located in three subdirectories located in the SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\specs\Default folder. These
subfolders are: Common, Components, and WRS. The properties of each image are defined
in the Theme Descriptors files.

The process for customizing images is similar to that for customizing styles. For
example, suppose your new theme design calls for changing the background image for
the banner at the top of SAS Web applications. A review of the Banner specifications at
SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\specs\Default\index.html
shows that the image key for the banner background is banner_ background. A search
for that string in the work area for the new theme shows the following IMAGE element
in the components.theme-name.vtl file in the
Velocity\ThemeDescriptors\custom\theme-name subdirectory of the work area:

<Image name="banner_ background" ... file="BannerBackground.gif"/>

You can change the image used for the banner background image in either of the
following ways:

0 by replacing the existing BannerBackground.gif file in the
themes\theme-name\images\Components subdirectory of the work area with a
revised image with the same name. Make sure that the new image has the
following criteria:

O The filename of the new graphic is identical to the filename of the graphic
being replaced.

0 The new graphic is in the same format as the original image (for example,
.Jjpg or .gif).

0 The dimensions of the new graphic and its pixels are same as the graphic
being replaced.

If you need to change the size, filename, or the image format of the graphic,
modify the theme descriptor. For example, if you replace the logo.gif file with a
new file called myLogo.jpg that has a width of 300 pixels and height of 70 pixels,
modify the ComponentsThemes.vtl file as follows:
<Image name="logo" description="My Logo" altTextKey="desktop.logo.text"
appliesTo="ALL" width="300" height="70" file="myLogo.Jjpg"/>

0 by changing the FILE= attribute in the IMAGE element in the
components .theme-name.vtl context file to point to a different image file.

Note: You should not change the value of the NAME= attribute in the IMAGE
element. SAS Web applications depend on the NAME= attributes remaining
constant. A

Another common image change is to replace the SAS logo in the standard banner
with your organization’s logo. You can change the graphic used for the banner logo
either by replacing the existing logo.gif file in the
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themes\theme-name\images\Components subdirectory of the work area with a copy of
your logo with that filename or by changing the target of the FILE= attribute for the
IMAGE element in the components.theme-name.vtl context file for which the NAME=
attribute has the value logo.

When customizing images, you should ensure that the replacement graphics have
approximately the same dimensions as the original graphics. Otherwise, the images
might disrupt the appearance of the applications in which they are used.

Changing Theme Templates

You should make changes to theme templates only in situations where you want to
change the layout of a page element (for example, to tweak the logo’s placement in the
banner or to adjust the padding between rows in a menu). If you decide to alter a
theme template, proceed with caution. SAS Web applications rely on the template
structure being consistent with the versions that are shipped with the software.
Improper changes to theme templates might prevent SAS Web applications from
functioning properly. In particular, do not change the dynamic substitution variables in
theme templates because SAS Web applications expect the existing values.

Dynamic substitution variables should not be changed in theme templates because
SAS Web applications expect the existing values. However, if you need to change a
dynamic substitution variable, here is an example where #BANNER_TITLE is the
dynamic substitution variable:

<td nowrap id=''bantitle’’ class="banner_ title">%BANNER_TITLE</td>

Note: When a new release of themes is installed at your site or an upgrade is
performed, the existing theme template files are replaced by the new theme template
files. If you have customized theme template files and want to retain them for future
use, copy them to a different location before the installation or upgrade. A

Additional Considerations

Another change that you might want to make when creating your new theme is to
update the theme displayName= element in the theme-name.themeDescriptor.vctxt
file in the Velocity\ThemeDescriptors\context subdirectory of the work area.
Provide a descriptive name for the new theme that will appear in the selection list of
available themes in the Preferences page in SAS Web applications.

Step 4: Rebuild SAS Web Application Themes

To rebuild the EAR file for SAS Web Application Themes and register your themes
in metadata, follow these steps:

1 Make sure that the SAS Metadata Server is running.
2 Access the SAS Deployment Manager.

On Windows, use the shortcut on the Start menu or run the config.exe file in
the SAS-installation-directory\SASDeploymentManager\9.2 directory.

On UNIX, run the config.sh file.
On z/OS, run the config.rexx file.

3 Select the Rebuild Web Applications option and click Next.

4 In the Select Configuration Directory\Level dialog box, specify the configuration
directory and the level (for example, Lev1) in which you want to rebuild the
applications.

5 In the Select Configuration Information dialog box, enter the user ID and
password for an unrestricted administrative user (for example, sasadm@saspw).
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6 In the Select Web Applications to Rebuild dialog box, select the SAS Themes check
box.

7 In the Summary dialog box, click start to start the rebuild.
8 When the rebuild is complete, click Finish to close the SAS Deployment Manager.
The rebuilt SAS Web Application Themes archive file (sas.themes.ear) can be found

in the SAS-configuration-directory\Lev1l\Web\Staging directory. It should now contain
a new Web archive (WAR) file for the new theme named sas.theme.theme-name .war.

Step 5: Deploy SAS Web Application Themes in Your Test Environment

To deploy the rebuilt SAS Web Application Themes to your Web application server in
a test environment, see “Redeploying the SAS Web Applications” on page 95.

If you chose to configure your Web application server manually or deployed the SAS
Web applications manually when you installed SAS 9.2, see your Instructions.html
generated by the SAS Deployment Wizard.

If you chose to have the SAS Deployment Wizard configure your Web application
server and deploy the SAS Web applications automatically, see the manual instructions
for your Web application server on the SAS third-party Web site at http://
support.sas.com/resources/thirdpartysupport/v92.

Step 6: Test the New Theme

After you have completed the deployment procedures, follow these steps to test the
new theme:

1 Navigate to the portal in the production environment.

2 Log on and select Options » Preferences. The new theme should appear as a
selection on the Preferences page.

3 Select the new theme and observe the effect of the changes that you made in “Step
3: Make Desired Changes to the Styles, Graphics, and Theme Templates” on page
167. To view the new theme, log off from the portal. Then log in to the portal to
view the new theme that was applied.

4 Repeat the procedures outlined in “Steps for Defining and Deploying a New
Theme” on page 162 until you are satisfied with the display of the new theme.

If you test the new theme several times, log out of the portal and log on again to view
the updated theme each time.

Step 7: Move the New Theme from Test to Production Environment

To move a theme from a test to a production environment, follow these steps:

o Copy the entire contents of the
SAS-configuration-directory\Levl\Web\Utilities\SASThemeExtensions
directory to the same directory path on the production machine.

0 Run SAS Deployment Manager, and use the Rebuild Web Applications option
to register the theme in the metadata. See “Step 4: Rebuild SAS Web Application
Themes” on page 169.

0 Rebuild SAS Web Application Themes and deploy to your Web Application Server.
See “Step 5: Deploy SAS Web Application Themes in Your Test Environment” on
page 170.
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0 Assign the new theme as the default theme. See “Step 8: Assign the Default
Theme” on page 171.

Step 8: Assign the Default Theme

If you want your new or custom theme to be the default theme for all users who have
not selected a theme for themselves in their application’s Preferences, then you should
set the new theme as the default.

There are two ways to modify the theme metadata:

0 Use SAS Management Console. See “Assign the Default Theme from SAS

Management Console” on page 171.
0 Use the UpdateDefaultTheme.sas program. See “Assign the Default Theme with
the UpdateDefaultTheme.sas Program” on page 171.

Assign the Default Theme from SAS Management Console

To assign a new theme as the default theme by using the SAS Management Console,
follow these steps:

1 Deploy the new EAR file by using the appropriate procedures for your Web
application server.

2 In SAS Management Console, on the Plug-ins tab, navigate to Application
Management » Configuration Manager » SAS Application Infrastructure and
right-click to display the SAS Application Infrastructure Properties dialog
box.

Click the settings tab.

In the pefault Theme field, enter the name of your theme.

Click OK to exit the SAS Application Infrastructure Properties window.

S Ol A W

To enable the new theme to go into effect, restart SAS Remote Services and the
Web Infrastructure Platform in the Web application server.

Assign the Default Theme with the UpdateDefauliTheme.sas Program

To assign a theme as the default theme, use the UpdateDefaultTheme.sas program
located in the SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\themes\theme-
nameMetadataTools directory. After the UpdateDefaultTheme.sas program has been
run, the new theme will be in effect for users who have not selected a different theme
on their Preferences page.

If SAS 9.2 is not installed on the middle tier, copy the UpdateDefaultTheme.sas
program to the metadata server, and submit the SAS program on that system.

Deploying SAS Weh Application Themes on a Different Web Application
Server

Typically, SAS Web Application Themes are deployed along with other SAS Web
applications on the same Web application server. If you want to deploy themes to a
different Web application server, you should modify the theme metadata.

There are two ways to modify the theme metadata:

0 Use SAS Management Console. See “Modify Theme Metadata from the SAS
Management Console” on page 172.
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0 Use the UpdateTheme.sas program. See “Modify Theme Metadata with the
UpdateTheme.sas Program” on page 172.

Modify Theme Metadata from the SAS Management Console

To deploy SAS Web Application themes to a different Web application server and
modify the theme metadata, follow these steps:

1 Deploy the new EAR file by using the appropriate procedures for your Web
application server.

2 In SAS Management Console, navigate to Application Management »
Configuration Manager, right-click on Theme Name, and select Properties.

3 On the Connection tab, complete the following:
Select the communication protocol (either http or https).

Enter the host name of the Web application server on which the theme is
deployed.

Enter the port number of the Web application server.
Enter the name of the new theme in the service field.
4 Click oK to save your changes.

5 To enable the new theme to go into effect, restart your Web application server.

Modify Theme Metadata with the UpdateTheme.sas Program

To deploy SAS Web Application themes to a different Web application server and
modify the theme metadata, follow these steps:

1 Deploy the new EAR file by using the appropriate procedures for your Web
application server.

2 Locate the UpdateTheme.sas program in the SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\themes\theme-
name\MetadataTools directory.

3 Modify the following fields in the UpdateTheme.sas:

%let Specify the name of the theme to update.
themeName=Theme

Name;

%let Specify the host name of the Web application server on which
hostName=Host the theme is deployed.

Name;

%let port=Port; Specify the port number of the Web application server.

%let Specify the application context root of the new theme as
URLPath=base deployed on the Web application server.

URL;

%let If you are using Secure Sockets Layer (SSL), specify https
protocol=http; instead of http as the protocol for the URL.

4 Run the UpdateTheme.sas program.

5 To enable the new theme to go into effect, restart your Web application server.
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Deleting a Custom Theme from the Metadata

To delete a custom-developed theme from the deployment for the SAS Information
Delivery Portal, use the DeleteTheme.sas program located in the SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\themes\theme-name
\MetadataTools directory.

If SAS 9.2 software is not installed on the middle tier, copy the DeleteTheme.sas
program to the metadata server, and submit the program to SAS 9.2 on that system.

Migrating Custom Themes

Overview

SAS 9.2 includes significant updates to the theme infrastructure. In addition to
introducing the templating mechanism, changes were made to enable more SAS Web
applications to support themes. To apply a custom theme that you developed for an
earlier release to SAS 9.2 Web applications, follow these steps:

1 Create a new theme structure. For information about creating a work area in
which to construct the new version of your existing theme, see “Step 2: Create a
Work Area for the Theme” on page 163.

2 Migrate the cascading style sheets used in your theme.
3 Migrate the images used in your theme.

4 Migrate the theme templates.
5

Migrate the descriptors used in your theme.

Migrating Cascading Style Sheets

Before attempting to move any CSS files from an existing theme to the
\themes\theme-name\styles subdirectory of the work area for the new theme, you
should first review the specifications for the SAS 9.2 Default theme at
SAS-configuration-
directory\LevlWeb\Utilities\SASThemeExtensions\specs\Default\index.html.
For any feature for which a component key has been defined, you should update the
corresponding component key values in the CSS template (.vt1l) files in the
\Velocity\Stylesheets\Common\contexts\themes\theme-name,
\Velocity\Stylesheets\Components\contexts\themes\theme-name, and
\Velocity\Stylesheets\WRS\contexts\themes\theme-name subdirectories of the
work area to achieve a compatible look and feel.

Custom style sheet files are required only if you need to provide theme support to
features that are not covered by the CSS templates. For each style sheet file that you
add, you must ensure that a corresponding STYLESHEET element is added to in the
appropriate theme descriptor template (.vt1l) file in the
\Velocity\ThemeDescriptors\contexts\custom\theme-name subdirectory of the
work area for the new theme. The STYLESHEET element must specify the value all
for its PRODUCT= attribute.
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Migrating Images

Before attempting to move any image files from an existing theme to the
\themes\theme-name\images subdirectory of the work area for the new theme, see the
image specifications for the SAS 9.2 Default theme at SAS-configuration-
directory\Levl\Web\Utilities\SASThemeExtensions\specs\Default\index.html.
If the image from the existing theme replaces one of the images in the new theme, then
you should ensure that the image from the existing theme is saved over the default
image in the proper directory under the \themes\theme-name\images subdirectory. If
the image from the existing theme does not replace an image in new theme, save it in
the \themes\theme-name\images\Common subdirectory.

For each image file that you update or add, you must ensure that a corresponding
IMAGE element is present in the appropriate theme descriptor template (.vt1l) file in
the \Velocity\ThemeDescriptors\contexts\custom\theme-name subdirectory of the
work area for the new theme.

Migrating Theme Templates

Before attempting to move any theme template files from an existing theme to the
\themes\theme-name\templates subdirectory of the work area for the new theme, you
should consider carefully whether they are compatible with SAS 9.2 Web applications.
SAS Web applications rely on the theme template structure being consistent with the
versions that are shipped with the software. Theme templates must have the expected
set of dynamic substitution variables in order for the applications to function properly.

Migrating Theme Descriptors

The theme descriptor template (.vt1) files in the
\Velocity\ThemeDescriptors\contexts\custom\theme-name subdirectory of the
work area for the new theme should represent the structure of the migrated theme
resources. Review the files to ensure the following:

o0 If you add cascading style sheet files to provide theme support for features that

are not covered by CSS templates, ensure that you add corresponding new
STYLESHEET elements to the STYLES section.

0 For each image file that you update or add, ensure that you update or add a
corresponding IMAGE element in the IMAGES sections.

o If you migrate existing theme template files, ensure that you update or add a
corresponding TEMPLATE element in the TEMPLATES sections to reflect the
change.
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Overview of SAS Flex Application Themes

Introduction to SAS Flex Application Themes

SAS BI Dashboard 4.3 and SAS BI Portlets in the November 2010 Release and later
are displayed with the Flex interface that is provided by SAS Flex Application Themes
2.2. At start-up time, Flex applications load Flex themes automatically. A theme
consists of ShockWave Flash (SWF) files that include cascading style sheets (CSS) files.
The theme content is downloaded to the client, and is cached by the user’s Web browser.
As a result, subsequent uses of the Web application result in quicker loading of theme
content than it is at initial loading. The SAS Corporate theme is the default theme for
all Flex applications.

Benefits of SAS Flex Application Themes

SAS Flex Application Themes are required for Flex applications, and they are
downloaded as SWF files to the client’s Web browser. Flex theme content runs within
the Adobe Flash player and offers the following benefits:

0 Flex Application Themes coexist with SAS Web Application Themes. For example,

SAS Information Delivery Portal 4.3 uses the default Web theme, but it displays
SAS BI Portlets with Flex Application Themes.

O Applications that use Flex Application Themes offer more visual impact,
interactivity, and responsiveness.

0 Improved visual impact, and perceived depth is achieved through the use of skins.
Skins are graphics that are applied to common user interface components that
change their appearance. For example, the Corporate theme provides skins with a
color palette that reflects the SAS visual identity. Skins also include some stylized
graphics in the user interface.

Location of SAS Flex Application Themes
SAS Flex Application Theme files are located in the following directories:
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SAS-configuration-directory\Levl\Web\Staging\exploded\sas.flexthemes.ear
\sas.flexthemes.war\2.1\ApplicationThemes\Corporate

SAS-configuration-directory\Levl\Web\Staging\exploded\sas.flexthemes.ear
\sas.flexthemes.war\2.2\ApplicationThemes\Corporate

Deploying SAS Flex Application Themes on a Different Weh Application
Server

Typically, SAS Flex Application Themes are deployed along with other SAS Web
applications on the same Web application server. If you want to deploy themes to a
different Web application server, follow these steps:

1 Deploy the EAR file by using the appropriate procedures for your Web application
server.

2 In SAS Management Console, navigate to Application Management »
Configuration Manager, right-click on Flex Application Themes, and select
Properties.

3 On the Connection tab, complete the following:
0 Select the communication protocol (either http or https).

o Enter the host name of the Web application server on which the theme is
deployed.

0 Enter the port number of the Web application server.
4 Click oK to save your changes.

5 To enable the new theme location to take effect, restart your Web application
server.
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Overview of Multicasting

A multicast group communications protocol is used to communicate among
middle-tier SAS applications in a single SAS deployment (the set of applications
connected to the same SAS Metadata Server). When installation is performed with the
SAS Deployment Wizard, the wizard supplies you with a default multicast address that
it generates based on the machine’s (metadata server) IP address. The combination of
multicast IP address and multicast UDP port should be different for each SAS
deployment and also different from those used by other multicast applications at your
site.

Multicast options are system properties that are specified as Java command line
options on the Web application server to affect the behavior of the system. Multicast
options provide the ability to tune and change the behavior of the multicast
communication occurring within the SAS system.

The IP address and multicast UDP port number for the multicast host must match
the values in the Web application server’s start-up script (for example,
SASServerl.bat) and the environment.properties file located in the
SAS-configuration-directory\Levl\Web\Applications\RemoteServices directory.

Configuring Multicast Options

Multicast options should be changed in a synchronous manner among the following:

O Java virtual machine on which the SAS Remote Services reside. See “Specify
Multicast Options for SAS Remote Services” on page 178.

0 any Web application server on which a SAS application is deployed. See “Specify
Multicast Options for Web Application Servers” on page 178.
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O configuration for the Report Output Generation tool (if applicable). For
information about this tool, see “Processing Reports Outside of SAS Web Report
Studio” on page 264.

Specify Multicast Options for SAS Remote Services

You can make changes to the multicast configuration for the Java virtual machine
where SAS Remote Services resides. Edit the appropriate file as needed.
On Windows:

o If you are running the SAS Remote Services from a command prompt, edit the
RemoteServices.bat file.

o If you use the Window service, modify the wrapper.conf file located in the
SAS-configuration-directory\Levl\Web\Applications\ directory.

On UNIX and z/OS, edit the RemoteServices.sh file.

Note: Some multicast options for SAS Remote Services are specified in the
environment.properties file located in the
SAS-configuration-directory\Levl\Web\Applications\RemoteServices directory. For
more information about the environment.properties file, see “About the SAS
Environment File” on page 457. A

Specify Multicast Options for Web Application Servers

You can make changes to multicast for any Web application server on which a SAS
application is deployed. Edit the appropriate files as needed:

JBoss on Windows:

o Edit the JBoss\bin\SASServerl.bat file.

o If you use the Windows service, modify theJJBoss
\server\SASServerl\wrapper.conf file.

On UNIX and z/OS, edit the sasserverl.sh file.
For multicast configuration changes to WebLogic or WebSphere application servers,
see your product documentation.

Key Multicast Properties

The following table shows some key multicast properties and provides an explanation
of these properties.
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Property

Default
Value

Unit

Description

multicast.address

multicast.port

multicast_udp_ip_ttl

239.X.YZ

8561

Not applicable

Not applicable

Decimal. Specifies

how far a multicast

packet should be

forwarded from a
sending host.

0 is restricted to

the same host.

1 is restricted to

the same subnet.
32 is restricted to
the same site.

64 is restricted to
the same region.

128 is restricted to

the same continent.

255 is unrestricted.

This value is provided by the SAS
Deployment Wizard prompting
mechanism and defaults to
239.X.Y.Z, where X, Y, and Z are
the last three octets of the
metadata server’s IP address.

In an IP version 6 environment,
the value defaults to ff14::/16.

This value is provided by the SAS
Deployment Wizard prompting
mechanism and represents the port
on which UDP communication
occurs.

The IP multicast routing protocol
uses the Time to Live (TTL) field of
IP datagrams to decide how far a
multicast packet should be
forwarded from a sending host.
The default TTL for multicast
datagrams is 1, which results in
multicast packets going only to
other hosts in the local network.

If all SAS applications
participating in the multicast (this
includes Remote Services, any
Java applications in the middle
tier, and BI Report Services) are on
the same machine, the value
should be 0.

If your site has a SAS middle-tier
application that resides on a
different subnet but uses the same
metadata server within the same
SAS deployment, increase the
value for this property.
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Default
Property Value Unit Description
multicast.security Not Not applicable By default (with no value), both
applicable encryption and authentication are
enabled. Valid values are:
O encrypt: encrypt but do not
require authentication
O none: do not encrypt and do
not require authentication
multicast.config.file Not URL string (file://, By default, a JGroups
applicable http://, and so on) configuration is provided. However,

you can provide your own
configuration by specifying the
URL path to that configuration.
This option enables you to specify a
port range or change from IP
multicast to the gossip router
capabilities of JGroups.

Configuring Multicast Security

The multicast group communication includes all information needed to bootstrap
SAS middle-tier applications. Because this includes sending the SAS environment
credentials (such as the sasadm account name and its password), scoping and encryption
options are provided in the SAS Deployment Wizard. The defaults are most appropriate
for deployments in the firewall, isolated data center environment. After installation, if
you choose to modify the scoping or encryption options, you can do so by specifying the
options for the -Dmulticast.security parameter for your Web application server.

Authentication Token for Multicast Security

The multicast protocol is protected with encryption by default because it conveys
credentials. By default, group communication is protected only with a fixed encryption
key that is built into the software. If your middle tier is not running in an environment
that is well isolated from end-user access, then you might want better protection against
eavesdroppers and unauthorized group participants. For such situations, choose a
multicast authentication token known only to your SAS middle-tier administrative staff.

The authentication token is a password-like string needed to connect to the group
and create a site-specific encryption key. The SAS Deployment Wizard simplifies
configuration by using the authentication token that is built into the software. This
option is best used in development and other low-security environments. It might also
be appropriate in higher-security environments where the multicast group
communication is isolated from the user community either via firewall or TTL option,
and where all data center administrative and operations staff have sufficient security
approval.

If your multicast group communication is not contained within an isolated data
center environment, or if the security procedures at your site require protection among
administrative and operational staff in various roles, use an authentication token that
is known only to the administrators of the SAS environment.
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By default, there is a code level authentication token shared between all SAS
middle-tier applications to prevent access to the multicast group from unauthorized
listeners. If you choose to use a customized authentication token, use an authentication
token value that meets your organization’s security guidelines. The authentication
token can be any password-like string. In a multi-tier configuration, the SAS
Deployment Wizard displays this prompt for each tier that has an application
participating in the SAS multicast groups. The same authentication token string must
be specified for each tier in the same SAS deployment (each tier associated with the
same metadata server).

Specify the authentication token as a command-line option for your Web application
server:

-DMULTICAST AUTHENTICATION_ TOKEN=token

For information about how to set command line options, see your
Instructions.html file. The -Dmulticast options are specified in the
RemoteServices.bat file or the RemoteServices.sh file.

By default, clients who want to join a multicast group to receive messages are
required to provide an authentication token for the join request. If you determine this
process is causing an impact on performance, or that it is unnecessary, you can
manually turn off the use of authentication tokens. If you specify NONE as an option,
encryption and authentication are disabled. If you specify ENCRYPT, encryption is
enabled with no authentication of the join request.

Multicasting with JGroups

SAS middle-tier applications use JGroups in the Web application server for
inter-machine communication between applications and caching of application
properties. The JGroups software uses IP multicasting as the protocol for group
communications, and binds to a valid IP multicast address and UDP port. Typically,
multihomed machines have multiple NIC cards, each with its own address. By default,
the JGroups software selects the first non-loopback NIC as its bind address. In some
cases, the Web application server selects the value of
InetAddress.getLocalHost () .getHostName () as the bind address for use by
JGroups.

The communication protocol used by JGroups will not function correctly if the value
chosen by JGroups for the SAS Remote Services application and the value chosen by
the Web application server for the SAS middle-tier applications on a single machine do
not match.

Set the following JVM command line option to ensure that the Web application
server and the JGroups software use the same bind address:

-Djgroups.bind_addr=ipaddress

Enabling JGroups Communication for Multihomed Machines

If your environment consists of multiple machine installations that include one or
more multihomed machines, you must configure the following JVM command line
option to ensure that JGroups communication is successful:

-Djgroups.bind_addr=IPAddress

Note: If this JVM command is not configured in environments with multihomed
machines, the distribution function in the Report Output Generation tool will not
function. A
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To enable the distribution function in the Report Output Generation tool in
environments with multihomed machines, the -Djgroups.bind_addr command should
be set in the following locations:

o SAS Remote Services. For more information, see “Specify Multicast Options for
SAS Remote Services” on page 178.

0 Web application server. For more information, see “Specify Multicast Options for
Web Application Servers” on page 178.

O Outputgen.ini file. Add the -Djgroups.bind_addr command to this file to
enable the distribution of reports.

On Windows, this file resides in this directory path:
Program Files\SAS\SASBIReportServices\4.3

As an example of how to enable the JGroups communication, consider this scenario
where the IP address for the Web application server in the middle tier is 10.12.10.230.
The IP address for the server tier is 10.12.10.228. In this case, the command is
specified in the RemoteServices.bat file, RemoteServices.SH file, or the
wrapper.conf file as follows:

-Djgroups.bind_addr=10.12.10.230

On the Web application server, the following command is added:

-Djgroups.bind_addr=10.12.10.230

In the outputgen. ini file, the IP address for the server tier is specified:

-Djgroups.bind_addr=10.12.10.228
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Introduction to SAS Web Report Studio

SAS Web Report Studio is a Web application that anyone can use to view, interact
with, create, and distribute public and private reports. Simply open an existing report
and interact with the information based on your current needs. For example, you can
view, reply to, or add comments to a report. Report authors can easily point and click to
query central sources of data. Alternatively, you can add prompts and design the layout
of tables, graphs, and text using drag and drop to create a well-formatted report. All
this is accomplished by using a Web browser. You do not need to understand a
programming language. Periodic reports can be scheduled to process unattended on a
recurring basis and then distributed using e-mail.

In addition, powerful SAS analytical results can be used by business professionals
across an organization through their Web browsers by leveraging SAS stored processes
in SAS Web Report Studio. Stored processes are SAS programs, created by business
analysts who are proficient in SAS, that contain instructions for calculating analytical
results that are rendered as part of a report or as a complete report. Stored processes
typically include queries, prompted filters, titles, images, and statistical analyses to
deliver predictive analytics to a large audience. SAS Web Report Studio combines
query, reporting, and analytical capabilities in a single Web-based tool that everyone
can use to meet a broad set of information needs.

The Report Wizard enables novice users to quickly create and distribute basic queries
and reports based on either relational or multidimensional data sources in five easy
steps. More advanced users can use additional layout and query capabilities that are
available, including the ability to define custom calculations and complex filter
combinations, multiple queries, and SAS analytical results into a single document. A
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gallery of predefined layout choices expedites the report creation process, and an
extensive range of advance report components enable users to create and interact with
reports from their Web browsers. Reports and the application can be branded to match
a corporate style.

Reports can be shared with others or kept in private folders based on security
settings. Certain pages of reports can be distributed to authorized users via e-mail or a
subscription channel.

SAS Web Report Studio runs within a Web application server such as JBoss, Oracle
WebLogic, or IBM WebSphere, and requires the SAS BI Reports Service Workspace. It
can be invoked from within SAS Information Delivery Portal.

SAS Web Application Themes contain definitions for themes that are used by several
SAS Web applications including the SAS Web Report Studio. Themes enable you to
create and apply consistent, visual customization and company branding that is applied
to all theme-enabled SAS Web applications. In SAS Web Report Studio, themes apply to
the user interface, including the dialog boxes that are used to view, create, edit, and
share reports.

SAS Web Report Studio requires the following:

o SAS BI Report Services, which includes the report output generation tool. The
report output generation tool (rptbatch.bat for Windows and rptbatch.sh for
UNIX and z/OS) enables you to create pre-generated, static versions of reports
from the command line. New parameters have been added to the report output
generation tool.

o The SAS BI Report Services Configuration, which creates libraries that are used
by SAS Web Report Studio and the report output generation tool. These libraries
include the query cache library and the distribution library.

The following figure shows SAS Web Report Studio 4.3.

Display 15.1 SAS Web Report Studio 4.3
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If SAS Web Report Studio is not deployed at your site, the SAS Web Report Viewer
application is deployed and used for viewing reports from SAS Information Delivery
Portal.

SAS Web Report Viewer users can view existing reports and make temporary
modifications, but they cannot save their changes or create new reports. In these
circumstances, users see SAS Web Report Viewer in the application’s banner.

You can further control SAS Web Report Viewer capabilities by using the set of
predefined roles that are specific to SAS Web Report Viewer. SAS Web Report Viewer
can also be deployed as part of a custom application that is developed by using SAS
AppDev Studio.

SAS Web Report Studio and the SAS Intelligence Platform

As an integral part of the SAS Intelligence Platform, SAS Web Report Studio
leverages the analytical power of SAS by using the common SAS Open Metadata
Architecture, which reduces administration tasks, and SAS Management Console,
which enables administrators to perform administration tasks. SAS Web Report Studio
uses SAS Information Maps, which are a business view of data created by SAS
Information Map Studio, so that you do not have to understand complex data structures
and databases. At the same time, SAS Web Report Studio ensures that enterprise data
is used consistently. SAS Web Report Studio can leverage the work of analytical SAS
tools, such as SAS Enterprise Guide, which makes it easy for a wide range of users to
access SAS analytical intelligence. SAS solutions, which are domain-specific
applications that are built on the SAS Intelligence Platform, leverage SAS Web Report
Studio for reporting.

New Features in the Administration of SAS Web Report Studio 4.3

SAS Web Report Studio 4.3 offers several new features and enhancements that make
administration easier, flexible, and convenient. These enhancements and changes are
as follows:

o0 Folders for images, templates, and items for report distribution for users now
reside within the /SAsWebReportStudio/Common folder. Previously, these folders
were located within the /SAS Folders/System/Applications/SAS Web Report
Studio/Web Report Studio 4.2 folder. When you upgrade to SAS Web Report
Studio 4.3, report templates and report distribution items are copied to the new
location. Existing banner images and conditional highlighting images remain in
the old location (so that referencing reports continue to work) and are also copied
to the new location.

0 By default, clustering is enabled.

0 By default, in-process scheduling is supported in a clustered environment. An
in-process scheduling server runs as a process inside SAS Web Report Studio,
which eliminates the need to send jobs to an external scheduling server. The
in-process server is installed as part of the SAS Web Report Studio installation,
which eliminates the need to install, maintain, and license separate scheduling
servers.

o SAS Web Report Studio 4.3 has 30 ports available for use by the application.
These ports are in the range of 7560 to 7589.

O An event is logged in the WebReportStudio_ KeyActions.log file when a user
creates, edits, or deletes a distribution list.
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Details about SAS Web Report Studio users’ logon and logoff from sessions can be
viewed conveniently in the WebReportStudio KeyActions.log file.

You can specify a different directory (other than the default directory) where the
Key User Action log files can be saved.

You can specify whether the display of the left pane in SAS Web Report Studio
window should depend on the user’s preferences during the previous logon session.
By specifying the value of user for the
wrs.ReportViewPrefs.LeftPanelOpenState property, you can ensure that SAS
Web Report Studio retrieves the user’s action from the previous logon session, and
accordingly displays or eliminates the left pane in the application.

Two new capabilities have been added to SAS Web Report Studio 4.3 and SAS Web
Report Viewer 4.3: Allow Direct Access to Cubes and Allow Direct Access to
Tables. The Allow Direct Access to Cubes capability is included by default in the
following roles: Web Report Studio: Report Creation, Web Report Studio:
Advanced, and Web Report Viewer: Advanced.

The Open Maps as Reports capability has been renamed to Allow Direct Access to
Information Maps. In addition, the Repair Report capability has been renamed to
Update Resources. For sites that upgrade from SAS Web Report Studio 4.2, the
names of these capabilities will remain the same.

O New styles are available for reports.

0 The Distribute Report Wizard includes new features.

0 SAS Web Report Studio reports can be scheduled only by regular users with a SAS

identity. SAS internal accounts cannot be used to schedule reports.

The optional trusted parameter is not available in the Report Output Generation
tool.

To distribute reports with the Report Output Generation tool in environments with
multihomed machines, the outputgen.ini file should be updated to include the
-Djgroups.bind_addr command.

Reports can be scheduled only by regular users with a metadata identity. SAS
internal accounts such as the SAS Trusted User cannot be used to schedule reports.

SAS Web OLAP Viewer for Java

The SAS Web OLAP Viewer for Java application is no longer supported. It has been
replaced by functionality that is available in SAS Web Report Studio 4.3. SAS Web
Report Studio 4.3 contains the following changes:

O
O

Bookmarks and data explorations are not supported.

All data explorations are migrated to SAS Web Report Studio 4.3 reports. You can
still use the search capabilities within SAS Information Delivery Portal 4.3 to find
those reports, as well as the information maps.

SAS Information Delivery Portal 4.3 includes a new Report Portlet that displays
SAS Web Report Studio 4.3 reports.

During software updates, the SAS Information Delivery Portal converts instances
of the Information Map Viewer portlet to the new Report Portlet.

The migration tool creates a copy of the original data explorations and bookmarks,
and places them in the same location where the original content resided.

Visual Data Explorer is not available to display information maps in SAS
Information Delivery Portal 4.3.

In Edit mode within the portal, users can select a SAS Web Report Studio report
instead of a data exploration.
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O

The SAS Collection Portlet, which is included in the suite of SAS BI Portlets and
is compliant with JSR 168, does not allow users to search for data explorations.
All data explorations are migrated to SAS Web Report Studio 4.3 reports. Users
can, however, search for information maps.

New Features in the Administration of SAS Web Report Studio 4.2

SAS Web Report Studio 4.2 offers several new features and enhancements that make
administration easier, flexible, and convenient. These enhancements are as follows:

O

Users’ folders for SAS Web Report Studio can be located anywhere below the sas
Folders directory in the Folders tab of SAS Management Console. Previously, in
SAS Web Report Studio 3.1, you were required to use predefined storage folders.
This is no longer the case.

Three predefined roles are available for SAS Web Report Studio with certain
capabilities that are assigned to these roles initially. These predefined roles
include Report Viewing, Report Creation, and Advanced. You are not required to
use predefined roles. You can create roles and capabilities that meet the needs of
your organization. You can determine the number of roles to create, which features
are available for each role, and control other aspects of role-based behavior.

The Report Distribution Wizard enables you to create and edit recipient lists by
specifying recipient names and e-mail addresses, and channel information within
the wizard’s dialog boxes.

When users need to view a report, and are transferred by an external application
such as the SAS Information Delivery Portal, those users can be transferred to SAS
Web Report Studio (if the application is installed). The functionality offered by
SAS Web Report Studio is determined by the capabilities assigned to these users.

You can set security measures to limit SAS Web Report Studio to interact only
with information maps that are in designated locations. For example, you might
limit the availability of all relational information maps because some of those
information maps include row-level permissions.

As with all SAS applications, logging is accomplished by using the Logging Service
Configuration dialog box within the Configuration Manager in SAS Management
Console.

In previous versions of SAS Web Report Studio, the LocalProperties.xml file
offered the only practical method to override properties and their values. Although
this file is available and supported in SAS Web Report Studio 4.2, it is
recommended that you use the Configuration Manager in SAS Management
Console to configure and set properties for SAS Web Report Studio. The
Configuration Manager plug-in offers a consistent interface to set properties for all
SAS applications.

You can add disclaimer text to tables and graphics, and the text appears below all
tables and graphics in reports.

In previous versions of SAS Web Report Studio, the
WebReportStudioProperties.xml file was used. Now, the Advanced tab in the
Web Report Studio Properties 4.2 dialog box is used to specify property names and
property values.

SAS Web Report Studio 4.2 maintains a working area that is hidden from users.
This working area, which is located at /System/Applications/SAS Web Report
Studio/Web Report Studio 4.2, is accessed by using the SAS Management
Console. This location might store shared content such as images.
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O Banner images are stored in the /Web Report Studio 4.2/BannerImages folder.
Sample conditional highlighting image files are deployed in the /Web Report
Studio 4.2/ConditionalHighlightingImages folder.

0 In previous releases of SAS software, if client-side pooling was configured, SAS
Web Report Studio 3.1 required that the pooling administrator’s user name and
password be stored in the metadata. With SAS Web Report Studio 4.2, this
requirement has been waived. Previously, SAS Web Report Studio 3.1 stored
credentials for the Web administrator (saswbadm) and pooling administrator in
the WebReportStudioProperties.xml file. This is no longer true with SAS Web
Report Studio 4.2.

0 Beginning with the third maintenance release for SAS 9.2, the log file,
SASBIReportServices4.2.log, is created when you first run the report output
generation tool with default permissions.

0 In the third maintenance release for SAS 9.2, you can change the location of the
temporary workspace for SAS Web Report Studio and SAS Web Report Viewer.

Prerequisites for Administering SAS Web Report Studio

This documentation assumes that you have successfully installed and configured SAS
Web Report Studio. Upon completion of installation, you should follow all of the
post-installation steps that are provided in the Instructions.html file that is
generated by the SAS Deployment Wizard.

For a comprehensive overview of installation, see the SAS Intelligence Platform:
Installation and Configuration Guide. For instructions about using the SAS Web Report
Studio interface, see the SAS Web Report Studio User’s Guide.

Main Tasks for Administering SAS Web Report Studio

Overview of Main Tasks for Administering SAS Web Report Studio

After you have installed SAS Web Report Studio, you can perform a number of
administrative tasks. For example, you should verify that SAS Information Maps are
stored in a location that is accessible to SAS Web Report Studio in order for users to
create reports from those information maps. SAS Web Report Studio 3.1 required that
information maps be placed in a specific location; this requirement has been waived for
SAS Web Report Studio 4.2.

The following sections summarize the administrative tasks that are specific to SAS
Web Report Studio.

Prepare Report Resources

Before users can start creating reports, the necessary resources must be prepared
and made available:
O Make sure that your data sources have been created.

In SAS Web Report Studio, the term data source refers to a SAS Information
Map. If you have not already done so, create metadata for your databases and
SAS data sets, and then create the information maps that will be used for reports.
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For details about creating metadata for your raw data, see the SAS Intelligence
Platform: Data Administration Guide.

For details about creating information maps, see the SAS Information Map
Studio online Help.

Set up storage of reports and report-related objects.

Ensure that resources are stored in appropriate locations, and add folders to the
storage structure in a way that facilitates access control of those folders. There are
no preset requirements for creating folders. You have the flexibility to organize
users’ folders in a manner that suits your organizational requirements.

Add content for use by report creators.

Make data sources (information maps), stored processes, banner images, fonts,
and imported reports available to users of SAS Web Report Studio.

Enable geographical maps.

If you want to display your multidimensional data in interactive geographical
maps, then you must enable the geographical maps feature. See Appendix 1,
“Configuring the ESRI Map Component,” on page 451.

Configure SAS Web Report Studio

Here are some configuration tasks that you might perform:

O

Modify, update, or troubleshoot the configuration properties and settings in Web
Report Studio 4.2 plug-in to SAS Management Console. See “Use the Configuration
Manager to Configure SAS Web Report Studio Properties” on page 196.

Assign users to SAS Web Report Studio’s predefined roles and capabilities. See
“Predefined Roles” on page 217.

The following configuration tasks are optional:

O

Enable unregistered PUBLIC users, who do not have a user definition in the SAS
metadata, to access SAS Web Report Studio. In SAS Web Report Studio 3.1,
PUBLIC users were allowed access to the metadata server by default, but this has
changed in SAS Web Report Studio 4.2. See “Enable Password Management to
Provide Access for PUBLIC Users of SAS Web Report Studio” on page 197. Also,
see “Manage Access” in the SAS Intelligence Platform: Security Administration
Guide.

Enable users to provide DBMS credentials interactively when logging on to SAS
Web Report Studio. When users enter their user IDs and passwords in SAS Web
Report Studio, those credentials are valid for the current session only, because
they are stored in memory and not in metadata. See “Provide DBMS Credentials
Interactively in SAS Web Report Studio” on page 197.

Customize SAS Web Report Studio’s pages by controlling the content displayed in
the banner. Banner images make it easier for report consumers to identify the
report and to distinguish the report from other reports. However, you have the
option to customize SAS Web Report Studio’s pages and prevent the product title,
report name, and company logo from appearing in the banner for reports. See
“Hide Banner Properties for SAS Web Report Studio” on page 199.

Configure logging for SAS Web Report Studio. The SAS 9.2 Intelligence Platform
uses a standard logging facility to perform logging for SAS servers and to track
and audit user actions for performance and security reasons. For details, see
“Overview of Logging for SAS Web Report Studio” on page 202. Also, see
“Administering Logging for SAS Servers” in SAS Intelligence Platform: System
Administration Guide.
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O

Improve the performance of SAS Web Report Studio by managing memory and
taking advantage of server-side pooling or client-side pooling capabilities. For
details, see SAS 9.2 Intelligence Platform: Application Server Administration
Guide.

Implement Security for SAS Web Report Studio

For general security tasks, see “Middle-Tier Security” on page 39. The following
security tasks apply to SAS Web Report Studio:

O

Set up users for SAS Web Report Studio.

Enable users to log on and manipulate reports by creating metadata identities
for the users. You can also manage users by assigning users to predefined SAS
Web Report Studio roles. For more information, see “Predefined Roles” on page 217
Manage access to reports.

Restrict access to reports in accordance with your security goals. See “Managing
Access to Reports” on page 233.

Configure a pooling workspace server to enforce row-level security. If your
information maps have filters that prevent users from seeing particular rows in
tables, then you should set up a separate pooled workspace server for SAS Web
Report Studio. Doing so prevents users from accessing the restricted tables
through other methods. See SAS 9.2 Intelligence Platform: Application Server
Administration Guide.

Note: For additional links to workspace server pooling topics, see “Improving the
Performance of SAS Web Report Studio” on page 208. A

Set up Web authentication.

You can configure SAS Web Report Studio to use Web authentication. For a
detailed discussion of different types of authentication and configuration
guidelines, see “Authentication Mechanisms” in the SAS Intelligence Platform:
Security Administration Guide.

Limit the availability of relational information maps that implement row-level
security.

By default, SAS Web Report Studio can interact with information maps
regardless of their location within the folder structure. However, you might choose
to establish a more controlled environment. See “Limit the Availability of
Relational Information Maps That Implement Row-Level Security” on page 230.

Perform Additional SAS Web Report Studio Administration

You might also want to do the following:

O

Customize reports.

Add disclaimer text to reports or add custom report styles. For details, see
Chapter 18, “Customizing SAS Web Report Studio Report Styles,” on page 239.

0 Set up the scheduling and distribution of reports.

Schedule the creation of pre-generated reports so they can render quickly, and
distribute reports to users. For details, see Chapter 19, “Pre-generated Reports
from SAS Web Report Studio,” on page 251.

Additional Documentation for SAS Web Report Studio

The following additional documentation is available:
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0 The SAS Web Report Studio: User’s Guide provides task instructions and
information about the user interface.

0 “Best Practices for Middle-Tier Configuration” on page 23 contains information
that is associated with middle-tier administration.
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Use the Configuration Manager to Configure SAS Weh Report Studio
Properties

The Configuration Manager plug-in available in SAS Management Console enables
you to perform various administrative tasks such as configuring properties and values
for SAS Web Report Studio. In previous versions of SAS software, properties and values
were defined in XML files. In SAS 9.2, properties and their values for SAS Web Report
Studio are specified on the Advanced tab within the Web Report Studio 4.3 Properties
dialog box. For information about how to use the Configuration Manager plug-in to
configure properties and values for SAS Web applications, see “Using Configuration
Manager” on page 64.

For more information about SAS Management Console, see “State of Your System” in
the SAS Intelligence Platform: System Administration Guide.

Configure the Analysis of SAS Web Report Studio Properties

To ensure that a complete analysis of SAS Web Report Studio properties is
accomplished at start-up, and to add the results of the analysis to the SAS Web Report
Studio log as a warning, follow these steps:

1 In SAS Management Console on the Plug-ins tab, navigate to Application
Management » Configuration Manager » Web Report Studio 4.3 and right-click
to display the Web Report Studio 4.3 Properties dialog box.

2 Click the Advanced Tab.

3 Click add to display the Define New Property dialog box.

4 Enter the property name as shown and specify the property value:
Property Name: wrs.pfs.logPropertiesAsWarn

Property Value: true

Click oK to exit the Define New Property dialog box.

Click Add in the Web Report Studio 4.3 Properties dialog box.

Click oK to exit the Web Report Studio 4.3 Properties dialog box.

To enable the property to take effect, restart your Web application server.

o N o o

Set Maximum Values for Report Filters
To configure the maximum number of filter values that can be displayed when report
creators define a filter, follow these steps:

1 In SAS Management Console on the Plug-ins tab, navigate to Application
Management » Configuration Manager » Web Report Studio 4.3 and right-click
to display the Web Report Studio 4.3 Properties dialog box.

2 Click the Advanced Tab.

3 Click add to display the Define New Property dialog box.

4 Enter the property name as shown and specify the property value:
Property Name: webreportstudio.max.filter.choices
Property Value: 1000

5 Click OK to exit the Define New Property dialog box.

6 Click Add in the Web Report Studio 4.3 Properties dialog box.

7 Click oK to exit the Web Report Studio 4.3 Properties dialog box.
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8 To enable the property to take effect, restart your Web application server.

Report creators can configure their reports to prompt for filter values that are
generated dynamically when the report is rendered. To enable this feature, report
creators choose the Prompting users to select values from a list and the
allow users to query for values options in the Create New Filter dialog box.
When the report is rendered, report viewers click the Get values button to load the
values that are available for the filter.

You can configure the maximum number of prompt values that can be loaded when
report viewers click the Get values button. The default value is 1,000.

To configure the maximum number of prompt values, and specify the number that
you want, follow these steps:

1 In SAS Management Console on the Plug-ins tab, navigate to Application
Management » Configuration Manager » Web Report Studio 4.3 and right-click
to display the Web Report Studio 4.3 Properties dialog box.

2 Click the Advanced tab.

3 Click add to display the Define New Property dialog box.

4 Enter the property name as shown and specify the property value:

Property Name: webreportstudio.max.prompt.choices
Property Value: 1000

5 Click OK to exit the Define New Property dialog box.

6 Click Add in the Web Report Studio 4.3 Properties dialog box.

7 Click oK to exit the Web Report Studio 4.3 Properties dialog box.

8 To enable the property to take effect, restart your Web application server.

For more information about dynamic prompt values, or for instructions about
creating a filter, see the online Help for SAS Web Report Studio.

Enable Password Management to Provide Access for PUBLIC Users of
SAS Web Report Studio

Unregistered (PUBLIC-only) users can pass through authentication but do not have
a user definition in SAS metadata, and they are denied access to the SAS 9.2 metadata
server. Previously, in SAS Web Report Studio 3.1, PUBLIC users were allowed access to
the metadata server by default.

In order to enable PUBLIC users to access SAS Web Report Studio 4.3 (or SAS Web
Report Studio 4.2), modify the value for the Allow Public Users field in the Web
Report Studio 4.3 Properties dialog box within Configuration Manager. When PUBLIC
users are given access to SAS Web Report Studio 4.3, their history and preferences are
retained and saved automatically for future use by SAS Web Report Studio.

Provide DBMS Credentials Interactively in SAS Web Report Studio

Typically, SAS Web Report Studio relies on stored credentials in the metadata in
order to provide access to third-party DBMS data. The advantage of this approach is
that the access is seamless. Users do not need to know a DBMS account ID and
password. The disadvantage of this approach is that it requires that you store
individual or group DBMS credentials in the metadata. Any change to the users’
passwords in the third-party database (for example, Teradata) must be copied to the
stored credentials in the metadata.

As an alternative to storing DBMS credentials for use by SAS Web Report Studio,
you can require that users provide DBMS credentials interactively. Each user must
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supply additional credentials (for example, an Oracle account ID and password) one
time in each SAS Web Report Studio session in which the user accesses third-party
DBMS data (for example, Oracle tables).

When users enter their user IDs and passwords in SAS Web Report Studio, those
credentials are valid for the current session only, because they are stored in memory
and not in metadata.

Note: SAS Web Report Studio users who schedule and distribute reports must have
stored credentials in the metadata. A

SAS Web Report Studio can accept user-supplied credentials for secondary servers in
two ways:

o If a user makes a request that requires DBMS credentials, and those credentials
are not stored in the metadata, SAS Web Report Studio always presents the
Missing report element dialog box with the Manage Credentials button.

o If the administrator configures the Show Manage Credentials option on the
Settings tab within Web Report Studio Properties 4.3, SAS Web Report Studio
presents users with the Manage Credentials dialog box. As a result, users can
supply the DBMS credentials preemptively when accessing their third-party
databases such as Teradata, Oracle, or DB2. For information about entering
credentials in SAS Web Report Studio, see the SAS Web Report Studio 4.3 User’s
Guide.

The following figure shows that the administrator has set the value for the Show
Manage Credentials field to Yes.
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To allow users to enter their credentials by selecting File » Manage Credentials in
SAS Web Report Studio 4.3, follow these steps in the SAS Management Console:

1 On the Plug-ins tab under Configuration Manager, right-click Web Report Studio
4.3 and select Properties.

2 In the Web Report Studio 4.3 Properties dialog box, click the Settings tab.

3 In the Application Configuration dialog box, select Yes for the Show Manage
Credentials field and click OK.

4 To enable this setting to take effect, restart SAS Web Infrastructure Platform
Services and SAS Web Report Studio applications.

Hide Banner Properties for SAS Web Report Studio

Pages in SAS Web Report Studio can be customized, and the product title, report
name, and company logo can be hidden from being displayed in the banner.

To prevent the product title from being displayed in the banner, specify the following
property name and property value on the Advanced tab within the Web Report Studio
4.3 Properties dialog box:

Property Name: wrs.banner.product.title.hide

Property Value: true

To prevent the report name from displaying in the banner, specify the following:

Property Name: wrs.banner.report.name.hide

Property Value: true

To prevent product title, report name, and company logo from displaying in the
banner, specify the following property name and value:

Property Name: wrs.banner.report.hide.all

Property Value: true

To ensure that a file with an XHTML fragment is added to the bottom of a report,
specify the following property name and value:

Property Name: wrs.footer.xhtml

Property Value: true

To enable these properties to take effect, restart your Web application server.

Edit LocalProperties.xml File to Set Properties for SAS Web Report
Studio

In previous versions of SAS Web Report Studio, the LocalProperties.xml file
offered the only practical method to override properties and their values. Although this
file is available and supported in SAS Web Report Studio 4.3, it is recommended that
you use the Configuration Manager in SAS Management Console to configure and set
properties for SAS Web Report Studio. The Configuration Manager offers a consistent
interface to set properties for all SAS applications.

If you prefer to create a LocalProperties.xml file, follow these steps:

1 Locate the sample file in the SAS-configuration-
directory\Lev1l\Web\Applications\SASWebReportStudio4.3\customer
directory. The sample file is named LocalProperties.xml.sample.

2 Make a copy of this file in the SAS-configuration-

directory\Lev1l\Web\Applications\SASWebReportStudio4.3\customer
directory, and name the copy LocalProperties.xml.

Note: Changes that you make to LocalProperties.xml take effect after you restart
your Web application server.
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Customize the Product and Browser Window Titles for SAS Webh
Report Studio

You can replace the default titles for the banner and the browser window in SAS Web
Report Studio by customizing the properties in the LocalProperties.xml file. You
cannot use the Configuration Manager in SAS Management Console to complete this
task.

To customize the titles for the banner and the browser window, follow these steps:

1 Locate the LocalProperties.xml.sample file in the SAS-configuration-directory

\Levl\Web\Applications\SASWebReportStudio4.3\customer directory.

2 Make a copy of the LocalProperties.xml.sample file in the same directory, and
name the copied file LocalProperties.xml.

3 Edit the LocalProperties.xml file by locating the following properties,
uncommenting them, and specifying the custom values for the custom banner
name and window browser title:

<webreportstudio.product.logo.text>

your custom product title
</webreportstudio.product.logo.text>
<webreportstudio.page.title.text>

your custom title for the browser window
</webreportstudio.page.title.text>

4 Save your changes to the LocalProperties.zxml file.
5 To enable these changes to take effect, restart your Web application server.

Configure the Display of Left Pane in SAS Web Report Studio

When users log on to SAS Web Report Studio 4.2, the application’s window displays a
left pane in the view and edit page mode. Users can close or open the left pane. The left
pane stays open until the user’s next logon session or until it is changed.

Beginning with SAS Web Report Studio 4.3, you can customize the initial display of
the left pane by specifying a value for the
wrs.ReportViewPrefs.LeftPanelOpenState property. The value specified for the
wrs.ReportViewPrefs.LeftPanelOpenState property determines the type of initial
display of the application’s window.

The following table explains values that can be configured for the
wrs.ReportViewPrefs.LeftPanelOpenState property in SAS Web Report Studio 4.3:
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Table 16.1 Property Values for the Display of the Left Pane in SAS Web Report
Studio 4.3

Values for the

Left Pane

Property Result in SAS Web Report Studio 4.3

open When users log on to SAS Web Report Studio 4.3, the left pane in the
application window is open. This setting is identical to the behavior of the left
pane in SAS Web Report Studio 4.2.

closed When users log on to the application, the left pane in the application window
remains closed.

user This is the default value in SAS Web Report Studio 4.3. When a user logs on to

the application, the application remembers the status of the left pane during
the user’s previous logon session and displays the same setting. If the user
closed the left pane during the last logon session, the application continues to
keep the left pane closed during the user’s next logon session.

To specify whether the left pane in the SAS Web Report Studio 4.3 window should
remain open, closed, or implement the user’s preferences during the previous logon
session, follow these steps:

1

In SAS Management Console on the Plug-ins tab, navigate to Application
Management » Configuration Manager » Web Report Studio 4.3 and right-click
to display the Web Report Studio 4.3 Properties dialog box.

Click the advanced Tab.
Click add to display the Define New Property dialog box.

4 Enter the property name and property value and click oK in the Define New

Property dialog box:
Property Name: wrs.ReportViewPrefs.LeftPanelOpenState
Property Value: user

If you want the left pane to remain closed by default for all users that log on to
the application, specify the value closed.

Click Add in the Web Report Studio 4.3 Properties dialog box.
Click ok to exit the Web Report Studio 4.3 Properties dialog box.
To enable this property to take effect, restart your Web application server.

Change the Temporary Workspace Location

SAS Web Report Studio 4.2 and later includes support for the wrs.io.tmpdir
property. This property enables you to change the location of the temporary workspace
for SAS Web Report Studio and SAS Web Report Viewer.

Here are some default locations for the Web application servers:

O JBoss:

JBOSS\jboss-4.2.0.GA\server\SASServerl\work\jboss.web\localhost
\SASWebReportStudio\sas.wrs.tmpfiles

o WebLogic:

C:\SAS\EntBIServer\Levl\Web\Temp\sas.wrs.tmpfiles

o WebSphere:

C:\Users\user[D\AppData\Local\Temp\2\sas.wrs.tmpfiles
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You can obtain the default directory path for the temporary workspace from the
SASWebReportStudio4.3.log in the SAS-configuration-directory \Levl\Web\Logs
directory.

To change the location of the temporary workspace for SAS Web Report Studio 4.3,
follow these steps:

1 In SAS Management Console on the Plug-ins tab, navigate to Application
Management » Configuration Manager » Web Report Studio 4.3 and right-click
to display the Web Report Studio 4.3 Properties dialog box.

2 Select the Advanced Tab.

3 Specify the following property names and property values on the Advanced tab
within the Web Report Studio 4.3 Properties dialog box:

Property Name: sas.webreportstudio.cleanup.temp.directory
Property Value: Locationoftemporaryworkspace
Property Name: wrs.io.tmpdir
Property Value: Locationoftemporaryworkspace
4 Click oK to exit the Web Report Studio 4.3 Properties dialog box.
5 To enable these properties to take effect, restart your Web application server.

Modify Port Numbers for In-Process Scheduling in a Clustered
Environment

SAS Web Report Studio 4.3 has 30 ports available for use by the application. These
ports are in the range of 7560 to 7589. For in-process scheduling in a clustered
environment, the default ports are:

o Port 1: 7570

o Port 2: 7571

o Port 3: 7572

If you have a multiple-level environment, the default port numbers are assigned for
each set of three ports. For example, a Lev2 environment uses the following port
numbers:

o Port 1. 7573

o Port 2: 7574

o Port 3: 7575

If there are port conflicts or you have a non-clustered environment, you might want
to assign different port numbers. In SAS Management Console, go to thePlug-ins tab
and navigate to Application Management » Configuration Manager » Web Report
Studio 4.3. Then, right-click to display the Web Report Studio 4.3 Properties dialog box.
For more information on changing configuration options in a clustered environment, see
“Setting Up Scheduling Using SAS In-Process Scheduling” in the Scheduling in SAS.

Configuring Logging for SAS Webh Report Studio

Overview of Logging for SAS Web Report Studio

The SAS 9.2 Intelligence Platform uses a standard logging facility to perform logging
for SAS servers. In SAS Management Console, the Logging Service dialog box enables
you to manage performance, track security enforcement, and analyze specific situations.
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For information about how to use logging for SAS Web applications, see
“Administering Logging for SAS Web Applications” on page 103.

SAS Web Report Studio records events in two log files. By default, both log files are
created in the SAS-configuration-directory \Levl\Web\Logs directory. The directory
path for the sasWebReportStudio4.3.1log file can be changed within SAS
Management Console.

The following table summarizes the log files:

Table 16.2 Log Files

Log Context and Default Filename Description

General Purpose Log Logs events such as serious errors, application
(sASWebReportStudio4.3.1log) restarts, and users logging on.

Key User Action Log Logs events such as application use, failed

(SASWebReportStudiod.3 KeyActions.log) attempts to log on, report access, and batch
- report activities. For a list of all events, see

“Understand Key User Action Log Output” on
page 205.

Note: There are similar log files for SAS Web Report Viewer in the directory. A

Change the Logging Levels

To change the logging levels, see “Administering Logging for SAS Web Applications”
on page 103.

Also, see “Administering Logging for SAS Servers” in the SAS Intelligence Platform:
System Administration Guide.

Configure Debug Logging Dynamically

You can change the logging level for debugging in the Logging Service Properties
dialog box as described in “Change the Logging Levels” on page 203. However, that
procedure requires you to redeploy and restart SAS Web Report Studio. As an
alternative, you can configure debug logging dynamically without restarting SAS Web
Report Studio. You can do the following:

O activate a one-line notification for every action that occurs. This one-line message
can be useful for providing debugging information about events.

0 change the log level for events that are logged for com.sas.apps.citation or for
one of its descendant contexts.

To implement this functionality, you manually edit the URL for SAS Web Report
Studio in your browser. In order to perform this task, you must belong to the Advanced
Role with the Manage Distribution List capability for SAS Web Report Studio

There is no browser-based feedback for this debugging feature. All relevant
information about events is placed in the General Purpose Log file.

To edit the URL, do either or both of the following:

0 To activate the one-line notification, add the following string to the end of the URL:
debugLog.do?LogAllActions=true

Here is an example:
http://localhost:8080/SASWebReportStudio/debuglog.do?LogAllActions=true
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Here is an example one-line message that might appear in the log file:
WRS 16:25:50,825 WARN report.OpenReportManagerAction
[da8££705996908f9:14eaec9:107ed50£82f:-7fea]- DEBUG
logging of action requested: OpenReportManagerAction

When you have finished debugging, to suppress the one-line notification, change:
debugLog.do?LogAllActions=true
to:
debuglLog.do?LogAllActions=false

o0 To change the logging level, add the following to the end of the URL:
debuglLog.do?LogName=log.context&LogLevel=level

Provide the following values:

0 Replace log.context with the log context that you want to debug. You can
specify com.sas.apps.citation, or any context under
com.sas.apps.citation. The com.sas.apps.citation context is the
highest level, and represents the entire SAS Web Report Studio subsystem.

o Replace level with the log level that you want. You can specify any one of the
following: DEBUG, INFO, WARN, ERROR, and FATAL.

Here is an example:
http://localhost:8080/SASWebReportStudio/
debugLog.do?LogName=com.sas .apps.citation&LogLevel=DEBUG

Manage the Key User Action Log File

For the Key User Action Log, SAS uses a rollover mechanism to manage the size and
age of the log. SAS periodically archives the current log and creates a new one. To
archive a log, SAS saves the log with a new name that includes the current date and
time. SAS archives the current log based on configurable settings related to the size of
the file and the duration since the last archive. SAS can also delete files after the
number of archived files reaches a particular limit.

The following table shows the default values for rollover properties.

Table 16.3 Rollover Properties and Default Values

Rollover Properties Default Values
sas.wrs.keyUserActionLog.rollover.max -1
sas.wrs.keyUserActionLog.rollover.sizeKBytes 4000
sas.wrs.keyUserActionLog.rollover.ageHours 24

To manage the Key User Action Log and modify the values for rollover properties,
follow these steps:

1 In SAS Management Console on the Plug-ins tab, navigate to Application
Management » Configuration Manager » Web Report Studio 4.3 and right-click
to display the Web Report Studio 4.3 Properties dialog box.

2 Select the advanced Tab.
3 Click add to display the Define New Property dialog box.

4 Enter the property name and property value and click oK in the Define New
Property dialog box:
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Property Name: sas.wrs.keyUserActionlLog.rollover.max
Property Value: Max Rollovers
Property Name: sas.wrs.keyUserActionlLog.rollover.sizeKBytes
Property Value: Threshold Size for Rollovers
Property Name: sas.wrs.keyUserActionlLog.rollover.ageHours
Property Value: Threshold Age for Rollovers

5 Click add in the Web Report Studio 4.3 Properties dialog box.

6 Click oK to exit the Web Report Studio 4.3 Properties dialog box.

7 To enable these properties to take effect, restart your Web application server.

If you are using SAS Web Report Viewer to render reports, then make similar changes
for SAS Web Report Viewer. Periodically move or delete outdated archived log files.

Understand Key User Action Log Output

Events are logged to the WebReportStudio4.3_ KeyActions.log file in an XML
format. Each event has a numeric code value that uniquely identifies the event.
Beginning with SAS Web Report Studio 4.3, an event is logged in the
WebReportStudio4.3_KeyActions.log file when a user creates, edits, or deletes a
distribution list. In order to perform these tasks, the user must belong to the Advanced
Role with the Manage Distribution List capability for SAS Web Report Studio. For
information about SAS Web Report Studio Roles, see “Predefined Roles” on page 217.
The following table lists the events and their respective codes.

Table 16.4 Log Events and Their Codes

Event Code

User logged on.

User attempted to log on but failed.
User logged off.

User saved a report.

User opened a report.

User deleted a report.

User moved a report.

User copied a report.

User renamed a report.

© 00 9 O Ok~ W N = O

System start.

=
(=)

User scheduled a report. If the user scheduled a folder of reports,
then the log file lists the folder.

User distributed a scheduled report. 11
User created, edited, or deleted a distribution list. 12

Here are some entries from a sample log file for SAS Web Report Studio 4.3:

<wrskeyuseractions>
<event><javaDate>1124136823696</javaDate><date>5/15/10</date><time>4:13PM</
time><code>9</code><description>System Startup</description></event>
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<event><javaDate>1124136826633</javaDate><date>5/15/10</date><time>4:13PM/
</time><user>sastrust@saspw</user><session>1</session>
<sasSession>a70abab74efe542e:-526869£2:1279155b649:-7£92 </sasSession>
<code>0</code><description>Logon</description></event>

<event><javaDate>1124136992808</javaDate><date>5/15/10</date><time>4:15PM/
</time><user>dolson</user><session>2</session>
<sasSession>a70abab74efe542e:-526869£2:1279155b649:-7f55<sasSession>
<code>0</code> <description>Logon</description></event>

<event><javaDate>1124136923432</javaDate><date>5/15/10</date><time>4:16PM/
</time><user>dolson</user><session>2</session>
<code>4</code><description>0Open</description>
<report>/ReportStudio/Shared/Reports/Deanna/Bursting/Orion 2 level bygroup -3
</report></event>

<event><javaDate>1124136977261</javaDate><date>5/15/10</date><time>4:17PM/
</time><user>dolson</user><session>2</session>
<code>3</code><description>Save</description>

<report>/ReportStudio/Shared/Reports/Deanna/Bursting/testReport</report></event>

<event><javaDate>1124136992808</javaDate><date>5/15/10</date><time>4:18PM/
</time><user>dolson</user><session>2</session><code>2</code>
<description>Logoff</description></event></event>

<event><javaDate>1124136826633</javaDate><date>5/15/10</date><time>4:19PM/
</time><user>sastrust@saspw</user><session>1</session>
<code>2</code><description>Logoff</description></event>
</wrskeyuseractions>

Note that a log file for SAS Web Report Studio 4.2 will not contain the session and
sasSession elements because they were introduced with SAS Web Report Studio 4.3.

View Details of Users’ Sessions in the Key User Action File

Beginning with SAS Web Report Studio 4.3, the
WebReportStudio4.3_KeyActions.log file enables you to obtain useful details about
SAS Web Report Studio users’ sessions.

Here are some key features of the unique session number assigned to events
associated with users’ tasks:

0 For all events associated with a user’s tasks (for example, logging on to SAS Web
Report Studio, opening a report, saving a report, logging off from SAS Web Report
Studio), the session number remains the same.

0 The number generated for the user’s sessions is short, and it remains as a unique
number until a system start-up occurs.

0 The session number is accompanied by a code value that indicates the type of task
being performed by the user. For example, a code value of 2 for a session indicates
that the user logged off from SAS Web Report Studio. This code is also interpreted
and displayed in plain text within the description field.

0 For a logon session, the session number is accompanied by a sasSession number
whose value corresponds with the session ID number that is listed in the
SASWebReportStudio4.3.log file.

The sasSession number is a globally unique and lengthy string that is associated
only with a code value of 0. A code value of 0 indicates a logon session by a user. When
a key event is listed in the WebReportStudio4.3 KeyActions.log file with a session
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number and a unique string for sasSession, you can correlate this key event with the
sasSession ID number listed in the SASWebReportStudio4.3.1log file.

In this example from the WebReportStudio4.3 KeyActions.log file, the session for
the user has a value of 3 that uniquely identifies this user’s session. The code value of 0
and the description indicate that this is a logon session. Because this is a logon session,
the sasSession element is listed with the globally unique string that correlates with the
session ID number listed in the standard log.

<event><javaDate>1124136992808</javaDate><date>5/15/10</date><time>4:16PM/
</time><user>dolson</user><session>3</session>
<sasSession>a70abab74efe542e:-526869£2:1279155b649:-7f55<sasSession>
<code>0</code> <description>Logon</description></event>

In this example, the same user opens a SAS Web Report Studio report. This user’s
session value of 3 indicates that this is the same user whose logon session was
identified with a value of 3 earlier. Here, the code value of 4 and the description
indicate that the user opened a report.

<event><javaDate>1124136923432</javaDate><date>5/15/10</date><time>4:17PM/
</time><user>dolson</user><session>3</session>
<code>4</code><description>Open</description>
<report>/ReportStudio/Shared/Reports/Deanna/Bursting/Orion 2 level bygroup -3
</report></event>

In this example, the user logs off from SAS Web Report Studio. The code value of 2
and the description indicate that logoff occurred for this user whose sessions were
associated with the value of 3.

<event><javaDate>1124136992808</javaDate><date>5/15/10</date><time>5:00PM/
</time><user>dolson</user><session>3</session>
<code>2</code> <description>Logoff</description></event>

Report Events in the Key User Action Log

The information in the Key User Action Log can be imported into SAS data sets and
presented in reports. To report the data, follow these steps:

1 Import the WebReportStudio4.3_ KeyActions.log data into a SAS data set.
Here are the main steps:

a Assign a libref to an XML file that contains log data, and specify the XML
engine.
In the following example, MyFile.xml is a copy of a Key User Action Log
file:

libname myxml xml ’'C:\My Files\XML\MyFile.xml’;

b Use the SAS data sets procedure to import the XML file into a SAS data set.
Here is an example:
proc data sets library=myxml;

This code creates a data set named EVENT in the MYXML library.
For more information, see SAS online Help and documentation.

2 In SAS Information Map Studio, create an information map based on the data set
that you created in the preceding step. For the information map, you might want
to provide the ability to filter based on the event code (<code> tag), the user name
(<user> tag), the report name (<report> tag), or the date (<date> tag). For
information about using SAS Information Map Studio, see the product Help.
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3

In SAS Web Report Studio, define a report based on the information map that you
created in the previous step. You can define the report to be refreshed manually,
and then schedule the report to run at regular intervals.

Redirect Key User Action Files to a Different Directory

By default, the Key User Action log files are saved in the SAS-configuration-directory
\Levl\Web\Logs directory. However, you can specify a different directory where the
Key User Action log files can be saved.

To specify a different directory where Key User Action log files can be saved, follow
these steps:

1

In SAS Management Console on the Plug-ins tab, navigate to Application
Management » Configuration Manager » Web Report Studio 4.3 and right-click
to display the Web Report Studio 4.3 Properties dialog box.

2 Click the Aadvanced Tab.
3 Click add to display the Define New Property dialog box.
4 Enter the property name as shown and specify the property value:

0 N o O

Property Name: sas.wrs.keyUserActionLog.path

Property Value: Fully Qualified Directory Path

Click oK to exit the Define New Property dialog box.

Click Add in the Web Report Studio 4.3 Properties dialog box.

Click oK to exit the Web Report Studio 4.3 Properties dialog box.

To enable the property to take effect, restart your Web application server.

Improving the Performance of SAS Webh Report Studio

Suggestions for Improving the Performance of SAS Web Report Studio
To optimize the performance of SAS Web Report Studio, do the following:

O

By default, SAS Web Report Studio is configured with server-side pooling.
Server-side pooling is controlled by the server end spawner. Setting up a pool of
workspace server processes eliminates the need to start a new process for each
user request. Client-side pooling is also available as an option. Both types of
pooling enable connections to relational workspace servers. For more information
about server-side and client-side pooling, see the SAS Intelligence Platform:
Security Administration Guide. Also, see SAS Intelligence Platform: Application
Server Administration Guide.

Modify the workspace server start-up options to specify a work library, a buffer size
for writing files to the work area, and a limit on SAS memory usage. For details,
see the SAS Intelligence Platform: Application Server Administration Guide.

Configure your middle tier as recommended in Chapter 3, “Best Practices for
Configuring Your Middle Tier,” on page 23.

Make appropriate use of pre-generated reports, such as manually refreshed
reports. Use report scheduling to control when pre-generated reports are
generated. Pre-generated reports offer faster performance than live reports. You
can improve your site performance significantly by increasing the usage of
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pre-generated reports. You can schedule reports to be generated on a nightly,
weekly, or monthly basis. For more information, see “Understanding
Pre-generated Reports” on page 252.

0 Use the query cache, which is enabled by default. You can change the location of
the cache, and you can disable caching. For more information, see “Using the
Query Cache” on page 209.

Using the Query Cache

Overview of the Query Cache

By default, SAS Web Report Studio (and SAS Web Report Viewer) use a large query
cache to improve performance. For reports that contain more than one data-driven
object, this cache maximizes efficiency. The query cache builds a temporary common
data table that can fulfill the needs of all data-driven objects in the report. When the
query cache is used, complex queries that include functions such as joins and filters are
run only once (to build the common data table). Each data-driven object in the report
can then run simple extraction queries against the common data table.

Note: The use of the cache is determined on a per-session basis, depending on the
content of each report. In the current release, cache optimization is used only for
reports that are based on relational data. A

During installation, the query cache is enabled and is associated with a SAS library.
After installation, you can perform the following optional tasks:

O change the location of the query cache library

O disable the query cache

Using the query cache will likely increase performance if your reports have the
following characteristics:

O joins from many tables

O many BY groups

0 multiple report objects

O data sources other than SAS (for example, Teradata or DB2)

o formatted data values from data sources other than SAS

Conversely, using the query cache will not increase performance for a report that has
all of the following characteristics:

o few joins from few tables

O

few BY groups

O

few report objects

O

only SAS data tables as a source, or non-formatted data values from data sources
other than SAS

There is no performance penalty for using the query cache unless the report uses a
large native SAS table with report-ready data.

Manage Host Access to the Query Cache Directory

By default, the query cache directory is located at your equivalent of
SAS-configuration-directory\Lev1\SASApp\Data\wrstemp. In order to protect any
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sensitive data in the cache, ensure full functionality, and optimize performance, it is
important to carefully manage operating system access to this directory. The following
table provides details.

Table 16.5 Who Needs Operating System Access to the Query Cache Directory

Server That Retrieves the Data Account That Accesses the Directory
Server-side pooled workspace server The launch credential of the server.
Client-side pooled workspace server Each puddle login.

Standard workspace server Each requesting user.

Here are some additional notes:

O In a new installation, appropriate initial protections are established for you.
However, if you change your server configuration or relocate the directory, make
sure that appropriate access is preserved.

0 On UNIX and z/OS, the directory’s owner (the SAS Installer account) and the
owner’s primary group have read, write, and execute permissions for the
directory. The SAS Spawned Servers account (for example, sassrv) should be
a member of the SAS installer’s primary group. All other users have no
access to the directory.

0 On Windows, the directory inherits access from its parent directory. The
configuration grants read, write, and modify permissions to the SAS Spawned
Servers account (sassrv).

O As a precaution, a background process deletes any tables that are not cleaned up
in the course of a transaction. Host access to the tables is achieved through the
pooled server’s launch credential or puddle login (if no pooling is involved, the SAS
Spawned Servers account, sassrv, is used).

0 We recommend that you specify the same query cache for all SAS application
server contexts within a deployment of SAS Web Report Studio.

Note: If you are setting up a restricted client-side pool in order to do secure
row-level permissions, designate a separate query cache directory for the
additional deployment of SAS Web Report Studio and give only the restricted
puddle login account access to the query cache directory. A

Change the Location of the Query Cache Library

The default location for the library that is used for the query cache is
SAS-configuration-directory\Lev1\SASApp\Data\wrstemp. After installation, you can
specify a different location for this library. For performance purposes, the library should
be created on a dedicated fast drive that has plenty of disk space (approximately
100GB, but the needed size will vary based on your system’s use and the number of
users). Backups are unnecessary because the cache files are temporary. Temporary files
are accessed by the relational workspace server. Therefore, the wrstemp library should
ideally be located on the same server. In addition, RAID configurations decrease
performance and are not recommended.

Note: Do not use the WORK or SAS WORK library for this feature. The query
cache will not function correctly if you use the WORK or SAS WORK library. A

For clustered environments, the folder for this library needs to be exported to all
nodes in the cluster (and you should specify the network address to this folder, not the
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local machine address). For non-clustered environments, or for a cluster that is
restricted to a single physical machine, this folder does not need to be exported.

The following display shows the BI Rep Sve Wkspace Config 4.3 Properties dialog box
where the settings for caching are configured:

BI Rep S¥c Wkspace Config 4.3 Properties

General Settings | ndvancedl nuthorizationl

[ Show only required items {denoted by *)

|Caching and Distribution Reset to defaulks |
* Query cache enabled: Reset
Itrue LI
Query cache 545 library name: Reset
ISnSnpp - wrskermp
Query cache server: Reset
ISP.SApp - Logical Pooled Workspace Server
Distribution 543 library name: Reset

ISnSnpp - wrsdist

[a]4 I Cancel | Help

To view the query cache library, follow these steps:

1 On the Plug-ins tab in SAS Management Console, navigate to Application
Management » Configuration Manager.

Right-click on BI Web Services for Java 9.2 and select Properties.

3 In the BI Rep SVC Wkspace Config 4.3 Properties dialog box, select the Settings
tab.

4 Verify that the appropriate values are specified for each of the following fields:
O Query cache enabled: true
O Query cache SAS library name: SASApp-wrstemp
O Query cache server: SASApp --- Logical Pooled Workspace Server
O Distribution Library: SASApp-wrsdist
Click oK to exit the dialog box.

6 If you modified the value for any property, you should restart the Web application
server to enable the properties to take effect.

Disable the Query Cache
To disable the query cache in the SAS Management Console, follow these steps:
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On the Plug-ins tab in SAS Management Console, navigate to Application
Management > Configuration Manager.

2 Right-click on BI Rep Svc Wkspace Config 4.3 and select Properties.
3 In the BI Rep SVC Wkspace Config 4.3 Properties dialog box, select the Settings

tab.
In the Query cache enabled field, select false.

If you are certain that you will not use the query cache in the future, modify the
Query cache SAS library name field by leaving it blank. If applicable, edit the
autoexec_usermods.sas file to remove the library assignment. If there is a
possibility that you will re-enable the query cache, then you should leave the
library in place.

Click oK to exit the dialog box.

To enable this change to take effect, restart your Web application server.

Redeploy SAS Weh Report Studio

After initial installation, if you make configuration changes, then you should rebuild
and redeploy SAS Web Report Studio. You would redeploy SAS Web Report Studio for
the following reasons:

O
O
O
O

O
O

SAS Web Report Studio is unconfigured and then reconfigured.
Workspace servers are changed.
Scheduling is configured.

The name of the deployed Enterprise archive (EAR) file and context root used to
access it is changed.

Restrictive policy files are implemented or modified.
Hot fix is used.

For information about rebuilding SAS Web applications with the SAS Deployment
Manager, and manually redeploying SAS Web applications to a Web application server,
see “Rebuilding the SAS Web Applications” on page 92.
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Overview of SAS Web Report Studio Folders

Proper storage of reports and report-related objects is important because storage of
reports (and some report-related objects) must always be synchronized between your
metadata repository and your external content server. In addition, if you organize
storage of reports appropriately for your environment, then controlling access to reports
is easier.

You have the flexibility to choose the location of the SAS Web Report Studio user
folders anywhere within the SAS Folders directory on the Folders tab of SAS
Management Console. For example, you can create a folder called Shared and ensure
that users’ documents such as reports, information maps, and stored processes are
stored in this folder. Another option is to create separate folders for reports,
information maps, and other items.

For each folder that you create within the SAS Folders directory, a corresponding
directory is also automatically created in the SAS Content Server. In this way, SAS
Management Console preserves the necessary synchronization between the folders in
the metadata repository and the content server.

For information and guidelines about how to set up your SAS folders, see the SAS
Intelligence Platform: System Administration Guide.

To manage the availability of images, templates, and items for report distribution to
users, SAS Web Report Studio administrators have access to the certain folders in the
SAS Content Server and within SAS Management Console. These folders, which can be
accessed by the SAS administrator, are as follows:

SAS Folders/System/Applications/SAS Web Report Studio/Common/
BannerImages
the folder where SAS Web Report Studio looks for banner images when building a
report. Banner images are available for users to insert into headers and footers in
their documents. You use SAS Management Console to manage the contents of the
BannerImages folder.

In SAS Web Report Studio 4.2, the folder path is SAS Folders/System/
Applications/SAS Web Report Studio/Web Report Studio 4.2/
BannerImages. When you upgrade to SAS Web Report Studio 4.3, existing images
remain in the old folder (so that referencing reports continue to work) and are also
copied to the new folder.

SAS Folders/System/Applications/SAS Web Report Studio/Common/
ConditionalHighlightingImages
the top-level folder for conditional-highlighting images that can be included in
reports.

In SAS Web Report Studio 4.2, the folder path is SAS Folders/System/
Applications/SAS Web Report Studio/Web Report Studio 4.2/
ConditionalHighlightingImages. When you upgrade to SAS Web Report Studio
4.3, existing images remain in the old folder (so that referencing reports continue
to work) and are also copied to the new folder.

SAS Folders/System/Applications/SAS Web Report Studio/Common/
ReportTemplates
the folder for the templates that are used when you create reports with custom
layouts in SAS Web Report Studio.

In SAS Web Report Studio 4.2, the folder path is SAS Folders/System/
Applications/SAS Web Report Studio/Web Report Studio 4.2/
ReportTemplates. When you upgrade to SAS Web Report Studio 4.3, this folder
and its contents are moved to the new location.
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SAS Folders/System/Applications/SAS Web Report Studio/Common/
DistributionDefs
the folder for items that handle report scheduling and distribution.

In SAS Web Report Studio 4.2, the folder path is SAS Folders/System/
Applications/SAS Web Report Studio/Web Report Studio 4.2/
DistributionDefs. When you upgrade to SAS Web Report Studio 4.3, this folder
and its contents are moved to the new location.

Storage Folders for SAS Web Report Studio Content

Storage folders for SAS Web Report Studio must exist in both the foundation SAS
Metadata Repository and the SAS Content Server or the file system. The sas
Folders/System/Applications/SAS Web Report Studio/Common folder in the
metadata repository corresponds to the sasfolders/System/Applications/SAS Web
Report Studio/Common directory in the SAS Content Server. These top-level folders
are created during installation, configuration, and deployment.

The parallel storage structures are necessary because reports and some report-related
objects (such as images) have both a metadata component and a content component. For
example, for each report that is saved in SAS Web Report Studio, two objects are stored:

0 A metadata object that describes the report is stored in your metadata repository.
The report metadata object contains information such as time stamps, authorship,
access controls that provide security for the report, and other report-specific and
application-specific properties.

O A report definition file is stored in your content server. The report definition file is
an XML file that contains information about how the report is presented and what
data is included in the report. The report definition is constructed according to the
SAS Report Model, which is an XML specification for business reports. Reports
that comply with the SAS Report Model can be created, viewed, and modified by a
variety of SAS applications.

In order to display a report, SAS Web Report Studio must retrieve both of these
components. The parallel storage structures in the metadata repository and the content
server facilitate this two-part retrieval.

CAUTION:
You must keep the report content files synchronized with their corresponding metadata
objects. ~

For details about how to keep report content files synchronized with their
corresponding metadata objects, see “Best Practices for Managing SAS Folders” in the
SAS Intelligence Platform: System Administration Guide.

Display Users’ Legacy Path Folders After Migration to SAS Web
Report Studio 4.2 or 4.3

If your site has migrated from SAS Web Report Studio 3.1 to SAS Web Report Studio
4.2 or 4.3, previous users of SAS Web Report Studio can navigate to their folders, which
are located within the SAS Folders directory.

The following display shows the Web Report Studio 4.3 dialog box where the Show
Legacy Paths field is set to Yes by default after migration from SAS Web Report
Studio 3.1 to SAS Web Report Studio 4.3. If there was no migration, this field is set to
No by default.
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Display 17.1 Show Legacy Paths for SAS Web Report Studio

Web Report Studio 4.3 Properties [ x|

General | Connection  Settings I Advanced | Authorization |
Application I Show only required items (denoted by *)
User Interface
Regional Settings |Applicati0n = Configuration Reset to defaults |
Paoling * v
Configuration * Allaw Public Users Resat ﬁ
Scheduling *
Matifications INU ;I
General Configuration "
Administrative and Errar Mg Force Relative URLs Reset
Formats
Formats Some Frank end security processors require relative URLs for
Currency Formats images and other content.
[no [
* Show Legacy Paths Reset I
Display the WRS Location drop down with legacy paths §if they
exist],
[ves [
*
Show Manage Credentials Reset I
Helpful if users Frequently enter secondary credentials
[to =
* Web Cantainer is Clustered Reset
Is the web container {WebSphere, Weblogic, JBaoss, .0 ina
clustered configuration? It is safe to say ves if unsure,
Yes LI
i b
[a]'4 I Cancel | Help

The legacy path folders are displayed in the drop-down Location menu in SAS Web
Report Studio. The following table shows the legacy folder paths and types of files that
are typically displayed when the drop-down menu is chosen under Location.

Table 17.1 Legacy Folder Paths in SAS Web Report Studio 4.2 or 4.3

Function in SAS Web Report Studio 4.2 or 4.3 Legacy Folder Paths

Open Report /BIP Tree/ReportStudio/Shared/Reports
Open Info Map /BIP Tree/ReportStudio/Maps
Locate Image to Include /BIP Tree/ReportStudio/Shared/Images

In the following display, the user has chosen to open a report and is able to view the
legacy folder path for /BIP Tree/ReportStudio/Shared/Reports.
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Ahout Predefined Roles

To enable the availability of specific capabilities provided by SAS Web Report Studio
and SAS Web Report Viewer users, each user can be assigned to one or more predefined

roles.

Note: You are not required to use predefined roles. However, it is recommended that

you do not modify predefined roles. You can create roles to meet your own

requirements, and assign capabilities to those roles. A

Predefined Roles and Capabilities for SAS Web Report Studio

SAS Web Report Studio includes three predefined roles with certain capabilities that
are assigned to these roles initially. These predefined roles are:

o0 Report Viewing
0 Report Creation

o Advanced
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You are not required to use predefined roles. You can create roles and assign
capabilities that meet the needs of your organization.

The following display of the Web Report Studio: Report Viewing Properties window
shows the capabilities that are assigned initially to the predefined role, Report Viewing.
This window is accessed by navigating the SAS Management Console to the User
Manager and selecting the capabilities tab in the Web Report Studio: Report
Viewing role window.

Display 17.3 Capabilities for the Report Viewing Role

=] Web Report Studio: Report Yiewing Properties

Generall Members Capabilties I Contributing Roles | Authnrization'
Q) Some roles have implicit capakilities, se= the description on the General kab.

Assigned capabilities { % - The tree icons reflect current selections and can be used ko change those selections, )

B [ Applications -
[#-Bg [ Enterprise Guide 4.3
@B ] Management Console 9.2
=T = web Report Studio 4.3
E'FE I:l Basic
; Comments
Print
Allow Direct Access ta Information Maps
Allow Direct Access to Cubes
Allow Direct Access to Tables
Promote Web Repart Viewer ko Web Repart Studia
Refresh Daka
Modify Repaository
--TFg [ oLap
b [ Dvill
- [ Drill To Detail
o [ Expand &nd Collapse
“ [T Expand &nd Collapse Al
=Bz ] Output
o [F Save
fo [T Emnail
= [T Export b
o [T Schedule Ovn Report

El % D Report Creation d

1 P 70 A e Fmmewk S mbine

a9an99aT

Description:

OF I Cancel Help

The following table shows three predefined roles, and capabilities that are initially
assigned to these roles in SAS Web Report Studio. Capabilities that are assigned
initially to these roles are indicated by an X. You can modify the original settings,
assign additional capabilities, or remove capabilities from these roles.

Certain capabilities are duplicated across the three predefined roles. For example, all
of the assigned capabilities for Report Viewing are also available in the Report Creation
and Advanced roles.

Note: If a user has been assigned multiple roles and multiple capabilities, removing
a capability from one role does not negate that capability if the user was assigned that
capability in a different role. For example, if John was assigned Print capability in all
three roles (Report Viewing, Report Creation, and Advanced), removing the Print
capability from the Advanced role alone does not prevent John from using that
capability. In order to completely remove the Print capability for John, it must be
deselected for all three roles to which John belongs. Alternatively, John can be assigned
to a single role where the Print capability is not assigned. »
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Table 17.2 Roles and Capabilities for SAS Web Report Studio
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Capability Report Viewing Report Creation  Advanced
Basic

Comments X X X

Print X X X

Allow Direct Access to X X X

Information Maps®

Allow Direct Access to Cubes’ X X X

Allow Direct Access to Tables®

Promote WRV to WRS X X X

Refresh Data X X X

Modify Repository X X X
OLAP

Drill X X X

Drill to Detail X X X

Expand and Collapse X X X

Expand and Collapse All X X
Output

Save X X X

Email X X

Export X X

Schedule Own Report X X
Report Creation

Create Report X X

Basic Edit X X

Aggregate or Detail X

Select All Data X X

Select Data in View X X

Copy Section® X X
Advanced Report Creation

Create Cascade Reports

Create Report Links X

Create Remote Application Report X

Links®

Advanced Edit X

Update Resources® X
Advanced Scheduling

Distribute X
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Capability Report Viewing Report Creation  Advanced
Save Archive X
Schedule Any Report X
Schedule Folder X

Administrative

Manage Distribution List

1 If you are using (or if you migrated from) SAS Web Report Studio 4.2, then the name of this
capability is Open Maps as Reports.

2 This capability is new in SAS Web Report Studio 4.3.

3 If you are using (or if you migrated from) SAS Web Report Studio 4.2, then the name of this
capability is Repair Report.

In order to be functional, some capabilities have prerequisites. Following is an
explanation of each capability and prerequisites for certain capabilities:

Basic:Comments
provide access to Comment Manager.

Basic:Print

generate PDF output.

Basic:Allow Direct Access to Information Maps

open information maps directly as reports. Without this capability, information
maps are suppressed from the Open and Manage pages. With this capability, users
can access information maps from the Open and Manage pages and view them as
reports. Users who have the Create Report capability can select an Edit action
when an information map is selected.

If you are using (or if you migrated from) SAS Web Report Studio 4.2, then the
name of this capability is Open Maps as Reports.

Basic:Allow Direct Access to Cubes
open cubes directly as reports, or open cubes as information maps when specifying
a data source. Without this capability, cubes are suppressed from the Open and
Manage pages. With this capability, users can access cubes from the Open and
Manage pages and view them as reports. Users who have the Create Report
capability can select an Edit action when a cube is selected.
This capability is new in SAS Web Report Studio 4.3.

Basic:Allow Direct Access to Tables
open tables directly as reports, or open tables as information maps when
specifying a data source. Without this capability, tables are suppressed from the
Open and Manage pages. With this capability, users can access tables from the
Open and Manage pages and view them as reports. Users who have the Create
Report capability can select an Edit action when a table is selected.

By default, this capability is not assigned to any roles because it would allow
users to bypass BI row-level permissions. If you have not implemented BI
row-level permissions, then consider adding this capability to the same roles to
which Allow Direct Access to Cubes is assigned.

This capability is new in SAS Web Report Studio 4.3.

Basic:Promote Web Report Viewer to Web Report Studio
displays the SAS Web Report Studio interface when a user requests to view a
report from another product such as SAS Information Delivery Portal. Initially,
this capability is assigned to all predefined roles. If this capability is unassigned,
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and a user’s request to view a report from within another product is granted, then
the SAS Web Report Viewer interface is used to present the report. When this
capability is assigned to a role to which a user belongs, the SAS Web Report
Studio interface is displayed when that user requests to view a report through the
SAS Information Delivery Portal or other products.

Basic:Refresh Data
refresh data for reports.

Basic:Modify Repository
provide basic modifications to repository such as copy, move, rename, and delete.
This capability does not grant the ability to save changes to reports.

OLAP:Drill
perform an OLAP drill operation.

OLAP:Drill to Detail
drill through to detail data for a single OLAP value.

OLAP:Expand and Collapse
expand or collapse OLAP data.

OLAP:Expand and Collapse All
expand or collapse an entire OLAP hierarchy. This capability requires the Report
Creation:Basic Edit capability and the OLAP:Expand and Collapse capability.

Output:Save
save changes to reports. This capability requires that the user also has Modify
Repository capability.

Output:E-mail
e-mail a report link.

Output:Export
export report content to Microsoft Excel.

Output:Schedule Own Report
schedule reports authored by the users themselves. The Schedule All Reports
capability is available in the SAS Web Report Studio’s Advanced role.

Report Creation:Create Report
create new reports. The Save capability is a prerequisite for this capability.

Report Creation:Basic Edit
perform basic editing operations for tables and graphs. Operations include:

O Assign Data

Total dialog box access

Control of Total Type for OLAP reports only (parent versus visual)

Percent of Total

Filter and Rank

Conditional Highlighting

Rotate Table

View Data Details

Sort, Sort Priority, Remove All Sort

Move

Hide

Replace / Swap

All Table Properties

O 0O oo ooooaogo o o
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o All Graph Properties

Report Creation:Aggregate or Detail
specify whether data is detail data or aggregated data (relational reports only)

Report Creation:Select All Data
able to choose “Select All” data items from the Select Data dialog box.

Report Creation:Select Data in View
use the Select Data dialog box to select data while viewing a report.

Report Creation:Copy Section
create a new report section that is a complete copy of another section. This
capability is new in SAS Web Report Studio 4.3.

Advanced Report Creation:Create Cascade Prompts
create cascading prompts.

Advanced Report Creation:Create Report Links
create linked reports.

Advanced Report Creation:Create Remote Application Report Links
create linked reports that link to another SAS application. This capability is new
in SAS Web Report Studio 4.3.

Advanced Report Creation:Advanced Edit
enable users to perform the following functions:

o Isolate
0 Member Properties
0 Suppress Empty

The Report Creation: Basic Edit capability is a prerequisite for this capability.
In SAS Web Report Studio, the Include Member with Only Missing Values
menu item is available only for multidimensional data sources. The Suppress
Empty function in the Advanced Edit capability is required in order for users of
multidimensional data sources to view and use the Include Member with Only
Missing Values menu item under the Data Menu in SAS Web Report Studio.

Advanced Report Creation:Update Resources
update an invalid information map reference that is contained in a report
definition. If you are using (or if you migrated from) SAS Web Report Studio 4.2,
then the name of this capability is Repair Report.

Advanced Scheduling:Distribute
schedule a report distribution.

Advanced Scheduling:Save Archive
archive file versions. When creating a pre-generated version of a report (for
example, a scheduled report), a version of the report is archived as a PDF file.
Reports with archived versions are visually different in report selection dialog
boxes, and access is allowed to these archived versions.

Advanced Scheduling:Schedule Any Report
schedule any report to which the users have WriteMetadata access, including the
reports that they have authored.

Advanced Scheduling:Schedule Folder
schedule a folder.

Administrative:Manage Distribution List
create, edit, or delete a distribution list.
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CAUTION:
Use of this capability creates a new physical table. Therefore, this capability must be
restricted to few users. The distribution list contains e-mail addresses. Initially, this
capability is not assigned to any SAS Web Report Studio role. An administrator can
assign this capability to the Advanced role, or create a new role (for example, a role
named as Manage Distribution) specifically for this capability and assign this role to
a restricted number of users.

Predefined Roles for SAS Web Report Viewer

SAS Web Report Viewer includes two predefined roles with certain capabilities
assigned initially to these roles. These predefined roles are:

o0 Report Viewing
0 Advanced

SAS Web Report Viewer does not allow users to create or modify reports.

The following table shows the two predefined roles for SAS Web Report Viewer.
Capabilities that are initially assigned to these roles are indicated by an X. You can
unassign existing capabilities or reassign capabilities to these roles. Unlike SAS Web
Report Studio, SAS Web Report Viewer has a smaller subset of capabilities available for
roles.

Table 17.3 Roles and Capabilities for SAS Web Report Viewer

Capability Report Viewing Advanced
Basic
Comments X X
Print X X
Allow Direct Access to Information Maps’ X X
Allow Direct Access to Cubes® X X

Allow Direct Access to Tables®

Refresh Data X X
OLAP

Drill X X

Drill to Detail X X

Expand and Collapse X X

Expand and Collapse All X
Output

E-mail X

Export X

1 If you are using (or if you migrated from) SAS Web Report Viewer 4.2, then the name of this
capability is Open Maps as Reports.
2 This capability is new in SAS Web Report Viewer 4.3.

Basic:Comments
provide access to Comment Manager.

Basic:Print
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generate PDF output.

Basic:Allow Direct Access to Information Maps
open information maps directly as reports. Without this capability, information
maps are suppressed from the Open and Manage pages. With this capability, users
can access information maps from the Open and Manage pages and view them as
reports.
If you are using (or if you migrated from) SAS Web Report Viewer 4.2, then the
name of this capability is Open Maps as Reports.

Basic:Allow Direct Access to Cubes
open cubes directly as reports, or open cubes as information maps when specifying
a data source. Without this capability, cubes are suppressed from the Open and
Manage pages. With this capability, users can access cubes from the Open and
Manage pages and view them as reports.
This capability is new in SAS Web Report Viewer 4.3.

Basic:Allow Direct Access to Tables
open tables directly as reports, or open tables as information maps when
specifying a data source. Without this capability, tables are suppressed from the
Open and Manage pages. With this capability, users can access tables from the
Open and Manage pages and view them as reports.

By default, this capability is not assigned to any roles because it would allow
users to bypass BI row-level permissions. If you have not implemented BI
row-level permissions, then consider adding this capability to the same roles to
which Allow Direct Access to Cubes is assigned.

This capability is new in SAS Web Report Viewer 4.3.

Basic:Refresh Data
refresh data for reports.

OLAP:Drill
perform an OLAP drill operation.

OLAP:Drill to Detail
drill through to detail data for a single OLAP value.

OLAP:Expand and Collapse
expand or collapse operation for OLAP data.

OLAP:Expand and Collapse All
expand or collapse an entire OLAP hierarchy. This capability requires the Report
Creation:Basic Edit capability and the OLAP:Expand and Collapse capability.

Output:E-mail
e-mail a report link.

Output:Export
export report content to Microsoft Excel.

Adding Content for Use by Report Creators

Add Content for Use by Report Creators

The resources that can be used as inputs to SAS Web Report Studio are information

maps, stored processes, banner images, fonts, and existing reports from other locations.
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SAS Web Report Studio uses the metadata server to access these resources, so these
resources must be registered in the metadata repository. The following sections describe
how to add this metadata to the repository.

Typically, the addition and changes of content is accomplished from within SAS Web
Report Studio. Alternatively, you can also add content from within SAS Management
Console.

Note: If you plan to use geographical maps in reports, then see “About the ESRI
Map Component” on page 451. A

Make Data Sources Available to SAS Web Report Studio

About Data Sources for SAS Web Report Studio

In SAS Web Report Studio, the term data source refers to information maps, tables,
and cubes. All data sources contain data items, which can refer to calculations or
physical data (tables or cubes).

Information maps provide a metadata (information) layer between the nontechnical
business user and the complexities of database structure and query languages.
Information maps are created with SAS Information Map Studio or the INFOMAPS
procedure. In a report that is created with SAS Web Report Studio, each section can
use only one information map. However, you can have multiple sections per report.

Make Information Maps Available to SAS Web Report Studio

In order for an information map to appear in the list of data sources in SAS Web
Report Studio, the user of SAS Web Report Studio must have both Read and
ReadMetadata permission to the information map.

Information maps can exist in any folder with one exception. If the special map
accessibility check is selected in the Web Report Studio 4.3 Properties dialog box
(typically used for sites with row-level permissions) and the information map is
relational, then the map must reside below one of the folders specified by the
administrator. In this case, the administrator can restrict SAS Web Report Studio to
use only relational information maps from known locations.

To enable the special map accessibility check, see “Limit the Availability of Relational
Information Maps That Implement Row-Level Security” on page 230.

Provide Direct Access to Tables and Cubes in SAS Web Report Studio

In SAS Web Report Studio 4.3, users who are in the appropriate roles can interact
directly with SAS data sets, third-party relational database tables, and SAS OLAP
cubes. To make a table or cube appear in a user’s list of data sources in SAS Web
Report Studio, do the following:

1 Give the user both Read and ReadMetadata permission to the table or cube.

2 Ensure that the user has the capability Allow Direct Access to Tables or
Allow Direct Access to Cubes.

Make Stored Processes Available to SAS Web Report Studio

Including a stored process in a report section is one of the ways in which to obtain
data for the report. Each report section can contain multiple stored processes. When
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the report section is rendered, the output of each included stored process is displayed.
Users can also run stored processes directly from within SAS Web Report Studio.

You cannot use SAS Web Report Studio to modify the query that is generated from
the stored process, but you can use SAS Web Report Studio to add layout elements such
as headers, footers, images, and text that are independent of the stored process output.

You can convert existing SAS programs into stored processes for use in SAS Web
Report Studio. The programs can be parameterized, which enables users to input data
in response to prompts. Prompted parameter values are transferred to the stored
process as macro variables. To convert an existing program to a stored process, follow
these steps:

1 Insert a *PROCESSBODY statement.
2 Insert a %STPBEGIN statement before a section of the code that produces output.
3 Insert a %STPEND statement after a section of the code that produces output.

For example, to alter this SAS program:

$let year=2002;

title "Sports & Outdoors Sales &year";

proc print data=sashelp.orsales;
where year=&year;

run;
to become a stored process, change the code to look like this:

$global year;
*processbody;
$stpbegin;

title "Sports & Outdoors Sales &year";
proc print data=sashelp.orsales;
where year=&year; /* &year is a parameter from a user prompt */

run;

$stpend;

Stored process output that will be included in a report must be generated through
the Output Delivery System (ODS). Output that is generated in other ways, such as
with PUT statements, is not accessible from SAS Web Report Studio. The %STPBEGIN
and %STPEND macros in the stored process code ensure that ODS is used to generate
the output.

The ODS output type for each stored process is determined by the manner in which
the stored process is registered and executed. The ODS output type should not be
controlled by making changes to the stored process code (neither by setting the value of
the stored process input parameter _RESULT, nor by explicit ODS statements).

The following table indicates how the style is determined for stored process output.
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Table 17.4 Style of Stored Process Output

Type of Output Example Style of Output

ODS text output PROC PRINT listing The style is determined by the
user’s preferences in SAS Web
Report Studio. For example,
"Seaside."

ODS graphical output PROC GCHART graphs The default is an ActiveX
device.* ActiveX also uses the
default style such as Seaside.
GOPTIONS DEVICE=ACTIVEX;

By default, the ACTIVEX device driver is used for graphs in stored process output. This format
requires users to install a graph control on their local system in order to render the graph.
However, to maintain a zero footprint on the client, SAS Web Report Studio does not require
this installation. Therefore, when the stored process is run in SAS Web Report Studio, the
ACTXIMG device driver is substituted so that a static image is created. Similarly, if the JAVA
device driver is specified, then the JAVAIMG device driver is substituted automatically.

To make a stored process available to users of SAS Web Report Studio, follow these
steps:

0 Register the stored process in the metadata by using either SAS Management
Console or SAS Enterprise Guide.

o In SAS Management Console, navigate to the stored process under SAS Folders.
On the Authorization tab for the stored process properties, verify that your SAS
Web Report Studio users have ReadMetadata access to the stored process.

To learn more about stored processes, see "SAS Stored Processes" in SAS 9.2 Stored
Processes: Developer’s Guide.

Make Images Available to SAS Web Report Studio

Each report that is created in SAS Web Report Studio can include one or more

images. The types of images that report creators can use are described in the following
table.
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Table 17.5 Images for SAS Web Report Studio

Type of Image Details and Defaults

Banner images Any report can include a banner image in the header and footer of the

report. Banner images make it easier for report consumers to identify the
report and to distinguish the report from other reports. Banner images
are stored in SAS Folders/System/Applications/SAS Web Report
Studio/Common/BannerImages.*

By default, the BannerImages folder is empty. Use the Folders tab in
SAS Management Console to manage your banner images.

Conditional A report that includes tables can use images to draw attention to items
highlighting images that might be of particular interest to report consumers. A report creator

can define conditions and, for each condition, select an image that is
displayed in every table cell where the condition is met. Conditional
highlighting images are stored in SAS Folders/System/
Applications/SAS Web Report Studio/Common/
ConditionalHighlightingImages.*

Use the Folders tab in SAS Management Console to manage your
conditional highlighting images.

Other images Any report can include additional images for decorative or other purposes.

These images can be stored under the SAS Folders/Shared/Images
folder or in any other folder of the user’s choice.

By default, the Images folder is empty. Use SAS Web Report Studio to add
images to this folder. For instructions, see the Help for SAS Web Report

Studio. Alternatively, you can use SAS Management Console to add images
to the folder. For instructions, see the Help for SAS Management Console.

* In SAS Web Report Studio 4.2, this folder is located in SAS Folders/System/
Applications/SAS Web Report Studio/Web Report Studio 4.2. When you
upgrade to SAS Web Report Studio 4.3, existing images remain in the old folder (so that
referencing reports continue to work) and are also copied to the new folder.

To make a banner image or conditional highlighting image available to users of SAS
Web Report Studio, follow these steps in SAS Management Console:

1
2

Make sure that the SAS Content Server is running.

In SAS Management Console, navigate to the appropriate images folder below sas
Folders.

Right-click on the appropriate images folder to display a menu.

From the menu bar, select Add Content From External File(s) or
Directories.

Select the file (or files) that you want to import and then click Open.

Note: Ifyou select a folder, the folder and its contents are recursively imported. In
SAS Web Report Studio, banner images or conditional highlighting images that are
stored in subfolders of the BannerImages and ConditionalHighlightingImages
folders are displayed in a single drop-down list. A

In the Enter description text box, enter the description that you want to be
displayed for the graphic in SAS Web Report Studio. Image descriptions should be
fewer than 20 characters.

Click OK to close the Enter Description text box. The imported images are
available in SAS Web Report Studio within 10 minutes.

To make the images available immediately, restart the Web application server.
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If an existing image is later modified, you can reimport the new image by using the
preceding instructions. SAS Web Report Studio will detect and use the updated image.
To delete an image so it is no longer available to users of SAS Web Report Studio,

follow these steps:

1 In SAS Management Console, navigate to the appropriate images folder below SAs
Folders and select the image or images that you want to delete.

2 Select the image files to be deleted, and right-click to display a menu.
3 From the menu, select belete and right-click.

Note: The minimum image resolution that is supported for clients (browsers) is
1024 x 768. A

Supported Image Types for SAS Web Report Studio

The following image types are supported by SAS Web Report Studio:
o JPEG

o GIF
o PNG
o BMP

Make Fonts Available to SAS Web Report Studio

You can customize the fonts that are available for tables and graphs in the report.
SAS Web Report Studio (and SAS Web Report Viewer, if it is installed) uses the default
fonts that are loaded from the following files:

O The ServerFonts.xml file lists fonts that are rendered on the server. These are
the fonts that are available for graphs in a report. The fonts that are listed in this
file should be installed on the middle-tier server where SAS Web Report Studio is
deployed.

O The clientFonts.xml file lists the fonts that are rendered on the client (user’s)
system. These fonts are available for tables, headers, and other text. These fonts
should be installed on the client system where the browser is running.

The serverFonts.xml and the ClientFonts.xml files are not modifiable.
To supply custom font definitions, create and edit the following files:

0O LocalServerFonts.xml

O LocalClientFonts.xml

You can create these files from the LocalServerFonts.xml.sample and
LocalClientFonts.xml.sample files that reside in the SAS-configuration-directory
\Levl\Web\Applications\SASWebReportStudio4.3\customer folder. To create the
files:

1 Open LocalServerFonts.xml.sample and save it using the name
LocalServerFonts.xml.

2 Open LocalClientFonts.xml.sample and save it using the name
LocalClientFonts.xml.

Each sample file contains information about adding fonts. Here is the general format
for the font information in the file:

<?xml version="1.0" encoding="UTF-8"?>
<fonts>
<font actualfont="Arial" displayfont="Arial" />
<!-- more fonts -->
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</fonts>

In the preceding code sample, the actualfont attribute is the font name that is
stored in the report. The value for this attribute should match the name of the font on
the system. If they differ, a font substitution can occur. The displayfont attribute is
the font name that is displayed to users.

Note: XML tags, such as <fonts>, are case-sensitive, and should be specified
exactly as shown. A

In the UNIX and z/OS environments, fonts must be installed correctly and loaded by
the JVM in order for SAS Web Report Studio to render them correctly. Both custom
fonts, as well as true type fonts supplied by SAS, should be installed in the jre.../
lib/fonts directory. See your UNIX or z/OS documentation for commands that apply
to font installations.

If you plan to use SAS Web Report Viewer to render reports, create and edit the
LocalServerFonts.xml and LocalClientFonts.xml file for SAS Web Report Viewer
in a similar way. Make a copy of each respective sample file in the SAS-configuration-
directory\Lev1l\Web\Applications\SASWebReportViewer4.3\customer directory and
add your fonts to the copy.

SAS Web Report Studio (and SAS Web Report Viewer, if applicable) must be
reconfigured and redeployed after the custom font files are created or modified. For
details, see “Rebuilding the SAS Web Applications” on page 92.

Make PDF Files Available to SAS Web Report Studio

SAS Web Report Studio enables you to open PDF files from within the application.
To enable the availability of PDF files, upload the files to a folder that is visible to SAS
Web Report Studio.

To upload PDF files for availability in SAS Web Report Studio, follow these steps:

1 In SAS Management Console, go to the Folders tab. Right-click on SAS Folders
to display the menu bar.

2 Below sAs Folders, right-click on Shared Data and select Add Content From
External File(s) or Directories.

3 In the Specify File(s) or Directories dialog box, select A11 Files from the
drop-down list for Files of type.

4 Navigate to the folder that contains the PDF that you want to upload. Select the
PDF file and click open.

5 If desired, enter a description in the File Description field.

You can now view the PDF file or files within SAS Web Report Studio. For
information about opening PDF files within SAS Web Report Studio, see SAS Webd
Report Studio 4.3 User’s Guide.

Limit the Availability of Relational Information Maps That Implement
Row-Level Security

By default, SAS Web Report Studio can interact with information maps regardless of
their location within the folder structure. In some situations, you might choose to
establish a more controlled environment. For example, you might limit the availability
of all relational information maps because some of those information maps include
row-level permissions.

To constrain SAS Web Report Studio so that it interacts only with information maps
that are in designated locations, follow these steps in the SAS Management Console:
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1 On the Plug-ins tab, under Application Management » Configuration
Manager, right-click Wweb Report Studio 4.3 and select Properties.

In the Web Report Studio 4.3 Properties dialog box, select the Advanced tab.
2 Click add.
3 In the Define New Property dialog box, enter each property name and property
value as follows and click OK:
Property Name wrs.map.accessibility.check.enabled
Property Value true.
Property Name wrs.map.accessibility.check.rootlocations
Property Value Path
4 For the property name wrs.map.accessibility.check.rootlocations, specify
one or more folders as the property value. If you list multiple locations, separate
the entries with commas. An example of a path is SBIP://METASERVER/
DepartmentFolder/InfoMaps.
5 Click OK to save your changes.
6 To enable these properties to go into effect, restart the Web application server.

You can specify more than one path for the rootlocations property. If you list
multiple locations, separate the entries with commas. With these settings, a relational
information map is eligible for use in SAS Web Report Studio only if it is located in the
folder path (or its subdirectories).

Note: These settings are typically used in conjunction with metadata layer
permissions. For example, if you specify a folder path that is the only valid location for
relational information maps, you should also limit the WriteMetadata and
WriteMemberMetadata permissions on that folder. A

Note: These settings do not constrain the availability of information maps that use
OLAP data. o

Import Reports That Conform to the SAS Report Model

In addition to enabling users to create new reports, SAS Web Report Studio enables
users to work with reports that were created elsewhere. Importing a report is the
process of retrieving the XML file that defines a report and then adding that report to
your report storage structure. The retrieved XML file is written to the appropriate
directory within your content server, and a corresponding metadata object is created
and stored in a parallel location in the metadata repository.

A report that you import into a new metadata repository will render properly only if
all of the report’s underlying components (such as an information map, a stored process,
and the data sources) are available in the appropriate locations in the new repository’s
report storage structure. To import a report, follow these steps:

1 Log on to SAS Management Console with a metadata profile that connects to the
metadata server into which you will import the report.

2 Navigate to the appropriate folder below SAS Folders, and select the folder into
which you will import the report.

3 Right-click on the appropriate folder to display a menu bar.

4 From the menu bar, select Add Content From External File(s) or
Directories.

5 In the Specify Source File(s) or Directories dialog box, select the report that you
want to import and click open.

6 In the Enter description dialog box, enter a description for the report and click ok.
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Import Legacy Reports

You can use the Output Delivery System (ODS) to make legacy SAS reports available
in a SAS Intelligence environment. For example, you might have a collection of legacy
reports that were created using a SAS program editor, SAS Enterprise Guide, or SAS
IntrNet. You can use ODS to write those reports directly to the ReportStudio storage
structure. SAS Web Report Studio treats the ODS output as a report, allowing a user to
display, move, rename, and delete the output as with any other report. However, this
type of report cannot be edited from SAS Web Report Studio.

To write ODS output directly to the report storage structure, use the SAS Report
XML tag set and the SASXPRRP access method in the FILENAME statement. When
you use the SASXPRRP access method in the FILENAME statement, a SAS Business
Intelligence Protocol (SBIP)* URL identifies the external file to which you want to
write. If your process generates multiple files in the same location, the SBIP URL
should refer to a directory rather than to a specific file.

A trailing slash in the SBIP URL is required when specifying a directory. If the
specified file or directory already exists, it is overwritten.

The following options to the SASXPRRP access method are required unless otherwise
indicated:

USERID="user ID"
specifies the user ID to access the server.

PASSWORD="password"
specifies the password to access the server.

DOMAIN="domain"
specifies the authentication domain name for the server.

OMRHOST="host"
specifies the network name of the machine hosting the metadata repository.

OMRPORT="nnnn"
specifies the port number of the metadata server for accessing the repository.

OMRUSER="user ID"
specifies the metadata user ID to access the repository. This can be the same as
the server user ID, or it can be different.

OMRPASSWORD="password"
specifies the password to access the repository. This can be the same as the server
password, or it can be different.

OMRREPOSNAME="name"
specifies the name of the repository.

For example, the following code outputs SAS Report XML to the specified report
storage container:

filename dest sasxprrp "SBIP://RepName/Departmentl/2008/Users/xyz/Reports"
userid="xyz" password="bip2004" domain="thisDomain"
OMRHost="bipsvrxyz.na.sas.com" OMRPort="9999" OMRUser="xyz"
OMRPassword="bip2004" OMRReposName="RepName"

r

* SBIP is a proprietary protocol for specifying the location of resources in a SAS Metadata Repository. For example, this path

SBIP://METASERVER/Department1/2008/Reports/MyReport.srx specifies the location of a report named

MyReport within a repository named Foundation.
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option noovp;

ods sasreport file="myreport.xml" path=dest;
proc print data=sashelp.class;

run;

ods sasreport close;

Managing Access to Reports

Overview of Managing Access to Reports

The following table summarizes the basic security considerations for reports.

Tahle 17.6 Report Security Considerations

Item Action to Secure the Item

Report definitions Metadata objects that are associated with the reports

Physical storage location of the report definitions

Underlying report data Metadata objects that are associated with the report data
Physical storage location of the report data
Information maps that reference the report data
Stored processes that reference the report data
Report definition (if the report includes embedded data)
Generated report (if the report is a batch report)

Different types of reports require different security measures. For example, if there
is no embedded data of a sensitive nature in a report definition, then the report
definition can be considered secure if the report’s underlying data, information maps,
stored processes, and output are secure. However, pre-generated reports (and some
reports that are created through ODS) can include embedded data, so these reports
must be protected with access controls that parallel the access controls on the
underlying information maps and stored processes.

CAUTION:
Do not rely on restricting access to the underlying information maps or stored processes to
ensure that batch reports are viewed only by the appropriate users. ~

Access to a report can be affected by multiple layers of controls. For example, the
following figure depicts the authorization layers that affect access to reports in a
deployment that is using a SAS content server with the SAS document store located in
a directory in the file system.
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Display 17.4 Authorization Layers That Affect Access to Reports
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In the figure, the requesting user’s access to reports is subject to controls in the
metadata, SAS Content Server, and file system authorization layers. However, the only
layer in which the requesting user’s permissions matter is the metadata layer, because
this is the only layer in which the requesting user’s identity is known. In the metadata
layer, each user’s access to reports is based on the user’s individual identity and group
memberships. When you work with metadata access controls for reports, consider these
points:

O The effective permissions on a report folder are inherited by all of the reports

within that folder.

0 The ability to view or work with a report can be affected by access to each of the
report’s underlying components.

o If your organization uses publication channels to deliver reports, the reports can
also be protected by controlling access to the publication channels. To enable all
registered users to add channels or subscribers or to add items to a particular
channel, see “Permissions by Item” in the SAS Intelligence Platform: Security
Administration Guide.

As the preceding figure depicts, SAS Web Report Studio uses only one account to
connect to the external storage location, so you cannot make access distinctions between
individual users by setting operating system access controls on specific items within the
external storage location. However, you should set operating system controls that allow
only the identity under which the SAS Content Server process is running (local system
in this example) to access this physical file location.

Similarly, SAS Web Report Studio uses only one account, the trusted user sastrust, to
communicate with the WebDAV content server, so you cannot make access distinctions
between individual users by setting access controls in the SAS Content Server.
However, you should use this layer to protect your SAS report content. For information
about how to set permissions by using the SAS Content Server admin console, see
“Using the SAS Content Server Administration Console” on page 126.

For more information about access controls and access management, see “Access
Management Tasks” in the SAS Management Console: Guide to Users and Permissions.
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Change Access to Reports

Each new report subfolder that you create in metadata inherits the effective access
controls of its parent folder. For information about how to limit access to each subfolder
or the items within the subfolders, see “Access Management Tasks” in the SAS
Management Console: Guide to Users and Permissions.

Enable Permissions in Restrictive Policy File for Publishing Reports
to Channels

When a SAS Web Report Studio report is saved as a pre-generated report in PDF
format, the output is published to a channel. The Web application server must have
explicit policy permissions granted to allow read and write access to this directory.

An express or typical installation completed with the SAS Deployment Wizard
creates a SAS environment that does not use restrictive policy files. By default, the
sas.all.permissions.policy is used to allow access to SAS Web applications. As a
result, SAS Web applications can access the necessary content.

If you implement restrictive policies at your site for JBoss or IBM WebSphere
application servers, you must ensure that read and write access is granted to the
directory where pre-generated reports are published to channels.

CAUTION:
SAS strongly discourages the use of restrictive policy files on SAS middle-tier applications
because they provide no end-user security, they are difficult to maintain, and they can be
very detrimental to application performance. ~

For more information about restrictive policy files, see “Configuring and Deploying
Restrictive Policy Files” on page 45.

Security Considerations for Pre-generated Reports

When a pre-generated report is created, the content of the report reflects the access
that the generating user ID has to objects such as data sources and stored processes.
For example, if a pre-generated report is configured to use an identity named
SalesMgrl, then the report can include anything that SalesMgrl is able to access.
Regardless of who actually views the report, the report content is always based on the
access controls that apply to SalesMgrl. This means that any user who has
ReadMetadata permission for a pre-generated report can view that report, even if other
metadata access controls deny the user access to the report’s underlying components
(such as data sources and stored processes). For this reason, you must give careful
consideration to the identity that each pre-generated report uses for generation, and
you must secure the pre-generated reports that you create. Pre-generated reports are
saved and open to anyone who has permissions to the Operating S